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1 Introduction 

GSB-Intro 

Welcome, and thank you for using Origin!  

Origin is a powerful data analysis and publication-quality graphing software, tailored to the needs of scientists 
and engineers. What sets Origin apart from other applications is the ease with which you can customize and 
automate your data import, analysis, graphing and reporting tasks.  

Customizations can range from simple modifications to a data plot, saved as a graph "template" for later use, 
to customized data analyses which produce publication-quality reports, saved as an Analysis Template. Batch 
plotting and analysis operations are also supported, wherein templates are used for repeat analysis of multiple 
files or datasets.  

We are confident that you will find Origin to be an effective tool for analyzing your data and presenting your 
findings. And to help you get the most from Origin, we offer first-class customer and technical support, 
training and consulting services.  

In this guide, unless otherwise noted, "Origin" will refer to both Origin and OriginPro. OriginPro offers all the 
features of Origin, plus extended analysis tools for Peak Fitting, Surface Fitting, Statistics, Signal Processing 
and Image Handling.  

The purpose of this guide is to try and present a broad overview of Origin's capabilities. We hope that new 
users will find this to be a valuable orientation to the Origin workspace and its primary features. For those who 
are already using Origin, we hope you will find useful information on new features and perhaps learn a thing or 
two about Origin features that you had overlooked previously.  

More detailed information is provided in the Origin Help file (Help:Origin from your Origin software's main 
menu) and numerous other learning resources exist. For a complete listing of available resources, see the 
Origin Resources chapter of this guide.  

 
Some things to look for in this guide:  

 

We have added short tutorials to numerous topics throughout this guide. These short 
tutorials are intended to give you a quick introduction to a key Origin feature. These 
tutorials will be marked with this icon.  

 

 

Also, sprinkled throughout this guide, you'll find tips on using Origin. These tips are 
marked with this icon.  

 

 

Important changes to key features and other critical information will be marked with 
this icon.  

We like to get feedback from our users on ways to improve and expand Origin's data analysis and graphing 
capabilities. We would love to hear from you. You can find contact information in the Origin Resources chapter 
of this guide.  

https://www.originlab.com/doc/User-Guide/OriginPro
https://www.originlab.com/doc/User-Guide/Resources
https://www.originlab.com/doc/User-Guide/Resources
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2 Installing and Updating Origin 

Installation-Startup 

2.1 Notes for Upgrade Users 

       

The Origin upgrade installs into a new program folder - it does not update a previous version. It is therefore 
not necessary to install or uninstall a previous version of Origin before upgrading.  

If you are upgrading from Origin 2018 or a later version, the process should be pretty painless. Origin 2018 
and later versions share a common license file and User Files Folder. The first time you run Origin, it should be 
licensed and know where your User Files are located. 

If you are upgrading from Origin 2017, you will be prompted to pick a new User Files Folder (see Selecting a 
User Files Folder, below). If you have custom Origin files from your previous version, you can transfer them 
to your new User Files Folder. From the Preferences menu, select Transfer User Files. Provided your 
Maintenance has not expired, you should not have to re-license your software. If your Maintenance has 
expired, you will need to re-license your Origin software (See Registering Origin, below). 

If you are upgrading from Origin 2016 or earlier, you will need to complete the license management process. 
When your upgrade is launched for the first time, a license dialog will display asking for your Product Key If 
you have custom Origin files from your previous version, you can transfer them to your new User Files 
Folder. From the Preferences menu, select Transfer User Files.  

If you have a dongle package, please update your dongle after the Maintenance renewal to make sure your 
dongle is available for the latest version. Upgrade your dongle by entering a Product Key in the License 
Activation dialog. Once done, you can use this dongle for Origin installed with the same serial number on any 
other computers without re-activating the dongle. 

 
Lastly, we want to point out that your Origin software has some great new features. For more information on 
key features by version, see the originlab.com/VersionComparison page on our website.  

2.2 Notes for Administrators of Multi-user Packages 

 Instructions for getting started with the multi-seat node-locked and concurrent network packages are 
available on the OriginLab website (originlab.com/GetStarted).  

In addition to the InstallShield setup that runs from the Product DVD, an MSI installer and sample transform 
are available. The MSI installer is ideal for use at multi-user sites, as it can be used to build an Origin 
installation package for distribution. Information on the MSI installer and alternate deployment techniques can 
be found on our website:  

MSI Installation 

Silent Install 

Building an Installation Package 

Installing Origin on a Remote Access Server such as Windows Terminal Server or Citrix. 

2.3 Installing Origin 

Origin is a Windows application. You can run Origin on an Intel-based Mac from Boot Camp or by running a 
virtualization software. For more information, see the Running Origin on Mac using Virtualization 
Software, on the OriginLab website.  

There are three steps that must be completed to prepare Origin for use:  

Installation 

Selecting a User Files Folder 

https://www.originlab.com/doc/User-Guide/Installation-Startup
https://www.originlab.com/doc/Origin-Help/UserFilesFolder
https://www.originlab.com/doc/Origin-Help/FileShare-UserFileTransfer
https://www.originlab.com/doc/User-Guide/Installation-Startup
https://www.originlab.com/doc/Origin-Help/UserFilesFolder
https://www.originlab.com/doc/Origin-Help/UserFilesFolder
https://www.originlab.com/doc/Origin-Help/FileShare-UserFileTransfer
https://www.originlab.com/VersionComparison
https://www.originlab.com/getstarted
https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/Multi-userDeployment/MSIInstall
https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/Multi-userDeployment/SilentInstall
https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/Multi-userDeployment/BuildanInstallPackage
https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/Multi-userDeployment/RemoteAccessServer
https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/RunOriginonaMac
https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/RunOriginonaMac
https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/DirectInstall
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License management 

Both the Origin upgrade and the newly-purchased products install into a new program folder. Origin does not 
overwrite previous versions when upgrading, so your old version continues to function. Likewise, your original 
version does not have to be installed when running the upgrade.  

If you are installing from a DVD, the startup program that launches when you insert the Origin DVD, includes 
an Origin installation button. If the startup program does not automatically run, you can browse the DVD to 
launch the setup.exe.  

 

If you are upgrading from a previous verison, the installer will automatically use your 
old version serial number.  

 

 

Origin only supports 64-bit since Origin 2020.  

2.3.1 How to Proceed if You Already Have the Origin Trial Version Installed 

If you already have the trial version of Origin installed on your computer, you can convert it to the full product 
or upgrade.  

If you have purchased the Origin package with node-locked license management, run Origin and select 
Help:Convert Trial to Product; or you can use Help: Activate License, click Activate for this computer 

radio button under the “Or if you have purchased already” section. In either case, you will be asked to enter 
the Product Key that was generated when you registered your software purchase on originlab.com. 

For all other license management packages, run the Origin Add or Remove Files program located in the 
Origin program icon folder, or rerun the Origin installer (both require a log in account with administrator 
permissions). When the Origin setup program starts, select the Modify option and then select Install 
Product (requires serial number). 

2.3.2 How to Correct or Change your Serial Number After you Complete an 

Installation 

If you installed Origin with an incorrect serial number, you can correct it by running the Origin Repair or 
Uninstall Origin program located in your Origin program icon folder, or rerun the Origin installer (both 
require a log in account with administrator permissions). When the Origin setup program starts, select the 
Modify option and then click Yes to change your serial number.  

2.4 Selecting a User Files Folder 

 Each Windows login user must maintain a User Files Folder (UFF) for storing Origin user data:  

If you are upgrading from Origin 2018 or later versions, your User Files Folder (UFF) location is unchanged. 

If you are upgrading from Origin 2017 or earlier, you will be prompted to pick a location for a new UFF. You 
must choose a different path from your old UFF.  

To transfer the contents of your old UFF and your toolbar and workspace configurations to the new UFF, you 
can run the Origin software and selecting Preferences: Transfer User Files. For more information, see 
Transfer User Files. 

https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/DirectInstall
https://www.originlab.com/doc/License/Single-User-Node-Locked-Lic
https://www.originlab.com/doc/Origin-Help/UserFilesFolder
https://www.originlab.com/doc/Origin-Help/FileShare-UserFileTransfer
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Consider these points in selecting your UFF:  

If you have a mobile computer, it is best to select a location on your computer rather than on your network. 

For non-mobile computers, you can select a location on the computer or on the network, as long as you have 
stable access to the folder.  However, it is NOT recommanded to select a network drive (e.g. OneDrive), in 
that it may influence Origin performance. 

Do not select the same UFF as other Origin users. To learn how to share custom files with other Origin users, 
please see the chapter on Sharing Origin Files, later in this Guide. 

Each time Origin starts, the program checks to see that your UFF is accessible. If Origin cannot connect to the 
UFF, you will be prompted to select a new location for the UFF. Note that you can change the location of your 
UFF at any time while running Origin. From the Preferences menu, select Options and then click the System 
Path tab.  

2.5 Licensing Origin 

All Origin packages include license management. The type of license management provided with your package 
is determined at the time of your Origin purchase.  

2.5.1 Node-locked 

 Each Origin computer requires a license to run Origin. The license is obtained from the OriginLab website by 
entering a Product Key in the License Activation dialog when you start Origin. In-dialog instructions are 
provided for computers with no internet access.  

2.5.2 Concurrent Network 

Each Origin computer must connect to a FLEXnet license service to run Origin. Your IT department or Origin 
administrator installs a FLEXnet license server provided by OriginLab (available from the Origin DVD), obtains 
a license for this server from the OriginLab website, and then sets up a license service. The license service 
counts and restricts the number of Origin computers that can run concurrently. For more information, see the 
Help Center on the OriginLab website (originlab.com/HelpCenter).  

2.5.3 Dongle 

 A dongle (USB hardware key) is provided with the Origin dongle-license package and must be present in the 
computer's USB port to run Origin. From Origin 2019, dongles are cross-version.  

2.6 Registering Origin 

 Registering Origin is required to obtain product support from OriginLab and the team of Origin distributors. 
Registration also activates Origin's Check for Updates menu command (Help: Check for Updates), allowing 
you to obtain patch and help file updates directly from your Origin software. In addition, Origin's App Center 
and Template Center dialog, which provide direct access to Apps&Templates and their updates from your 
Origin software, requires that your installation be registered.  

For Node-locked licenses, registration is completed automatically when you activate your Origin via the 
License Activation dialog box that opens when you start Origin. To verify that you are registered, select About 
Origin from the Help menu. The dialog should display the Registration ID that is assigned to your Origin 
installation.  

https://www.originlab.com/doc/User-Guide/Sharing-Files
https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter


UserGuide 2026 

6 

 

For all other license management packages, open Origin, and then select Register on-line... from the Help 
menu to open the Registration dialog box. Use the Registration dialog to register your Origin installation on 

the Origin website. During this process, a Registration ID is issued. Enter or copy and paste this Registration 
ID into the Registration dialog to complete the process. The About Origin dialog should now display your 
Registration ID.  

2.7 Maintenance 

 Most Origin packages are sold with the first year of Maintenance included. Maintenance provides you with free 
Origin upgrades, and may also include priority technical support, discounts on Origin training and consulting 
services, and a home-use license.  

 

Maintenance customers should receive notice of their eligibility for a free upgrade, 
when choosing Help: Get Help Files/Check for Updates.  

To check if your Origin package includes Maintenance, select the Help menu and then select About Origin. If 
your package includes Maintenance, the About Origin dialog will show your Maintenance expiration date.  

To learn about the benefits of Maintenance, contact OriginLab or your local Origin distributor. 

As your maintenance expiration date approaches, Origin will display a maintenance expiration message with a 
link to the OriginLab website to learn how to renew your maintenance. This reminder message provides a 
check box to prevent showing in the future. 

2.8 Service Releases 

 When called for, OriginLab publishes free service releases (patches). A service release typically provides bug 
fixes and may include some minor improvements. All customers are encouraged to apply service releases to 
ensure that your Origin software performs correctly. To check if a patch is available, select the Check for 
Updates command from the Help menu. Patches are also available from the Support area of the OriginLab 
website (originlab.com/Support).  

2.9 Notification of Upgrade 

OriginLab regularly releases new versions of Origin, adding features and feature improvements based on 
customer input. Customers with maintenance are entitled - and encouraged - to use the most recent Origin 
version. After a new version release, OriginLab and the team of Origin distributors notify maintenance 
customers by email. However, to make sure you receive notification of a new version release, please create an 
account on the OriginLab website (originlab.com) and select the check box in your user profile to receive 
"product updates".  

https://www.originlab.com/index.aspx?go=PURCHASE/Maintenance
https://www.originlab.com/index.aspx?go=PURCHASE/Maintenance
https://www.originlab.com/index.aspx?go=SUPPORT
https://www.originlab.com/
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2.10 Setting the Origin Display Language 

 Origin packages sold to organizations in a limited number of countries, including Japan, Germany, 
Switzerland, Austria, Liechtenstein, and China, may support running Origin with English display, or with 
Japanese, German or Chinese display. To access this language control, select Change Language from the 
Help menu.  

2.11 System Transfers - Deactivating a License 

    

2.11.1 Node-locked Licenses (Computer ID-based) 

A system transfer is required if you plan to replace your licensed Origin computer with a different computer.  

If Origin can still be used on your computer: 

Open Origin and then select Deactivate License from the Help menu. After successful deactivation, your 
Computer ID will be removed from OriginLab’s server so that you can install and activate on another 
computer.  

If your licensed Origin computer is no longer available: 

Log into your portal at www.originlab.com. 

Under Licensing, click the Manage my License(s) link. 

Click on the Serial Number associated with the license that you want to deactivate. 

Click the go link in the Deactivation column. 

2.11.2 Concurrent Networks 

A system transfer is only required if you need to replace the FLEXnet license server. A system transfer is not 
required when replacing an Origin computer.  

To obtain a replacement FLEXnet server license file, complete the "System Transfer Request Form" available 
from the Support area of the OriginLab website.  

2.12 Uninstalling Origin 

 To uninstall Origin, run the Origin Repair or Uninstall program located in the Origin program icon folder, or 
use the Windows Uninstall or change a program tool. In both cases, the Origin Setup program displays 
providing options to Modify, Repair/Update, or Remove. Select the Remove option and complete the 
wizard as prompted.  

The Remove program deletes all folders and files that were installed by the Origin setup program. It also 
deletes folders and keys created by the installer in the Windows registry. Make sure you deactivate the license 
before uninstall Origin.  

https://www.originlab.com/restricted/Login.aspx?ReturnUrl=%2frestricted%2fSystem_Transfer.aspx
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3 Origin Resources 

Resources 

The following tables list key Origin resources available to you. If you purchased Origin from a local distributor, 
your Origin distributor may provide additional resources. Please contact your distributor to learn more.  

3.1 Direct Support Resources for Origin 

 For Information On ...  Go Here  

Technical 
Support  

Contact information for OriginLab or 
your Origin Distributor  

Report a bug 

Suggest a feature 

originlab.com/Support  

Chat Online  
Chat online with an OriginLab 
representative 

originlab.com  
 

... and click in 
the lower-right corner  

User Forum  
Share information with and get help 
from the Origin user community 

originlab.com/Forum  

Send Feedback  

Open a web form so that you can 
provide direct feedback (positive or 
negative), and/or allow you go make 
suggestions for improving Origin. 

Origin menu Help: Send Feedback  

Training and 
Consulting  

Making optimal use of OriginLab 
products  

Help in developing custom tools for 

your particular application 

originlab.com/Training  

3.2 Resources Installed with your Origin Software 

    

 For Information On ...  Go Here  

Learning Center  

Load graph samples and analysis 
samples 

Transfer User Files when upgrading to 
the latest version 

Learning Center for direct access to 
Tutorials, Videos, Origin Blog, User 

Help: Learning Center (or press 
F11)  
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Forum and social media pages. 

Sample Projects  
Load analysis samples project 

(This is a tab in Learning Center)  

File: Sample Projects...  
or  
Help: Learning Center: Sample 
Project (or press F11)  

Help Files  
Online or local (CHM) Help for Origin 
(GUI, Programming) 

Help: Get Help Files/Check for 
Updates (to update CHM files)  

Context-
sensitive Help  

Control-by-control explanation of Origin 
dialog boxes 

The dialog box must be open 

Some dialogs have multiple 
sections/tabs and you may have to click 
on that section/tab to set the focus 

Press F1 when the dialog box is 
open 
 
or  
 

Click in the upper-right corner 
of the dialog box  

Start Menu 
- Windows-like 
Search  

Recent files 

Help with problems or questions that 
arise while using Origin 

Direct access to Origin features and 
dialog boxes 

Open or search for Apps relevant to a 
particular task 

Location of Origin menu commands for 
searched-for features 

Press F1 when no dialog box is 
open 
 
or  
 
Click the Start menu icon at the 
bottom-left of the workspace.  

 

 
For additional information on 
using this feature, see  
The Origin Interface, Start Menu.  

Tutorials  
Step-by-step instructions on performing 
many Origin operations, from the 
simple to the complex 

Help: Origin : Tutorials  

3.3 Online Resources for Origin 

  

 For Information On ...  Go Here  

Online 
Documentation  

Product documentation originlab.com/Doc  

Help Center  
Resources list 

Installation and License Documentation 
originlab.com/HelpCenter  

https://www.originlab.com/doc/User-Guide/Origin-Interface
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Contact Info 

Video Tutorials  

Help with a range of Origin features 
including "tips and tricks" 

Available in playlists and categories 

Search Origin video or YouTube pages 
by keyword  
or type v <key phrase> in the Origin 
Start menu. 

originlab.com/Videos 
youtube.com/user/TheOriginlab  

Webinars  
Live and recorded webinars highlighting 
key features 

originlab.com/Webinars  

Origin Blog  
Blog posts with plenty of software tips 
and tricks 

blog.originlab.com  

Case Studies  
How others are using Origin in their 
work 

originlab.com/CaseStudies  

Graph Gallery  
Outstanding examples of Origin graphs, 
many of them submitted by the Origin 

community 

originlab.com/GraphGallery  

 

 

Information on key Origin features often can be found by just doing a quick web 
search. Open a browser and search on phrases such as... "Origin shortcut keys", 
"LabTalk graph legend", or "OriginC NAG functions".  

 

https://www.originlab.com/doc/User-Guide/Origin-Interface
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4 OriginPro 

OriginPro 

  

OriginPro, the professional version of Origin, provides all of the features of Origin, plus additional analysis 
tools and capabilities. If you don't know which product you have -- Origin or OriginPro -- look to the title 
bar.  

 

 

 

 

Users of standard Origin will note that some menu commands are marked with (Pro), 
indicating that the feature is available only in OriginPro. If you own the standard 
version of Origin, but find that you need features of OriginPro, you can upgrade by 
contacting your Origin representative.  

If you wish to continue using standard Origin without seeing (Pro) menu commands, 
click Preferences: System Variables and enter the following in the Set System 
Variables dialog box and click OK (Comment is optional):  

 
 

4.1.1 Curve Fitting 

 In addition to Origin's linear and nonlinear curve fitting capabilities, OriginPro includes support for the 
following:  

Linear fitting with X error. 

Nonlinear fitting with X and Y errors (orthogonal regression). 

Fitting with implicit functions (orthogonal distance regression). 

https://www.originlab.com/index.aspx?go=Company/Distributors
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Fitting Comparison: Fit and rank all functions in a category, compare two models to one dataset or two 
datasets to one model. 

Global fitting of multiple curves using different functions, with the option of sharing parameters. 

 
For more information, see these web pages: Linear and Polynomial Fitting and Nonlinear Fitting.  

4.1.2 Surface Fitting 

  With OriginPro, you can perform 3D Surface Fitting. Choose from 21 built-in surface fitting models including 
Gauss2D, DoseResponse2D, Exponential2D, and Polynomial2D; or define your own function.  

Fit worksheet data (XYZ) or matrix data (Z values). 

Locate and fit multiple peaks using one of several peak identification methods. 

Automatic peak parameter initialization. 

Apply constraints and bounds to parameters and fix parameter values.  

Output parameter and statistical results plus residual curves. 

Find specific Z values along the fit surface and include them in your output. 

Option for automatic recalculation of results and saving tool settings to a Theme file for repeat use. 

 
For more information, see this web page: Surface Fitting.  

4.1.3 Peak Fitting 

 OriginPro includes the Peak Analyzer tool with support for the following:  

Peak finding (Local Max, Window Search, 1st Derivative, 2nd Derivative, Residual after 1st Derivative). 

Detect and subtract baseline (Constant, Dataset, XPS, End Points Weighted, Straight Line, User-Defined, 
None). 

Fit Peaks with built-in or user-defined functions.  

Fit individual peaks with different fitting functions. 

Fit Baseline as part of the peak fitting process (user-defined or built-in functions). 

Control fit parameters (fix, share, set bounds). 

 
For more information, see this web page: Peak Fitting.  

4.1.4 Statistics 

 OriginPro includes support for advanced statistical analyses in these areas:    

Descriptive statistics (cross-tabulation, distribution fit, correlation coefficient, partial correlation coefficient). 

ANOVA (one-/two-way repeated measures, three-way). 

Multivariate analysis (principal components, cluster, discriminant/canonical discriminant analyses; partial least 
squares). 

Survival analysis (Kaplan-Meier, Cox Proportional Hazards, Weibull Fit, test of equality of survival functions)  

Parametric hypothesis tests (two-/pair-sample t-Test on rows, one-/two-sample test for variance, one-/two-
sample proportion test). 

http://www.originlab.com/index.aspx?go=Products/Origin/DataAnalysis/CurveFitting/LinearAndPolynomialFitting
http://www.originlab.com/index.aspx?go=Products/Origin/DataAnalysis/CurveFitting/NonlinearFitting
https://www.originlab.com/doc/Origin-Help/Fitting-2DSurf
http://www.originlab.com/index.aspx?go=Products/Origin/DataAnalysis/CurveFitting#Surface_Fitting_PRO
https://www.originlab.com/doc/Origin-Help/PeakAnalyzer
http://www.originlab.com/index.aspx?go=Products/Origin/DataAnalysis/PeakAnalysis#Peak_Fitting_PRO
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Nonparametric tests (one-/paired-sample Wilcoxon signed rank, paired-sample sign test, Mann-Whitney, two-
sample Kolmogorov-Smirnov, Kruskal-Wallis ANOVA, Mood's median test, Friedman ANOVA, support for 
simultaneous tests). 

Power and sample size (one-/two-/paired-sample t-test, one-/two-proportion test, one-/two-variance test, 
one-way ANOVA). 

ROC curve analysis. 

 
For more information, see this web page: Statistics.  

4.1.5 Signal Processing 

 In addition to Origin's standard suite of signal processing tools, the following are available in OriginPro:  

Signal transforms (short-time Fourier analysis, Hilbert transform, 2D FFT/2D IFFT). 

Filtering (IIR filter design, 2D FFT filter). 

Correlation (2D correlation). 

Wavelet Analysis (continuous wavelet transform, discrete wavelet transform, inverse discrete wavelet 
transform, multi-scale wavelet decomposition, smoothing, noise removal, 2D wavelet decomposition, 2D 
wavelet reconstruction). 

Rise-time Gadget (linear search, histogram, largest triangle). 

Decimation (moving average, finite impulse response). 

Coherence. 

Envelope curves (upper and/or lower, smooth during envelope detection). 

 
For more information, see this web page: Signal Processing.  

4.1.6 Gadgets 

 Origin Gadgets provide a quick and easy way to perform exploratory analysis on plotted data. While there are 
specific Gadgets for each analysis, all work by allowing you to graphically and interactively position a region-
of-interest (ROI) object around the data that you wish to analyze. OriginPro includes these additional Gadgets:  

Cluster Gadget (stats on points inside/outside the ROI; with support for masking, editing, copying and deleting 
points). 

2D Integration Gadget (integration on image plot or contour plot from matrix or worksheet data). 

Rise-time Gadget (analyze rise/fall time of stepped signals). 

 
For more information, see this web page: Exploratory Analysis.  

4.1.7 Image Processing 

 Origin and OriginPro include a collection of easy-to-use image processing tools. OriginPro includes additional 
tools in the following areas:  

Image adjustments (function lookup table, leveling). 

Image conversion (dynamic binary, threshold, RGB merge/split, image scale). 

Spatial filters (user filter). 

Arithmetic transforms (alpha blend, extract to XYZ, image simple math, math function, morphological filter, 
pixel logic, replace background, subtract background, subtract interpolated background). 

http://www.originlab.com/index.aspx?go=Products/Origin/Statistics
http://www.originlab.com/index.aspx?go=Products/Origin/DataAnalysis/SignalProcessing
http://www.originlab.com/index.aspx?go=PRODUCTS/Origin#Exploratory_Analysis
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For more information, see this web page: Image Processing.  

4.1.8 Apps 

Many add-on Apps are coded to integrate with an OriginPro feature and therefore, they require an OriginPro 

license to run. OriginPro-only Apps will be listed in the Origin File Exchange with a red symbol beside 

them.  

Here are some of our more popular OriginPro Apps:  

Redundancy Analysis 

Speedy Fit 

Correlation Plots 

Neural Network Regression 

X-Ray Diffraction Analysis 

Phylogenetic Tree 

2D Peak Analysis 

Standard Curve Analysis 

Linear Mixed Effects Model 

Rank Models 

Peak Deconvolution 

Design of Experiments 

2D Confidence Ellipse 

Independent Component Analysis (Requires R software) 

Logistic Regression 

Sequential Fit 

Piecewise Fit 

Piecewise Smooth 

Principal Component Analysis 

Principal Component Analysis for Spectroscopy 

Slope Analyzer 

Global Peak Fit 

3D Smoother 

Cyclic Voltammetry 

Enzyme Kinetics 

Polynomial Surface Fit 

Heat Map with Dendrogram 

 
For general information on Apps visit www.originlab.com/apps.  

http://www.originlab.com/index.aspx?go=Products/Origin/DataAnalysis/ImageProcessing
http://www.originlab.com/fileexchange/index.aspx
https://www.originlab.com/fileExchange/details.aspx?fid=372
https://www.originlab.com/fileExchange/details.aspx?fid=510
https://www.originlab.com/fileExchange/details.aspx?fid=574
https://www.originlab.com/fileExchange/details.aspx?fid=581
https://www.originlab.com/fileExchange/details.aspx?fid=554
https://www.originlab.com/fileExchange/details.aspx?fid=449
https://www.originlab.com/fileExchange/details.aspx?fid=551
https://www.originlab.com/fileExchange/details.aspx?fid=573
https://www.originlab.com/fileExchange/details.aspx?fid=567
https://www.originlab.com/fileExchange/details.aspx?fid=440
https://www.originlab.com/fileExchange/details.aspx?fid=453
https://www.originlab.com/fileExchange/details.aspx?fid=462
https://www.originlab.com/fileExchange/details.aspx?fid=365
https://www.originlab.com/fileExchange/details.aspx?fid=457
https://www.originlab.com/fileExchange/details.aspx?fid=329
https://www.originlab.com/fileExchange/details.aspx?fid=321
https://www.originlab.com/fileExchange/details.aspx?fid=325
https://www.originlab.com/fileExchange/details.aspx?fid=369
https://www.originlab.com/fileExchange/details.aspx?fid=328
https://www.originlab.com/fileExchange/details.aspx?fid=326
https://www.originlab.com/fileExchange/details.aspx?fid=346
https://www.originlab.com/fileExchange/details.aspx?fid=395
https://www.originlab.com/fileExchange/details.aspx?fid=415
https://www.originlab.com/fileExchange/details.aspx?fid=383
https://www.originlab.com/fileExchange/details.aspx?fid=335
https://www.originlab.com/fileExchange/details.aspx?fid=282
https://www.originlab.com/fileExchange/details.aspx?fid=223
http://www.originlab.com/apps


 

17 

5 The Origin Interface 

Origin-Interface 

 

5.1 The Origin Workspace 

  

This chapter contains basic information on navigating the Origin workspace. Long-time Origin users can skim 
this chapter.  

 

 

Window size and position are automatically adjusted to accommodate different 
displays. This is done to accommodate switching between your laptop and a higher-
resolution monitor, without having to resize/reposition every window and dialog box. 
There is a system variable to control rescaling behavior: @SRWS .  

5.1.1 Windows File Explorer Previews 

While not part of the Origin interface, you can use Windows File Explorer (previously "Windows Explorer") to 
preview graphs in a project file.  

https://www.originlab.com/doc/LabTalk/ref/sys-var-list
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Windows Explorer's Large or Extra large icons views (right-click in File Explorer and choose View: Large 
Icons or Extra Large Icons or select from the Explorer View menu) will show an image of the last active 
graph before the project file was saved. 

Open the Preview Pane (ALT + P) and scroll through all graphs in the project file. 

If you do NOT wish to save graph previews into the file (either in icon view or in the Explorer Preview Pane), 
you can set LabTalk system variable @PESS=0 or =-1. For information on changing the value of a system 
variable, see FAQ-708 How do I permanently change the value of a system variable? 

5.1.2 Origin Menus and Menu Commands 

  

Context-sensitivity of menu bar and menus: The menu bar and menu commands are context-sensitive; 
they change as you change window type (from worksheet to graph to matrix, for instance). Only menus 
pertinent to the active window will display.  

Menu bitmaps, toolbar buttons and shortcut keys: Some menu commands also have bitmaps that display 
to the left of the command. Additionally, you may see a shortcut key combination listed to the right of a menu 
command. The button bitmap and the shortcut keys indicate alternate ways to access the same functionality. 

Shortcut menu commands: Many commands are available from shortcut menus. To open a shortcut menu, 
right-click on an Origin object (worksheet window, graph axis, text object, etc.). Only pertinent menu 
commands will show. 

Collapsible menus: By default, main and shortcut menus in Origin are "collapsed", meaning they display an 
abbreviated set of commands. When you use a menu item which isn't included, it is added to the menu. If you 
prefer to always see full menus, click Preferences: Options > Miscellaneous tab and clear the Enable 
Collapsible Menus box. 

Most recently used analysis menu commands: Most-recently used menu commands will appear at the 
bottom of the analysis menus (Worksheet, Analysis, Statistics, Image, etc.). This gives you quick access 
to tools when performing repeat operations. 

Most recently used files: Several File submenus (e.g. File: Recent Projects) keep a list of your most 
recently opened or saved files. Thus, files that you are currently working on are easily located and opened. 

https://www.originlab.com/doc/LabTalk/ref/sys-var-list
https://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
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Custom Menu Organizer: Since Origin 8.1, Origin users have been able to use the Custom Menu 
Organizer  to add or remove menu items. To learn more, see the chapter Customizing Origin, later in this 
Guide. 

 

There is a plain-text log of all Origin file activity. The file is named as 
"OriginProjHistory.txt" and saved to User Files (Help: Open Folder: User Files 
Folder). Maximum number of entries is controlled by system variable @MHF (default = 
1000).  

5.1.3 Origin Toolbars 

  

Use the Customize Toolbar dialog box (View: Toolbars) to control toolbar display and reset or reinitialize 
toolbars.  

Customize toolbar button appearance: Use controls on the Options tab of the Customize Toolbars 
dialog box to modify button and toolbar appearance. 

Dock/Float a toolbar: Toolbars can be undocked and made to float on the workspace. To float a toolbar, 
hover over the left-end of the toolbar. When the pointer becomes a four-headed arrow, drag the toolbar off of 
the toolbar space. To return the toolbar to its former docked position, double-click the toolbar title bar.  

Hide/Show a toolbar: Clicking the Close button on a floating toolbar removes the toolbar from view. To 
restore a hidden toolbar, open the Customize Toolbars dialog box and on the Toolbars tab, place a check 
mark beside the toolbar. 

Hide/Show a button: Click the small arrow at the right end of a toolbar and open a flyout menu to 
enable/disable toolbar buttons. 

 

Move/Hide button: Alt + drag a button to move it to a new position within or between toolbars. Alt + drag 
to an empty portion of the workspace to create a new toolbar; ; or to hide a button, Alt + drag a button to any 
child window (cannot be empty workspace) and when the button displays as "X", release to hide the button in 
the toolbar. 

 

Hide/Show all toolbars in the Origin interface: Select View: Hide Toolbars menu or press the hotkey Ctrl+Alt+R 

 
For more information on customizing Origin's standard toolbars, see Customizing Toolbars and Buttons, 
later in this User Guide.  

https://www.originlab.com/doc/User-Guide/Customizing-Origin
https://www.originlab.com/doc/User-Guide/Customizing-Origin
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5.1.4 Mini Toolbars 

OriginLab continues to add Mini Toolbar support for common objects and tasks. These toolbars appear when 
the user selects an object or when the user clicks in certain key areas inside the page. Available controls 
depend on context (selected object, window type, etc).  

 

Before using Mini Toolbars, make sure there is a checkmark beside View: Mini Toolbars (default). 

To display the toolbar, select an object such as a data plot, a text label, or a worksheet cell. 

In addition, there are toolbars for more-general page- and layer-level customizations and these toolbars are 
displayed by hovering near the margins of the window. When you see your mouse cursor change to something 

like this , this is your cue that clicking in this spot will display a Mini Toolbar of relevant tools.  

 

Most Mini Toolbars have a Properties button that gives access to more complex settings (e.g. a graph 
window's Plot Details dialog box).  

If you move away or you do not act quickly enough, a Mini Toolbar will fade away. To restore a Mini Toolbar 
after it has faded, press the SHIFT key. 

To add or remove buttons from a Mini Toolbar, click on the three dots at the bottom center of the toolbar. This 
opens the Customize Mini Toolbar dialog box where you can enable or disable buttons as needed. 
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5.1.5 Recent Files 

There is a magnifying-glass icon over an Origin logo at the left-bottom corner. Hover on the icon + logo with 
your mouse, then click on it, then it will pop up to show the recent items with a search tool. You also can press 
the Ctrl+F1 button on your keyboard to pop-up it.  

 

5.1.6 Search Tool 

There is a search box with magnifying-glass icon at last of main menu.  
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When you first click the box, the search tool will index with progress bar scrolling. Once the indexing is 
finished, you can enter the keyword(s) to search available resources. Press the F1 button on your keyboard 
will also expand the search panel.  

Then all Origin resources related to the keyword(s) will be listed in these categories:  

Toolbars 

Menus 

Mini Toolbars 

Shortcut Menus 

Apps 

FAQ 

Help 

Samples 

Templates 

All these categories will be shown as collapsible sections with number of items displayed. If no result is found 
under the categories, the sections will be hidden.  

Without entering any keyword, only Useful New Tools are listed in the panel. Click the Settings button 
beside the Search box to open the Settings dialog to customize the searching mechanism and the results 
display.  
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5.1.7 Learning Center 

Learning Center is a "startup" dialog that gives quick access to graphing and analysis examples, plus 
learning resources (tutorials, videos, the OriginLab blog, etc.).  

To open the dialog, choose Help: Learning Center or press F11. 

Check or clear the Show on Startup box to show or hide this dialog each time Origin starts. 
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View and load sample graphs, including sample data and notes on re-creating the graph. 

Load analysis samples with data. 

Browse the Learning Resources tab for tutorials and videos and links to the Origin Blog, User Forum and 
Origin social media pages. 

Move files from your previous User Files Folder to your new User Files Folder. 

 

 

To see new graphs in newest version, open the Learning Center, click the Graph 
Samples tab, set the plot filter drop-down to All Plot Types and search the version 
number, such as 2024.  

5.1.8 Project Explorer 

Project Explorer (PE) is a tool to help you organize the contents of your Origin project files (OPJ).  

https://www.originlab.com/doc/Origin-Help/FileShare-UserFileTransfer
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Project Explorer (PE) is split into two panels. The primary panel shows the OPJ folder structure. The sub-panel 
shows windows contained in the folder that is highlighted in the primary panel.  

 

Prior to 2018, the PE sub-panel listed sub-folders in the folder selected in the top panel. 
To restore this display mode, set the value of system variable @PEF = 1.  

5.1.8.1 Using Project Explorer to manage your projects 

Right-click the PE title bar or click the drop-down menu to display the panels stacked (Vertical Alignment) or 
side-by-side (Horizontal Alignment). 

Context menus in both panels provide options to delete, hide, print, etc. Menu options vary depending on what 
is selected or where you have right-clicked.  

Multiple-selection of windows in the sub-panel is supported (press Shift or Ctrl while clicking with your mouse). 

The sub-panel supports differing views of windows: Details (default), List, Small Icons, Large Icons, Extra 
Large Icons.  

In any view, mousing over a window icon shows a popup preview of the graph, worksheet, matrix, layout, 

image, or notes window. 

 

To disable PE previews, set the value of system variable @PESS.  

Control display of popup previews by right-clicking in the subpanel and placing a check mark beside Hold Ctrl 
Key for Preview Popup. Henceforth, popups will only appear as you press CTRL. 

https://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
https://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
https://www.originlab.com/doc/LabTalk/ref/sys-var-list
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When displaying windows as Extra Large Icons, the PE sub-panel displays a thumbnail of graphs, layout 
windows, workbooks, matrixbooks, images and notes window.  

 

You can right-click on PE folder (upper panel) and choose Copy -- or select the folder and do a CTRL + C and 
CTRL + V -- to copy and paste the folder structure and content to (a) another folder in the current project or 
(b) another project running in a second Origin session. To copy a single workbook window, right-click on the 
window (lower panel) and copy and then paste the window to (a) another folder in the same project, or (b) to 
a new project running in a second Origin session. 

 

Select Help: Open Folder: Program Folder, click the Samples subfolder, then drag the 
file Tutorial Data.opj to your Origin workspace. 

By default, Project Explorer is docked to the left side of the Origin workspace in auto-hide 
mode. Mouse over the Project Explorer tab to show the PE window.  

 

Click on the "push pin" icon on the PE title bar to pin the window in the docked position.  
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By default the sub-panel is in Details view. In this view, window metadata such as Name, 
Size and Comments show below these column headings. Try dragging column headers to 
reorder them.  

 

Right-click on the column headings and show or hide any of the headings by checking or 
unchecking the box beside each.  

 

To add a comment in the Comments field, click once, pause briefly and click a second time. 
This puts you into edit mode. Enter a comment.  

 

To change the Name of a window, right-click in the row and choose Rename. By default, 
the Name field displays the window Short Name; or if a window Long Name exists, the 
window Long Name (all windows must have a Short Name but Long Names are optional). 
Click the SN or LN button to the right-side of the editable Name field to edit the Short 
Name or Long Name. If the Long Name does not exist, you can enter one.  

 

In the top panel of Project Explorer, scroll to the folder 3D Surface with Point Label and 
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click on it. The sub-panel shows that there are three windows in the folder. Note that the 
worksheet window eastcali3053 is bold indicating that it is the "active" window - the window 
that is being acted upon as well as the window that determines what operations are 
available. There is also a Notes window, and a matrix window named MBook4.  

 

In the sub-panel, double-click on MBook4 and note that it is now bold and has a magenta 
"halo", indicating that it is the active window. You will also see that the whole window(in the 
workspace) displays with a halo which can be customized in color with the system variable 
@AWC-- another indicator that this is the "active" window. Double-click on this MBook4 icon 
again and note that the icon is now dimmed. Note also that the actual window disappears 
from the workspace. This is because MBook4 is now hidden. Double-click the MBook4 icon 
again and the window is restored and made active.  

 

With MBook4 active, click Plot > 3D: Surface: 3D Colormap. This creates a 3D colormap 
surface graph (close the attention message). Note also that a new window -- Graph1 -- has 
been added to the sub-panel of Project Explorer. 

Right-click in an empty portion of the sub-panel and choose View: Extra Large Icons. 
Note that Graph1 now displays a graph thumbnail.  

 

Right-click again and choose View: Large Icons. Note that windows are now represented 
by icons but if you hover on them, you can see the window contents as a pop-up.  

https://www.originlab.com/doc/LabTalk/ref/sys-var-list
https://www.originlab.com/doc/LabTalk/ref/sys-var-list
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5.1.8.2 Folder Notes 

You can add Folder Notes to a PE folder.  

Right-click on a folder and choose Folder Notes .  

If no folder Comment exists, this adds a blank Folder Notes window to the folder (see this page for options 
for adding and displaying Notes window content). 

If there is existing Comment (hint: right-click on the folder and choose Properties), adding Folder Notes 
will copy the Comment to the Folder Notes window. 

When switching between folders, for example using the new Folders and Windows toolbar, these Folder 
Notes will always be displayed in the workspace, if pinned or minimized.  

If you close Folder Notes (i.e. by clicking the Close button ), they are embedded in the folder and will 

only be displayed again by right-clicking on the folder in PE and choosing Folder Notes. 

 
In addition ...  

Press Ctrl + hover on a PE folder to see rendered Notes window content. 

System variable @FNS is added to determine which is the default Folder Notes syntax (= 0 (Text), = 1 
(HTML), = 2 (Markdown), or = 3 Origin Rich Text (default)). 

A Mini Toolbar is added for adding Folder Notes, Duplicate Folder or to Open Folder Properties Dialog. 

 

5.1.8.3 Folders and Windows Toolbar 

 

A Folders and Windows toolbar is added for working with Project Explorer folders and 
folder contents. When first running Origin, you may see this new toolbar "floating" in 
the Origin workspace. You can drag it (by the title bar) to an empty portion of the 
toolbar spacer; or you can choose View: Toolbars and click the Reinitialize button to 
reset toolbars to the standard configuration.  

https://www.originlab.com/doc/User-Guide/Publishing-and-Export
https://www.originlab.com/doc/User-Guide/Publishing-and-Export
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The Folders and Windows toolbar makes it easier to switch between PE folders ('Seesaw) or to add the 
active window as a shortcut in the previous folder; plus, to pin the active window in place or to arrange 
windows in the active folder Window: Arrange Windows <Last used>.  

Folder Backward: From current folder, return to previous folder. 

Folder Forward: From previous folder, return to current folder. 

Seesaw: Alternate between two folders (Ctrl + Alt + X). From the menu, Windows: Seesaw.  

Add Active Window Shortcut for Seesaw: Share the active window to the previous folder as a shortcut 
(Ctrl + Shift +F7). Alternately, right-click the window title and add shortcut to previous folder.  

Add shortcuts from previous folder: Add shortcuts by window type, to the current folder. 

Arrange Windows (last used): Same as Window: Arrange Windows <Last used>. 

Pin Active Window: Pin window so that it isn't included when Arrange Windows (last used) is clicked. 
Alternately, right-click the window title and Pin Window (or unpin). 

5.1.8.4 Window Shortcuts 

When you are in a Project Explorer folder, you can hover on another folder, right-click and Add Shortcuts. 
This opens a dialog for adding windows as shortcuts, by type, to the active folder.  

 

When a shortcut window is added to the active folder, a home button ("Go to original") . Clicking the 
button will navigate to (and activate) the original window in its containing folder. 

A shortcut window will display the name of the PE folder in parentheses, on the window title bar. 

Clicking Close on a shortcut window will hide the shortcut in the current folder. 

To remove shortcuts from the active folder, right-click on the folder in Project Explorer and Remove 
Shortcuts (dimmed when there are no shortcuts to remove). 
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Minimized or maximized windows added as shortcuts will be restored up or down so that they are visible but 
do not fill the workspace. 

5.1.9 Apps Center and App Gallery 

 Apps are add-on applications for Origin that perform specific graphing and/or analysis tasks. A small number 
of Apps that are broadly applicable to science and engineering fields are pre-installed with your Origin 
software. 

 

Use the App Center dialog for browsing, updating or downloading Origin Apps. This new dialog gives you 
direct access to all of the Apps on the OriginLab File Exchange without you having to open a browser and 
navigate there. 

 

To launch the App Center, click the Add Apps button that appears on all tabs of the Apps Gallery, docked at 
the right-side of your Origin workspace. If you do not see the Apps Gallery, click View: Apps (or ALT + 9) and 
verify that there is a check mark beside Apps.  

Installed and Up-to-date Apps will appear in the App Center with a green check mark beside them  

Installed Apps for which there is a newer version will appear with an Update icon beside them  

Those not installed will appear with a clickable Download and Install icon beside them  
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Origin's Statistics, Analysis: Fitting and Analysis: Peaks and Baseline menus include a Find Apps entry. 
Clicking Find Apps opens the App Center to show only Apps that relate to the current menu (e.g. Statistics). 
You can download or update Apps directly from the App Center.  

Use the Apps Gallery to organize and access your installed Apps.  

 

New Apps and App updates are are continually made available to Origin and OriginPro 
users. Be sure to open your App Center occasionally (press F10) and if it displays the 
red Download Now button, click to get the latest list of available Apps.  

 

For more information on Apps, please visit www.originlab.com/apps.  

5.1.10 Object Manager 

 The Object Manager is a dockable panel that opens to the right side of the workspace, by default. Use the 
Object Manager for quick manipulation of the active graph or workbook window.  

 
Graph Windows  

Select an element (layer, plot group, data plot or special point) in the Object Manager to select the 
corresponding element in the graph window and vice versa. Selection also (a) dims all other plots in the graph 
layer and (b) selects the source data in the worksheet. 

 

Object Manager can show a "Graph Objects" view and a "Plots" view of graph windows. To toggle between 
the two views right-click in an empty portion of the Object Manager and choose Show Plots/Show Graph 
Objects; or press Ctrl + Shift + S. 

http://originlab.com/index.aspx?go=PRODUCTS&PID=3236
https://www.originlab.com/doc/User-Guide/Graphing
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Hide or show plots or graph objects by clearing or checking the corresponding box in the Object Manager. 

 

At the graph level, change Object Manager list order (Drawing Order or its reverse -- Order of Appearance 
). 

At the layer level, change layer order. 

At the plot level, show labels, show or hide plots, reorder plots or create plot groups. 

Within a plot group (labeled as gN), ungroup plots, re-order plots by dragging or by shortcut menu command, 
change plot type. 

Remove a plot (permanently) from the graph window. 

Access the Plot Details, Layer Contents and Plot Setup dialog boxes. 

Right-click on the layer icon and Reverse Plot Order. 

 
Workbook or Matrix Windows  

The Object Manager also supports certain actions for workbooks and matrices:  

List all sheets in the active workbook or matrix. 

Quickly select multiple sheets by pressing CTRL + Up/Down arrow. 
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Click a sheet in Object Manager to activate the corresponding sheet in the workbook or matrix. 

Right-click in Object Manager for access to common worksheet operations, including Delete, Insert, Add, 
Move, Copy, and Duplicate. 

Right-click on a matrix or virtual matrix in Object Manager to Rename. 

 

 

 
Layout Windows  

When a Layout Page is active, the Object Manager lists and allows arrangement of objects via shortcut 
menu commands.  

All objects, including added graphs, tables and text objects, list in the Object Manager. 

Hide or show objects by clearing or checking the adjacent box. 

Select multiple objects in Object Manager, then right-click and align or distribute them using shortcut menu 
commands. 

5.1.11 Origin Child Windows 

  

 

Active windows -- the window that will be acted upon by graphing and analysis 
operations -- display a colored frame to make the active window more obvious. You can 
customize the active window indicator properties (frame color, where the frame shows, 
frame line style) with "@ System Variables" @AWC (color) and @AWI (style). 

https://www.originlab.com/doc/LabTalk/ref/sys-var-list
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Workbooks: The Origin workbook provides a framework for importing, organizing, analyzing, transforming, 
and plotting your data. The tabbed workbook contains between 1 and 1,024 sheets. Each sheet may contain 
more millions of rows and more than 65,000 columns of data. In addition to your data, workbook windows 

may also store graphs, annotations, column-based functions, scripts and programmable button objects, 
LabTalk variables and import filters.  

Matrixbooks: Like the worksheet, a matrixsheet is a grid of cells, arranged in rows and columns. The primary 
difference is that in the worksheet, each column is a dataset and each dataset can be configured to contain 
various types of data (text, text & numeric, numeric (double), numeric (int), etc). In contrast, the matrix is a 
single, numerical dataset of Z values, related in the XY plane by row (Y) and column (X) index numbers. The 
matrixbook contains between 1 and 1,024 sheets. Each sheet can contain multiple matrix objects (up to 
65,504). 

Graphs: The graph window is the primary container for your data plots. Origin supports over 100 chart types, 
chosen specifically for their applications in various technical fields. Each chart is created using a built-in, user-
modifiable graph template that can be saved with your custom settings. In addition to data plots, the graph 
may also contain annotations (text and drawing objects) or button objects that, when triggered, perform some 
custom graphing or analysis task. Graph windows can be inserted into worksheet cells or "floated" on 
worksheets (outside the grid) in a workbook window.  

Images: The image window is a window for importing, viewing and editing raster images and videos (.avi, 
.mov, .mp4). 

Function Graphs: The function graph is a specialized graph window that displays a curve described by a 
function. The function graph differs from other Origin graphs in that it is not produced from a dataset of 
discreet values (though you can generate data after plotting).  

Layout Pages: The layout window allows you to combine and arrange graph and worksheet windows and 
various annotations onto a single "display panel." It is used primarily for creating presentations.  

Excel workbooks. Excel workbooks can be opened or created in Origin. Workbooks can be saved separately 
or as part of your Origin project file.  

Notes: The Notes window supports plain text, Rich Text, HTML and Markdown. Use it for simple tasks such as 
recording analysis procedures, making notes to students and colleagues, and cutting and pasting text from 
other applications; or use it for rendering highly formatted text, including HTML reports and mathematical 
expressions. 

https://www.originlab.com/doc/User-Guide/Publishing-and-Export
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Note: For more information on Origin's child windows, see  

Help: Origin: Origin Help > Origin Basics > Elements of the Origin Workspace > Creating a Child 
Window  

Help: Origin: Origin Help > Origin Basics > Elements of the Origin Workspace > Basic Child Window 
Operations  

 
 
To save an Origin child window independently of the Origin project file:  

Select File: Save Window As... to save active window. File extensions OGW(U), OGG(U), OGM(U) are for 
Origin Workbook, Graph and Matrix windows, respectively. 

Right-click the window title bar and choose Save as... from the context menu.  

 
Note: To save an Excel window as an external Excel file, right-click the Excel window title in Origin and choose 
Save Workbook as... from the context menu.  

 

Origin 2018 added Unicode (UTF-8) support for Origin projects, child windows and 
templates. When you save a window file -- with the exception of the project file which 
as of Origin(since 2023) can only be saved as Unicode-compliant (*.opju) -- you will 
have the option of saving a file with or without a "u" appended to the file type (*.otp or 
*.otpu). If you intend to use the file only in the latest version of Origin, you should 
choose the Unicode-compliant (appended "u") option as it offers some performance 
advantages.  

 
To open a worksheet, graph, matrix, or notes window that was saved to a file:  

Select File: Open or click the Open button on the Standard toolbar to open window files.  

Select File: Recent Books, File: Recent Graphs to open recently saved workbook and graph window files.  

Note: Origin supports window Short Name, Long Name and Comments and the Short Name must be 
unique in the Origin project. The window Short Name will be renamed if such a name has already exists in the 
project. If you open window file in the current project, then save the project, the window will be included in 
the project.  

 
To open an Excel workbook file:  

https://www.originlab.com/doc/Origin-Help/Create-ChildWindow
https://www.originlab.com/doc/Origin-Help/Create-ChildWindow
https://www.originlab.com/doc/Origin-Help/Operate-ChildWindow-Basic
https://www.originlab.com/doc/Origin-Help/Operate-ChildWindow-Basic
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If you are intending to work with Excel files in Origin, please see this section of the 
Origin Help file before proceeding.  

Select File: Open Excel menu to open a external Excel file. Or, you can click Import Excel button in the 
Standard toolbar or select Data: Import from File: Excel (XLS, XLSX, XLSM)... from the main menu to 
import the Excel file.  

Note: If you choose Open Excel, the Excel file is opened as an Excel workbook, in an Excel session that runs 
inside Origin. In this mode, you have only limited access to Origin features. If you choose Data: Connect to 
File: Excel or Data: Import From File: Excel, the Excel file is imported into an Origin workbook and all 
Origin features are available.  

5.1.11.1 Arranging Child Windows 

Origin includes some window arranging tools that go beyond the basic Tile and Cascade functionality. Users 
in industry and research who work with high resolution monitors and many windows should find the tools 
helpful.  

 

The new Folders and Windows toolbar has a Pin Active Window button that is used 
to exclude the active window when windows are arranged by menu command or toolbar 

button. Clicking this button adds a pin button to the window title bar. Alternately, 

right-click on any window and choose Pin Window from the shortcut menu.  

Occasionally, you may decide -- after arranging windows -- to enlarge a window for 
better viewing. You can restore the window to its previous size and position by clicking 
Window: Restore Window Size (Ctrl + Shift + Z).  

5.1.11.1.1 Arrange Windows Dialog 

Central to using these tools is the Arrange Windows (winarrange) dialog (Window: Arrange Windows).  

https://www.originlab.com/doc/Origin-Help/Work-Excel-Basic
https://www.originlab.com/doc/Origin-Help/Work-Excel-Basic
https://www.originlab.com/doc/Origin-Help/Import-Excel
https://www.originlab.com/doc/Origin-Help/Import-Excel
https://www.originlab.com/doc/Origin-Help/Import-Excel
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Use the dialog to sort and arrange windows in the Origin workspace.  

Arrange windows into columns. 

Sort by order of activation, Project Explorer order, or window name (ascending, descending). 

Sort within window type. 

Horizontal (left to right) or vertical direction (top to bottom). 

Overlap each column (cascade) by user-defined Offset. 

All above arrangement include minimized windows or not. 

5.1.11.1.2 Snapping Windows 

Windows that are arranged in rows and columns can be "snapped"; that is, dragged and resized along a 
common edge. The visual cue for engaging the snap is a green bar.  

Toggle this feature off or on using Window: Snap Windows (Ctrl+F12). 
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To resize a single window without snapping, press SHIFT while dragging window border. 

When tiled windows cover the workspace, swap two window positions by pressing ALT while dragging the 
window title bar. 

To snap a window into an empty space, press SHIFT while dragging. 

 

5.1.11.2 Float and Pin Child Windows 

From Origin 2023b, Child Windows can be moved outside of the Origin workspace as independent floating 
windows. Such windows have customizable Menus and Toolbar buttons, so you don’t have to move back to the 
main Origin window to access them.  

Float windows are auto pinned so that they will remain when switching folders in Project Explorer.  

Pinned window inside Origin will auto remain when switching folders in Project Explorer. To roll back to old 
behavior, set system variable @pws=0.  

5.1.12 The Command Window and Script Window 

The Command Window can be used to issue LabTalk commands to Origin, to do simple mathematical 
calculations, or to check the value of LabTalk variables. The Command Window maintains a time-stamped 
command history that can be carried over from session to session, and intellisense which provides auto-
completion features when writing X-function commands. The Command Window is dockable and has two 
panels. The left-hand panel displays the command history, while the right-hand panel provides the command 

line.  

The Script Window predates the Command Window. It does not support all Command Window features 
(there is no command prompt and no scrollable command history) but it is handy for running simple LabTalk 
commands at the cursor (run multi-line scripts by highlighting the entire script and pressing Enter). In 
addition, the window's Tools menu also opens the LabTalk Variables and Functions dialog box where you 
can view a list of Origin variables, functions, macros, loose datasets, etc.  

https://www.originlab.com/doc/Origin-Help/Floating-Windows
https://www.originlab.com/doc/Origin-Help/Floating-Windows
https://www.originlab.com/doc/Origin-Help/Operate-ChildWindow-Basic
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Script Window also supports for Unicode, auto-completion, syntax-coloring, and font-
size control/zoom (Ctrl + mouse wheel). These features should improve usability, 
particularly for those with 4k monitors. If you want a "plain text" Script Window, set 
@NSW=0 (for help with setting the value of a system variable see this FAQ).  

 
To open the Command Window:  

Click the Command Window button on the Standard toolbar. Alternately, select Window: Command 
Window menu or press ALT+3. 

 
To open the Script Window:  

Select Window: Script Window menu or press SHIFT+ALT+3. 

5.1.13 The Formula Bar 

The Formula Bar is similar to formula bars in OpenOffice and Excel. While it is not necessary to use the 
Formula Bar to enter cell expressions, it does offer the advantages of function search, interactive range 
selection and improved visibility of expressions, particularly of long expressions that exceed cell width.  

 

With a workbook active, toggle the Formula Bar on or off by clicking View: Formula Bar on the main menu. 

To change font size, change the value of LabTalk system variable @FBFS (default is "130"). 

 
For more information, see the Workbooks, Worksheets and Columns chapter.  

 

The Search Functions dialog that is opened from the Function menu in certain 
dialogs (e.g. Set Column Values) can be opened by clicking Tools: Search 
Functions. 

5.1.14 The Status Bar 

 

The  Status Bar is located at the bottom of the Origin workspace. It reports multiple parameters, including:  

Help messages and tool descriptions.  

Statistics on the current workbook, matrix or graph selection.  

Whether the AutoUpdate analysis feature is turned on.  

https://www.originlab.com/doc/LabTalk/ref/sys-var-list
https://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
https://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
https://www.originlab.com/doc/User-Guide/Worksheets-Columns
https://www.originlab.com/doc/User-Guide/Worksheets-Columns
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The name of the System Theme, if any.  

Information pertinent to the active window. 

Angular unit (radians, degrees, or gradians). 

Tool tips for functions listed in the Set Values F(x) menu. 

Notifications from OriginLab, represented by a small red flag to the right side of the Status Bar.  

 

 
Customize and Copy Status Bar Data  

 

You can select what shows in the Status Bar by right-clicking on the Bar and selecting (or clearing) items from 
the context menu.  

Copy displayed statistical values by selecting Copy Statistics from the context menu. The copied data are 
TAB separated between quantity and values, with each key value pair separated by a CRLF delimiter. 
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5.1.15 Smart Hints and the Smart Hint Log 

  

Smart Hints are triggered by user actions and are intended to give the user help with current task. These 
hints may appear briefly inside a dialog box, as in this example.  

 

 
 

Alternately, Smart Hints may appear in the lower left corner of the Origin workspace, as in this example.  

 

 
Unless you hover over a Hint, it will quickly fade. You can prevent display of individual Smart Hints by checking 
the "Do not show this message in the future" box at the bottom of a Smart Hint.  

Hints are logged for the current Origin session and can be reviewed by clicking the Smart Hint Log tab, 
docked at the edge of the Origin workspace (Note that in-dialog Hints are not logged).  

 

 
To open (and close) the Smart Hint Log window:  

From the Origin menu, select View: Smart Hint Log or press ALT+7. 

To prevent a particular Smart Hint from displaying again in the current session, right-click on the hint in the 
Smart Hint Log window and check Do not show this hint again from the context menu. A message asks you 
to confirm that you do not want to show or log this message.  

To turn off all Smart Hint display in the session, open the Script Window and type the following:  

@SHS = 0; 
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To turn on Smart Hint display (including those were individually hidden), type @SHS = 1, and click Help: 
Reactivate All Hints.  

 

When you set the value of a system variable using the Script Window, you are altering 
Origin's behavior for the current session only. To set the value of a system variable 
across sessions, see this FAQ.  

5.1.16 Code Builder 

 Origin integrated development environment (IDE) is called Code Builder. Code Builder provides tools for 
writing, compiling, and debugging your Origin C functions. Additionally, it can be used for running and 
debugging Python code.  

To open Code Builder:  

From the Origin menu, select View: Code Builder or click the Code Builder button on the Standard 

toolbar or press ALT+4.  

Code Builder can also be opened by clicking Connectivity: Open untitled.py. In this mode, you can paste 
and run Python code by pressing CTRL + F5. 

5.1.17 Messages Log 

The Messages Log window shows messages about operations including Output Information, Results and 
Errors. It displays messages that are not sent to the Script Window or the Command Window.  

 
To open (and close) the Messages Log window:  

From the Origin menu, select View: Messages Log or press ALT+6. 

 
Clickable link of export results  

Export dialogs (see bullet list in image) will add a date-time stamped clickable link to the Messages Log. Click 
the link to open the file with the default application (e.g. Notepad for *.dat).  

https://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
https://www.originlab.com/doc/python/Running_Python_Code
https://www.originlab.com/doc/python/Running_Python_Code
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To open file location in Windows Explorer without opening the file, right-click on a link and choose Open File 
Location; or press Ctrl while clicking on the link. 

Two system variables are added to control image export link behavior. See Exporting Graphs and Layout Pages 
to an Image File for more information. 

5.1.18 Results Log 

Origin automatically types many analysis and fitting results to the Results Log. Each entry in the Results Log 
includes a date/time stamp, a window name, a numeric stamp which is the Julian day (see Dates below), the 

type of analysis performed, and the results.  

In most cases, when results are reported to the Results Log, it opens automatically. Manually open (or close) 
the Results Log by doing one of the following:  

Click the Results Log button on the Standard toolbar. Alternately, from the Origin menu, select View: 
Results Log or press ALT+2.  

 
Right-click in the Results Log to open a shortcut menu with commands to Copy, Print, Clear..., and View 
Results.  

5.1.19 Float, Dock and Auto-Hide Windows 

 There are several Origin windows, which can be floated, docked, auto-hidden, or hidden. These windows 
include Project Explorer, Results Log, Command Window and Messages Log. This allows you to 
customize your Origin workspace so as to maximize utility and save screen space.  

 

5.1.20 Context Menu 

https://www.originlab.com/doc/User-Guide/Publishing-and-Export
https://www.originlab.com/doc/User-Guide/Publishing-and-Export
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 Right-click on the grey workspace area, you can create a new project, open Recent Origin Files and Project 
Browser dialog, or return to the last window.  

 

 

5.2 Dark Mode 

Dark mode is supported from Origin 2024.  

 

By default, Origin follows Windows dark mode settings. You can use the Dark Mode toolbar or System Variable 
@CTP to turn on/off Dark Mode independently. Besides, there are buttons on the Dark Mode toolbar to toggle 
dark mode for individual window for particular window type. 

 

Multiple built-in dark color themes available under Preference: Dark Theme menu. 

When exporting or copying dark-mode graph as image, there is option to copy/export as displayed, or without 
dark mode applied 

5.3 Numbers in Origin 
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Displayed vs. Actual Cell Value: When you import or type your data into a workbook or matrixbook, Origin 
uses a combination of user-specified settings to determine how to display the data in each cell. What displays 
is a visual representation of the data value. The actual data values are stored with the full precision allowed by 
the dataset's Data Type (see table below). When you perform calculations, it is the actual data values that are 
used and not the displayed values. 

When Contents Exceed Cell Width: Prior to Origin 2020b, if the sequence of characters in a sheet cell 
exceeded what could be displayed at the current cell (column) width, Origin represented cell contents as a 
series of pound signs (######). This has changed to mimic MS Excel's worksheet behavior: 

Text strings will not trigger display of pound signs ###### regardless of column width. To view the full 
string, you must increase column width. 

Numeric values that exceed column width will first be rounded to the nearest decimal and only if that is not 
sufficient to display the full integer value, will pound signs ###### display in place of the numeric value. 

This rounding of numeric values affects the displayed value only. The internally-stored value does not change. 

To restore the old behavior of displaying pound signs ###### whenever cell contents were not fully 
displayed, set system variable @WPE = 1. For information on changing the value of a system variable, see 
this FAQ. 

Missing Values in the Worksheet: When spreadsheet programs first appeared it was recognized that there 
was a need for a special number that was "not a number" which would - when used in a calculation - generate 
itself. Origin has such a number and its internal value is -1.23456789E-300. Because Origin recognizes this 
value as a special value, it can be used to enter a missing value into a worksheet or matrix and it can be used 
in calculations or scripts (for instance, to return a missing value unless some condition is met). Origin displays 
missing values in a worksheet or matrixsheet as "--". However, you shouldn't confuse this display (output) 
with what you enter as a missing value (input). 

Decimal, Scientific and Engineering Notation: You can display workbook or matrixbook data in 
Decimal:1000, Scientific:1E3, Engineering:1k, and Decimal:1,000 notations. You can manually choose 
from these data display options but you can also pre-define thresholds for automatic display of scientific 
notation. By default, these thresholds are set to 6 (upper) and -3 (lower). 

Dates and Times in Origin: Origin's long-time mathematical system for dates and time is based on 
Astronomical Julian Day Numbers, with a 12 hour offset. This system defines January 1, -4712 (January 1, 
4713 BCE), 12 hours Greenwich Mean Time as zero. Recently, two alternate time systems were added: (1) a 
true Julian Date value (0 is at noon instead of the following midnight) and (2) a "2018" system in which 0 is 
defined as 00:00 on January 1, 2018. The 2018 system supports greater precision when, for instance, 
importing data with the Import Wizard (e.g. Custom Date Format supports "MM'/'dd'/'yyyy 
HH':'mm':'ss'.'######"). Previously, precision was limited to 0.0001 seconds. For more information, see 
Dates and Times in Origin. 

Note: For more information on numbers, see  

Help: Origin: Origin Help > Origin Basics > Elements of the Origin Workspace > Numbers in Origin  

 
Origin workbooks and matrixbooks support the following Data Types:  

Workbook  Matrixbook  Bytes  Range of Values  

double  double  8  ±1.7E±308 (15 digits)  

real  float  4  ±3.4E±38 (7 digits)  

short  short  2  -32,768 to 32,767  

https://www.originlab.com/doc/LabTalk/ref/sys-var-list
https://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
https://www.originlab.com/doc/Origin-Help/DateTime-in-Origin
https://www.originlab.com/doc/Origin-Help/Number-in-Origin
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long  int  4  -2,147,483,648 to 2,147,483,647  

char  char  1  -128 to 127  

byte  char, unsigned  1  0 to 255  

ushort  short, unsigned  2  0 to 65,535  

ulong  int, unsigned  4  0 to 4,294,967,295  

complex  complex  16  ±1.7E±308 (15 digits), each 8 bytes  

5.4 Topics for Further Reading 

Project Explorer 

Customizing Toolbars 

Mini Toolbars 

The Object Manager 

Finding Data in your Origin Project 

Basic Child Window Operations 

Numbers in Origin 

Dates and Times in Origin 

FAQ: How do I turn off the collapsible menus and show full menus? 

Customizing Toolbars 

Setting Your Preferences 

The Numeric Format Tab of Preferences: Options 

https://www.originlab.com/doc/Origin-Help/Project-Explorer
https://www.originlab.com/doc/Origin-Help/Customize-Toolbars
https://www.originlab.com/doc/Origin-Help/Mini-Toolbar
https://www.originlab.com/doc/Origin-Help/Object-Manager
https://www.originlab.com/doc/Origin-Help/Finding-Project
https://www.originlab.com/doc/Origin-Help/Operate-ChildWindow-Basic
https://www.originlab.com/doc/Origin-Help/Number-in-Origin
https://www.originlab.com/doc/Origin-Help/DateTime-in-Origin
https://www.originlab.com/doc/Quick-Help/collapsible-menu
https://www.originlab.com/doc/Origin-Help/Customize-Toolbars
https://www.originlab.com/doc/Origin-Help/Tool-Option-DIalog
https://www.originlab.com/doc/Origin-Help/Options-Dialog-NumFormat-Tab
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6 Origin File Types 

Origin-File-Types 

6.1 Roundup of Origin File Types 

  

 

A series of Unicode-compliant (UTF-8) file types was added for Origin 2018. Users 
upgrading from previous versions may recognize that the old familiar file types now 
have a Unicode counterpart, denoted by an appended 'u' (e.g. *.opj => *.opju). With 
the exception of the *.opj file type, Origin(since Origin 2023) will read and write both 
the Unicode and non-Unicode file types and non-Unicode file types remain backward 
compatible with earlier versions of Origin.  

Origin 2023 and later versions will still read the older, non-Unicode *.opj file type but 
you can no longer save as *.opj. Going forward, you will need to save your project files 
as Unicode-compliant *.opju files. 

Origin 2023 and later versions will still supports saving other non-Unicode file types 
such as *.ogw, *.otp, *.ogg, etc. 

  

File Type  File Extension  Used As  

Origin 
Project Files  

*.opj;*.opju  A container for all data. See Alert, above.  

Child 
Window Files  

*.ogw(u);*.ogg(u);*.ogm(u);*.txt  
The child windows for workbooks 
(.ogw(u)), graph (.ogg(u)), 
matrix(.ogm(u)), notes (.txt).  

Template 
Files  

*.otp(u);*.otw(u);*.otm(u)  

A stored customizable suite of data-
handling and format options: 
graphs(.otp(u)), worksheets (.otw(u)), 
matrix(.otm(u)).  

Import Filter 
Files  

*.oif  
An external file which handles basic 
import file parsing and data extraction.  

Fitting 
Function 
Files  

*.fdf  A fitting function definition file.  

Region of 
Interest Files  

*.roi  

One or more sets of XY coordinates that 
define the position of one or more 
regions-of-interest (ROI) within a given 
matrixsheet or Image Window.  

LabTalk 
*.ogs  

A text file organized in sections of LabTalk 
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Script Files  script.  

Origin C Files  *.c;*.cpp;*.h;.etc  
A file used for developing Origin C 
programs.  

X-Function 
Files  

*.oxf;*.xfc;  
An Origin tool with a flexible mechanism 
for performing a wide variety of data 
manipulation tasks.  

Origin 
Package Files  

*.opx  
A package file created for distributing 
custom applications.  

Origin Menu 
Files  

*.xml;*omc;  

A file that contains Origin menu 
information. An *.xml can be edited 
outside of Origin for menu customization 
purposes. An *.omc file contains the 
configuration of customized menus.  

Initialization 
Files  

*.ini  
A file that controls the configuration of 
some Origin features on startup.  

Configuration 
Files  

*.cnf  
A text file that contains LabTalk script 
commands.  

Custom Plot 
Symbols  

origin.uds  
A binary file that holds the bitmap images 
of custom symbols.  

6.2 Topics for Further Reading 

Opening, Closing and Backing Up the Origin Project File 

Protecting Origin Projects 

Origin Template Files 

The Theme Organizer 

System Themes 

Import Wizard, Save Filters Page 

Origin Fitting Functions, the Fitting Function Organizer and the Fitting Function Builder 

OGS Files and Getting Started with LabTalk 

Running LabTalk Script from OGS Files 

Using X-Functions in LabTalk 

Packaging Multiple Files as an OPX File 

https://www.originlab.com/doc/Origin-Help/OPJ-Open-Close-Backup
https://www.originlab.com/doc/Origin-Help/OPJ-Protect
https://www.originlab.com/doc/Origin-Help/OFileType-Template
https://www.originlab.com/doc/Origin-Help/ThemeRef-ThemeOrganizer
https://www.originlab.com/doc/Origin-Help/ThemeRef-System
https://www.originlab.com/doc/Origin-Help/ImpWiz-SaveFilterPage
https://www.originlab.com/doc/Origin-Help/FitFunc-Organizer-Builder
https://www.originlab.com/doc/LabTalk/Tutorials/Tutorial-Get-Started
https://www.originlab.com/doc/LabTalk/guide/From-Files
https://www.originlab.com/doc/LabTalk/Tutorials/Tutorial-XF
https://www.originlab.com/doc/Origin-Help/FileShare-Pack-OPX
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7 Import Data 

Import-Data 

 

A new generalized data import mechanism we call Data Connectors was added in Origin 2019b. As the name 
implies, Data Connectors create a link between your project and an external source file. The source file may be 
local, it can be on a company network; it can even be on a web-server. Data Connectors support options for 
excluding imported data when saving the project (smaller files, plus, maintain a live link to source data) and 
for protection of data against accidental alteration or deletion. Data Connectors also make possible import of 
previously-unavailable data sources, including HTML Tables and JavaScript Object Notation (JSON). Data 
Connectors support drag-and-drop and Auto Import on Project Open. In addition, OriginLab continues to 
expand Connector support to new data formats. In Origin 2021b, for instance, we have improved Connectors 
for National Instruments TDMS and NetCDF files; plus we've added a new Thermo Fisher Scientific 
MSRawFile Connector.  

 
Other supported import mechanisms:  

OriginLab continues support for Origin's long-standing X-Function + filter-based routines for ASCII, CSV, 
Excel, binary files, and many third-party formats, including MATLAB, pClamp, NI TDM and NetCDF. If you are a 
long-time user and you have import filters and Themes that you have long relied on, they should still work as 
they always have. 

Copy-paste for quick import of simply-structured data (mostly useful for quickly adding data to worksheets).  

For complex ASCII, binary or User-defined file types, you can use the graphical interface of the Import 
Wizard to parse your file and save settings to an import filter file. The Import Wizard supports power features 
such as saving file metadata to variables and use of custom Origin C functions for data processing and import. 

If you work with SQL databases, you can use Origin's Database Connector and SQL Editor interface to 
create connection strings and SQL queries. 

7.1 A Note to Upgrade Users 
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Longtime Origin users who are upgrading from older versions should note that import routines have moved 
from the File menu to a new Data menu. Here, you will also find Origin's newest data-import tool: Data 
Connectors.  

 

7.2 Data Connectors 

 

Data Connectors are a general mechanism for importing data to your Origin projects from local or from web-
based files and pages. Data Connectors differ from older Origin import methods primarily in two default (but 
modifiable) behaviors:  
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Data imported via Connector is locked to editing. This helps ensure data integrity. 

Data imported via Connector is not saved with the project. This helps to keep your project files smaller. 

 
Data Connectors support a number of common data formats, including:  

Text/CSV 

Excel 

Origin File (project, workbook, matrix) 

MATLAB 

JavaScript Object Notation (JSON) 

HDF 

TDMS 

HTML Table 

Import Filter (use a custom import filter with the Data Connector mechanism)  

Shapefile 

NetCDF 

XML 

 

To connect to SQL database, see Database.  

 
To import data with a Data Connector:  

With your workbook active, click the Data menu.  

If you are connecting to a local or network file, click Connect to File and pick a file type.  

To connect to multiple files, click Connect Multiple Files.  

If you are connecting to web data, click Connect to Web and enter a URL. 

7.2.1 Things to Know about Data Connectors 

By default, when import data file size exceeds 500kB, the imported data and graphs made from that data are 
NOT saved with the Origin file (see LabTalk system variable @FSE). All analysis output resulting from imported 
data ARE saved with the Origin file. Not saving raw data with your project file can significantly reduce file size 
and improve performance when working with large projects. 

IMPORTANT: Since, by default, connector-imported data (> 500kB) is not saved with the project file, users 
should always ask themselves whether they need to preserve imported data. This could be an issue when the 
data source is web-based and stored in a place beyond your control. If you prefer to save all data imported via 
a Data Connector, with your Origin file, click the Data Connector icon and clear the check mark beside 
Exclude Imported When Saving prior to saving your file†. Note that each Data Connector-containing book 
will have its own Exclude... check mark. Alternately, if you decide the Data Connectors are not needed, you 
can click the Data Connector icon and choose Remove Data Connector (from this book) or Remove Data 
Connectors from All Books (in the project). 

Data can be re-imported at any time by clicking the Data Connector icon ( or ) in the upper left corner of 
the worksheet and choosing Import (Ctrl+4) or Import All.  

https://www.originlab.com/doc/Origin-Help/Data-Connector
https://www.originlab.com/doc/Origin-Help/Data-Connector
https://www.originlab.com/doc/Origin-Help/Imp-DragDrop
https://www.originlab.com/doc/LabTalk/ref/sys-var-list
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By default, imported via a Data Connector is locked from editing. You can graph it and analyze it but you 
cannot modify it. While this ensures against accidental modification, some users may find this too restrictive. 
Unlock sheet data by clicking the Connector icon and choosing Unlock Imported Data. See this FAQ for more 
information on removing editing restrictions from Connector-imported data. 

A workbook can have only one type of Connector (e.g. Text/CSV). For files with a simple structure such as 
Text/CSV, you can have multiple sheets with each connecting to a separate file, as long as they share the 
same Connector. For files with more complex structures such as Excel or MATALAB, you will initially connect to 
one sheet/variable, then use the Data Navigator's Add and Connect Sheet(s) shortcut menu command to 
add other sheets/variables in the book, as needed. You can only connect a single Excel or MATLAB file to a 
single Origin workbook or matrixbook. 

In books containing files with a simple structure (e.g. CSV), when you right-clicking on a sheet tab and add a 
new sheet, the sheet is added with an empty Connector. The unconnected state is denoted by a pale-yellow 

Connector icon  (see Connector states, below). Click on the Connector icon to open a shortcut menu where 
you can connect the sheet to a data source. 

 

Data Connectors that you do not use can be hidden by choosing Data: Connect to File: Customize... and 
clearing the checkbox next to unused Connectors. 

Data Connectors for file formats not shipped with Origin, are available by clicking Data: Connect to File: Add 
New.... New Data Connectors are added to the Data menu. 

https://www.originlab.com/doc/Quick-Help/Change-Data-When-Connector-Used
https://www.originlab.com/doc/User-Guide/Import-Data
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†Origin caches data imported by Data: Connect to Web, for a period of time 
determined by LabTalk system variable @CFDT, plus file size. By default, a 10MB file 
will use cached data for ~24 hrs. In other words, if you re-import (i.e. reconnect to the 
web file) within 24 hrs, you will be using data that was cached on first import. If you 
re-import to this 10MB file after 24 hrs passes, the cache is cleared and the data are 
freshly imported. To learn how to control this caching behavior see, these topics:  

LabTalk system variable @CFDT. 

The LabTalk delete -web command.  

7.2.2 Data Source File Path 

A Data Connector icon appears in one of five states:  

When the data source is connected, the icon looks like this:  

When data in the sheet are unlocked to editing (either by the Connector menu or @IPDC=0), the icon looks 

like this:  

When a data source import is pending, the icon looks like this:  

When a new sheet is added to a connected book, an empty Connector is added to the sheet and the icon looks 

like this:  

When the data source is no longer viable (e.g. the data source has been moved), the icon looks like this:  

When the sheet is protected against all edits (worksheet protection), the Connector menu is disabled and the 

icon looks like this:   

 
Regardless of the state of the connection, you can click the Connector icon, then use the Data Source File 
Path and Common Data Path to help you maintain the connection between your Origin files and your source 
data.  

https://www.originlab.com/doc/LabTalk/ref/sys-var-list
https://www.originlab.com/doc/LabTalk/ref/Delete-cmd
https://www.originlab.com/doc/Quick-Help/Change-Data-When-Connector-Used
https://www.originlab.com/doc/User-Guide/Worksheets-Columns
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Relative to Project Path: If your data are stored in folders under the project file, you could set Data Source 
File Path to Relative to Project path. You can then move the project and data sources together, and their 
relative paths are preserved. No path corrections are then needed when re-opening the project file from a 
different location on your network.  

Relative to Common Data Path: If data sources are under some common path, you could set Data Source 

File Path to Relative to Common Data Path. If the files are subsequently moved, you can re-establish the 
Common Data Path and then Import All Books. 

7.2.3 Data Navigator 

The Data Navigator is a collapsible panel that is automatically added to the workbook when you connect to 
multi-page/multi-variable files such as Excel, MATLAB or Origin Projects.  
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Origin will import data from the first sheet and list other sheets in dimmed type. 

Right-click on a dimmed sheet -- or press CTRL or SHIFT and select multiple sheets -- then choose Add and 
Connect Sheets. 

The file name is assigned to the book Long Name and sheets are the original sheet name is assigned to sheet 
Name. 

Connected sheets can be deleted from the current Origin workbook. 

7.2.4 Data Connectors and Drag-and-Drop 

There is drag-and-drop support for the file types listed under Data: Connect to File:  

For files with a simple header information (e.g. only column name and units), a Data Connector is added and 
the file is properly parsed with no need for an import filter. 

For files that are not properly parsed (i.e. header information ends up in the data portion of the worksheet), 
consider making an Origin Import Filter (*.oif) file using the Import Wizard. 

Import filters can be saved to the data file folder, the User Files\Filters folder or in the current window. If you 
intend to use a template for your data import, you can save the filter to the window; otherwise the filter file 
(*.oif) should be placed either in the data file folder or in \User Files\Filters. 

7.3 Connecting to Text/CSV 

  

You can use a Data Connector to import local or web-stored text files (TXT, DAT, CSV). Data Connector 
methods work well for these file types, simplifying and in some cases eliminating, some of the problems 
associated with Origin's older X-Function-based import routines. For instance, import of date-time data always 

required manual configuration of date-time columns. With Connectors, if your date-time data are of a 
standard, easily-recognized format, that configuration is done for you automatically.  

 
To connect to a file on a local or LAN drive:  

With the workbook active, choose Data: Connect to File: Text/CSV.  

Browse to and select your file. 

https://www.originlab.com/doc/Origin-Help/ImpWiz-SaveFilterPage
https://www.originlab.com/doc/Origin-Help/Operate-ChildWindow-Basic
https://www.originlab.com/doc/Origin-Help/WksCol-DateTime


UserGuide 2026 

58 

Set your CSV Import Options. In many cases, you can simply accept defaults and your file will be cleanly 
imported, so as a test, try importing data without modifying defaults. If the results are unsatisfactory, rerun 
the import and modify the default settings. Click the Other Options button (to the left of OK) for more 
options. 

 

In this mini-tutorial, we use the Text/CSV Connector to import a text file with a date-time 
component. While older Origin import methods treated the date-time data as text, requiring 
the user to manually set the date-time column to Date after import, the Text/CSV Connector 
is able to automatically configure the worksheet column on import.  

Click the New Workbook button and choose Data: Connect to File: Text/CSV. 

Browse to the <Origin Program>\Samples\Import and Export\ folder and open Date with 
higher precision.dat. 

In the CSV Import Options dialog, accept default settings and click OK. Data are imported 
to the workbook. 

Click on the column A header to select the column, then right-click and choose Properties. 
Note that Format has been automatically set to Date, Display has been set to Custom 
Display and a custom format shows in Custom Display. 

 

 

 

In this mini-tutorial, we use a Data Connector to import multiple files. These identically-
structured files have multiple rows of metadata that we want to preserve. So, you will 
make use of an import filter file that has been developed using the Import Wizard, to 
import the files and write file metadata out to multiple column label rows in each 
worksheet. In so doing, you will see (a) how to import multiple files using a Data 
Connector and (b) how you can use an import filter file (*.oif) developed with an earlier 
version of Origin, to import files using Origin's newer Data Connector technology.  

Start a new project and with the workbook active, choose Data: Connect Multiple 
Files. 

In the files2dc dialog box, set the following:  

Data Connector = Import Filter 

Source = Specified Files 

https://www.originlab.com/doc/Tutorials/ImportWizard
https://www.originlab.com/doc/Origin-Help/WksHeaderRow-DataSupportDisplay
https://www.originlab.com/doc/Origin-Help/Imp-DragDrop
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File Names = <Origin Program>\Samples\Import and Export\S15-125-03.dat, S21-
235-07.dat and S32-014-04.dat 

Same Book = enabled (checking the box will bring all files into one book) 

Click OK and in the dialog that opens, set Import Filter = Data Folder: 
VarsFromFileNameAndHeader.oif 

Click OK and the three files are imported as separate sheets in the workbook. 

 
To connect to a file on the Web:  

Choose Data: Connect to Web. 

If you have a file URL, enter it in the URL box. Otherwise, set File Type to Text/CSV (optional but helps to 
filter Recent URLs), then click directly on Recent URLs and pick from the list. 

 

 

You can use the CSV Import Options dialog to specify a partial import of web-stored 
files just as you can for locally-stored files. Check the Partial Import box for guidance 
on the syntax used to define Column and Row import.  

 

Note: To learn more about working with the Text/CSV Connector, see the Origin Help:  

Help: Origin: Origin Help > Text/CSV Connector  

7.4 Connecting to MATLAB Files 

While Origin continues to support older X-Function based MAT file import, Data Connectors offer some distinct 
advantages for import of both locally-stored and web-stored MATLAB files:  

Connecting to a MATLAB file at the root level will add all variables as Origin matrix objects in the matrixsheet. 

A slider is added so that you can flip through Origin matrix objects in the sheet. You can toggle between slider 
and thumbnails using the Slider or Thumbnails Mini Toolbar button. 

The Connector also adds a collapsible Data Navigator panel to the window. If you wish to add variables as 
individual sheets, you can right-click on the Data Navigator list and add them. 

https://www.originlab.com/doc/Origin-Help/Connect-to-File
https://www.originlab.com/doc/User-Guide/Import-Data
https://www.originlab.com/doc/User-Guide/Import-Data
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To connect to a MATLAB file:  

With a workbook or matrixbook active, click Data: Connect to File: MATLAB or Data: Connect to Web and 
enter a URL to your .mat file. 

Select the variables that you want to import (add them to the Browser's bottom panel) and click OK. 

 

Note: To learn more about working with the JSON/MATLAB Connector, see the Origin Help:  

Help: Origin: Origin Help > JSON/MATLAB  

7.5 Connecting to NetCDF and Shapefiles 

The NetCDF file format is used for sharing multi-dimensional scientific data. The format is widely used in 
climate science. Shapefiles are commonly used to store geographic boundaries and other geo-spatial data.  

 

 
To connect to a NetCDF file:  

With a workbook or matrixbook active, click Data: Connect to File: NetCDF; or Data: Connect to Web and 
enter a URL to your .nc file. 

https://www.originlab.com/doc/Origin-Help/Connect-to-File
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Select the variables that you want to import by adding them to the Browser's bottom panel. 

Adjust Import Options ("pencil" button) as needed and and click OK twice. 

If a workbook is active but the variable requires a matrixbook, you will be prompted to add a new matrixbook 
or an embedded matrixbook in the active workook. 

 
To connect to a Shapefile:  

With a workbook or matrixbook active, click Data: Connect to File: Shapefile and browse to and choose 
your .shp file. 

Specify whether to Load Attributes and (optionally) encoding and/or Convert to WGS84, and click OK. 

Note: To learn more about working with the NetCDF Connector, see the Origin Help:  

Help: Origin: Origin Help > NetCDF Connector  

7.6 Connecting to a Cloud Drive 

You can connect to Origin, MS Excel and ASCII files stored on MS OneDrive or Google Drive. Once you've 
established your account credentials, connecting to cloud files is similar to connecting to local files:  

With a workbook active, click Data: Connect to Cloud. This opens the browser for picking files.  

Use the browser's drop-down controls to switch cloud services or accounts, if needed.  

 

Pick a file and click Open. 

Note that the first time you connect to a cloud account, you'll be asked to verify that account. OriginLab will 
only access and transfer data between your cloud account and your local computer using a temporary file. No 
other communication of information occurs.  

7.7 Working with Excel Data 

 There are several ways to work with MS Excel data in Origin:  

https://www.originlab.com/doc/Origin-Help/Connect-to-File
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You can copy Excel data to the Clipboard and paste or paste link that data into Origin. 

You can use a Data Connector to import a local Excel file by (1) clicking Data: Connect to File: Excel, (2) 

clicking the button on the Standard toolbar, or (3) dropping your Excel file onto the Origin workspace.  

You can use a Data Connector to import Excel data from the web by clicking Data: Connect to Web: Excel 
(see below). 

You can use Origin's older X-Function-based routines to import a local Excel file by clicking Data: Import 
From File. This option was recently hidden to accommodate the Excel Connector but if you prefer to use this 
method, see this section of the Origin Help file. 

 
Things to know:  

Origin imports files of type .xls, .xlsx or .xlsm.  

If you are importing data using the Excel Connector, you can refresh your Origin-side data at any time by 

clicking the Connector icon and choosing Import; or re-import your Excel data at the time that you open 
the Excel-connected Origin project. 

If you are using the older (X-Function based) impMSExcel import routine: Certain file import information is 
saved to the workbook on import. Having once imported an Excel file to an Origin workbook, you can use the 
Re-import button on the Standard toolbar to re-import an updated Excel file -- including those that contains 
multiple sheets -- to your Origin workbook. 

Origin does not support dynamically linking one Excel workbook with another Excel workbook, nor does it 
recognize or translate Excel formulas. 

 

Note: To learn more about working with Excel data, see the Origin Help:  

Help: Origin: Origin Help > Working with Microsoft Excel and Connecting to File > Excel  

 

 

Both the Excel Connector and impMSExcel routines support partial import of Excel 
data. For more information, see the Origin Help file topic Partial Importing and Re-
importing.  

7.7.1 Connecting to Excel Files 

Origin's Data Connectors create a live link between your external data files and your Origin project.  

To connect to a local file, click Data: Connect to File or click the button located on the Standard 
toolbar. 

To connect to a web-stored file, click Data: Connect to Web. 

You can connect one Excel file per Origin workbook. 

If the file is a multi-sheet file, you must first connect to a single sheet. This opens the the Data Navigator 
panel (described above) where you can connect to additional pages, as needed. 

When all sheets are identically structured, ensuring that the first sheet is properly parsed (e.g. the header 
information is correctly handled) will allow you to connect additional sheets without making adjustments.  

https://www.originlab.com/doc/Origin-Help/Work-Excel-Basic
https://www.originlab.com/doc/Origin-Help/Work-With-Excel
https://www.originlab.com/doc/Origin-Help/Connect-to-File
https://www.originlab.com/doc/Origin-Help/PartialImport-ReImport
https://www.originlab.com/doc/Origin-Help/PartialImport-ReImport
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Click the New Workbook button to create a new workbook, then choose Data: 
Connect to File: Excel. 

Browse to and open <Origin Program>\Samples\Import and Export\United States 
Energy (1980-2013).xls. 

In the Excel Import Options dialog that opens, accept default settings and click OK. 

In the Data Navigator panel that opens to the left side of the workbook, hold the 
CTRL key and select the other three (dimmed) sheets, right-click and choose Add and 
Connect Sheet(s). The remaining sheets -- Natural Gas, Coal and Total Primary 
Energy -- are imported into the workbook. Note that if the unconnected sheets are 
large in size, you can opt to connect to them one-at-a-time, as needed. 

7.8 Import from File 

 The import routines listed under Data: Import From File pre-date Data Connectors. While the Import From 
File routines are no longer being developed, they are still supported.  

Note, also, that Connectors may not exist for some of the file types listed in this table. If no Data Connector 
exists, you should use the Data: Import From File methods.  

 

The Standard toolbar Import Single ASCII button now calls the Data: Connect 
to Files: Text/CSV routine. For the impASC routine, see the next section.  

7.8.1 Importing ASCII Files with impASC 

The Data: Import From File: Multiple ASCII... ( ) method is generally satisfactory for importing text 
files having a simple structure (works for single or multi-file import). This routine will typically handle files with 
commonly-used delimiters and a simple header structure, without adjustments.  

If the file import needs adjustments, select the Show Options Dialog checkbox when selecting your file(s) in 
the ASCII dialog. This will open the impASC dialog box prior to file import, allowing you to tweak the way 
that the files are handled.  

https://www.originlab.com/doc/User-Guide/Import-Data
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Note: To learn more about working with the ASCII Import using the impASC dialog, see the Origin 
Help:  

Help: Origin: Origin Help > Customizing the ASCII Import Options  

7.8.2 Saving Import Settings 

Once you've adjusted impASC dialog import settings, you can save them in one of two ways:  

With the worksheet template. 

As a Theme file from within the impASC dialog box (including saving for drag-and-drop).  

Saving import settings with the worksheet template offers portability (e.g. templates are easily shared with 
colleagues). Saving import settings as a Theme offers the advantage of being able to recall any number of 
import options combinations (Themes) when importing via the impASC dialog box.  

For more information on Themes and templates, see the Customizing Origin chapter later in this User Guide. 
Additionally, see topics listed under "Topics for Further Reading", below.  

 

You can quickly load your custom import theme from the list at the bottom of the Data 
menu. You can also use the Data: Import from File: Add/Remove File Types ... 
menu to open the Import Menu Customization dialog box where you can select and 
add User Themes to the Data: Import From File menu.  

7.8.3 Third Party Formats 

If a Data Connector does not exist for a certain third-party format, you can still use Origin's older X-
Function-based import routines. These include many widely-used formats, including pClamp, NI TDM, and 
NetCDF. As with all X-Function-based routines, you can customize third-party file import options and save your 
settings with the worksheet template or as a dialog Theme for later use. As with other supported file types, 
you can import third party files by drag-and-drop.       

File Type  Method  To Learn More, see  

https://www.originlab.com/doc/Origin-Help/ImpASC-Options
https://www.originlab.com/doc/Origin-Help/Operate-ChildWindow-Basic
https://www.originlab.com/doc/Origin-Help/Dialog-Theme
https://www.originlab.com/doc/Origin-Help/Imp-DragDrop
https://www.originlab.com/doc/User-Guide/Customizing-Origin
https://www.originlab.com/doc/Origin-Help/Imp-DragDrop
https://www.originlab.com/doc/Origin-Help/Dialog-Theme
https://www.originlab.com/doc/Origin-Help/Intro-ImportFilter-Manager
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Help: Origin: Origin Help > Importing 
and Exporting Data  

 
Thermo (SPC, CGM)  
pCLAMP (ABF, DAT, AB?)  
Princeton Instruments (SPE)  
Sound (WAV)  
NetCDF (NC)  
CDF (CDF)  
HDF5 (H5, HE, HDF5)  
NI DIAdem (DAT)   
Famos (DAT, RAW)  
ETAS INCA MDF (DAT, MDF)  
IgorPro (PXP, IBW)  
Prism (PZFX, XML)  
MATLAB (Mat)  

Minitab (MTW, MPJ)  
KaleidaGraph (QDA)  
SigmaPlot (JNB)  
MZXML(mzData, mzXML, 
mzML, imzML)  
EarthProbe (EPA)  
EDF (EDF, BDF, REC, HYP)  
Somat SIE (SIE)  
JCAMP-DX (DX, DX1, JDX, 
JCM)  
HEKA (DAT)  
SPSS (SAV)  
BRUKER OPUS  
SAS (sas7bdat)  
Tektronix (ISF)  
Data Translation (DCF, HPF)  
Binary 2D Array (IMG, B2D)  
Image   

Data: Import 
from File:  

> Importing Third Party Files  

 

Note: Some of these 3rd party file formats are hidden by default. To add, choose Data: Import From 
File: Add/Remove File Types.... This opens the Import Menu Customization dialog box where you 
can choose which file types to show in the Import From File menu. To insert a separator after a menu 
command, right-click on the command in the right-hand panel and choose Add Separator. To remove a 
separator, double-click on it in the right-hand panel.  

  

 

If no Data Connector exists for a given file type (i.e. those listed in the table above), 
then drag-and-drop support is managed by file extension, using the Filter Manager 
dialog. From the main menu, click Preferences: Import Filters Manager....  

 

Note: To learn more about working with the Third-party Formats, see the Origin Help:  

Help: Origin: Origin Help > Importing Third Party Files  

7.9 The Import Wizard 

https://www.originlab.com/doc/Origin-Help/Import-ThirdPartyFormats
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For import of complex ASCII files -- those not satisfactorily handled by the methods previously discussed -- 
you can use the interactive Import Wizard. Files with an optional header section followed by a sequential 
binary structure, can also be imported using the Import Wizard:  

Another advantage to using the Import Wizard to your ASCII data is that you can create import filters that are 
targeted to a group of similarly-named data files. This is especially helpful when those files contain metadata 
that that needs to be handled in a certain way. The filter can then be used for drag-and-drop import 
operations and it can be added to the Data: Import From File menu. You can view and edit these import 
filters by Preferences: Import Filters Manager menu.  

 
To run the Import Wizard:  

Choose Data: Import From File: Import Wizard... or click the button located on the Standard toolbar.  

Develop Origin import filter files (*.oif) for import of ASCII files not handled satisfactorily by the Text/CSV 
Connector. 

Import data from the web pages using the Clipboard (see below). 

Extract variables from the import file name and header. 

Specify custom delimiters and date formats to parse your data. 

The ability to post-process your imported data using a custom LabTalk script.  

 

Note: For more information, view the help topic:  

Help: Origin: Origin Help > Importing and Exporting Data > The Import Wizard  

7.10 Copy/Paste the Clipboard Data 

 One obvious way to get data into Origin is simply to copy data to the Clipboard and paste it into Origin. This 
can be as easy as selecting a block of data in an Excel workbook and pasting it into an Origin workbook. 
However, Clipboard data may not be formatted, arrayed or delimited in a way that makes it easy to paste your 
data into Origin. Here are some things you should know:  

Data copied from Excel and pasted to Origin will be brought over with full precision, regardless of the number 

of displayed decimal digits in Excel. 

When working with Excel files with header information, paste the Clipboard data into data row 1 in Origin (not 
into the column label rows), then select a row and use the (right-click) shortcut key commands Set as Long 
Name, Set as Units, Set as Comment, etc. to tag your header information. 

Data copied from the web can be formatted in various ways. You may have to experiment a bit to find a 
method that brings the data over cleanly. If a simple copy and paste doesn't work, try using the Import 
Wizard. The Import Wizard provides an interactive interface for parsing Clipboard data, with the added benefit 
that you can save your procedure to an import filter file (.oif) for reuse with identically formatted data. For 
more information, see the tutorial Using the Import Wizard to Import Clipboard Data. 

https://www.originlab.com/doc/Origin-Help/ImpWiz
https://www.originlab.com/doc/Origin-Help/ImpWiz-ClipboardData
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7.11 Selectively Import Data by Querying an Origin File 

You can selectively import columns of data from an external Origin file by specifying an SQL-like Query in the 
Data Connector Browser prior to import.  
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To selectively query Origin files using the Origin Connector:  

With the worksheet active, choose Data: Connect to File or Connect to Web. 

Browse to your Origin file and click Open. This opens the Data Connector Browser. 

Click the Select Query button . 

Enter your Query in the Select Query dialog, then click OK. 

Data will be selectively imported into the active workbook as specified by your query.  

 
Common Keywords:  

Keyword  Description  

_SName  
short name, e.g. _SName, 
Sheet_SName  

_LName  long name, e.g. _LName, Book_LName  

_Comments  
comments, e.g. _Comments, 
Sheet_Comments  

Column_D1  
column user-defined parameter, where 
1 is the parameter index  
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Column_[Name]  
column user-defined parameter, where 
[Name] is a parameter name containing 
spaces  

 
Examples:  

Select Column from Project where _SName == "A"; 

Select Column from Project where _Comments like "S*3"; 

Select Column from Project where (Column_P1 like "*y*" and Column_D1 > 3); 

Select Column from Project where Sheet_SName like "Trial*"; 

Select Column from Project where (Book_SName like "Book*" or Book_LName like 

"*fit*") 

 
For more information, see Examples of using SQL query condition in Origin Connector.  

7.12 Database 

  

Origin supports connecting to databases by ODBC and OLE DB. Additionally, Origin includes a simple SQL 
Editor to add connection strings and generate SQL queries within Origin.  

 
To import SQL data, start with the Data: Connect to Database menu command:  

Open lets you browse for and open a saved connection (ODS) or query (ODQ) file. 

New opens the Database Connector dialog.  

 

https://www.originlab.com/doc/Origin-Help/Origin-Connect-Refer
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Connection string: Select this if you already have a text-based connection string for a given data source 
(ODBC or OLE DB). 

ODBC data source: Select this if you have defined an ODBC data source via the Windows ODBC Data 
Source Administrator applet. 

ODBC driver: Select this if you have an ODBC driver and want to create a data source applicable to this data 
connector instance. 

Windows Data Link Properties dialog: Select this if you are using an OLE DB-
based data source such as some SQL Server or Access client libraries. 

 
Other things to note:  

Use the LabTalk system variable @IPDB to control protection of imported range (0 = no protection, 1 = 
protected but allow reorder, 2 = protected). 

Similar to other Connectors, you can opt to Exclude Imported (data) When Saving as OPJU/OGWU. 

 

Note: For more information, see the Origin Help  

Help: Origin: Origin Help > Importing and Exporting Data > Importing Data from a Database  

7.13 Digitizer 

 At times, you may only have a graphic representation of some data that you would like to explore further. Use 
the Digitizer to import an image file, then digitize the plots, converting your image to numeric data that you 
can study and re-plot using Origin's analysis and graphing tools.  

https://www.originlab.com/doc/LabTalk/ref/sys-var-list
https://www.originlab.com/doc/Origin-Help/Import-From-Database
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Import most common image formats. 

Rotate the imported image, remove noise and calibrate scales by picking start and end values. 

Pick points on curves manually or automatically. 

Manually add curve inflection points, as needed. 

Interactively remove points that you do not want digitized. 

Support for Cartesian, polar and ternary coordinate systems. 

 

To open the Digitizer:  

Click the Digitize Image button on the Standard toolbar or choose Tools: Digitizer... from the main 

menu. 

7.14 Saving Origin Files without Imported Data 

Users have long had the option of saving Origin files without data. Save Template As..., Save Workbook As 
Analysis Template and Save Project without Data, were three options for saving Origin files without data 
while preserving settings and operations with the file.  

Users now have the option to save Origin files without imported data. This is a particularly attractive option for 
those who work with large data files, where saving of that data with the file would hinder performance or 
waste disk space.  

By default, data imported using a Data Connector, will not be saved with the book when the import file size 
exceeds 500kB. Each book has its own Exclude Imported When Saving check mark and clearing the check 
mark on any page in the book will cause all imported data to be saved with the book. 
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Any book in the project -- not only those with Data Connectors -- can be configured to exclude imported data 
by right-clicking on the window title bar, selecting Properties, then checking the Exclude imported data 
when saving project box at the bottom of the dialog. 

 

 
The act of excluding data when saving differs from saving a template file in a couple of important ways:  

When you exclude imported data, you are still saving all output resulting from analysis operations on imported 
data -- fitting results, statistical analyses, Set Values calculations, etc. -- you just don't save imported data or 
graphs of that imported data. 

Books which you have saved without imported data retain a "live" link to the original data source. For Data 
Connector-containing books, click the Data Connector icon and click Import (active sheet) or Import All (all 
sheets in book). For books used for standard file import, activate the empty book and click Data: Re-import 
Directly; or click the Re-Import no dialog button on the Import toolbar (see next). 

7.15 Re-Importing Data Files 

 There are two import commands in the Data menu that are specifically intended for repeat import of the 
same file (i.e. the file path and name must be the same):  

Re-Import Directly. When you import a file into an Origin worksheet or matrixsheet, by default a number of 
parameters, including file path and name, are saved in the sheet. If you have an external data file that is 
periodically updated or you want to reload a standard file into the worksheet, you can re-import directly 
without opening an import dialog. 

Re-Import.... This menu command opens the corresponding X-Function import dialog box for the file type so 
that you can adjust your import options before re-importing. 
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Notes:  

Only one file can be re-imported at a time. When you use either of these two menu commands, only the 
file associated with the active worksheet or matrixsheet, will be imported. If the selected data are 
imported from multiple files, re-importing will fail.  

If you import an ASCII file via the Import Wizard and select Data: Re-Import..., the impASC dialog 
will open instead of the Import Wizard.  

Re-import does not work for Binary or User Defined data types brought in using the Import Wizard. 

7.16 Clone Import 

Clone import works by "modeling" an import -- and optionally, an associated analysis operation -- and then 
applying what was done to the initial file, to a series of similar files. As long as the active book contains 
imported data and associated operations, it can be cloned. In this sense, cloning is similar to creation of an 
Analysis Template but is somewhat more limited in power (e.g cannot be used with the Batch Process 
tool).  

Clone import is supported by both Data Connector and X-Function-based import methods. A brief tutorial 
will show you the basics of cloning import and analysis operations.  

 

Click the New Workbook button to open a new workbook. 

Using Window's File Explorer, browse to your <Origin Program>\Samples\Curve Fitting 
folder and find a file called Sensor01.dat. Drag-and-drop the file onto the new workbook. 
The .dat file is imported using the Text/CSV Connector. 

Click the column B header to select the column, then click the Scatter button to create 
a scatter plot. 

Click on the X or Y graph axis scale and in the Axis dialog box that opens, click the Scale 
tab, then press Ctrl and select both Horizontal and Vertical axis icons in the left panel. Set 
Rescale to Auto and click OK. 

With the graph active, click Analysis: Fitting: Linear Fit and open the dialog box. Set 
Recalculate = Auto, accept other default settings and click OK. Answer No to the 
Reminder Message and click OK. 

Right-click on one of your workbook tabs and click Add Graph as Sheet. This will add your 
scatter plot with the linear fit results, as a page in your workbook.  

 

Make sure the sheet with data imported from Sensor01.dat is active and click the Clone 

Import button on the Import toolbar.  

Browse, once again, to your <Origin Program>\Samples\Curve Fitting folder, press Ctrl or 
Shift and select files Sensor02.dat - Sensor07.dat. Click Add Files and then click OK. What 
you should see is that using the original book as a model for import and analysis operations, 
the Sensor files are imported using the Text/CSV Connector and, one-by-one, they are 

https://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
https://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
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processed (it may take a few seconds for all operations to go to completion).  

 

7.17 Topics for Further Reading 

Data Connectors 

Importing Simple ASCII Data Files 

Customizing the ASCII Import Options 

Updating Excel Data in Origin. 

Video: Use Clone Import to Batch Process More Data Files 

Tutorial: Importing Multiple Files into Workbooks Cloned from Active Workbook 

Importing Third Party Files 

Importing Data by Drag-and-Drop 

Tutorial: Updating Graphs by Re-importing Data from a Database 

Tutorial: Connect to Web Data by Copy Link Address 

Importing Data from a Database 

Drawing or Deleting Data Points 

Tutorial: The Digitizer 

https://www.originlab.com/doc/Origin-Help/Data-Connector
https://www.originlab.com/doc/Origin-Help/Import-Single-ASCII
https://www.originlab.com/doc/Origin-Help/ImpASC-Options
https://www.originlab.com/doc/Origin-Help/Work-With-Excel
https://www.originlab.com/videos/details.aspx?id=269
https://www.originlab.com/doc/Tutorials/Import-Multi-Clone
https://www.originlab.com/doc/Origin-Help/Import-ThirdPartyFormats
https://www.originlab.com/doc/Origin-Help/Imp-DragDrop
https://www.originlab.com/doc/Tutorials/Update-Graph-By-Reimport-Data-From-Database
https://www.originlab.com/doc/Tutorials/Web-Connect-Copy-Link
https://www.originlab.com/doc/Origin-Help/Import-From-Database
https://www.originlab.com/doc/Origin-Help/Draw-Delete-DataPoint
https://www.originlab.com/doc/Tutorials/enhanced-digitizer
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8 Workbooks Worksheets Columns 

Worksheets-Columns 

 

8.1 Workbook, Worksheet and Column Basics 

The Origin workbook is a nameable, moveable, sizeable window that provides a framework for importing, 
organizing, analyzing, transforming, plotting and presenting your data.   

Each workbook is a collection of one or more worksheets (up to 1024).  

Each worksheet contains a collection of columns (up to 65,500) and each column contains rows of cells (up to 
90,000,000).  

Each column has a Short Name (e.g. "A") that uniquely identifies it within the worksheet and a Column 
Designation (e.g. "(X)" which determines how it is handled, by default, in plotting and analysis operations. 

Each worksheet, and each worksheet column, has data-containing cells identified by row (index) number; and 
a preceding metadata containing area ("header") comprised of optional label rows, including Long Name, 

Units, Comments, etc. 

 

Two convenient buttons were recently added to the workbook window: Add Sheet and 
Show/Hide Organizer.  

 

8.1.1 Some Workbook, Worksheet and Column Limits 
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Object  Maximum Number  

Worksheets in a workbook  
Rows in a worksheet, 1 column 
Rows in a worksheet, 5 columns 
Rows in a worksheet, 32 columns 
Columns in a worksheet, 1 row 
Columns in a worksheet, 100 rows 
Columns in a worksheet, 1000 rows 

1024† 
90,000,000 
90,000,000 
90,000,000 
65,500 
65,500 
65,500 

† > 255 sheets requires saving file to Unicode-compliant (e.g. *.opju) file format. Unicode formats not 
compatible with Origin versions prior to Origin 2018.  

8.1.2 Naming Workbooks, Worksheets and Columns 

       

 

Workbooks  
A Workbook has a Short Name and an optional Long Name and Comments. 
Origin uses the Short Name for internal operations. 
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Short Name must be unique within the project file, can contain only alpha-
numeric characters (letters and numbers), must begin with a letter and are limited 
to 13 characters. 

A Workbook Long Name is optional, need not be unique within the project file, 
can use any characters in any order and has a limit of 5,506 characters (including 
spaces). 

To name a workbook, right-click on the window title bar and choose Properties. 
Here you can edit Long name, Short name and Comments. Use the Window Title 

drop-down to control which name(s) show on the window title bar. 

Worksheets  

A Worksheet has a Name and optional Label and Comments. 

The Name must be unique within a workbook. 

A Worksheet Name has a 64 character limit, including spaces. These special 
characters are not allowed: {}|"<>()![]. 

Worksheet Label and Comment are optional. They need not be unique within the 
project file, can use any characters in any order, and can be of any practical 
length. 

To name a worksheet, double-click on the sheet tab, or right-click on the tab and 
choose Name and Comments. More details are listed under Worksheets, below. 

Columns  

A Column has a Short Name and an optional Long Name. 

The Short Name must be unique within the worksheet. When spreadsheet cell 
notation is enabled (default setting), you cannot edit the column Short Name (see 
Column Short Name Restriction). When cell notation is disabled, you can edit the 
column Short Name. When editing Short Names note that they must use only 
alphanumeric characters (no special characters), must begin with a letter or 
number, and cannot exceed 18 characters. 

A Column Long Name is optional, need not be unique within the project file, can 
use any characters in any order and has a limit of 30,000 characters. The Long 
Name can be edited directly by clicking in the Long Name cell or by right-clicking 
on the column header and choosing Properties from the shortcut menu. 

Dialog box and Status Bar references to data range will use Long Names, 
provided that (1) Long Name exists and (2) you have selected Use Long Names 

when available (Preferences: Options: Miscellaneous). Otherwise, Short 
Names are used. 

8.1.3 Workbooks 

Origin workbooks are highly customizable and can be saved with data (e.g. Workbook File) or without data 
(e.g. Workbook Template). Since they can be configured for many different applications, there is a good 
chance that you will collect a number of custom files over time. The New Book dialog is useful for organizing 
and choosing these files for use.  

8.1.3.1 New Book and Book Templates 

https://www.originlab.com/doc/Origin-Help/Column-Short-Names-Restrict
https://www.originlab.com/doc/Origin-Help/Operate-ChildWindow-Basic
https://www.originlab.com/doc/Origin-Help/Operate-ChildWindow-Basic
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8.1.3.1.1 To add a empty new Workbook 

Click the New Workbook button on the Standard toolbar. 

or  

Select File: New: Workbook: Black Workbook menu. 

 

8.1.3.1.2 To open the New Book dialog 

Click File: New: Workbook: Browse or press Ctrl + N. 

 

An Open Template Center button was recently added to the New Book dialog. 
Click the button to browse for additional workbook templates that you can download 
and add to your template list.  

 

The dialog lists both add-on (Extended) and User-defined (User) files.  

Files can be sorted by Name, Book Type, Category or Location. 

A file preview shows when you hover on the icon. 

Right-click on a template name and Edit metadata or Set as Default (e.g. New Workbook button ). 

Also, right-click to Clear Default. 

Enable Show in Menu to list a window in the New: Workbook or New: Matrix menus. 
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Filter windows by category using the "All Categories" menu.  

Filter windows by type using the Book Type drop-down menu. Reset to show all. 

Right-click on a template to Set as Default or Edit metadata. 

Enable/disable Show on startup and new project. 

 

Each window's Properties dialog has a Comments box for entering text. These 
comments are included in the New Book dialog previews and the Project Explorer 
previews. In addition, comments are searchable from the Edit: Find in Project tool.  

8.1.3.2 Spreadsheet Cell Notation (SCN) 

Origin workbooks support Spreadsheet Cell Notation (SCN). Spreadsheet Cell Notation allows the sort of 
cell-level calculations that are familiar to users of spreadsheets (more details below).  

By default, SCN is ON for all new workbooks. 

In Origin 2017 - 2019, when SCN was enabled in the workbook, you saw this icon in the upper-left corner 
of the worksheet. 

Beginning with Origin 2019b, the SCN icon is hidden (by default) but SCN remains enabled (also by default) 
to make room on the workbook window for the Data Connector icon. 

Most users will want to leave SCN enabled but in rare cases (e.g. you need to customize the column Short 
Name), you may want to turn SCN off. To disable SCN, right-click on the workbook title bar and choose 
Properties. Look for the Spreadsheet Cell Notation check box about half-way down the page. 

When SCN is turned off, users of all versions will see this icon in the upper-left corner of the workbook. 

If you open a project or workbook window in Origin and SCN is turned OFF in a particular workbook, the SCN 

OFF button will display in the upper-left corner. This includes projects or workbooks that were created 
prior to Origin 2017. To enable SCN, right-click on the book title bar, choose Properties and check the 
Spreadsheet Cell Notation check box. 

8.1.3.3 What Types of Data Can I Store in the Workbook? 

The workbook serves as a flexible container for all of your work-related data -- not just text and numeric data. 
You can add graphs, matrices, images, notes; and store calculations, scripts and variables, text objects and 
programmable buttons, and create live links to other project data. Beyond its role as a flexible data container, 
the workbook can also serve as a medium for batch analysis and reporting.  

https://www.originlab.com/doc/User-Guide/Origin-Interface
https://www.originlab.com/doc/User-Guide/Origin-Interface
https://www.originlab.com/doc/User-Guide/Worksheets-Columns
https://www.originlab.com/doc/User-Guide/Import-Data
https://www.originlab.com/doc/Origin-Help/Column-Short-Names-Restrict
https://www.originlab.com/doc/Origin-Help/Column-Short-Names-Restrict
https://www.originlab.com/doc/Origin-Help/Batch-Processing
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This table summarizes the kinds of objects that can be saved in the workbook window at the workbook, 
worksheet and worksheet cell levels, and how to access them.  

Element  Workbook  Worksheet  Worksheet Cell  

Graphs  

Right-click on the 

sheet tab > Add 
Graph as Sheet  

Right-click in the gray 
area beyond the last 

column > Add Graph  

Right-click on the cell 

> Insert Graph  

Matrices  

Right-click on the 

sheet tab > Add 
Matrix as Sheet  

--  --  

Images  --  --  

Right-click on the cell 

> Insert Images from 
Files  

Notes  

Right-click on 
workbook title bar > 

Properties > 
Comments  

Click the workbook's 
Show/Hide 
Organizer button > 

Data Sheets > enter 
notes in box  

Click on the cell and 

Insert Note with the 

Mini Toolbar (see 
below).  

https://www.originlab.com/doc/Origin-Help/Basic-operations-on-WKS
https://www.originlab.com/doc/Origin-Help/Basic-operations-on-WKS
https://www.originlab.com/doc/Tutorials/Adding-Objects-to-Worksheet
https://www.originlab.com/doc/Origin-Help/InsObject-to-WksCell
https://www.originlab.com/doc/Origin-Help/Basic-operations-on-WKS
https://www.originlab.com/doc/Origin-Help/Basic-operations-on-WKS
https://www.originlab.com/doc/Origin-Help/InsObject-to-WksCell
https://www.originlab.com/doc/Origin-Help/InsObject-to-WksCell
https://www.originlab.com/doc/Origin-Help/Folder-Win-Properties-Dialog
https://www.originlab.com/doc/Origin-Help/Folder-Win-Properties-Dialog
https://www.originlab.com/doc/Origin-Help/Wkbk-Organizer
https://www.originlab.com/doc/Origin-Help/Wkbk-Organizer
https://www.originlab.com/doc/Origin-Help/InsNote-to-WksCell
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Variables  

Click the workbook's 
Show/Hide 
Organizer button > 
page.info, Imported 
Files, User Tree, etc.  

The Insert Variable 
Dialog Box (Used with 
Worksheets) 

The Insert Variable 
Dialog Box (Used with 
Text Labels) 

Added text objects 
linked to 
data/variables  

Right-click on the 
worksheet cell and 
Insert Variables; or 
select a cell and 

Define Name using 
Mini Toolbar.  

Functions and 
Formulas  

Right-click in the gray 
area to the right of 

last column > Show 
Script Panel  

Select a column, 
right-click and Set 
Column Values. 
Alternately, enter 
formula in F(x)= cell.  

Click on a cell and use 
the Formula Bar or 
direct cell entry, to 

create cell formula.  

Scripts  

Right-click in the gray 
area to the right of 

last column > Show 
Script Panel  

Right-click the 
selected column > 
Set Column Values 

Added text/drawing 
objects and 
associated scripts 

--  

File Metadata  

Click the Show/Hide 
Organizer button on 

the workbook toolbar  

--  --  

Links  --  --  

Enter cell-level links 

to URLs, other 
worksheet 
ranges/cells, project 
graphs, matrices and 
image files.  

Text and 
Drawing 
Objects  

--  

Add Programmable 
Buttons and Text 
Labels and Drawing 
Objects to the 

worksheet.  

--  

Arrows  --  --  
Right-click and Insert 
Arrow  

8.1.4 Worksheets 

A workbook can have up to 1,024 sheets. A sheet has a single Name which can contain spaces and special 
characters. Optionally, you can add a Label and/or a Comment.  

To edit the sheet Name  

https://www.originlab.com/doc/Origin-Help/InsVariable-Dialog
https://www.originlab.com/doc/Origin-Help/InsVariable-Dialog
https://www.originlab.com/doc/Origin-Help/InsVariable-Dialog
https://www.originlab.com/doc/Origin-Help/GraphRef-InsInfoVar-Dialog
https://www.originlab.com/doc/Origin-Help/GraphRef-InsInfoVar-Dialog
https://www.originlab.com/doc/Origin-Help/GraphRef-InsInfoVar-Dialog
https://www.originlab.com/doc/Origin-Help/LinkVar-TextLabel
https://www.originlab.com/doc/Origin-Help/LinkVar-TextLabel
https://www.originlab.com/doc/Origin-Help/LinkVar-TextLabel
https://www.originlab.com/doc/Origin-Help/Named-Range
https://www.originlab.com/doc/Origin-Help/Named-Range
https://www.originlab.com/doc/Origin-Help/WkbkScript-Panel
https://www.originlab.com/doc/Origin-Help/WkbkScript-Panel
https://www.originlab.com/doc/Origin-Help/WkbkScript-Panel
https://www.originlab.com/doc/Origin-Help/WkbkScript-Panel
https://www.originlab.com/doc/Origin-Help/Wks-SetColVal-QuickStart
https://www.originlab.com/doc/Origin-Help/Associate-script-object
https://www.originlab.com/doc/Origin-Help/Associate-script-object
https://www.originlab.com/doc/Origin-Help/Associate-script-object
https://www.originlab.com/doc/Origin-Help/Wkbk-Organizer
https://www.originlab.com/doc/Origin-Help/Wkbk-Organizer
https://www.originlab.com/doc/Origin-Help/InsLink-to-WksCell
https://www.originlab.com/doc/Origin-Help/Associate-script-object
https://www.originlab.com/doc/Origin-Help/Associate-script-object
https://www.originlab.com/doc/Origin-Help/Create-TextLabel
https://www.originlab.com/doc/Origin-Help/Create-TextLabel
https://www.originlab.com/doc/Origin-Help/Create-Draw-Objects
https://www.originlab.com/doc/Origin-Help/Create-Draw-Objects
https://www.originlab.com/doc/Origin-Help/InsObject-to-WksCell
https://www.originlab.com/doc/Origin-Help/InsObject-to-WksCell
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Double-click on the sheet tab and enter a Name. Alternately, right-click on the sheet tab, choose Name and 
Comments and edit the Name field. 

 
System variable @SSL can be used to modify sheet naming behavior. Look for @SSL in the LabTalk System 
Variable List.  

 

When mousing over the worksheet tab, Name, Label and Comments appear as a 

tooltip.  

 
To add worksheets to the workbook, right-click on a worksheet's tab and choose one of the following:  

Insert. Inserts a single worksheet ahead of the active sheet. 

Add. Appends a single worksheet. 

Duplicate Without Data. Duplicates the active worksheet without duplicating the data. 

Duplicate. Duplicates the active sheet, including the data. 

Each sheet in a workbook can have its own set of customizations. When you Insert or Add a worksheet, the 
new sheet is based on the ORIGIN.otwu file (specifically the version of ORIGIN.otwu that is saved to your User 
Files Folder if you have customized this file). To add a sheet that is based on another sheet in the workbook 
(including number of columns and special formatting), you would use the Duplicate or Duplicate Without 
Data shortcut command.  

 
To move sheets between existing books or use them to create new books:  

You can also (a) drag existing sheets between books or (b) drag and drop sheets onto an empty portion of the 
workspace, to create a new book.  

 

To select multiple sheets when dragging between books or when dropping sheets onto the workspace to create 
new books:  

Press Shift/Ctrl on multiple worksheet tabs, then drag selected tabs to another window or an empty portion of 
the workspace. 

https://www.originlab.com/doc/LabTalk/ref/sys-var-list
https://www.originlab.com/doc/LabTalk/ref/sys-var-list
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or...  

Right-click on a worksheet tab, and choose Navigate. In the Navigate Worksheets dialog, Ctrl/Shift + select 
sheets, then right-click and choose Move to, then New Book or Selected Book. 

8.1.4.1 Worksheet Properties 

To open the Worksheet Properties dialog  

Right-click in the gray area to the right of the worksheet grid (but inside the workbook window) and choose 
Properties. 

 
You can use the Worksheet Properties dialog box to customize properties of the sheet, including...  

Display of row labels, header labels and grid lines (View tab). 

The number or rows and columns and other sheet dimensions such as column or row header height (Size tab). 

Enabling of rich text, text wrap, how to display truncated cell content, sheet font and color (Format tab). 

Auto add rows, ignore hidden rows in plotting and analysis, cell resizing (Miscellaneous tab). 

Printing/exporting of grid lines, headers and footers, background color (Print/Export tab). 

Script to run after import or upon data change (Script tab). 

Display and edit a user tree (e.g. the user adds some configuration info for use in the template) (User Tree 
tab). 

 
Note that many of the sheet customizations can be applied at the cell level by right-clicking on a selected cell 
and choosing Format Cells.  

For more information, see The Worksheet Properties dialog box.  

8.1.4.2 Manipulating Sheets with Object Manager 

Use the Object Manager's shortcut menu commands to manipulate display of workbook content:  

List all sheets in the active workbook. 

Click a sheet in Object Manager to activate the corresponding sheet in the workbook. 

Right-click in Object Manager for access to common worksheet operations, including Delete, Insert, Add, 
Move, Copy, and Rename. 

 

https://www.originlab.com/doc/Origin-Help/WksProperties-Dialog
https://www.originlab.com/doc/User-Guide/Origin-Interface
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8.1.4.2.1 Hide/Show Sheets 

You can hide (and show) worksheets by using the Object Manager.  

In the Object Manager, select one or more worksheets. 

Right-click and choose Hide. Hidden sheets are dimmed in Object Manager and hidden in the workbook. 

To show the sheet(s), right-click on the dimmed sheets and choose Show.  
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Note that you can also right-click on one or more worksheet tabs and choose Hide/Show. 

Additionally, there is a Navigate shortcut menu item, available in both sheet-tab and Object Manager shortcut 
menus, that opens the Navigate Worksheets dialog. You can hide or show sheets by clearing or checking the 
Show check boxes in this dialog. 

Another way to show sheets is via the Workbook Organizer: 

Right-click in the gray area to the right of the last worksheet column and choose Show Organizer. 

In the lower left panel, hidden sheets will be dimmed (grayed-out). Double-click on the dimmed sheet to 
Show. 

 

8.1.4.3 Worksheet Views: Split and Freeze 

Origin has two utilities for locking the view in part of the worksheet, while allowing you to scroll through the 
remainder of the sheet. The two could be used interchangeably in some situations.  

8.1.4.3.1 Splitting the worksheet into panels using dividers 

This places a moveable, vertical or horizontal divider at the selected row or column; or if a single cell is 
selected, both a vertical and a horizontal divider. This divides the worksheet into identical and scrollable views 
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of the worksheet data area. The user is able to scroll within each panel while rows or columns in the other 
panel(s) remain visible.  

 

Select a worksheet row/column or a single cell and choose Window: Split. 

To remove the split choose Window: Remove Split. 

 

8.1.4.3.2 Freeze rows or columns in the worksheet 

The user can freeze the first 1 to 10 rows and/or columns in the worksheet, thus locking them in view while 
the remainder of the rows or columns remain scrollable. Locked row and column headers are shaded in a 
darker color to indicate freeze.  
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Highlight a row or column, or a single cell between index row/column = 1 and 10, then do one of the 
following: 

Choose View: Freeze/Unfreeze Panes. 

Press Ctrl + Shift + F. 

Select a row/column or a single cell and click the Mini Toolbar button Freeze Panes. 

Click in upperleft-most cell in the sheet and click the Unfreeze Panes button. 
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8.1.5 Worksheet Columns 

To add a new column to the right end of an existing worksheet, right-click in the gray area to the right of 

the worksheet columns and choose Add New Column or Click the Add New Column button on the 
Standard toolbar.  

To add multiple columns to the worksheet, make the worksheet active then choose Column: Add New 
Columns... from the main menu. Specify the number of columns to add in the Add New Columns dialog box 
and click OK; or use the Format: Worksheet... menu item or the F4 hot key to open the Worksheet 
Properties dialog, then set the desired value for Column Number in the Size tab. 

To insert a column into the worksheet, highlight a column, then right-click and choose Insert. A column is 
inserted ahead of the selected column and column Short Names are adjusted accordingly. 

 
Worksheet columns can be renamed by:  

Double-clicking on the column heading opens the Column Properties dialog box. Enter/edit Short Name 
and/or Long Name.  

Type a Long Name directly into the worksheet header cell by double-clicking in the cell.  

Import a data file and specify that the workbooks, worksheets, and columns be named upon import. 

Use the Enumerate Labels tab of the Worksheet Properties dialog to enumerate or duplicate column 
names and labels. 

Type names into a few columns (e.g. Peak 1 and Peak 2), then highlight the cells and drag the bottom-right 
corner of the selection to auto fill and enumerate the names for other columns. This also works for other 
column label rows such as Comments. 

 
See the above table for rules on worksheet column naming.  

8.1.5.1 Column Designations 

https://www.originlab.com/doc/User-Guide/Worksheets-Columns
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As mentioned, worksheet Column Designations (aka "Plot Designations") generally determine how data are 
handled during analysis and plotting operations. For instance, you might select an X column + three Y columns 
to perform a simultaneous linear fitting of each Y dataset against a common set of X values. Or you might 
select the same columns to graph 3 line plots against a common set of X values. In addition, there are 
designations for Z values, for error data, for labels, etc. (for more information, see Setting Column Designation 
in the Origin Help file).  

 

 
While there are a number of places in the user-interface where you can designate columns during some 
analysis or plotting operation, at a basic level, they are set in the worksheet by (1) clicking on the column 
header to select a column, then (2) doing one of the following:  

Choose an option from the column-level Mini Toolbar. 

Click a button on the Column toolbar. 

Right-click on the column and choose Set As and choose an option from the shortcut menu. 

Right-click on the column, choose Properties and set Plot Designation. 

8.1.5.2 The Column Properties Dialog Box 

 The Column Properties dialog box is used to customize properties of the column including...  

Long Name, Short Name, Units, Comments, etc. 

Format (Numeric, Text, Time, Date, etc.).  

Plot Designation. 

 
To open the '''Column Properties''' dialog box:  

Double-click on the column header. 

Right-click the selected column(s) and choose Properties.... 

Use the Properties tab to edit the column Short Name, if desired. Other properties -- Long Name, Units 
and Comments -- can be edited here or entered directly into the column label row cells.  

8.1.5.3 Formatting Column Data 

Data in the Origin worksheet is treated as either text or numeric data. While the display of text data in the 
worksheet is fairly straightforward, the display of numeric data is more complicated.  

Unless otherwise specified, all numbers in the worksheet are stored internally as floating point, double 
precision (Double(8)) numbers. This includes date and time, data which is formatted to display in degrees-
minutes-seconds or numbers that are formatted to display a fixed number of decimal digits.  

When dealing with numeric data, understand that what you see in the worksheet is a representation of a 
number that is stored internally. This is important for two reasons:  

https://www.originlab.com/doc/Origin-Help/WksCol-SetDesignation
https://www.originlab.com/doc/Origin-Help/Mini-Toolbar
https://www.originlab.com/doc/User-Guide/Toolbars
https://www.originlab.com/doc/Origin-Help/ColProperties-Dialog-Properties-Tab
https://www.originlab.com/doc/Origin-Help/ColProperties-Dialog
https://www.originlab.com/doc/Origin-Help/Format-Wks-Data
https://www.originlab.com/doc/Origin-Help/WksCol-SetDesignation
https://www.originlab.com/doc/Origin-Help/Number-in-Origin
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Calculations involving worksheet values are always done on the double-precision number that is stored 
internally, not the value that is displayed in the worksheet. 

You can apply various Format and Display options to change the way that this stored number displays in the 
worksheet. 

 

While the central place for formatting worksheet data is the Properties dialog, as described 
above, keep in mind that there are quick-access Mini Toolbar buttons for changing the 
Display of numeric and date-time data. Note that the Format of selected columns must first 
be set as Date or Numeric/Text & Numeric for these buttons to be visible.  

 

 

8.1.5.3.1 Numeric Display Formats 

Double-click on a column heading to open the Column Properties dialog.  

Click the Properties tab, then set Format = Numeric. 

Set Display to Decimal: 1000, Scientific: 1E3, Engineering: 1K, Decimal: 1,000 or Custom (see below). 

 

8.1.5.3.2 Date and Time Formats 

By default, Origin stores date-time data as a modified Julian Day value and it uses this number for date-time 
calculations. Typically, however, you will prefer to display this Julian Day value in a more meaningful date-time 
format:  

Double-click on a column heading to open the Column Properties dialog.  

Click the Properties tab, then set Format = Time, Date, Month or Day of Week. 

Set the Display list to one of the listed options.  

If none of the listed options are appropriate you can choose Custom Display and construct your own custom 
date-time string using these date-time format specifiers. 

 

When importing date-time data into the worksheet, Origin will sometimes treat this data as 
text (Origin's CSV Connector generally does a better job of recognizing date-time data). If 
your date-time data are left-aligned in the worksheet cell, Origin "sees" it as text. You will 
need to open the Column Properties dialog box and choose your Format and Display 
options. When you see that your date-time data are right-aligned in the cell, you know that 
Origin "sees" the data as numeric data, displaying in a date-time format.  

https://www.originlab.com/doc/Origin-Help/ColProperties-Dialog-Properties-Tab
https://www.originlab.com/doc/User-Guide/Worksheets-Columns
https://www.originlab.com/doc/Origin-Help/DateTime-in-Origin
https://www.originlab.com/doc/LabTalk/ref/Date-and-Time-Format-Specifiers
https://www.originlab.com/doc/User-Guide/Import-Data


Workbooks Worksheets Columns 

91 

 

8.1.5.3.3 Color Format 

Origin 2021 introduced a new column and cell Format -- Color.  

 

Supports direct entry of HTML color codes into the worksheet cell to set cell background color, with the option 
to display or hide the HTML codes in the Color cell. 

Use the color() function to calculate hex values and set colors from RGB values in other data columns using 
Set Column Values or cell formula (e.g. color(A,B,C) sets color using RGB values in columns A, B and C). 

Select a column in which Format = Color and use a Mini Toolbar button to Save as Increment List (color 
list) for use in your graphs. 

Alternately, from the Custom colors menu in the Color Chooser, choose Create Color List from Column 
and pick a Color worksheet column from the flyout. 
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8.1.5.3.4 Other Custom Display Formats 

Origin can display numeric values in the worksheet in a variety of custom formats. This illustration shows 
various formats applied to the same set of numeric values (column A(X)).  

 

The following is a sample listing of some supported custom format options (this just happens to be the pre-
populated list that ships with Origin 2019). Note that you can enter custom formats directly into the Custom 
Display list and they will be saved to this list.  

There are many other format options. For more information, see Custom Numeric Formats  

Format  Description  
Example 
if cell value = 
123.456  

*n  Display n significant digits.  *3 displays 123  

.n  Display n decimal places.  
.4 displays 
123.4560  

S.n  
Display n decimal places, in scientific notation of the form 
1E3.  

S.4 displays 
1.23456E+02  

http://wikis/docwiki/index.php?title=UserGuide：Custom_Numeric_Format
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E.n  Display n decimal places, in engineering format.  
E.2 displays 
123.46  

* "pi"  Display a number as a decimal, followed by the symbol π.  
* "pi" displays 
39.29727π  

#/4 "pi"  
Display a number as a fraction of π, with a denominator of 
"4".  

#/4 "pi" 
displays 157π/4  

#/# "pi"  Display a number as a fraction of π.  
#/# "pi" 
displays 275π/7  

##+##  
Display a number as two digits, a "+" separator, then two 
digits (e.g. surveying stations).  

##+## displays 
01+23  

#+##M  
Display a number as one digit, a "+" separator, then two 
digits, plus a suffix of "M".  

#+##M displays 
1+23M  

#n  
Display a number as an integer of n digits, pad with leading 
zeros as needed.  

#5 displays 
00123  

#%  Display a number as a percentage.  
#% displays 
12346%  

# ##/##  Display a number as proper fraction.  
# ##/## 
displays 123 
26/57  

# #/n  Display a number as proper fraction, in nths.  
# #/8 displays 
123 4/8  

DMS  
Display a number in Degree° Minute' Second", where 1 
degree = 60 minutes, and 1 minute = 60 seconds.  

DMS displays 
123°27'22"  

D MDn EW 
(longitude) 
D MDn NS 
(latitude)  

Display a number in Degrees and Decimal Minutes. 
Parameter n specifies decimal places. Positive values will 
have "E" or "N" appended, Negative values will have "W" or 
"S" appended. If you wish to preserve negative values do not 
append "EW" or "NS".  

D MD3 EW 
displays 123° 
27.360 E  

D MDn 
EWB 
(longitude) 
D MDn NSB 
(latitude)  

Display a number in Degrees and Decimal Minutes. 
Parameter n specifies decimal places. Letter "B" ("before") 
specifies that positive values should have "E" or "N" prefixed, 
negative values will have "W" or "S" prefixed. If you wish to 
preserve negative values do not append "EWB" or "NSB".  

D MD3 EWB 
displays E 123° 
27.360  
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 %#x  
Display a number as a 32-bit hexadecimal (max 8 hexdigits). 
The "#" symbol specifies "Ox" prefix.  

%#x displays 
0x7b  

 %#0nx  
Display a number as a 32-bit hexadecimal (max 8 hexdigits) 
notation, as an n-character string, pad with leading 0 as 
needed.  

%#06x returns 
0x007b  

 %#0nI64X  
Display a number as a 64-bit hexadecimal notation (max 13 
hexdigits, 15 total including #="0x"), as an n-character 
string, pad with leading 0 as needed.  

%#014I64X 
returns 
0X00000000007B  

-+n  

Display a negative/positive (-+) format that can be combined 
with other custom formats. For instance, if you had a column 
containing both positive and negative numbers, you might 
set Custom Display as "-+.2" to display numbers to 2 
decimals with a prefix of "-" or "+". Normally (by default), 
the "-" does display while the "+" does not. However, this 
syntax also substitutes a "long minus" in place of the usual 
"short minus" used in displaying worksheet negative 
numbers. Note that the "-" and "+" symbols may be 
combined in your custom string (e.g. "-+") or used alone 
(e.g. "-").  

 

-+.2 displays 
+123.4560  

8.1.6 Column Label Rows 

  

Column label rows store metadata -- data that is used to describe other data. Typically, this metadata may be 
brought in as header information in imported files, or it may be manually entered. Display of column label rows 
is optional and the user can selectively show them or hide them, as needed.  

Column label row information is often used in plotting operations (e.g. worksheet Long Names used as graph 
legend text or Axis titles). The F(x)= row is used in performing math operations on columns of data (see 
below). Data stored in User-defined Parameter rows might be used in labeling or grouping of datasets in 
plotting, data manipulation, statistical analysis or math operations (see Tutorial 2, below).  

https://www.originlab.com/doc/User-Guide/Worksheets-Columns
https://www.originlab.com/doc/User-Guide/Worksheets-Columns
https://www.originlab.com/doc/User-Guide/Worksheets-Columns
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Tips...  

You can copy a selected subrange of worksheet cells and include associated column label row information with 
the copy-paste operation. To copy label rows with data cells, right click on your subrange selection and choose 
Copy (including label rows). 

You can highlight label row cells and stats will be reported to the Status Bar. 

 

8.1.6.1 Managing Display of Column Label Rows 

Display (showing or hiding) of column label rows is controlled by shortcut menu commands:  

https://www.originlab.com/doc/User-Guide/Origin-Interface
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Right-click here and choose View from the shortcut menu. 

Right-click here and choose Edit Column Label Rows or other label row command. 

Right-click here to control worksheet elements (display Row Label, Column Header, etc) or select a cell in this 
area, then right-click to Set Comments Style. 

There is also a worksheet column label row Mini Toolbar for managing label rows. Use it to do such things as 
hide selected label rows, enable Rich Text or change label row order.  

 

8.1.6.2 Column List View 

Origin 2019 introduced a new view mode for the worksheet called Column List View that is a transposed 
view of the column label row metadata. This view is potentially useful if your worksheets have many rows of 
metadata and you want to focus on some particular aspect of that metadata. With the worksheet active, 
choose View: Column List View or press Ctrl + W.  
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Further, you can apply a data filter to metadata in Column List View. When you return to the standard 
worksheet view (clear the mark beside View: Column List View), only data associated with the filtered 
metadata will show in the worksheet.  

 

Column List View displays column index number ahead of column short name (+ 
column designation). In addition, you can hover on the left edge of column long name 
and a tooltip reports dataset size. To disable the display of column index, set @DSI=1.  

 

8.1.6.3 Sparklines 

Numeric data stored in a column will graphically display in the column header in a special label row called 
Sparklines. A sparkline is, by default, a small inset line plot of the data in a column, plotted as the dependent 
variable (Y) against the row number or the associated X column as independent variable (X). When importing 
data, Origin displays sparklines by default when the number of columns is less than 50.  

https://www.originlab.com/doc/Origin-Help/Wks-DataFilter
https://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
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To Show or Hide Sparklines:  

Show Sparklines by clicking Column: Add or Update Sparklines. This opens the sparklines dialog. 

Show Sparklines for selected columns by clicking the Add Sparklines button on the Column toolbar. 

Right-click on the worksheet's Sparklines column label row and choose Add or Update Sparklines.  

Delete sparklines by right-clicking the Sparklines column label row and pressing the Delete key.  

In addition to the default line plot, Sparklines can display as Histogram or Box Charts. Highlight one or more 
columns by clicking on the column header, then choose Column: Add or Update Sparklines. In the dialog 
box that opens, set the Plot Type to Histogram or Box. 

 

Sparkline plot properties can be customized. Double-clicking on a sparkline pops open a graph window. 
Double-clicking on the pop-up window opens the Plot Details dialog box where you can customize the plot. 
When you close the pop-up window, your customizations are applied to sparkline. 

 

Sparklines can, in large numbers, cause Origin to act sluggishly. If your project is 
difficult to work with and you suspect sparklines may be contributing, you can prevent 

sparkline creation and hide existing sparklines in the project using system variable 
@SPK. Additionally, you can delete sparklines from the current project using delete -
spk.  

8.1.7 The Workbook Organizer 

 As mentioned, the workbook commonly stores metadata, some of which is visible in the column label rows. 
Other metadata may be hidden in the workbook. Such hidden metadata might include things like import file 

https://www.originlab.com/doc/LabTalk/ref/sys-var-list
https://www.originlab.com/doc/LabTalk/ref/Delete-cmd
https://www.originlab.com/doc/LabTalk/ref/Delete-cmd
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path and name, date and time of data import, file header information not written to the column label rows, 
variable names and values, etc. This hidden metadata can be viewed in the Workbook Organizer panel.  

To show (or hide) a workbook's Organizer panel:  

Click the Show/Hide Organizer button on the workbook button bar. 

Right-click on the workbook title bar and select Show Organizer  

 

 

8.1.8 Managing Workbooks with Mini Toolbars 

A number of common book-, sheet-, column and cell-level properties can be set or toggled ON/OFF with a 
Mini Toolbar button.  
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To see which tools are available, make a worksheet selection and then hover on your selection. 

Page-level formatting options are shown by hovering in the upper-left corner of the sheet or near the window 
margins in the gray area to the right of the worksheet columns. 

Go here for a full list of worksheet Mini Toolbars. 

8.1.9 Find and Replace in Worksheets 

 

Clicking Find opens a small dialog for searching the current worksheet selection. 

Small dialog supports string or numeric, forward and backwards search. 

While the dialog is minimized, you can edit within the selection or press CTRL + Page Up/Page Down to search 
backwards or forwards; or change the worksheet selection and restore the dialog to perform a new search. 

Click the ellipsis button (...) to open Origin's larger Find and Replace dialog. 

 

https://www.originlab.com/doc/Origin-Help/Mini-Toolbar
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Origin has another "Replace" tool that can be scripted: wreplace. To open a UI dialog, 
open the Script Window (Window: Script Window) and type wreplace -d. To learn 
about scripting options, see the X-Function documentation for wreplace.  

8.2 Simple Utilities for Filling Columns with Data 

  

Origin provides several utilities for filling a worksheet range or column, with data. The simplest of these use a 
menu command to fill a worksheet column with either row index numbers, uniform random numbers or 
normal random numbers. This is useful for generating quick datasets to test and try out other Origin 
features.  

These simple procedures create a dataset in a pre-selected worksheet range or column(s):  

Action  Toolbar Button  Menu Command  

Fill a range or column with row 
numbers  

 

Column:Fill Column With:Row 
Numbers 

or 

Right-click and select Fill 
Range/Column(s) With Row Numbers 

Fill a column with uniformly 
distributed random numbers 
between 0 and 1  

 

Column:Fill Column With:Uniform 
Random Numbers 

or 

Right-click and select Fill 
Range/Column(s) With Uniform 
Random Numbers 

Fill a column with normally 
distributed random numbers  

 

Column:Fill Column With:Normal 
Random Numbers 

or 

Right-click and select Fill 
Range/Column(s) With Normal 
Random Numbers 

Fill a column with a patterned or 
random set of numbers  

--  
Right-click and select Fill 
Range/Column(s) With A set of 
Numbers... 

Fill a column with a patterned or 
random set of Date/Time Values  

--  
Right-click and select Fill 
Range/Column(s) With A set of 
Date/Time Values... 

Fill a column with arbitrary set of 
Text&Numeric values  

--  
Right-click and select Fill 
Range/Column(s) With Arbitrary set of 
Text&Numeric values... 

 
The auto fill feature can be used in filling column label rows and the worksheet data cells:  

https://www.originlab.com/doc/X-Function/ref/wreplace
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To use auto fill to extend a pattern in the data across a range of cells (numeric data only):  

Select a contiguous block of cells and move the mouse cursor to the bottom right corner of the selection.  

When the cursor becomes a "+", hold down the ALT key and drag the mouse to the bottom or the right.  

 
To use auto fill to repeat a pattern in the data across a range of cells (text or numeric data):  

Select a contiguous block of cells and move the cursor to the bottom right corner of the selection.  

When the cursor become a "+", hold down the CTRL key and drag the mouse toward the bottom or to the 
right. 

 

Tips of data selection methods:  

When selecting a range of worksheet data, press Ctrl + click or Ctrl + drag, to deselect 
unwanted cells. 

Select a column and press Ctrl + Shift + RIGHT arrow to extend selection to the the 
last occupied column. Select a row and press Ctrl + Shift + DOWN arrow to extend 
selection to the last occupied row. 

 
Datasets can also be generated quickly using LabTalk script. As an example:  

With a new worksheet active, open the Script Window from the Windows menu, and copy-paste the 
following lines of script code into that window: 

col(1)={0:0.01:4*pi}; 

col(2)=sin(col(1)); 

Highlight the two lines and press ENTER to execute them. The first two columns of the worksheet will be filled 
with data. 

8.3 Setting Column Values 

    

The Set Values dialog box is used to set up a mathematical expression that creates or transforms one or 
more columns of worksheet data. The dialog box includes a menu bar, a control used to define output range, a 
tool for searching and inserting LabTalk functions into your expression, a column formula box used to define a 
one-line mathematical expressions, a Before Formula Scripts panel (usage optional) intended for data pre-
processing and defining of variables used in your one-line expression and for Python users, a Python 
Function tab for defining and using Python functions which can also be used in your expressions.  

https://www.originlab.com/doc/User-Guide/Programming-in-Origin
https://www.originlab.com/doc/Origin-Help/Wks-SetColVal-QuickStart
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Since Origin 2017, the column formula box (the upper box) in Set Values has supported a simplified 
spreadsheet cell notation like is used in MS Excel and Google Sheets. A cell is addressed using column 

Short Name + row index number (e.g. the first cell in column A -- formerly represented as "col(A)[1]" -- is 
now simply "A1").  

In new workbooks, spreadsheet cell notation is enabled by default. Spreadsheet cell notation can only be used 
in defining the column formula. It cannot be used in the Before Formula Scripts panel of Set Values, nor can 
it be used in your LabTalk scripts. Note that the "old" column and cell notation will work in spreadsheet mode, 
so if you are an experienced user and you prefer to use the old notation, you may enter it as you always have. 
For an introduction to the spreadsheet cell notation syntax as well as a contrast with the "old" methods, see 
Column Formula Examples.  

To open the Set Values dialog box for a single column:  

Select a worksheet column or a range of cells in a worksheet column.  

From the menu, choose Column: Set Column Values... or right-click on the worksheet column and choose 
Set Column Values... from the shortcut menu. 

 
To open the Set Values dialog box for multiple columns:  

Select multiple, contiguous worksheet columns (skip no columns) or the entire worksheet. 

From the menu, choose Column: Set Multiple Column Values... or right-click on the worksheet column and 

choose Set Multiple Column Values... from the shortcut menu. 

https://www.originlab.com/doc/Origin-Help/Wks-SetColVal-QuickStart
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8.3.1 Set Values Menu Commands 

Menu 
Commands  

Formula: Load a saved formula into the column formula box. Formulas are saved 
using Formula: Save or Formula: Save As.... 

wcol(1): Use the menu to include worksheet columns in either your column 
formula or your Before Formula Scripts (column reference is inserted at the 
cursor). A Column Browser is available to help in selecting the correct columns. 
Columns are listed by column index. 

Col(A): Similar to wcol(1) menu functionality but columns are listed by column 
name (including Long Name, if it exists). 

Function: Add LabTalk functions to your expressions (function name is inserted at 
the cursor). Note that when you hover over a function in the menu list, the 
function description will be shown in the Status Bar. When a function is selected, 
its description will be displayed in a pop-up Smart Hint.  

Variables: Add a variable or a constant to Column Formula or Before Formula 
Scripts; Add range variables (including by selection) or file metadata, to Before 
Formula Scripts. 

Options: Allow direct editing of column formula in worksheet Formula row; add a 
comment about the column formula; or preserve text in Set Values columns (do 
not treat as text as missing values). 

Column Formula  
Add a single line expression for generating data. Functions, conditional operators 
and variables can be used. 

Before Formula LabTalk scripts to be executed before the expression in the column formula box is 

https://www.originlab.com/doc/LabTalk/guide/LT-Supported-Functions
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Scripts  executed.  

Python Function  Define and use Python functions in your expression. 

 

 

Access to Origin's built-in functions:  

The Set Values dialog and the F(x)= cell get Auto Complete support. Begin typing to 
see a list of possible functions.  

Additionally, you can find and insert a function from the Functions menu in Set 
Values dialog. When you mouse over one of the functions in the sub-list of Function 
menu, a one-line tooltip is displayed in the Status Bar. If you select the function, a 
Smart Hint appears with a more detailed explanation and a link to the full function 
description, syntax, examples, etc. 

Additionally, you can click the Search and Insert Functions button to search for 
available functions by keyword and, once found, insert the function into your 
expression. Note that the Search Functions dialog can also be opened directly from 
menu Tools: Search Functions. 

 
To learn more, see Set Column Values - Quick Start  

8.3.2 The "F(x)=" Worksheet Column Label Row 

For simple expressions, you can use the F(x)= row to set column values. Any expression you enter here is 

directly entered into the Set Values dialog and vice versa. Note that the simplified spreadsheet cell notation 
that works in the formula box in Set Values also works in F(x)=:  

Double-click in a cell in the F(x)= column label row. 

Enter an expression to enter output in the data column below. 

 

Ease of use to the F(x)= label row:  

The Auto Complete hint enables when you enter a formula in F(x)= cell and Set Values dialog. If you prefer 
not to use Auto Complete, you can disable it by setting system variable @FAC=0. 

Autofill is supported for column formulas entered in F(x)= cell. That is, the formula will auto-adjust to use a 
sequence of new input datasets when autofill. To use, hover at the lower right corner of the cell and when the 
cursor becomes a "+", press Ctrl and drag to the right with your mouse. 

https://www.originlab.com/doc/python
https://www.originlab.com/doc/User-Guide/Origin-Interface
https://www.originlab.com/doc/Origin-Help/Wks-SetColVal-QuickStart
https://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
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8.3.3 Set Column Values Tutorials 

 

Tutorial 1: A Quick Units Conversion using F(x)=  

Start with a new workbook and import the file \Samples\Graphing\WIND.DAT. 

We will assume that column B contains Speed values in miles per hour (MPH). Click on 
the column heading for column C, then right-click and choose Insert. Origin inserts a 
new column C and moves Power values to column D. 

Now, we'll convert the MPH values in column B to kilometers per hour (KPH). Double-
click in the F(x)= cell of column C and enter  

B*1.6 

and press Enter. Column C is filled with values in units of KPH. 

 
Tutorial 2 : Computing Moving Average and Moving Standard Deviation  

Import the file Samples\Signal Processing\fftfilter1.DAT. 

Add two more columns to the worksheet by clicking the twice. 

Click on the header of the 3rd column to select it, then right-click and select Set 
Column Values... from the context menu. 

In the Set Values dialog, enter the following in the upper panel:  

movavg(B,5,5) 

and press Apply. Column 3 is filled with an 11-point moving average of the data from 
column B (note that you can insert functions such as movavg from the Function menu 
of the Set Values dialog box). 

Click the >> button above the edit box to switch to the 4th column. 
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In the edit box for the 4th column, enter the formula:  

movrms(B,5,5) 

and press OK. This 4th column will be filled with root-mean-square (RMS) values, using 
a window size of 11 at each point. 

 
Tutorial 3: Set Values for Multiple Columns  

Create a new project by clicking the New Project button on the Standard toolbar. 

Click the Import Multiple ASCII button to import the files F1.dat and F2.dat in 
the <Origin Folder>\Samples\Import and Export\ path. In the impASC dialog, set 
Multi_File (except 1st) Import Mode to Start New Books and click OK. 

Two workbooks are created, named as F1 and F2. Click the New Workbook button 

on the Standard toolbar to create another workbook. 

With the 3rd workbook active, click the Add New Columns button to add a 

column. Highlight all columns and select Column: Set Multiple Columns Values from 
the main menu or right-click the columns and select Set Multiple Columns Values 
from the shortcut menu to open the Set Values dialog box. 

Expand the bottom panel by clicking the Show Scripts button . Enter this script in 
the Before Formula Scripts edit box,  

range r1=[F1]F1!wcol(j); //"j" is the column index. 

range r2=[F2]F2!wcol(j); 

Enter (r1+r2)/2 in the Column Formula edit box  

Select Options: Direct Edit Formula Cell to clear this option.  

Select Options: Formula Text... and enter (F1+F2)/2 in the Formula Text dialog, 
then click OK.  

Click the OK button in the Set Values dialog box. You will see the results in the 
worksheet, and (F1+F2)/2 will display in the F(x)= column label row instead of the 
formula.  

8.4 Setting Cell Values 

Origin supports cell-level expressions similar to those used by spreadsheet programs. Cell-level expressions 
which return a single value (numeric, string or date/time) can be entered into any worksheet data cell or into 
cells in a User-Defined Parameter row of the column label row area. When Edit Mode (Edit: Edit Mode) is 
toggled on, cell formulas display. When Edit Mode is toggled off, the formula result is displayed. Cell content 
can be edited regardless of Edit Mode state.  

https://www.originlab.com/doc/Origin-Help/WksHeaderRow-DataSupportDisplay
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To use cell formulas, Spreadsheet Cell Notation must be enabled (it is by default). 

Cell formulas begin with an equal sign (e.g. =B1 - C1). 

Cell formulas can return a numeric, a string or a date-time value. 

Cell formulas can incorporate cell references, variables, operators, LabTalk-supported functions and constants. 

Cell formulas can reference values in other sheets or books. 

Cell formulas can be extended to other cells by dragging with your mouse. 

The Auto Complete hint -- which shows as soon as you enter the first character beyond "=" -- applies to the 
Set Values dialog, the F(x)= label row and cell formulas. 

There is a periodic refresh performed on cell calculations. If the sheet contains large numbers of cell formulas, 
this can slow your work. System variable @SCNT is added to manage the recalculation time (default is 5000 
millseconds) so if the continual recalculation is annoying, you can set a longer time period. Later, if you need 
to force a refresh, you can open the Script Window/Command Window and run @SCNT = -1.  

 
To learn more, see Using a Formula to Set Cell Values.  

8.4.1 The Formula Bar 

When creating cell formulas, or column formulas using F(x)=, the Formula Bar makes it easier to find and 
insert functions, select cell ranges and view and edit expressions, particularly long expressions that exceed cell 
width.  

 

 
To enter an expression into a cell (data cell or F(x)=), click on the cell, then:  

Enter an "=" and type your expression; or click the button to open the Search and Insert Functions 
dialog. 

https://www.originlab.com/doc/Origin-Help/Using-Formulae-to-Set-Cell-Values
https://www.originlab.com/doc/LabTalk/ref/sys-var-list
https://www.originlab.com/doc/Origin-Help/Using-Formulae-to-Set-Cell-Values
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Search for the desired function then double-click on it to insert it into your Formula Bar expression. 

Interactively select your data range going to the worksheet and (a) clicking on a column heading or (b) 
dragging to select a range of cells. 

When your expression is complete, click the button or press Enter. 

 

Note that you can drag the edge of the Formula Bar to resize it. You can also change 
the default font size by changing the value of LabTalk system variable @FBFS (default 
is "130").  

8.4.2 Set Cell Values Tutorials 

 

Tutorial 1: Extending a cell formula to other cells  

Click the New Workbook button to open a new book. 

Click on the column A heading to select, then right-click and choose Fill Column with 
Row Numbers. 

Click on cell B1 and enter:  

=A1+A$1 

Press ENTER. This adds the value in A1 to the value in A1.  

With the cell still selected, hover on the selection handle in the lower-right corner of the 
cell and when it looks like a "+", double-click to extend the cell formula to the bottom 
of the column. 

Click the Add New Columns button to add column C. 

Click on the Cell in C1 but this time enter (omitting the "$"):  

=A1+A1 

Press ENTER. This adds the value in A1 to the value in A1.  

With the cell still selected,hover on the selection handle in the lower-right corner of the 
cell and when it looks like a "+", double-click to extend the cell formula to the bottom 
of the column. Note that this time, the resulting values are different. 

Click Edit: Edit Mode to display the underlying cell formulas. Note that the "$" in 
column B "locked" the second cell A1 reference so that it didn't change but that the A1 
reference in column C changed with the row index number as we extended the cell 
calculation to other cells. 

https://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
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Tutorial 2: Quickly finding maximum values in multiple columns of data using special 
keyword "This"  

The only place where you can use cell formulas in the worksheet column label rows 
(worksheet header rows), is in a User Parameter row.  

Create a new workbook and then choose Data: Import From File: Single ASCII and 
import the file \Samples\Import and Export\S15-125-03.dat. 

With your mouse, hover just to the left of the F(X)= row label and when the pointer 
becomes an arrow, right-click and Add User Parameters.  

In the dialog box that opens, enter "MaxValue" and click OK. 

In column A(X), in the MaxValue cell, enter:  

=Max(This) 

Click outside the cell and cell should now display "10". 

Click back on this cell, then grab the selection handle in the lower right corner of the 
cell and drag to the right to extend the cell formula to MaxValue cells in columns B(Y), 
C(Y) and D(Y). All MaxValue cells should now display the maximum values in their 
respective columns. 

 

 

Tutorial 3: Use a column label row value in a cell calculation  

All data in the worksheet column label rows, including User Parameter rows, is stored 

as string data. To use a "number" stored in a column label row in a cell calculation, you 
must convert the string to a numeric value. In the following example, we use the 
LabTalk value() function to convert column label row data to a numeric so that it can 
be used in a cell calculation:  

Create a new workbook and then choose Data: Import From File: Single ASCII and 
import the file \Samples\Import and Export\S15-125-03.dat. 

With your mouse, hover just to the left of the F(X)= row label and when the pointer 
becomes an arrow, right-click and Add User Parameters.  

In the dialog box that opens, enter "Correction" and click OK. 

In column D, enter the value "0.2" into the Correction cell. 

Click the Add New Columns button to add column E. 

In cell E1, enter:  

https://www.originlab.com/doc/Origin-Help/WksHeaderRow-DataSupportDisplay
https://www.originlab.com/doc/Origin-Help/WksHeaderRow-DataSupportDisplay
https://www.originlab.com/doc/LabTalk/ref/Value-func
https://www.originlab.com/doc/LabTalk/ref/Value-func
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 =D1+value(D[Correction]$) 

Press ENTER. This converts the Correction value to a numeric and adds the numeric to 
the value in cell D1. The cell should display 101.9.  

 
NOTE: The "$" in the above expression does not function to create an absolute cell 
reference as in the first example above. In this context, the "$" syntax is used to 
express a string variable stored in a user-parameter cell, before converting that string 
to a numeric value.  

8.4.2.1 Naming Data Ranges 

You can assign a name to a worksheet data range or column label rows, and use the name in cell formulas or 
column formulas and to define Reference Lines in graphs.  

 
To create a named range:  

 

Highlight a cell or a range of cells and choose Data: Define Name.  

In the New Name dialog box, enter a Name for the selected (Refers to) range. 

Assign a Scope to your named range. 

Optionally: if you wish to use the named range to return interpolated values, enable Define as Function 
and/or add a Comment. 

 
To manage named ranges:  

With the worksheet active, choose Data: Name Manager. 

Use the dialog to modify name, scope, range and comments. 

https://www.originlab.com/doc/LabTalk/ref/Column-Label-Row-Characters
https://www.originlab.com/doc/User-Guide/Worksheets-Columns
https://www.originlab.com/doc/User-Guide/Worksheets-Columns
https://www.originlab.com/doc/Origin-Help/AxesRef-RefLines
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8.5 Remove Formula/Links 

Removing formulas and links can make it easier to share project data with colleagues without having to share 
such things as externally-linked (DDE) Excel files. It is also useful for significantly reducing project size before 
archiving data.  

 

 
Things you can convert to raw numbers:  

Cell formulas 

Column formulas 

Linked cell values (e.g. values copied a report sheet and paste-linked to other worksheet cells in the project). 

DDE links (e.g. paste-linked values from an external Excel sheet). 

 
To open the tool:  

Click Edit: Remove Links... 

for more information, see the Origin Help file.  

8.6 Cell Notes 

Any worksheet cell -- data row or column label row -- can contain a cell note; even those that contain data or 
other objects such as images or embedded graphs (Note: cells containing Links are not supported).  

Worksheet cell Notes support Rich Text, meaning you can style text using Origin Rich Text syntax. In 
addition, you can add images and graphs, and link to worksheet cell values, report table values, etc. See 
Notes Windows for Reporting.  

https://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
https://www.originlab.com/doc/User-Guide/Import-Data
https://www.originlab.com/doc/Origin-Help/RemoveLinks-Dialog
https://www.originlab.com/doc/User-Guide/Publishing-and-Export
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To add notes, select the worksheet cell and click the Mini Toolbar Add Note button and enter your text.  

 

Note that Column List View also supports cell notes in the label row area.  

 

While editing your cell note, use Format toolbar buttons to format your text.  

 

Note that a right-click inside the notes popup brings up a shortcut menu for inserting various Origin objects, 
for resizing the popup to fit added content and to Edit Raw Text in Notes Window.  

Alternately, you can select the cell, then click the Mini Toolbar Open in Notes Window button to open 
content in a Notes window. Rich Text is enabled by default.  
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While editing in the Notes window, use Format toolbar buttons (a) to format your text. To see your note in 
"Render" mode (b), press CTRL + M (Notes: Render Mode). To insert the finished Note into the worksheet 
cell, click the Close button (c).  

 

The reinserted Note can be see by hovering on the worksheet cell.  

 

Notes:  

For text that is not assigned a paragraph style (see next section), you can use the Font Size control on 
the Format toolbar, to control text size. Font Size can be set for each window but all Notes windows 
must share a common Font (e.g. Segoe UI). 

Origin supports "substituting" cell Notes in graph legend and text objects using @WN (e.g. %(1, @WN, 

https://www.originlab.com/doc/LabTalk/ref/Options-Substitution-Notation
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B, 3) for Note in col(B), 3rd cell of 1st plot's source worksheet). 

There is a system variable @CNF (default=12) for control of cell notes preview font (independent of font 
when opened in a Notes window). 

8.6.1 Text Styles Manager 

In addition to styling text with the Format toolbar, you can apply a simple set of styles to each 
line/paragraph. Manage styles with the Text Styles Manager dialog box.  

With a worksheet active, choose Tools: Text Styles Manager. 

Select a Style to Modify and Apply or Close.  

 

Note that you can add styles by selecting <new> from the Styles to Modify drop-down list; or select a style 
and Delete.  

To apply a paragraph style to Notes window text:  

Open the cell note in a Notes window. 

With Render Mode off (CTRL + M, to toggle), click on a line of text then right-click, choose Paragraph 
Styles and choose a style from the popup menu. 

To check results, press CTRL + M (Render Mode). 

8.7 Processing Worksheet Data 

Origin provides a number of utilities for manipulating worksheet data. Most of these are found on the 
Worksheet menu while some are on the Edit, Column or Analysis menus (note that a worksheet must be 
active). Some utilities are available from a shortcut menu: select your data and right-click.        
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Utility  Menu Access  

Sorting Data 

Worksheet: Sort Range 
Worksheet: Sort Columns 
Worksheet: Sort Worksheet 
Worksheet: Sort Columns by Label 

Find 

Replace 

Go To (sheet row/column) 

Select/Hide Columns 

Edit: Find in Project 
Edit: Find in Sheets 
Edit: Replace 
Edit: Go To 
Edit: Select/Column: Select Columns  

Hide Column 

Hide Rows 

Column: Hide/Unhide Columns 
Hide/Unhide Rows (shortcut menu only)  

Move Columns 

Swap Columns 

Column: Move Columns or Column toolbar. 
Column: Swap Columns  

Query Worksheet Data Worksheet: Worksheet Query  

Copy Columns to (new locations) Worksheet: Copy Columns to  

Append Worksheet Restructure: Append Worksheet  

Join Worksheets 
Restructure: Join Worksheets by Column 
Restructure: Join Worksheets by Label  

Split Columns 

Split Worksheet 

Split Workbooks 

Restructure: Split Columns 
Restructure: Split Worksheet 
Restructure: Split Workbooks  

Split Cell Strings to Multiple Columns 

No menu access. To open the dialog box:  

Click Window: Script Window. 

At the cursor, type text2cols -d and press Enter. 

 
For more information, see this link  

Stack Multiple Columns into One with 
Grouping 

Restructure: Stack Columns 
Restructure: Unstack Columns 

https://www.originlab.com/doc/Origin-Help/Wks-Sort-Data
https://www.originlab.com/doc/Origin-Help/Wks-Sort-Data
https://www.originlab.com/doc/Origin-Help/Wks-Sort-Data
https://www.originlab.com/doc/Origin-Help/Wks-Sort-Col-by-Labels
https://www.originlab.com/doc/Origin-Help/Finding-Project
https://www.originlab.com/doc/Origin-Help/Wks-Find-Replace-Data
https://www.originlab.com/doc/Origin-Help/Wks-Find-Replace-Data
https://www.originlab.com/doc/Origin-Help/Select-or-Hide-Cols
https://www.originlab.com/doc/X-Function/ref/colmove
https://www.originlab.com/doc/Origin-Help/Column-Toolbar
https://www.originlab.com/doc/X-Function/ref/colswap
https://www.originlab.com/doc/Origin-Help/Wks-Query-QS
https://www.originlab.com/doc/Origin-Help/copy-columns
https://www.originlab.com/doc/Origin-Help/append-worksheet
https://www.originlab.com/doc/Origin-Help/join-worksheets-bycol
https://www.originlab.com/doc/Origin-Help/join-worksheets-bylabel
https://www.originlab.com/doc/X-Function/ref/colsplit
https://www.originlab.com/doc/Origin-Help/split-wks-into-sheets
https://www.originlab.com/doc/Origin-Help/split-wkbk
https://www.originlab.com/doc/X-Function/ref/text2cols
https://www.originlab.com/doc/Origin-Help/Wks-Stacking-Cols
https://www.originlab.com/doc/Origin-Help/Wks-Unstacking-Cols
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Unstack Grouped Data into Multiple 
Columns 

Stack Columns Common to Multiple 
Sheets by Label 

Restructure: Stack Worksheets  

Summarize Data with Pivot Table Restructure: Pivot Table  

Filter data by defining conditions on 
one or more columns 

Column: Filter menu, or Worksheet Data toolbar  

See Also: Data Masking  

Data Reduction 

Worksheet: Remove/Combine Duplicated Rows  

Worksheet: Reduce Columns 
Worksheet: Reduce Rows  
Worksheet: Reduce to Evenly Spaced X 
Worksheet: Reduce Duplicate X Data 
Worksheet: Reduce by Group  

Worksheet Transpose Restructure: Transpose  

Convert Worksheet Data Convert to XYZ Convert to Matrix  

Apply Conditional Formatting to 
Worksheet Cells 

Worksheet: Conditional Formatting: Highlight 
Worksheet: Conditional Formatting: Heatmap 
Worksheet: Conditional Formatting: Duplicates 

Reverse Order Column: Reverse Order  

8.8 Conditional Formatting of Worksheet Data 

In addition to the above worksheet data utilities, the Origin worksheet supports Conditional Formatting. 
Conditional Formatting has three modes:  

Highlight mode opens a dialog box with controls to apply color to worksheet cells based on one or more 
conditions (e.g. "equal to", "not equal to", "text that contains", etc). 

Duplicates mode opens a dialog box with controls to apply to worksheet cells that contain duplicate values. 

Heat Map mode opens a dialog box with controls to apply a color map to cells based on worksheet values. The 
worksheet Heat Map is zoomable and scrollable, making it easy to get a "big picture" overview of data 
variation in three dimensions. 

https://www.originlab.com/doc/Origin-Help/stack-worksheets-label
https://www.originlab.com/doc/Origin-Help/Wks-Pivot-Table
https://www.originlab.com/doc/Origin-Help/Wks-DataFilter
https://www.originlab.com/doc/Origin-Help/Wks-Data-Toolbar
https://www.originlab.com/doc/User-Guide/Data-Analysis
https://www.originlab.com/doc/Origin-Help/reduce-duplicate-rows
https://www.originlab.com/doc/Origin-Help/Reduce-Columns
https://www.originlab.com/doc/Origin-Help/reduce-rows
https://www.originlab.com/doc/X-Function/ref/reduce_ex
https://www.originlab.com/doc/X-Function/ref/reducedup
https://www.originlab.com/doc/X-Function/ref/reducexy
https://www.originlab.com/doc/Origin-Help/transpose-wks
https://www.originlab.com/doc/Origin-Help/Convert-to-XYZ
https://www.originlab.com/doc/User-Guide/Matrix-Book-Matrix-Sheet-Matrix-Objects
https://www.originlab.com/doc/Origin-Help/conditional-format
https://www.originlab.com/doc/Origin-Help/conditional-format
https://www.originlab.com/doc/Origin-Help/conditional-format
https://www.originlab.com/doc/Origin-Help/conditional-format
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Manage conditional formatting in the active sheet using the Conditional Format Manager.  

 

When using 3-Color Limited Mixing to apply color to worksheet heatmaps, you can now 
precisely control where the middle color falls. Specify by Percentile, by Percent or by 
Value.  

8.9 Protecting Worksheet Data 

You can apply blanket protections to one or more worksheets and, in the process, provide for a few 
exceptions.  

 

Click the sheet-level Mini Toolbar Protect Sheet button. 

Press Ctrl/Shift + select on multiple worksheet tabs then right-click and Protect Sheet. 

Press Ctrl/Shift + select on multiple sheets in Object Manager then right-click and Protect Sheet. 

 
Any of these actions produces a Protect Sheet Options dialog so that you can set some exceptions. This 
dialog is also available by clicking Preferences: Protect Sheet Options.  

https://www.originlab.com/doc/Origin-Help/conditional-format
https://www.originlab.com/doc/Origin-Help/PD-Dialog-ColorMapContour-Tab
https://www.originlab.com/doc/Origin-Help/PD-Dialog-ColorMapContour-Tab
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To remove protections from one or more worksheets, select the worksheets and remove the check mark 
beside the Protect Sheet Mini Toolbar button; or from the Object Manager or sheet tab shortcut menus' 
Protect Sheet option. 

8.10 Workbooks for Analysis and Reporting 

    

Apart from text and numeric data, the workbook can contain various other types of information -- images, 
graphs, notes and matrices; links to cell values in other books, project variables, documents or web pages; 
plus, import file metadata, variables and scripts -- making the workbook a flexible medium for collecting 
research data or for creating custom reports.  

Further, as we will see, the workbook can "store" a complex sequence of analysis operations -- for instance, 
the application of a data filter, plus a fitting operation on the filtered data, combined with a customized plot of 
the results -- into something that we call an Analysis Template. The Analysis Template makes it possible to 
automatically generate a custom report of results, simply by supplying new input data.  

 

https://www.originlab.com/doc/Origin-Help/Analysis-Templates
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One attractive option for generating reports (there are others -- see the tip at the bottom of this section) is to 
export data to a custom MS Word template, and optionally, a PDF file. This is done by running an output-
generating analysis in Origin, then associating key results with bookmarks in a Word template, and, finally, 
saving the workbook as an Analysis Template. To generate your report, you open the Batch Processing tool, 
point to both your Analysis Template and your Word template, run the batch process and generate your 
reports.  

For information on generating custom reports using an MS Word Template, see the tutorial Batch Processing 
with Word Template for Reporting. 

For information on batch analysis and generating custom reports, see the Batch Analysis section of the "How 
to Handle Repetitive Tasks" chapter of this Guide. 

https://www.originlab.com/doc/Tutorials/BatchProcess-WordTemplate
https://www.originlab.com/doc/Tutorials/BatchProcess-WordTemplate
https://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
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Another option for generating reports is to create HTML reports using Origin's Notes 
window. A Notes window can link to graphs, worksheet cells, etc., either directly or 
using a placeholder sheet. For more information, see HTML Reports from Notes 
Windows.  

8.11 Topics for Further Reading 

The User Files Folder 

Origin Template Files 

What is Saved with the Workbook Template? 

The New Workbook Dialog 

Arranging the Worksheet 

https://www.originlab.com/doc/User-Guide/Publishing-and-Export
https://www.originlab.com/doc/User-Guide/Publishing-and-Export
https://www.originlab.com/doc/Origin-Help/UserFilesFolder
https://www.originlab.com/doc/Origin-Help/OFileType-Template
https://www.originlab.com/doc/Origin-Help/Wkbk-Saved-with-Template
https://www.originlab.com/doc/Origin-Help/New-workbook-dlg
https://www.originlab.com/doc/Origin-Help/Arrange-Wks
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Displaying Supporting Data in the Worksheet Header Rows 

Controlling How Numeric Data Display  

Dates and Times in the Worksheet  

Generating Simple Worksheet Datasets 

Column Short Name Restriction 

Using Formulae to Set or Transform Worksheet Column Values 

Using a Formula to Set Cell Values 

Simple Manipulation of Worksheet Datasets 

Inserting Graphs, Images and other Objects into Worksheet Cells 

Inserting Links into Worksheet Cells 

Inserting Variables into Worksheets 

Conditional Formatting of Worksheet Cells 

Analysis Report Sheets and Columns 

https://www.originlab.com/doc/Origin-Help/WksHeaderRow-DataSupportDisplay
https://www.originlab.com/doc/Origin-Help/Wks-Col
https://www.originlab.com/doc/Origin-Help/WksCol-DateTime
https://www.originlab.com/doc/Origin-Help/Wks-GenerateDataset
https://www.originlab.com/doc/Origin-Help/Column-Short-Names-Restrict
https://www.originlab.com/doc/Origin-Help/Wks-Set-Column-Values
https://www.originlab.com/doc/Origin-Help/Using-Formulae-to-Set-Cell-Values
https://www.originlab.com/doc/Origin-Help/Wks-Manipulate-Datasets
https://www.originlab.com/doc/Origin-Help/InsObject-to-WksCell
https://www.originlab.com/doc/Origin-Help/InsLink-to-WksCell
https://www.originlab.com/doc/Origin-Help/InsVariable-Dialog
https://www.originlab.com/doc/Origin-Help/conditional-format
https://www.originlab.com/doc/Origin-Help/Analysis-Rep-Wks-Cols
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9 Matrix Book Matrix Sheet Matrix Objects 

Matrix-Book-Matrix-Sheet-Matrix-Objects 

 

9.1 Matrixbooks, Matrixsheets and Matrix Objects 

A matrix is a dataset of Z values arranged as an array of columns and rows which are linearly mapped to X 
and Y values.  The following table summarizes some important matrixbook limits:  

Maximum Number of...  32Bit OS  64Bit OS  

Matrixsheets in a matrixbook 
Matrix objects in a matrixsheet 
Cells in a matrix (Note) 

1024† 
65,527 
90,000,000 

1024† 
65,527 
90,000,000 

† > 255 sheets requires saving file to Unicode (e.g. *.opju) file format. Unicode formats not compatible with 
Origin versions prior to Origin 2018 SR0.  

Note: The product of any combination of rows and columns must not be greater than 90,000,000.  

9.1.1 Naming Matrixbooks, Matrixsheets and Matrix Objects 
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Matrixbook  

The matrixbook has a Short Name whether you display it or not. Origin uses the 

Short Name for internal operations. 

Short Names must be unique within the project file, cannot contain spaces, must 
begin with a letter, consist only of alphanumeric characters (A to Z and 0 to 9), 
and limited to 13 characters. You can use lowercase characters and the text will 
appear as such, but upper and lower case are not unique characters. (You cannot 
name one matrix MBOOK1 and another mbook1.) 

Long Names are optional, need not be unique within the project file, can contain 
spaces, can begin with a letter, a number or a special character, and the length 
cannot exceed 520 characters, including spaces. 

Matrixsheets  

The sheet Name must be unique within the matrixbook and is limited to 32 
characters. 

Can contain spaces and numbers. 

Can contain special characters except `!%"|()[]{}<>. 

Can begin with a letter, number or allowed special character. 

Optionally, sheet can have Label and Comments. 

Matrix Objects  
By default, Origin assigns a matrix object index number to each object, as it is 
created. This index number cannot be changed.  
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You can add a name to the object by clicking on the yellow object icon - for a 

data matrix or for an image matrix - in the upper right corner of the 
matrixsheet and choosing Rename from the menu. Alternately, you can double-
click on the matrix object number/name below the thumbnail and enter a name. 

9.1.2 Different Views of the Matrix 

   In the worksheet, a dataset is contained in a single column and the dataset may consist of X,Y,Z, Error, or 
Label data. In the Origin matrix, a dataset is arranged in a specified dimension of rows and columns. The 
matrix contains a single dataset of Z values.  

Matrix columns are mapped to linearly-spaced X values.  

Matrix rows are mapped to linearly-spaced Y values.  

 
Note that the matrix window has two column and row heading view modes:  

By default, matrix row and column headings display as row and column index numbers (View: Show 
Column/Row from the menu or press Ctrl+Shift+C).  

You can opt to view matrix row and column as X and Y values by choosing View: Show X/Y from the Origin 
menu (or press Ctrl+Shift+X). The displayed X and Y values are the X and Y coordinate values, calculated by 
linear interpolation of the axes From and To values by the number of columns and rows. 

 

 
In addition to the two row and column heading view modes, there are two matrix display modes:  

In Data Mode (View: Data Mode from the menu or press Ctrl+Shift+D), the matrix object displays as raw 
numbers. 

In Image Mode (View: Image Mode from the menu or press Ctrl+Shift+I), the matrix object displays as 
either a gray scale image or a color image, depending upon the type of data in the matrix. A matrix of real 
numbers or complex numbers displays as a gray-scale image while RGB values will display as a color image. 

https://www.originlab.com/doc/Quick-Help/Data-and-Image
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Note: If the matrix object is an image, the object icon will display as whether you are viewing the 
matrix object in Image Mode (View: Image Mode) or Data Mode (View: Data Mode). Similarly, when 

you import numeric data into the matrix, the object icon will display as regardless of View mode.  

9.1.3 Matrixbooks 

 Like the workbook window, the matrixbook window is created from a customizable template (.otmu file). The 
matrix template stores such things as number of sheets in the book, the names of the matrixsheets, matrix 
dimensions, data type, math functions, data import handling instructions as well as various style and format 
options.  

To add a empty new Matrix  

Click the New Matrix button on the Standard toolbar. 

or  

Select File: New: Matrix: Black Matrixbook menu. 

 
When you create a new matrixbook, the book is named MBookN, with N reflecting the order of window 
creation. Appended to the book name, you will see something like ":1/3" where the first integer denotes the 
active matrix object and the second denotes the number of matrix objects in the active matrixsheet. Following 
the above example, if you click the yellow object icon to the right side of the matrix, the menu shows three 
matrix objects with the first being the active one - the one with a check mark placed beside it (note that in our 
illustration, the objects are empty).  

https://www.originlab.com/doc/User-Guide/Worksheets-Columns
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You can right-click on a worksheet tab and Add Matrix as Sheet and insert a 
matrixbook into a workbook. This is useful when building Analysis Templates that 
involve matrix-based operations such as 3D surface fitting or 3D plotting operations.  

 

 

9.1.4 Matrixsheets 

 

Prior to Origin 2018, an Origin matrixbook could have a maximum of 255 sheets. That 
number is now increased to 1024. When you have more than 255 sheets in a book, you 
will need to save the file using one of the new Unicode-compliant formats (opju, ogmu, 
etc).  

A matrixbook can have up to 1024 matrixsheets. The default matrixbook template - ORIGIN.otmu - has a 
single matrixsheet containing 32 rows and 32 columns. Each matrixsheet can differ in dimensions(number of 
rows and columns and X & Y range).  

To specify the dimensions of the matrixsheet:  

Click on a tab to activate the sheet and choose Matrix:Set Dimensions/Labels. This opens the Matrix 
Dimensions and Labels dialog box. 

Specify a number of columns (X dimension) and rows (Y dimension). 

Specify a From and To value for X (columns) and Y (rows). 

 

https://www.originlab.com/doc/User-Guide/Worksheets-Columns
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Note: The X and Y coordinates of the matrix are evenly spaced. The first X is mapped to the first matrix 
column and the last X is mapped to the last matrix column. The X coordinates of other columns are 
interpolated. Matrix rows are similarly mapped using the From Y and To Y values. When plotting or 
analyzing matrix data, the position of a point in 3D space is determined by the column X and row Y 
coordinate values (not column or row index) and the Z value contained in the cell intersected by the row 
and column.  

9.1.5 Matrix Objects 

A matrixsheet can contain up to 65,504 matrix objects, though the actual limit is likely to be far less 
(determined by system resources). Objects in a sheet share the same X/Y dimensions and column (X) and row 
(Y) headers, but every object can have its own Z header. Other matrix object properties include internal data 
type and numeric display options.  

Matrix object properties are set in the user interface via the Matrix Properties dialog box. To open the dialog 
box:  

Make sure that the matrix object is active (check mark shows beside it in the object menu). 

Choose Matrix:Set Properties... from the main menu.  

 

You can set properties for multiple matrix objects without closing the Matrix Properties 
dialog box by clicking the << Previous or Next >> buttons at the top of the dialog 
box.  

 

9.1.6 Import Image to Matrix 

Origin has two structures for importing multi-frame images -- the matrix window and the Image window. The 
matrix window is better-suited to performing data analysis tasks (e.g. surface fitting, statistics, mathematic 
transformations of data, etc.) and some graphing operations, but take note of the following:  

https://www.originlab.com/doc/Origin-Help/MatOb-Header
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When you import an image to the matrix, you can -- as with other matrix data -- switch between "Data Mode" 
(View Data Mode) and "Image Mode" (View: Image Mode). 

However, until converted to data, matrices contain RGB values (regardless of View mode), as seen in the 
second window in the sequence below.  

Performing certain analysis or graphing tasks (e.g. Nonlinear Matrix Fit or creating an Image Plot) requires 
that the matrix first be converted to Z values by choosing Image: Conversion: Convert to Data. 

 

For more information, see Image Conversion in the Origin Help File.  

 
To import an image or image stack to the matrix window:  

With the matrix active, choose Data: Import From File: Image to Matrix. 

This opens the Image to Matrix (impImage) dialog. Note that there are are controls for Import Grayscale 
GeoTIFF as Data, Show Image Thumbnails and multi-file import-handling. 

https://www.originlab.com/doc/Origin-Help/Images-Conversion
https://www.originlab.com/doc/Origin-Help/Fitting-2DSurf
https://www.originlab.com/doc/Origin-Help/Image-Plot
https://www.originlab.com/doc/Origin-Help/Images-Conversion
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9.1.6.1 Image Thumbnails and Image Slider 

 

When importing multi-frame TIF files, thumbnail/slider display is controlled by system 
variable @MSS (default value =10):  

If the sheet contains a single frame, don't show thumbnail/slider. 

For 1 < frames < 10, show thumbnail 

For frames > 10, show slider 

 
When the sheet contains multiple objects, you can display those objects as a series of thumbnails in a spacer 
at the top of the matrix window.  

Right-click on the matrix window title bar and place a check mark beside Show Image Thumbnails. 

https://www.originlab.com/doc/LabTalk/ref/sys-var-list


Matrix Book Matrix Sheet Matrix Objects 

131 

 

 

Alternately, you can use a slider control to view these objects in the active matrixsheet.  

 

 
If you are seeing thumbnail images in the spacer at the top of the window, you can switch to the slider by 
doing the following:  

Hover in the space between the thumbnails and when the cursor changes to a grid icon , click to show the 

page Mini Toolbar (you can also click in the gray area to the right of your matrix image).  

Toggle the Slider or Thumbnails button to show slider or thumbnails.  
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Likewise, you can turn off both thumbnails and slider by clicking the Image Selector button. Click the View 
Image button to toggle between Data Mode and Image Mode.  

 

9.1.6.2 Naming Matrix Objects 

You can assign a name to a matrix object:  

With the matrix object active, choose Data: Define Name. 

Give the matrix a Name, set Scope and, optionally, add a Comment. 

Named ranges can be used in Matrix: Set Values (e.g. to perform math operations on other matrix objects of 
the same dimensions).  

9.1.6.3 Import GeoTIFF to Matrix 

GeoTIFF is a public-domain image format that stores spatial information in a TIFF file and which has 
applications in mapping. Origin supports import of GeoTIFF files to both matrices and Image windows.  

 
To import a GeoTIFF file to the active matrix:  

Click Data: Import From File: Image to Matrix. 

In the Image to Matrix dialog (impImage), check the Import Grayscale GeoTIFF as Data box and click OK. 

 

For more information, see the Origin Help file page for GeoTIFF Importing and Processing.  

9.2 Extracting Information from the Matrixsheet or Object 

https://www.originlab.com/doc/Origin-Help/GeoTIFF-Importing-Processing
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When viewing matrixsheets or matrix objects in Image Mode (View: Image Mode), you can extract 
information from the matrix using the Region-of-Interest (ROI) tools:  

Go to Tools: Region of Interest Tools and verify that there is a check mark beside the menu item. If not, 
click on this item or press CTRL + SHIFT + T to enable the ROI tools.  

To add an ROI, click on the displayed ROI tool (e.g. Rectangle Tool ) on the Tools toolbar and choose an 

ROI shape from the flyout menu (rectangle, circle, polygon, region). Alternately, you can right-click on the 
image (make sure no existing ROI is selected) and choose Add ROI from the shortcut menu. 

Using your mouse, drag out an area on the image (not needed if adding from the shortcut menu) and double-
click to set your selection. Once the selection is set, additional clicks allow rotating, stretching, or skewing the 
ROI.  

You can add multiple ROIs using either the Add ROI shortcut menu (hint: right-click on the matrix image) or 
with the Tools toolbar buttons. Note that when adding multiple ROIs using the toolbar buttons, you'll need to 
rename each as it is created (otherwise, it will be destroyed when you create a new ROI). Double-click on the 
ROI to open a small dialog and change the Name of the object (hint: simply append a unique number to each 
Name).  

Right-click on your ROI and choose an option from the shortcut menu. To discard the selected ROI, press 
Delete:  

Crop: Crop the image to the minimum rectangular area that will contain the ROI. By default, values outside 
the ROI will show black (zero values in Data Mode). 

Copy: Rectangle only. Creates an image from the ROI. 

Clear: Clear data within the ROI(s). Available only for TIFF stacks, NetCDF data; otherwise unavailable 
(dimmed).  

Add ROI: Adds and enumerates name of each ROI (so that manual renaming is unnecessary when adding 
multiple ROIs). 

Copy Positions: Copy the position of the selected ROI. 

Paste Positions: Paste the position of the selected ROI to another ROI (width, height...all).  

Export ROI: Save the ROI object(s). 

Import ROI: Replace the object(s) with those in a saved *.ROI file (hint: create a "dummy" ROI to import). 

Create ROI from XY: Opens the Create ROI from XY (xy2roi) dialog where you designate XY coordinates 
for creating ROI. 

Clear All ROIs: Remove ROIs from matrixsheet. 

Create New: Use the mroi2mat tool to generate a new matrix from the ROI. 

Extract as XYZ: Use the mroi2xyz tool to generate a new worksheet of XYZ values. 

Intensity Profile: Use the mroiprofile tool to generate statistics for the ROI. 

Convert to Data: Convert RGB image to data. 

Convert to Gray: Convert RGB image to grayscale. 

View Complex Image: View components of the complex image. 

 

https://www.originlab.com/doc/Origin-Help/NetCDF-Manipulating
https://www.originlab.com/doc/X-Function/ref/xy2roi
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ROI stats are automatically reported to the Status Bar. Right-click on the Status Bar to hide 
or show statistics.  

 

9.3 Image Plot 

Data in a matrix can be plotted as an Image Plot. Axis scales are determined by the matrix XY coordinates 
(when the matrix is active, choose View: Show X/Y).  

Note that if you import an image to the matrix (Data: Import From File: Image to Matrix) you must first 
convert the image to data (Image: Conversion: Convert to Data) before creating your Image Plot (Plot: 
Contour: Image Plot).  

https://www.originlab.com/doc/User-Guide/Origin-Interface
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Activate a matrix window and choose Plot: Contour: Image Plot. 

 

By default, the image plot will use the same colormap, Z scale range and missing value color, as matrix image 
mode (View: Image Mode). See Matrix: Apply Palette to Color Map, below.  

9.4 Image Window 

The Image Plot described above is used to plot values in a single matrix object. The Image Window can be 
used to:  

Open an image file for basic manipulation (flip, rotate, convert to gray-scale) using the Image Window's Mini 
Toolbar. 

Edit an image inserted into a worksheet cell or graph window (double-click on the inserted image). 

Import an image set such as the common "TIFF stack".  

Import multiple discrete image files as an image stack. 

Open and play a movie (.avi, .mov, .mp4) file. 

Define one or more regions-of-interest (ROI) for which you can Copy Positions, Paste Positions (from 
another ROI), and Export or Import position information saved to an Origin *.ROI file (a text file with 
position information on each ROI on the image). 

Open and operate on images inserted to worksheets or graphs: crop, copy, export ROI, etc. 

9.4.1 Image and Video Import 

Choose File: New Image, then choose an option from the flyout menu. 

Empty Window: You can later add a file by right-clicking and choosing Import or Import from Web. 

Alternately, click the New Image button on the Standard toolbar. 
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Image/Video (CTRL + ALT + I): Use the file type drop-down to specify an image or video file format. 

 

Multiple Image Files (CTRL + ALT + T): Specify which files to import as a stack, including GeoTIFF. Note 
that the resulting stack will show an image slider, by default.  



Matrix Book Matrix Sheet Matrix Objects 

137 

 

Web Image (CTRL + ALT + L): Enter a URL in the dialog to link to a web-stored image. Hint: to grab an 
image URL, right-click on the web image and choose Copy image link or Copy image address. 

 

9.4.1.1 Import GeoTIFF as Image 

GeoTIFF is a public-domain image format that stores spatial information in a TIFF file and which has 
applications in mapping. Origin supports import of GeoTIFF files to both matrices and Image windows.  

To import a GeoTIFF file as an image:  

Click File: New: Image: Image/Video and choose the GeoTIFF image. 

 
To import multiple GeoTIFF files as image:  

Click File: New: Image: Multiple Image Files and choose your images. Images are imported to the active 
Image window and a slider is added to scroll images.  
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All Images must be the same size. 

Negative numbers (e.g. -999) are treated as missing values.  

The Image window Mini Toolbar has a button for setting Missing Value Color  

Convert an Image window containing multiple GeoTIFF files to matrix using Image: Convert to Matrix. Each 
image in the stack becomes an object in the output matrix. 

 

Click inside the window, somewhere near the top, to show the Mini Toolbar.  

 
For more information, see the Origin Help file page for GeoTIFF Importing and Processing.  

9.4.1.2 Image Import Notes 

To help control Origin project file size, right-click on an Image Window image and enable Linked File. This 
saves a link to the image file into the window but excludes the image from the saved project. When you 
reopen the saved project, the window will appear empty; at this point, you can decide whether you need to re-
import the image (CTRL + 4 or Import from the window shortcut menu). 

Actual Size Mode is turned on by default for images of max width or height of less than 800 pixels. The size 
threshold can be adjusted using system variable @IWP (see this FAQ for info on changing the value of a 
system variable). 

9.4.2 Image Window Navigation 

Display of image information and navigation controls is enabled or disabled via the the View menu and/or the 
Image Window Mini Toolbar (None, Thumbnails, Video or Slider).  

https://www.originlab.com/doc/Origin-Help/GeoTIFF-Importing-Processing
https://www.originlab.com/doc/LabTalk/ref/sys-var-list
https://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
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The same Mini Toolbar button is shown for GeoTIFF images:  

 

 
Additional Keyboard control for Video navigation  

Pressing the left/right arrow keys will move the frame by 1. 

Shift + arrow key will move the frame by 5. 

Shift + Ctrl + arrow key will move the frame by 20. 

9.4.3 Image Resize 

To resize the image by one of several interpolative methods:  

With the Image Window active, choose Image: Resize. 

Choose options including your Interpolation Method (Nearest Neighbor, Bilinear, Bicubic, Pixel Area Relation, 
Lanczos) and click OK. 
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9.4.4 Mini Toolbars for Image Window 

Mini Toolbar buttons are available for performing simple image manipulation, including rotating, flipping or 
converting to grayscale.  

 

 

You can apply a color palette to a grayscale image using the Palette button on the 
Style toolbar. Click More Palettes to open the Color Manager dialog box and add 
more palettes.  

9.4.5 ROIs in the Image Window 

https://www.originlab.com/doc/User-Guide/Customizing-Graphs
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If your ROI is hard to see against the background image, you can select the ROI and 

use the Style toolbar Line/Border Color button to change outline color.  

You can define one or more regions-of-interest in the Image window using the Rectangle Tool ) on the 
Tools toolbar.  

Select the tool and drag out an ROI. Once added, adjustments to size and position can be made by selecting 
the object and dragging the blue selection handles. 

To add multiple ROIs to an image, click on the Rectangle Tool and drag out your ROI; right-click on the 
image and choose Add ROI (CTRL + Q); or use the Add ROI button on the Image window Mini Toolbar. In 
either case, you'll need to rename added ROIs as you go: double-click on the ROI and give it a unique name so 
that it is not replaced by the next added ROI.  

 

Right-clicking on the ROI produces a context menu with the following options:  
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Clip: Available when the image is opened from a graph (e.g. by double-clicking the graph image). This clips 
the graph image to the Image window ROI. The original graph image size is reduced to the size of the clipped 
region. To restore the full image in the graph window, right-click outside of the ROI and choose Remove 
Clipping. 

Crop: Crop Image window image and graph image (if exists) to the ROI. Graph image size and position are 
kept.  

Copy: Copy the ROI as an image. You can then paste it to other windows inside Origin, e.g. a graph or 
worksheet window, or to other applications. For multi-frame image, only the active frame is copied. 

Apply Scale to Graph: Available when the image is inserted into a graph by Image from Image Window. 
This updates the graph image to the Image window ROI.  

Copy Positions: Copy the ROI box coordinates of 4 vertices. You can choose to paste it as plain numbers, or, 
Paste Position to another ROI box. For the latter option, you can choose to paste only ROI Width/Height, or 
Horizontal/Vertical location.  

Export ROI: Saves details (e.g. ROI name, position of vertices, etc.) to a .ROI file. 

Import ROI: Applies details of a previously-saved ROI, to the selected ROI.  

Create New from XY: Create a new ROI box of arbitrary shape from a set of XY coordinates (boundary) and 
index data. Support for gray-scale image only. See also Create ROI from XY in NetCDF data. 

https://www.originlab.com/doc/Origin-Help/NetCDF-Manipulating
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Create Linked Image: Outputs the ROI to a new Image window. Changes to the ROI will be passed to the 
new Image window. 

Create Linked Matrix: Outputs the ROI data to a new matrix window. Changes to the Image window ROI will 
be passed to the matrix.This makes it easier to carry out many analysis and statistics operations that cannot 
be done on an Image window (i.e. a matrix is required). 

9.5 Profiling Matrix Data 

    

Data in a matrix can be viewed in profile -- either in the X, Y or arbitrary cross-section.  

Activate the matrix object and choose Plot > 2D: Profile: Image Profiles from the main menu.  

This creates an image plot and opens the Image/Contour Profile dialog box. Use the dialog box to specify X 
and/or Y profile plots and the location and appearance of the cross-sectional lines. Note that this dialog box is 
interactive. You can make adjustments to your image profile -- move the cross-sectional lines or change the 
configuration or the appearance of the plots -- without closing the dialog box. After closed the dialog box, a 
button Profiles...will appear at the right-top corner of graph window, which can be used to reopen the 
Image/Contour Profiles dialog. 

 

9.6 Setting Matrix Values 

  The Set Values dialog box is used to generate or transform data in a matrix object.  
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You can assign a name to a matrix object and use the name Set Values (e.g. to 
perform math operations on other matrix objects of the same dimensions).  

To open the Set Values dialog box, make sure that the matrix object is active, then:  

From the menu, choose Matrix: Set Values.  

or  

Select the matrix by clicking in the upper-left corner (in the empty header cell just below the matrix 
icon/name), then right-click on the matrix and choose Set Matrix Values from the shortcut menu. 

 

Menu 
Commands  

Formula: Load a saved formula into the matrix formula box. Formula are saved 
using Formula: Save or Formula: Save As.... 

Mat(1): Use the menu to include matrix objects in either your matrix formula or 
your Before Formula Scripts (matrix object reference is inserted at the cursor). A 
Matrix Browser is available to help in selecting the correct objects. Objects are 
listed by object index. 

Mat(A): Similar to Mat(1) menu functionality but matrix objects are listed by 
object Long Name, if one exists. 

Function: Add LabTalk functions to your expressions (function name is inserted at 
the cursor).  

Variables: Add a variable or a constant to Matrix Formula or Before Formula 
Scripts; Add range variables (including by selection) or file metadata, to Before 
Formula Scripts. 
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Matrix Formula  
Add a single line expression for generating data. Functions, conditional operators 
and variables can be used. 

Before Formula 
Scripts  

Enter one or more lines of LabTalk script to be executed before the expression in 
the Matrix formula box is executed.  

 

 

Use the Before Formula Scripts panel at the bottom of the Set Values dialog box to 
define variables or LabTalk functions that you wish to use in your matrix formula.  

Click the Search and Insert Functions button to search for built-in LabTalk 
functions.  

9.7 Manipulation of Matrix Data 

  

Utility  Menu Access  

For an XY coordinate pair picked with 
the Screen Reader, output Z values for 
for the matrix stack (multiple matrix 
objects) to a worksheet. 

Matrix: Pixel Extraction  

Flip or Rotate a matrix. 
Matrix: Rotate90 
Matrix: Flip: Vertical 
Matrix: Flip: Horizontal  

Resize a matrix using one of four 
methods (Expand, Shrink, Interpolate 
and Pad). 

Matrix: Resize  

Transpose a matrix. Matrix: Transpose  

Generate a 3-dimensional dataset by 
transforming XYZ values by formula. 

Matrix: Generate Grid  

Expand the matrix by scaling in the X 
and Y directions. 

Matrix: Expand  

Shrink the matrix by some row/column 
factor, using one of several shrink 
methods. 

Matrix: Shrink  

Use a palette file to transform a matrix 
in Image Mode. Set a system variable 

Matrix: Apply Palette to Color Map  

https://www.originlab.com/doc/User-Guide/Graphical-Exploration-of-Data
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to apply a color palette (Style toolbar, 
Palettes button) to all matrix objects 
(@MAP=0, default) or only the active 
matrix object (@MAP=1). 

Convert a matrix of values to 
worksheet columns (see next section). 

Matrix: Convert to Worksheet  

9.8 Changing the Color Scheme of a Matrix 

You can use the Palette button and the Missing Value Color button in the Mini Toolbar to customize 
the color of the matrix window.  

 

The selected palettes and missing value color will apply to all matrix objects in the 
active matrix sheet, but will not change the palettes and missing value colors of objects 
in other matrix sheets in the same matrix window.  

9.9 Converting Matrixes to Worksheets 

   

 
To convert a matrix to worksheet:  

With a matrix active, choose Matrix: Convert to Worksheet: Open Dialog. 

 
There are two methods for converting matrix data to worksheet data -- Direct and XYZ Columns. Starting, 
for instance, with the following arrangement:  

 

9.9.1 Direct 

This copies the Z values in the matrix to a worksheet with no reordering. If the matrix consists of M rows by N 
columns of Z values, this method produces a worksheet which has M rows and N columns. By default, the X 
and Y coordinates of the matrix Z values are not copied to the worksheet. You can opt to copy X coordinates to 
the 1st worksheet row or a parameter row and the Y coordinates to the 1st worksheet column.  
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9.9.2 XYZ Columns 

When there is a single matrix object, this method produces a worksheet with three columns: X,Y, and Z, with 
X and Y columns containing the X and Y coordinate values and the Z column containing the matrix Z value at 
each XY coordinate.  

 

 

In addition, this method:  

Saves matrix object Long Name, Units and Comments to the Z column label rows. 

If the converted matrix contains a color image, the resulting Z column will display a Color column of HTML 
colors for each matrix cell. 

https://www.originlab.com/doc/User-Guide/Worksheets-Columns
https://www.originlab.com/doc/User-Guide/Worksheets-Columns
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When converting multiple matrix objects:  

When there are N matrix objects, you can set Convert On = All Objects and output columns as X, Y and Z x 
N (i.e. XYZZZ...).  

 

9.10 Converting Worksheets to Matrixes 

With the worksheet active, choose Worksheet: Convert to Matrix and choose one of the following methods: 

   

Method  Conversion Type  Notes  

Direct  X across columns 
Ideal for spreadsheet data that conforms to the 
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Y across columns 

No X and Y 

following:  

X data values in the 1st column, Y data values 
in the 1st row and Z values in columns 2 to N 
and rows 2 to M.  

Y data values in the 1st column, X data values 
in the 1st row and Z values in columns 2 to N 
and rows 2 to M.  

Note: See Virtual Matrix, below.  

Expand  
Row 

Column 

Some ASCII files have an upper limit for 
characters allowed on a single line. Use this 
method when your file breaks a single line of 
data across multiple lines.  

Expand by Row: specifies the number of ASCII 
file rows comprising one matrix row. 

Expand by Column: specifies the number of 
ASCII file columns comprising one matrix 
column. 

XYZ 
Gridding  

Regular 

Sparse  

Random (Renka Cline)  

Random (Shepard)  

Random (Thin Plate Spline)  

Random (Kriging Correlation)  

Random (Weighted Average) 

Conversion Type depends upon XY spacing:  

Choose Regular applied for data that are 

regularly spaced in XY. 

Choose Sparse when you have missing values. 

Choose Renka-Cline, Shepard, TPS, Kriging 
or Weighted Average methods for data that 
are irregularly spaced in XY. Option for No 
Extrapolation outside Boundary. 

Note: a worksheet of XYZZZ... columns will be 
converted to a matrixsheet with each Z column 
as a separate object.  

XYZ Log 
Gridding  

methods same as XYZ Gridding  

Calculates logarithmic values for X and Y, then 
performs XYZ Gridding. A worksheet of 
XYZZZ... columns will be converted to a 
matrixsheet with each Z column as a separate 
object.  

9.11 Virtual Matrix 

  Data arranged in a block of worksheet cells can be treated as a "virtual matrix". As is the case with regular 
matrix data, virtual matrix data can be used to create 3D plots, such as color mapped surfaces or contour 
plots. The data can include a column or label row with the X or Y values. Unlike a regular matrix which only 
supports a linear spacing in the X and Y dimensions, a virtual matrix supports irregular spacing of X and Y 
coordinate values (provided those values are in ascending or descending order). 
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Note: You can create 3D plots from XYZ columns of worksheet data in which data are irregularly spaced 
in the X and Y dimensions. This is not considered a "virtual matrix."  

9.12 Topics for Further Reading 

Matrixbooks, Matrixsheets and Matrix Objects 

Matrixbook and Matrixsheet Operations 

What is Saved with the Matrix Template? 

Matrix Dimensions and XY Coordinates 

Matrix Object Data Properties 

Setting Matrix Values 

Matrix Conversion and Gridding 

Creating 3D and Contour Graphs from a Virtual Matrix 

Viewing and Profiling Matrix Data 

https://www.originlab.com/doc/User-Guide/Graphing
https://www.originlab.com/doc/Origin-Help/MatBk-Mats-MatOb
https://www.originlab.com/doc/Origin-Help/MatBk-Mats-Operation
https://www.originlab.com/doc/Origin-Help/MatBk-Template-What-is-saved
https://www.originlab.com/doc/Origin-Help/Mats-Dim-XYCoord
https://www.originlab.com/doc/Origin-Help/MatOb-DataProperty
https://www.originlab.com/doc/Origin-Help/Set-Mat-Value
https://www.originlab.com/doc/Origin-Help/Matrix-Conversion-Gridding
https://www.originlab.com/doc/Origin-Help/Plot-3D-Contour-VirtMat
https://www.originlab.com/doc/Origin-Help/View-Profile-MatData
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10 Graphing 

Graphing 

 

10.1 Creating a Graph 

Graphs can be created from both hard data and from mathematical functions. With Origin, you can create over 
100 graph types using Origin's built-in graph templates. Each of these graphs has been specifically chosen for 
its applications in various technical fields.  

All graph types are accessible from the Plot menu. Note that while most graph types also have a 
corresponding 2D Graphs or 3D and Contour Graphs toolbar button, some do not. Until you've had time to 
familiarize yourself with available toolbar buttons, the Plot menu should be your "go to" place for creating 
graphs. 

Creating most graphs involves just two steps.  

Select your data.  

Select the plot type.  

Some Origin graph types have very specific data requirements. Other graphs can be created from multiple 
data arrangements. See the Origin Graph Types section for specific requirements.  

10.1.1 Creating Graphs from Worksheet Data 

  

Origin's most generic graph types -- line, column/bar, pie -- plus a lot of the more specialized types, are 
created from worksheet data. The following quick tutorial demonstrates importing an ASCII data file and 
creating a simple graph. 

 

Tutorial: One click to create graph with selected data  

Open a new workbook and select Data: Import from File: Single ASCII... from the 
main menu.  

Choose the file Samples/Curve Fitting/Multiple Gaussians.dat and click Open. 

Now highlight columns B(Y), C(Y), D(Y) and E(Y) by clicking and dragging across the 
four column headings. 

Click Plot > Basic 2D: Line & Symbol: Line & Symbol. A graph window is created 
with four line and symbol plots. Note that the plots differ by line color and by symbol 
type. 

Return to the worksheet, and again select columns B(Y), C(Y), D(Y) and E(Y). 

This time, select the Plot > Multi-Panel/Axis: 4 Panel menu item. Note that a very 
different plot is created using the same datasets. 

We were able to quickly create two different graphs using the same data. The chapter Customizing Graphs 
discusses customizing graphs and saving templates in more depth.  

We are also able to create 3D plot types from worksheet data. The following tutorial demonstrates creating a 
3D surface plot, then overlaying it with a 3D scatter plot.  

https://www.originlab.com/doc/User-Guide/Graphing
https://www.originlab.com/doc/User-Guide/Customizing-Graphs
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Tutorial: 3D Surface Plot from XYZ Data  

Create a new, empty workbook window and import the file \Samples\Matrix Conversion and 
Gridding\XYZ Random Gaussian.dat. 

Highlight column C and right click. Select Set As: Z from the fly-out menu. 

Select Plot > 3D: 3D Colormap Surface to create a 3D Colormap Surface plot. 

Select the Graph: Layer Contents... menu item or right click the layer icon on the left-top 
of the graph to open the Layer Contents dialog. In this dialog, click on drop-down next to 

the button and select 3D Scatter/Trajectory/Vector from the fly-out menu. 

Select column C from the left panel and click on the Add Plot button to add the 3D 

scatter plot to the graph. Click OK to close the dialog. 

Double-click on the plot to open the Plot Details dialog. In the left panel, expand the 
Layer1 node and then expand the 2nd node which represents the scatter plot. Click and 
select the branch named Original. Be sure to leave the node-level check box selected, 
otherwise this plot will be hidden. 

In the Symbol tab on the right side, set Shape to Ball, Size to 12 and Color to Color 
Mapping: Col(C). 

In the Drop Lines tab, clear the Parallel to Z Axis check box. 

Select Layer1 from the left panel of the Plot Details dialog. In the Lighting tab, under 
Mode, select Directional. Click OK to close the dialog. 

Click on the scatter plot in the graph to select this plot, then in the Style toolbar, click on 

the button and select the Rainbow palette.  

Your graph should look like this:  
:
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You can hold down the R key on your keyboard and use the mouse to freely rotate the 
3D surface. With the pointer tool active, click on the layer for additional controls to 
move, stretch and rotate the surface.  

 

 

The minimum Z axis length of 3D graph is 10% (Plot Details layer level, Axis tab).  

 

10.1.1.1 Worksheet Column Plot Designations 
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 The labels (X), (Y), (Z), etc. in column headings are referred to as the Column Plot Designation. Columns 
can also be designated as Label, Disregard, Y Error or X Error. Each plot type has certain data 
requirements (e.g. a simple line plot requires one X and one Y dataset) and column plot designations work in 
concert with settings saved in the graph template, to allow you to quickly create a graph.  

To set the Column Plot Designation, select a column or multiple columns, then from the menu choose 
Column: Set as:<option>; or right-click and choose an option from the Set As: context menu.  

In the 1st tutorial above, we plotted 2D graphs, which require Y data from one or more worksheet columns. 
The Y data were automatically plotted against the X column data to their left. In 2nd tutorial, we plotted a 3D 

graph using Z data. The Z data were plotted against X and Y data columns to the left of the Z data column.  

Note: For more information on Column Plot Designations and how they affect plotting behavior, see Plot 
Designation, in documentation for the Column Properties Dialog Box.  

10.1.1.2 Selecting Worksheet Data 

 Various ways to select data for plotting:  

Single column: Click on the column heading, e.g. B(Y) 

Multiple columns: To select a small number of contiguous columns, click on the first column heading and 
drag the pointer to the last column heading. To select a large number of contiguous columns, click on the first 
column heading, use the scroll bar at the bottom of the worksheet to locate the last column, then press the 
SHIFT key and click on the last column heading. To select non-contiguous columns, press the CTRL key while 
clicking on the desired column heading. 

A range in a column: Click on the first cell of the range and drag to the last cell of the range. 

Multiple ranges within a column: Select one range. Press the CTRL key while selecting each range. When 
plotting, each range will be treated as a separate data plot in a plot group. 

Ranges across multiple columns: If cells are contiguous, click on the first cell and drag to the last cell. If 

cells are not contiguous, press the CTRL key while selecting each range. Each range selection will be treated as 
a separate data plot in a plot group. 

Range(s) across all columns: Click on the first row heading and drag to the last row heading, to select 
multiple rows. This will select data in all columns in the worksheet. Press the CTRL key while selecting row 
headings for non-contiguous rows. Each range selection will be treated as a separate data plot in a plot group. 

Entire worksheet: Press CTRL+A to select the entire worksheet; or mouse over the bottom-right corner of 
the blank cell in the upper-left corner of the worksheet. When the pointer becomes a downward-pointing 
arrow, click to select the entire worksheet. 

Specific columns: To select columns by data in column label rows (header rows); or to select columns using 
a pattern, choose Edit: Select. 

 

As noted in the Worksheet Column Plot Designations section just above, if you select Y 
or Z columns, Origin defaults to plotting the Y column against the nearest X column to the 
left; or plots the Z column against the nearest X and Y columns to the left. But in the case of 
simple XY 2D plots (line, line + symbol, etc.), you can ignore this rule and plot by selecting 
XY columns whether or not the selected X is to the left or right of Y.  

https://www.originlab.com/doc/User-Guide/Worksheets-Columns
https://www.originlab.com/doc/Origin-Help/ColProperties-Dialog-Properties-Tab
https://www.originlab.com/doc/Origin-Help/ColProperties-Dialog-Properties-Tab
https://www.originlab.com/doc/User-Guide/Graphing
https://www.originlab.com/doc/User-Guide/Graphing
https://www.originlab.com/doc/User-Guide/Graphing
https://www.originlab.com/doc/User-Guide/Worksheets-Columns
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10.1.2 Creating a Graph from Matrix Data 

 As discussed in the Matrixbook, Matrixsheets and Matrix Objects chapter, a matrix is a dataset of Z values 
arranged as an array of columns and rows which are linearly mapped to X (column) and Y (row) values. Matrix 
data is used to create 3D, contour and heatmap graphs -- all of which require require "3D" data. In earlier 
versions of Origin you had to have your data in a matrix to create such plot types but this is no longer the case 
(see discussion of the Virtual Matrix below). A few graph types such as a color-filled surface with error bars 
still require matrix data.  

There are still many situations in which you will be creating 3D plots from matrix data. If data are stored in a 
worksheet and for one reason or another, you need to convert it into a matrix form, see Converting 
Worksheets to Matrixes.  

Once your data are in a matrix form, plotting matrix data is simple: activate the matrix window then select 
your plot type using a Plot menu command or corresponding 3D and Contour Graphs toolbar button. Since 
you cannot plot only a portion of the matrix, data selection isn't necessary. You can, however, choose a subset 
of the data plot to display once the graph is created. See Editing Plot Range, below.  

10.1.2.1 The Virtual Matrix 

The Virtual Matrix concept was covered in the Matrixbook, Matrixsheet and Matrix Object chapter of this Guide. 
To recap, a virtual matrix is a block of worksheet cells which contain Z values, with X and Y coordinates in the 
first row or column label row, and first column. X and Y coordinates don't have to be evenly spaced and can 
even contain text or date/time data.   

When selecting and plotting virtual matrix data to 3D, Contour and Heatmap graph types, the worksheet's 
Column Plot Designations are ignored. Instead, a dialog box is opened where you designate your X and Y 
coordinates. The intersecting data points are then treated as Z values.  

 

Tutorial: Contour Plot from Virtual Matrix  

With a new workbook active, use the Data: Import from File: Import Wizard... 
menu to open the Import Wizard dialog. 

Press the browse button in the dialog and select the file Waterfall.dat from the 
Samples\Graphing subfolder. 

This file has an import filter already associated with it. Press the Finish button to 
import the file.  

With the workbook active, press CTRL+A to select the entire sheet. 

Now select the Plot > Contour: Contour - Color Fill menu item. The plotvm dialog 
will open.  

In the dialog, set the Y Values in drop-down to Column Label, and then set the 

https://www.originlab.com/doc/User-Guide/Matrix-Book-Matrix-Sheet-Matrix-Objects
https://www.originlab.com/doc/User-Guide/Matrix-Book-Matrix-Sheet-Matrix-Objects
https://www.originlab.com/doc/User-Guide/Matrix-Book-Matrix-Sheet-Matrix-Objects
https://www.originlab.com/doc/User-Guide/Graphing
https://www.originlab.com/doc/User-Guide/Matrix-Book-Matrix-Sheet-Matrix-Objects
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Column Label drop-down to Excitation Wavelength(nm). 

Set the X Values in drop-down to 1st column in selection, then press OK to close 
this dialog. 

The contour plot will be created. 

Use the Graph: Speed Mode... menu item, then in the dialog that opens, set the 
Speed Mode drop-down to Off and press OK. This will turn off speed mode so that all 
data points are plotted (see the discussion of Speed Mode, below). 

Click on the contour plot to select this data plot, then from the Style toolbar, click the 

Palette button and then select the Pumpkin Patch palette. Your graph should 
look similar to the image below:  

 

 

 

Once you customize your contour levels and colors, you can save your settings as a 
Theme, or simply copy-paste your customizations from one graph to another. To save a 
Theme, right-click on the graph and choose Save Format as Theme; or use the 
Colormap Theme controls on the Colormap/Contours tab of the Plot Details dialog 
box.  

10.1.3 2D and 3D Function Plots 

     

Unlike plots from worksheet data or plots from matrix data, parametric plots are not plots of actual data. 
Instead, they are plots of mathematical functions.  

To create function plots and parametric function plots, select File: New: Function Plot menu. There are four 
options to choose from:  

Type  Function Form  

https://www.originlab.com/doc/User-Guide/Graphing
https://www.originlab.com/doc/User-Guide/Customizing-Origin
https://www.originlab.com/doc/Origin-Help/PD-Dialog-ColorMapContour-Tab
https://www.originlab.com/doc/Origin-Help/PD-Dialog-ColorMapContour-Tab
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2D Function Plot  y = f(x)  

2D Parametric 
Function Plot  

x = f1(t) 
y = f2(t)  

3D Function Plot  z = f(x, y)  

3D Parametric 
Function Plot  

x = f1(u, v) 
y = f2(u, v) 
z = f3(u, v)  

 
These plot types are also accessible from the function plot buttons on the Standard toolbar.  

 

 

 

Tutorial: 3D Function and 3D Parametric Function in Same Layer  

From the menu, choose File: New: Function Plot: 3D Parametric Function Plot... 

In the dialog that opens, click on the arrow button at the top right side of the dialog, 
and from the fly-out menu select the built-in example Partial Torus (System) and 
press OK to close the dialog. The function plot will be created. 

With the function plot window active, invoke the menu File: New: Function Plot: 3D 
Function Plot.... 

In the dialog that opens, enter -5 and 5 for the From and To edit boxes for x and y 
scale. 

In the Z(x,y) edit box, enter 0. 

Set the drop-down at the bottom left corner of the dialog to Add to Active Graph and 
press OK to close dialog. 

The Z=0 plane will be added to the graph, and the plane will properly intersect the 
parametric surface plot. You can hold down the R key and use the mouse to freely 
rotate the plot.  
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Some function plot dialogs provide sample formulas. Click the arrow button beside Theme at the top of the 
dialog box to access them. You can download more examples at http://originlab.com/3dfunctions. 

For 2D parametric, 3D, and 3D parametric function plots, data is generated when the function plot is created. 
To create data for 2D function plots, right-click the plot and choose Make dataset copy of Function or if on 
the Function tab in Plot Details, click the Workbook button. 

You can exclude function plots from the graph legend by right-clicking on the selected legend object and 
placing a check mark beside Legend: Hide Legend for Function Plots (To add them back to the legend, 
clear the check mark). 

Besides function plots, you can also create graphs with all built-in and user-defined nonlinear curve-fitting or 
surface-fitting functions. From the menu, choose Analysis: Fitting: Simulate Curve... or Simulate 
Surface.... You can even add noise to the plot. Corresponding data is created as well. 

10.1.3.1 Adding Function Plots to Existing Graphs 

You can add function plots to existing graph windows containing other plot types. See FAQ-171, specifically 
the section entitled Add Function Plot to an Existing Graph.  

10.2 Plotting without Using Column Plot Designations 

 While worksheet Column Plot Designations are always used when creating graphs from the Plot menu or one 
of the graph toolbars, the Plot Setup dialog box does not make use of them. With Plot Setup, you assign 
column designations on an ad hoc basis, allowing you to overcome some of the restrictions of template-based 
plotting.  

However, to make use of the Plot Setup dialog box, you need to have some familiarity with the hierarchy of 
objects contained in the Origin graph window.       

10.2.1 Pages, Layers, Plots and the Active Plot 

 Each Origin graph window is comprised of a single, editable graph page. The graph page is defined by the 
white area inside the graph window. Anything that lies outside the page is not printed or exported. By default, 
the dimensions of the graph page are defined by the printable area of your default printer driver; without 
adjusting settings, a printed graph should fill the printed page.  

http://originlab.com/3dfunctions
https://www.originlab.com/doc/Quick-Help/Plot-Functions
https://www.originlab.com/doc/User-Guide/Worksheets-Columns
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The graph page must contain at least one, and may contain as many as 1024, graph layers.  

Each graph layer generally contains one or more data plots (graphical depictions of datasets). Note that the 
graph in the image above contains three graph layers, represented by the three non-printing layer icons in the 
upper-left corner of the graph page. Note that there is one layer icon which is highlighted, indicating that this 
is the active layer.  

Just as there is only one active layer, there is only one active plot in a graph. Usually, the active plot is the 
first plot in the active layer. To verify which plot is active, click on the Data menu while the graph is active. 
The active plot will have a check mark beside it. 

 

 
The hierarchical structure of the graph page can be seen in these places:  

The Plot Details Dialog Box (Format: Page ...) 

The Object Manager (View: Object Manager) 

The Plot Setup Dialog Box (Graph: Plot Setup...) 
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10.2.2 The Plot Setup Dialog Box 

The Plot Setup dialog box is a flexible all-in-one plotting tool for creating graphs and manipulating the data 
plots in an existing graph.  

Creating graphs without regard to Column Plot Designations 

Creating graphs from a combination of data sources: multiple worksheets, workbooks, matrixbooks, loose 
datasets, etc. 

Creating graphs combining multiple plot types. 

Adding, removing, replacing data plots. 

Grouping or ungrouping data plots. 

Reordering data plots in a layer or moving data plots to another layer. 

 

To create a graph with the Plot Setup dialog, make sure no data is selected in the active worksheet and 
choose the plot type that you want to create (from the Plot menu or by clicking on a toolbar button).  
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To open the Plot Setup dialog for an existing graph window, right-click on any layer icon in the upper left 
corner of the graph window and select Plot Setup..., or choose menu Graph: Plot Setup....  

 

 

Tutorial: Creating a Simple Line Plot with the Plot Setup Dialog Box  

Click the New Workbook button on the Standard toolbar. 

Click Data: Import From File: Single ASCII, browse to the Origin installation folder and 
import the file \Samples\Curve Fitting\Step01.dat. Starting from column B, columns are 
actually paired - X data and Y data -- but by default all columns are assigned a "Y" Column 
Plot Designation on import. 

Without selecting any data, click Plot > Basic 2D: Line. This opens the Plot Setup dialog 
box. 

Click the two "double-arrow" buttons to show all three dialog box panels. 

In the middle panel, select the "X" box for Column B (Sensor Ax) and the "Y" box for 
Column C (Sensor Ay), then click the Add button to add the plot to Layer 1 in the bottom 
panel.  

Select the "X" box for column D (Sensor Bx) and the "Y" box for Column E (Sensor By), then 
click Add. 

Select the "X" box for column F (Sensor Cx) and the "Y" box for Column G (Sensor Cy), then 
click Add. Three plots are added to Layer 1. 

Press CTRL and click on each plot in the bottom panel to select all three, then right-click and 
choose Group. 

Click OK to create a grouped line plot. 

 

 

 

Tutorial: Creating a Graph with Data from Multiple Worksheets  

Click the New Workbook button on the Standard toolbar. 

Click Data: Import From File: Multiple ASCII, browse to the Origin installation folder and 
select Sensor01.dat, Sensor02.dat and Sensor03.dat under \Samples\Curve Fitting\ to 
import. After Import, 3 workbooks are created.  

Without selecting any data, click Plot > Basic 2D: Line+Symbol. This opens the Plot 
Setup dialog box. 
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Expand the top panel if it is hidden. From the Available Data list, choose Worksheets in 
Folder.  

Select Sensor01, Sensor02 and Sensor03 sheets in the top panel. 

In the middle panel, select the "X" box for Column A (Displacement) and the "Y" box for 
Column B (Sensor Output), then click the Add button.  

Click OK to create a grouped Line+Symbol plot using Sensor Output columns from 3 
worksheets. 

 

The Plot Setup middle panel only allows choosing one X column at a time.  

If your worksheet is set up with the correct Column Plot Designations (e.g. XYXY) but you only want columns 
with same Long Name, click the toggle in the upper-right corner of middle panel so that only plottable columns 
show (e.g. for 2D plot types, X columns are not shown). Then you can sort the columns and select all columns 
with same Long Name and plot them together. The Y columns will be plotted against corresponding X columns. 

To change a data plot's type, choose the corresponding plot in bottom panel. Corresponding X and Y columns 
will show in middle panel. Choose a new plot type in middle panel and click the Replace button.  

All data plots in a group share the same plot type. If you want to change the plot type of a single plot in a 
group, right-click the Group node in bottom panel and Ungroup first.  

Drag and drop data plots in the bottom panel to move them to different layers. 
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If the bottom panel is hidden and you have selected columns in the middle panel, you can directly click the OK 
button to create your graph. 

10.3 Manipulating Data Plots 

The following sections discuss higher level modifications to existing graphs such as changing plot type, adding 
or removing plots from the layer and controlling the density of plotted points (Speed Mode). For more detailed 
plot customizations, including those involving such things as changing plot symbols, colors, and legend 

customizations, see the Customizing Graphs chapter.  

10.3.1 Changing Plot Type 

 Some Origin plot types (e.g. scatter, line, line+symbol) allow you to interchange the plot type of an existing 
plot with a few other select plot types. Some examples:  

Scatter, line, line+symbol, column/bar are interchangeable. 

3D scatter/trajectory/vector, 3D bars, 3D surface are interchangeable. 

 
To change the plot type of an existing plot:  

Right-click on the data plot and choose Change Plot to: Graph Type from the shortcut menu. 

Click on the data plot and choose Format: Plot... and in Plot Details choose from the Plot Type drop-down 
list. 

Click on the data plot, then click one of the supported graph toolbar buttons. 

 
Note that if you switch plot types and the selected plot is part of a plot group, all plots in the group are 
switched.  

 

A word of caution: This is an old Origin feature, and for a quick change of common plot 
types in a single-layer graph it works well. Changing plot types in a multi-panel, multi-
layer graph can lead to unwanted outcomes. When working with more complex graphs, 

it is better to create a graph directly using the specified Plot menu command or toolbar 
button .  

10.3.2 Exchanging Data Plots 

  

You can quickly change the data source (X, Y, or worksheet) of a plot using these context menu commands. 
Right-click on a data plot, then select one of these options:  

Change X/Y/Z. These menu items allow you to swap the current X,Y or Z data with data from any column in 
the project.  

Select Columns. This opens the Column Browser where you can select another column in the Current 
Folder, in the Current Folder (recursive) (includes subfolders) or in Current Project. 

Change Worksheet. This menu item allows you to replace both X and Y with data from another worksheet. 
The selected worksheet must have the same Short Names, the same Column Plot Designations and the same 
row index range as the current worksheet. 

 

Tutorial: Changing X and Y assignment of a data plot  

Start with a new workbook and import the file automobile.dat from the 
Samples\Statistics sub-folder of the Origin installation folder. 

https://www.originlab.com/doc/User-Guide/Graphing
https://www.originlab.com/doc/User-Guide/Customizing-Graphs
https://www.originlab.com/doc/User-Guide/Graphing
https://www.originlab.com/doc/User-Guide/Worksheets-Columns


UserGuide 2026 

164 

Select the Gas Mileage column and select the Plot: Basic 2D: Scatter menu item. 
The Gas Mileage column is plotted against the default X column Year. 

Right-click on the data plot and select Change X: Engine Displacement. The Gas 
Mileage column is now plotted against Engine Displacement.  

 

Note: If new data is significantly outside of the current range for X or Y axes, you will be asked if the 
graph should be rescaled. If data are not significantly different, you may want to manually rescale the 
graph (Hot key: CTRL+R).  

 

 

If you have performed some analysis on the data plot (e.g. linear regression with 
Recalculate set to Auto), the fit results will automatically update when you change 
X/Y or the worksheet.  

10.3.3 Adding, Removing and Hiding Data Plots 

 Use the following methods to add or remove data plots from a graph.  

10.3.3.1 Adding Data by Drag and Drop 

 You can add data to a graph by drag and drop. When using this method, Origin relies on worksheet Column 
Plot Designations to create the plot.  

Select the worksheet data (one or more columns or a range of one or more columns).  

Move the mouse over the left or right edge of the selected range.  

When the pointer looks like this , hold down the left mouse button and drag the data to the graph 
window. Release the mouse. 

If there are multiple layers in the graph, drag the data to the desired layer, then release the mouse. 

 

Usually the current plot type is used when plotting by drag-and-drop. To change the 
global plot type to use when drag and drop, choose Preferences: Options... from the 
main menu. Go to the Graph tab and change the Drag and drop plot type.  

10.3.3.2 Adding Data with Insert: Plot to Layer 

 Use the Insert menu to insert some types of plots to the active graph layer. Choice of plot type depends on 
the active graph window and the last-activated data source (worksheet or matrix). For instance, if you create a 
2D graph, select data in a workbook window, then return to graph window and click Insert: Plot to Layer, 
your insert choices will be Line, Scatter, Line + Symbol, Column..., Area and Contour....  

To use the Insert menu command, you should have an existing graph window:  

Go to the worksheet or matrix window and select your dataset(s). 

Return to the graph window, make sure that the target layer is active layer, then choose Insert: Plot to 
Layer: Plot Type. 

https://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
https://www.originlab.com/doc/User-Guide/Worksheets-Columns
https://www.originlab.com/doc/User-Guide/Worksheets-Columns
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10.3.3.3 Adding and Removing Data with the Layer Contents Dialog Box 

  Open the Layer Contents dialog box by double-clicking or right-clicking on the layer icon(s) in the top left 
corner of the graph page. Controls in the left panel can be used to filter and list available datasets. The right 
panel lists datasets that are plotted in the active layer.  

 

Controls in the center of the dialog box allow you to add or remove plots from the active graph layer. When 
adding data to the graph, click the list button (downward-pointing arrow) to pre-select the plot type before 
adding data to the layer. Use controls in the right panel to group or ungroup plots, or re-order plots in the 
layer.  

10.3.3.4 Adding, Removing, Replacing or Hiding Data Plots with the Plot Setup Dialog Box 

 Among other things, the Plot Setup dialog box can be used to add or remove data plots from the graph.  

To add plots to the graph, use the top panel of Plot Setup to identify your source data. 

Use the controls in the middle panel to specify the plot type and how the data selection should be treated (as 
X, Y, yError or Label). 

In the bottom panel, choose the Layer to which you want to add plots, then click the Add button. 

To remove a plot from the layer, select the plot in the bottom panel, then right-click and choose Remove.  
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To hide a plot, uncheck the Show check box for the plot. 

To replace a plot, select the plot in bottom panel, then change the X and Y selection and plot type in middle 
panel and click the Replace button. Note that replacing one 3D/Contour Plot/Image matrix with another is 
also supported.  

 

10.3.3.5 Adding Data by Direct ASCII Import 

 You can import ASCII files directly into the active graph window using the the Import ASCII toolbar button. 
Note that this method works only with files having a simple structure and it supports only the simplest of 
graph types - Line, Scatter, Line + Symbol, Column and Bar charts.  

Click the Import ASCII button. This opens the Import ASCII dialog box.  

Choose a file.  

Click Open.  

The file is imported and plotted in the active graph window.  

10.3.3.6 Adding Data by Copying and Pasting a Plot 
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With many Basic 2D graphs (e.g. Scatter, Line, Line + Symbol, Bubble, etc.), you can copy a plot from an 
existing graph layer and paste it to another layer in the same window or into a separate graph window. Prior to 
Origin 2020, this would only produce a black line plot. Origin 2020 expanded copy-paste of plots to other plot 
types, while preserving plot properties (symbol size, color, etc.).  

Click on the plot to select it and press CTRL+C.  

Click on the target graph and press CTRL+V.  

You can also copy a plot by selecting the plot in the graph and clicking on the Copy Plot button on the Mini 
Toolbar.  

 

 

Previous versions also allowed you to select and copy a simple plot (Line, Scatter, Line 
+ Symbol, 2D Column/Bar) and paste underlying data into a worksheet. The default 
settings no longer support this but you can reverse this by setting LabTalk system 
variable @CPNP=1.  

10.3.3.7 Removing or Hiding Plots with the Object Manager 

 The Object Manager is a dockable panel that allows for easy manipulation of graph layers and data plots. 
See the section on The Object Manager in this Guide.  

To hide or remove plots, right-click on a plot and choose from the shortcut menu:  

https://www.originlab.com/doc/User-Guide/Origin-Interface
https://www.originlab.com/doc/User-Guide/Origin-Interface
https://www.originlab.com/doc/LabTalk/ref/sys-var-list
https://www.originlab.com/doc/User-Guide/Origin-Interface
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Show or hide plots of the same Long Name. 

Show all plots. 

Remove a plot from the graph window (hidden plots can be quickly shown again; removed plots must be 
added back using one of the above methods). 

If the plot is part of a group, you can right-click on an individual plot and remove just that plot or you can 
right-click on the group icon and remove the entire plot group. 

When you right-click on a plot, you can use Hide Plots with Same Name and Hide All Plots shortcut menu 
items to quickly hide selected plots in the window without removing them entirely (restore plots by enabling 
their display in the Object Manager or in Plot Details). 

10.3.3.8 Removing or Hiding Data with Plot Details 

In the left panel of the Plot Details dialog box (Format: Plot...), right-click on a plot and choose Remove or 
Hide from the context menu. Remove will delete the data plot from the graph so if you just want to 
temporarily hide a plot, choose Hide. Neither of them will delete data from worksheet or matrix.  

https://www.originlab.com/doc/User-Guide/Graphing
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10.3.3.9 Deleting Plots using the Delete Key 

Click on a data plot (either in the graph window or Object Manager) and press the Delete key. If the selected 
plot is part of a group, the entire group is deleted.  

Note that this is more sweeping than the Remove shortcut menu command in that it will remove an entire 
plot group from the graph window. This action does not delete worksheet or matrix data.  

To restore the deleted plots, choose Edit: Undo Remove Plot from the main menu.  

10.3.3.10 Editing Plot Range 

Once a graph is made, you can edit the plot display range, specifying only a portion of the plotted data:  

Right-click on the plot and choose the Edit Range... shortcut menu command. Edit the From and To values. 

In the right panel of the Layer Contents dialog box (Graph: Layer Contents), turn on the Range column by 
right-clicking on the column headings and choosing Range. Click on a plot's range values, then click the ... 

button that appears to the right side of that column. 

In the bottom panel of Plot Setup (Graph: Plot Setup), click on the plot range in the Range column and click 
the ... button that appears to the right side of that column. 

10.3.3.11 Rescaling after Adding/Removing Data Plots 

Adding or removing data plots from a 2D or 3D graph may result in the need to rescale axes.  

Origin will generally ask the user how to handle rescaling.  

Some dialog boxes that are used to add or remove datasets from a plot (e.g. Layer Contents) typically have a 
rescale check box.  

You can also select the layer beforehand, then click the Mini Toolbar Auto Rescale button, to automatically 
rescale. This is equivalent to opening the Axis dialog box Scale tab and setting Rescale = Auto.  
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Choose Graph: Rescale to Show All to rescale the graph after editing the plot range. 

10.3.4 Grouping Data Plots 

 When you make multiple range or column selections, then create a graph, Origin groups the resulting data 
plots in the graph layer. This applies to most 1D (statistical) and 2D graphs, plus 3D XYY (XYY 3D bar, 3D 
ribbon, 3D wall, and 3D waterfall plots) and 3D XYZ (3D scatter, 3D bar) graphs.  

Grouping provides for quick creation of presentation-ready graphs because each plot in the group is assigned a 
differentiating set of plot attributes (line color = black, red, green...; symbol shape = square, circle, 
triangle...; etc.). Assignments are made by cycling through a pre-determined (user-modifiable) increment list 
of styles. For instance, the first plot of a grouped line plots might be denoted by a black line; the second plot 
might be denoted by a red line (the second color in the color list), the third plot by a green line (the third color 
in the color list), and so on.  

 

Tutorial: Creating a simple grouped data plot  

Open a fresh worksheet and click the Import Single ASCII button on the 
Standard toolbar. 

Browse to the Samples\Graphing subfolder in the Origin software folder and Open 
GROUP.DAT. 

Select B(Y), C(Y), and D(Y) columns 

Click the Line & Symbol button on the 2D Graphs toolbar. Note that line and 

symbol color and symbol type are automatically differentiated for each plot.  

 

 

Tutorial: Grouping (or ungrouping) plots manually  

Via the Layer Contents dialog box 

To open the Layer Contents dialog box, double-click on the layer n icon in upper-left 
corner of the graph window.  

To create a group, select the desired data sets from the Layer Contents list (use CTRL 
+ select, SHIFT + select, or simply drag the mouse to select multiple data sets). 

Click Group. Note that each plot in Layer Contents is now preceded by a gn (for 
"group1", "group2", etc.). 

https://www.originlab.com/doc/Origin-Help/PD-Dialog-Group-Tab
https://www.originlab.com/doc/Origin-Help/PD-Dialog-Group-Tab
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To ungroup, click on one of the grouped data plots in the Layer Contents list and click 
Ungroup. 

 

Via the Plot Setup dialog box 

To open the Plot Setup dialog box, ALT + double-click on the layer n icon in upper-
left corner of the graph window.  

To create a group, select the desired plots from the Plot List (use the CTRL or SHIFT 
keys to select multiple data sets). 

Right-click and select Group. Note that a Group icon now precedes the selected plots 
in the Plot List. 

To ungroup, right-click on the Group icon and choose Ungroup from the shortcut 
menu. 

10.3.5 Speed Mode 

  With Speed Mode, you can control the number of data points displayed in a graph layer. This option is most 
used when working with large data sets, though note that there have been improvements in this area and 
Origin now has Density Dots and Color Dots graph templates specifically for creating scatter plots of large 
datasets.  

Speed Mode can be turned on for any 2D or 3D graph. When Speed Mode is enabled, the layer icon displays in 
red and a Speed Mode is On banner appears in the layer. The banner is not included when printing, copying, 
or exporting the graph.  

 

To adjust Speed Mode settings:  

With your graph active, select Format: Layer... from the Origin menu. 

Select the Display/Speed tab. 

For plots created from worksheet data, Select the Worksheet Data, Maximum Points Per Curve check box 
to enable Speed Mode for all the data plots in the layer that are created from worksheet data. Type the desired 

https://www.originlab.com/doc/User-Guide/Graphing
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value (n) in the associated text box. If the number of data points in a data plot exceeds n, Origin displays a 
subset of the data plot containing n points, drawn by extracting values at regular intervals from the data set. 

For 3D data plots created from a matrix or for contour data in the layer, Select the Matrix Data, Maximum 
Points Per Dimension check box to enable Speed Mode. Type the desired value (n, m) in the X and Y text 
boxes. If the number of data points in a data plot exceeds n or m, Origin displays a subset of the data plot 
composed of -- at maximum -- n by m points. This subset is drawn by extracting values at regular intervals 
from the matrix columns (X) and rows (Y). 

For broad control, you can select Speed Mode from the Graph menu. This opens the speedmode X-

Functiondialog. The dialog lets you specify which windows the settings should apply to ( Target ) and also, 
offers several levels of data plot thinning from Off to High, plus Custom.  

 

Click the Enable/Disable Speed Mode button on the Graph toolbar, to toggle 
Speed Mode on/off for all layers in the graph window.  

To turn off the Speed Mode is On banner for all graphs:  

Select Preferences: Options to open the Options dialog box.  

Select the Graph tab and clear the Speed Mode Show Watermark check box and refresh the graph, if 
needed. Note that this only disables the banner across the graph; it does not disable Speed Mode. 

 

There is a page-level Mini Toolbar button to toggle the Speed Mode Banner off or on, 
at the individual graph level.  

 

10.3.5.1 Notes on Speed Mode 

Besides Speed Mode, Origin has another generalized data reduction mechanism for plots with scatter points 
(e.g line & symbol). The Plot Details's plot-level Display tab has a Data Points Display Control drop-down 
so that you can systematically skip plotting of points by one of several methods (e.g. Skip Points by 
Increment). 

LabTalk control of where to begin skipping (e.g. layer.plot1.symbol.skipstart=10, will start skipping at row 
10). 

https://www.originlab.com/doc/X-Function/ref/speedmode
https://www.originlab.com/doc/X-Function/ref/speedmode
https://www.originlab.com/doc/Origin-Help/PD-Dialog-PlotLevel-Display-Tab


Graphing 

173 

Skip Points and Speed Mode plot the last data point, by default, but this is controlled by system variable 
@SMEP. 

The Speed Mode controls on the Display/Speed tab of the layer's Plot Details only apply to what you see on 
screen. They do not apply to graphs that are printed or exported, by default.  

If you wish to skip points in printouts, use controls in the Print dialog. See the discussion of the Skip Points 
feature as it applies to some graph windows in the Origin Help file.  

If you wish to apply Speed Mode settings to graphic export, please see this discussion of Performance Group 
controls on the Miscellaneous tab of the Plot Details dialog box or use controls under the Export Settings 
node in the Graph Export dialog. 

Speed Mode settings are saved with the graph template. If you make changes to Speed Mode settings for a 
particular graph type, you will have to resave the graph template to make those changes permanent. 

Always exercise judgement when using Speed Mode. Since Speed Mode systematically weeds out a portion of 
your data points, any graph in which Speed Mode is turned on, may -- or may not -- accurately represent your 
data, to your satisfaction. Always familiarize yourself with your data and adjust and compare Speed Mode 
settings to ensure that trends in your data are accurately depicted. 

10.4 Publishing Your Graph: Copy/Paste, Image Export, Slide Shows and 
Printing 

There are a number of ways to present your finished graph.  

Copy a graph page and paste it in other applications such as Word, Powerpoint, etc. 

Export the graph page as an image file (raster or vector). 

Send Graphs to PowerPoint. 

Printout. 

Slideshow within Origin. 

Create Movies. 

Please read details in the Publishing and Export chapter of this User Guide and the "Topics for Further Reading" 
there.  

10.5 Origin Graph Types 

 Origin supports over 100 plot types. Origin's 2D graphs are plotted from Worksheet data. Origin's 3D graph 
are plotted from Worksheet data (XYY, XYZ), a worksheet arrangement we refer to as a Virtual Matrix or 
from Matrix data.  

 

Origin Graph Samples of most 2D and 3D graph types are included with your Origin 
software. To view graphs, supporting data and guidelines for making the graphs, 
choose Help: Learning Center(F11).  

 
The tables below list all Origin graph types, grouped by Plot menu category:  

 

https://www.originlab.com/doc/LabTalk/ref/sys-var-list
https://www.originlab.com/doc/Origin-Help/Print-Dialog
https://www.originlab.com/doc/Origin-Help/PD-Dialog-Misc-Tab
https://www.originlab.com/doc/Origin-Help/ExpGraph-Dailog
https://www.originlab.com/doc/Origin-Help/ExpGraph-Dailog
https://www.originlab.com/doc/User-Guide/Publishing-and-Export
https://www.originlab.com/doc/User-Guide/Publishing-and-Export
https://www.originlab.com/doc/User-Guide/Matrix-Book-Matrix-Sheet-Matrix-Objects
https://www.originlab.com/doc/User-Guide/Matrix-Book-Matrix-Sheet-Matrix-Objects
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The Plot menu icon for each graph type precedes the graph name.  

The Notes column provides basic information on data requirements. For more specific data requirements, click 
on the graph name beside the Plot menu icon. 

10.5.1 Plot Menu Graphs by Category 

 

Plot menu templates display basic data requirements on hover.  

When the cursor hovers over a plot icon, pressing F1 key will pop up the help 
documentation for that plot, including the plot created by Extended Template and Apps.  

 

 

 

You can modify the size of the Plot menu icons using the LabTalk system variable 
@PPS. To find out how to change the value of a system variable, see Customizing 
Origin Using System Variables.  

Basic 2D 

Bar, Pie, Area 

Multi-Panel/Axis 

Statistical 

Contour 

Specialized 

Categorical 

3D 

Browser Graph 

Function Plot 

My Templates 

Other Graphing Tools 

10.5.1.1 Basic 2D 

  

https://www.originlab.com/doc/LabTalk/ref/sys-var-list
https://www.originlab.com/doc/Origin-Help/Customization-with-SysVar
https://www.originlab.com/doc/Origin-Help/Customization-with-SysVar
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Graph Types  Notes  

Scatter 

Scatter Central 

Column Scatter 

Y Error 

XY Error 

Error Band 

Scatter + Rug 

Bubble 

Color Mapped 

Bubble + Color Mapped  

Start with a Worksheet. 

If there is an associated X column, X column supplies X 
values; otherwise, Y sampling interval or row number is 
used. 

For specific data requirements, follow links in the Graph 
Types column. 

Line 

Horizontal Step 

Vertical Step 

Spline 

Start with a Worksheet. 

Select one or more Y columns or at least a portion of one 
Y column.  

Multiple Y columns are grouped in layer.  

If there is an associated X column, X column supplies X 
values; otherwise, Y sampling interval or row number is 
used. 

For specific data requirements, follow links in the Graph 
Types column. 

Line + Symbol 

Line Series 

Before and After Graph 

2 Point Segment 

Start with a Worksheet. 

Select one or more Y columns or at least a portion of one 
Y column.  

Multiple Y columns are grouped in the graph layer 
(except Line Series). 

For Line Series graph, select 2 or 3 Y columns.  

If there is an associated X column, X column supplies X 
values; otherwise, Y sampling interval or row number is 
used. 

For specific data requirements, follow links in the Graph 

https://www.originlab.com/doc/Origin-Help/2DScatter-Graph
https://www.originlab.com/doc/Origin-Help/2DScatterCentral-Graph
https://www.originlab.com/doc/Origin-Help/column-scatter
https://www.originlab.com/doc/Origin-Help/Y-ErrBar-Graph
https://www.originlab.com/doc/Origin-Help/XY-ErrBar-Graph
https://www.originlab.com/doc/Origin-Help/Error-Band-Graph
https://www.originlab.com/doc/Origin-Help/Scatter-Rug-Graph
https://www.originlab.com/doc/Origin-Help/Bubble-Graph
https://www.originlab.com/doc/Origin-Help/Color-Mapped-Graph
https://www.originlab.com/doc/Origin-Help/Bubble-Color-Map-Graph
https://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
https://www.originlab.com/doc/Origin-Help/Line-Graph
https://www.originlab.com/doc/Origin-Help/HorizontalStep-Graph
https://www.originlab.com/doc/Origin-Help/VerticalStep-Graph
https://www.originlab.com/doc/Origin-Help/Spline-Graph
https://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
https://www.originlab.com/doc/Origin-Help/LineSym-Graph
https://www.originlab.com/doc/Origin-Help/Line-Series-Graph
https://www.originlab.com/doc/Origin-Help/Before-After-Graph
https://www.originlab.com/doc/Origin-Help/2Point-Seg-Graph
https://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
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3 Point Segment 

Spline Connected  

Types column. 

Lollipop Plot 

Vertical Drop Line  

Start with a Worksheet. 

For Bar, Column or Column + Label, select one or more Y 
columns (multiple Y columns are grouped in layer). 

For Floating Bar/Column, select two Y columns. 

For Stack graphs and Lollipop plots, select two or more Y 
columns. 

If there is an associated X column, X column supplies X 
values; otherwise, Y sampling interval or row number is 
used. 

For specific data requirements, follow links in the Graph 

Types column. 

Density Dots 

Color Dots 

Start with a Worksheet. 

Select one Y (Density Dots) or two Y (Color Dots) 
columns. 

For more information, follow links in the Graph Types 
column. 

Colormapped Line Series 

Stacked Lines by Y Offsets 

Row-wise 

Start with a Worksheet. 

If there is an associated X column, X column supplies X 
values; otherwise, Y sampling interval or row number is 
used. 

For specific data requirements, follow links in the Graph 
Types column. 

10.5.1.2 Bar, Pie, Area 

Graph Types  Notes  

Column 

Column + Label 

Bar 

Start with a Worksheet. 

For Bar, Column or Column + Label, select one or more Y 
columns (multiple Y columns are grouped in layer). 

For Floating Bar/Column, select two Y columns. 

For Stack graphs and Lollipop plots, select two or more Y 
columns. 

If there is an associated X column, X column supplies X 
values; otherwise, Y sampling interval or row number is 

https://www.originlab.com/doc/Origin-Help/3Point-Seg-Graph
https://www.originlab.com/doc/Origin-Help/Spline-Connected-Graph
https://www.originlab.com/doc/Origin-Help/Lollipop-Plot
https://www.originlab.com/doc/Origin-Help/Vertical-Drop-Line
https://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
https://www.originlab.com/doc/Origin-Help/Density_Dots
https://www.originlab.com/doc/Origin-Help/Color-Dots
https://www.originlab.com/doc/Origin-Help/Colormap-Line-Series
https://www.originlab.com/doc/Origin-Help/StackLineYOffset-Graph
https://www.originlab.com/doc/Origin-Help/Row-Wise-Graph
https://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
https://www.originlab.com/doc/Origin-Help/Column-Graph
https://www.originlab.com/doc/Origin-Help/Column-label-Graph
https://www.originlab.com/doc/Origin-Help/Bar-Graph
https://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
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Stacked Column 

Stacked Bar 

100% Stacked Column 

100% Stacked Bar 

Floating Column 

Floating Bar 

Kite Diagram 

used. 

For specific data requirements, follow links in the Graph 
Types column. 

3D Color Pie Chart 

2D Color Pie Chart 

Doughnut Plot 

Pie of Pie 

Bar of Pie 

Doughnut of Pie 

Doughnut with Total 

Pie with Different Radius 

Doughnut with Different 
Radius 

Pie Map 

Bar Map  

Start with a Worksheet. 

Select exactly one Y column or a range from one Y 
column. 

If there is an associated X column, the X data are used in 
the graph legend; otherwise row number is used. 

For specific data requirements, follow links in the Graph 
Types column. 

Area 

Stacked Area 

Start with a Worksheet. 

If there is an associated X column, X column supplies X 
values; otherwise, Y sampling interval or row number is 
used. 

https://www.originlab.com/doc/Origin-Help/Stack-Column-Graph
https://www.originlab.com/doc/Origin-Help/Stack-Bar-Graph
https://www.originlab.com/doc/Origin-Help/100-Stack-Column-Graph
https://www.originlab.com/doc/Origin-Help/100-Stack-Bar-Graph
https://www.originlab.com/doc/Origin-Help/Floating-Column-Graph
https://www.originlab.com/doc/Origin-Help/Floating-Bar-Graph
https://www.originlab.com/doc/Origin-Help/Kite-Diagram
https://www.originlab.com/doc/Origin-Help/3D-Color-PieChart
https://www.originlab.com/doc/Origin-Help/2D-Pie-Chart
https://www.originlab.com/doc/Origin-Help/Doughnut-Plot
https://www.originlab.com/doc/Origin-Help/Pie-of-Pie
https://www.originlab.com/doc/Origin-Help/Bar-Of-Pie
https://www.originlab.com/doc/Origin-Help/Doughnut-Of-Pie
https://www.originlab.com/doc/Origin-Help/Doughnut-with-Total
https://www.originlab.com/doc/Origin-Help/Pie-with-DiffRadius
https://www.originlab.com/doc/Origin-Help/Doughnut-with-DiffRadius
https://www.originlab.com/doc/Origin-Help/Doughnut-with-DiffRadius
https://www.originlab.com/doc/Origin-Help/Pie-Map
https://www.originlab.com/doc/Origin-Help/Bar-Map
https://www.originlab.com/doc/Origin-Help/Area-Graph
https://www.originlab.com/doc/Origin-Help/StackArea-Graph
https://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
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100% Stacked Area 

Fill Area 

Fill 2 Colors 

For specific data requirements, follow links in the Graph 
Types column. 

10.5.1.3 Multi-Panel/Axis 

Graph Types  Notes  

Double-Y 

Double-Y Column Graph 

Double-Y Column-Line 
Symbol 

Start with a Worksheet. 

Select two Y columns. 

If there is an associated X column, X column supplies X 
values; otherwise, Y sampling interval or row number is 
used. 

For specific data requirements, follow links in the Graph 
Types column. 

2Ys Y-Y 

2Ys Column 

2Ys, Column-Line Symbol 

Start with a Worksheet. 

Select two Y columns. 

If there is an associated X column, X column supplies X 
values; otherwise, Y sampling interval or row number is 
used. 

For specific data requirements, follow links in the Graph 
Types column. 

3Ys Y-YY 

3Ys Y-Y-Y 

4Ys Y-YYY 

4Ys YY-YY 

Multiple Y Axes... 

Start with a Worksheet. 

Select one Y column for each Y axis. 

Multiple Y Axes opens interactive dialog. Choose plot 
type, number of axes, plots per layer, axis color to match 
plot, etc. 

For specific data requirements, follow links in the Graph 
Types column. 

Vertical 2 Panel 

Start with a Worksheet. 

Select one Y column (or range) per panel. 

If there is an associated X column, X column supplies X 

https://www.originlab.com/doc/Origin-Help/100-StackArea-Graph
https://www.originlab.com/doc/Origin-Help/FillArea-Graph
https://www.originlab.com/doc/Origin-Help/Fill-2-Colors-Graph
https://www.originlab.com/doc/Origin-Help/Double-Y-Graph
https://www.originlab.com/doc/Origin-Help/DoubleY-Column-Graph
https://www.originlab.com/doc/Origin-Help/DoubleY-Column-LineSym-Graph
https://www.originlab.com/doc/Origin-Help/DoubleY-Column-LineSym-Graph
https://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
https://www.originlab.com/doc/Origin-Help/2Ys-Y-Y-Graph
https://www.originlab.com/doc/Origin-Help/2Ys-Column-Graph
https://www.originlab.com/doc/Origin-Help/2Ys-Column-LineSym-Graph
https://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
https://www.originlab.com/doc/Origin-Help/3Y-Y-YY-Graph
https://www.originlab.com/doc/Origin-Help/3Y-Y-Y-Y-Graph
https://www.originlab.com/doc/Origin-Help/4Y-Y-YYY-Graph
https://www.originlab.com/doc/Origin-Help/4Y-YY-YY-Graph
https://www.originlab.com/doc/Origin-Help/MultiY-Graph
https://www.originlab.com/doc/Origin-Help/Vertical-2-Panel-Graph
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Horizontal 2 Panel 

4 Panel 

9 Panel 

Stack... 

Multiple Panels by Label... 

values; otherwise, Y sampling interval or row number is 
used. 

For specific data requirements, follow links in the Graph 
Types column. 

Zoom  

Start with a Worksheet. 

Select at least one Y column or a range from at least one 
Y column. 

If there is an associated X column, X column supplies X 
values; otherwise, Y sampling interval or row number is 
used. 

For specific data requirements, follow the link in the 
Graph Types column. 

 

10.5.1.3.1 1 Layer, 2 Y Axes 

It has long been possible to create "Double-Y" plots in Origin. Previously, "2 Y axes" meant "2 layers." Since 
Origin 2023, Origin introduces support for a new "1 layer, 2 Y axis" plotting mechanism. The new mechanism 
has general applications for 2D scatter, line, line + symbol (incl. variations such as the "Before-After" 
graph), column, box, histogram, and area charts. Using new GUI controls, the user can create such a graph 
using only the basic plot type templates.  

Beginning with Origin 2023, the Multi-Panel/Axis category (Plot: Multi-Panel/Axis) has two rows of 
"Double-Y" templates with the new, single-layer on top and the older, two-layer templates below.  

 

The new and the legacy templates will produce the same graph, the only difference being that the legacy 
template will create two layers while the new template will create only one. The plotting procedure is the same 
for both:  

In the worksheet, select 2 columns of "Y" data. 

Click Plot: Multi-Panel/Axis and choose the desired template. 

https://www.originlab.com/doc/Origin-Help/Horizontal-2-Panel-Graph
https://www.originlab.com/doc/Origin-Help/4Panel-Graph
https://www.originlab.com/doc/Origin-Help/9Panel-Graph
https://www.originlab.com/doc/Origin-Help/Stack-Panels-Graph
https://www.originlab.com/doc/Origin-Help/MultiPanel-Graph
https://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
https://www.originlab.com/doc/Origin-Help/Zoom-Graph
https://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
https://www.originlab.com/doc/Origin-Help/Before-After-Graph
https://www.originlab.com/doc/Origin-Help/Before-After-Graph
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See Customizing Graphs for an example of creating a "1 Layer, 2 Y Axes" graph.  

 
Other controls that are added to support this new "1 layer, 2 Y axis" plotting mechanism:  

The Plot Details Group tab now has a Subgrouping = By Axis option. In the graph above, we did not use 
this setting. Instead, we chose to use a single group and make use of line+symbol template's default 
increment lists for line color and symbol shape. However, we could just as well have split the left and right Y 
plots into two separate groups and thus, implement separate Plot Details Group tab behaviors for each group. 

 

The aforementioned plot types now include a Display tab at the plot level in Plot Details. Use radio buttons 
Plot Data on the Left Y Axis or Right Y Axis. 

 

https://www.originlab.com/doc/User-Guide/Customizing-Graphs
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The Axis dialog box now has a Rescale Each Axis Independently check box that should be enabled for a 
"double-Y" graph (If for some reason, your two vertical axes don't seem to want to scale independently, check 
on this setting). 

 

10.5.1.4 Statistical 

  

Graph Types  Notes  

Box Chart 

Interval Plot 

Bar Chart 

Box Overlap 

Box Normal 

Half Box 

Bar Overlap 

Bar Normal 

Scatter Interval 

Marginal Box Charts 

Beeswarm Plot  

Start with a Worksheet. 

Select at least one Y column or a range from at least one 
Y column. 

For specific data requirements, follow the link in the 
Graph Types column. 

https://www.originlab.com/doc/Origin-Help/BoxChart-Graph
https://www.originlab.com/doc/Origin-Help/interval-plot
https://www.originlab.com/doc/Origin-Help/Bar-chart
https://www.originlab.com/doc/Origin-Help/BoxChart-Graph
https://www.originlab.com/doc/Origin-Help/BoxChart-Graph
https://www.originlab.com/doc/Origin-Help/BoxChart-Graph
https://www.originlab.com/doc/Origin-Help/Bar-chart
https://www.originlab.com/doc/Origin-Help/Bar-chart
https://www.originlab.com/doc/Origin-Help/interval-plot
https://www.originlab.com/doc/Origin-Help/Marginal-Boxes-Charts
https://www.originlab.com/doc/Origin-Help/Beeswarm-Plot
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Histogram 

Histogram + Rug 

Histogram + Probabilities 

Multi-Panel Histograms 

Distribution  

Distribution + Rug 

Histogram with Labels 

Stacked Histograms 

Population Pyramid 

Marginal Histograms 

Marginal Plots (Grouped 
Marginal Histogram) 

Start with a Worksheet. 

Select at least one Y column or a range from at least one 
Y column. 

For specific data requirements, follow links in the Graph 
Types column. 

Scatter Matrix 

Start with a Worksheet. 

Select two Y columns or a range from two Y columns. 

For specific data requirements, follow the link in the 
Graph Types column. 

Violin Plot 

Violin with Box 

Violin with Point 

Violin with Quartile 

Violin with Stick 

Split Plot 

Half Violin 

Start with a Worksheet. 

Select at least one Y column (or a range from at least 
one Y column). 

Split violin requires exactly 2 data columns, plus a third 
grouping column. 

For data requirements and other information on plot 
variations, see Violin Plot. 

For data requirements and other information on Ridgeline 
Charts, follow the link in the Graph Types column.  

https://www.originlab.com/doc/Origin-Help/Histogram-Graph
https://www.originlab.com/doc/Origin-Help/HistogramRug-Graph
https://www.originlab.com/doc/Origin-Help/Histogram-Graph
https://www.originlab.com/doc/Origin-Help/Stacked-Histograms-Graph
https://www.originlab.com/doc/Origin-Help/Histogram-Graph
https://www.originlab.com/doc/Origin-Help/HistogramRug-Graph
https://www.originlab.com/doc/Origin-Help/Histogram-Graph
https://www.originlab.com/doc/Origin-Help/Stacked-Histograms-Graph
https://www.originlab.com/doc/Origin-Help/Population-Pyramid-Graph
https://www.originlab.com/doc/Origin-Help/Marginal-Histograms-Graph
https://www.originlab.com/doc/Origin-Help/Marginal
https://www.originlab.com/doc/Origin-Help/Marginal
https://www.originlab.com/doc/Origin-Help/Scatter-Matrix
https://www.originlab.com/doc/Origin-Help/Violin-Plot
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Ridgeline Chart  

Pareto Chart - Binned Data 

Pareto Chart - Raw Data 

Start with a Worksheet. 

Select one Y columns or a range from one Y column 
(Raw), or a Y column of Binned results. 

For specific data requirements, follow the link in the 
Graph Types column. 

QC (X-bar R) Chart 

Start with a Worksheet. 

Select at least one Y column or a range from at least one 
Y column. 

For specific data requirements, follow the link in the 
Graph Types column. 

Bridge Chart  

Stacked Bridge Chart  

Stacked Total Bridge Chart 

Horiz-Bridge Chart 

Double Y Box  

Start with a Worksheet. 

Select one or more Y columns (or a range of one or more 
Y columns). If there is an X column to the left of the Y 
column(s), this X column is treated as categorical data; 
otherwise, the worksheet's row indices will be used. 

Origin Bridge Charts are variants of one basic chart type. 
For more information, see Bridge Charts. 

Probability Plot 

Q-Q Plot 

Start with a Worksheet. 

Select one Y column or a range from one Y column. 

For specific data requirements, follow the link in the 
Graph Types column. 

Bland-Altman Plot  

Start with a Worksheet. 

Select two Method columns and one Subject column 
(optional). 

Correlation Plot  

Correlation Plot is an APP tool. To use it, please make 
sure the app is installed. 

Start with a Worksheet. 

The data can be checked in the dialog. 

https://www.originlab.com/doc/Origin-Help/Ridgeline
https://www.originlab.com/doc/Origin-Help/ParetoChart-BinData
https://www.originlab.com/doc/Origin-Help/ParetoChart-RawData
https://www.originlab.com/doc/Origin-Help/QC-XBarR-Graph
https://www.originlab.com/doc/Origin-Help/2Ys-Box-Chart
https://www.originlab.com/doc/Origin-Help/Legend-CateData
https://www.originlab.com/doc/Origin-Help/Bridge-Chart
https://www.originlab.com/doc/Origin-Help/Probability-Plot
https://www.originlab.com/doc/Origin-Help/QQ-Plot
https://www.originlab.com/doc/Origin-Help/Bland-Altman_Plot
https://www.originlab.com/FileExchange/Details.aspx?fid=574
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Paired Comparison Plot  

Paired Comparison Plot is an APP tool. To use it, please 
make sure the app is installed. 

Start with a Worksheet. 

Select one Data column, then select Group columns in 
the dialog. 

10.5.1.5 Contour 

  

Graph Types  Notes  

Contour - Color Fill 

Contour B/W Lines + 
Labels 

Gray Scale Map 

Contour - Categorical Z 

Contour Color Fill, B/W Lines + Labels, Gray Scale Map, 

Contour Profiles: XYZ, Virtual Matrix, Matrix. 

Contour - Categorical Z: XYZ, Virtual Matrix. 

For specific data requirements, follow links in the Graph 
Types column. 

Heatmap 

Heatmap with Labels 

Split Heatmap  

Heatmap and Heatmap with Labels start with a 
Worksheet (XY, XYZ), Virtual Matrix or Matrix. 

Split Heatmap starts from a Worksheet.  

For specific data requirements, follow links in the Graph 
Types column. 

Contour Profiles 

Image Profiles 

Start with a Worksheet, Virtual Matrix or Matrix 
(Image Profiles, Matrix only). 

For specific data requirements, follow links in the Graph 
Types column. 

Polar Contour theta(X), r(Y) 

Polar Contour r(X), theta(Y) 

Start with a Worksheet or Matrix. 

For data requirements and other information on polar 
contour graphs from worksheet data, see Polar Contour 
from XYZ Data. 

For data requirements and other information on polar 
contour graphs from matrix data, see Polar Contour 

from Matrix Data. 

https://www.originlab.com/FileExchange/details.aspx?fid=390
https://www.originlab.com/doc/Origin-Help/ColorFill-Contour-Graph
https://www.originlab.com/doc/Origin-Help/BWLinesLabels-Contour-Graph
https://www.originlab.com/doc/Origin-Help/BWLinesLabels-Contour-Graph
https://www.originlab.com/doc/Origin-Help/Contour-GrayScaleMap
https://www.originlab.com/doc/Origin-Help/Contour-Categorical
https://www.originlab.com/doc/Origin-Help/Heat_map
https://www.originlab.com/doc/Origin-Help/Heatmap-Labels
https://www.originlab.com/doc/Origin-Help/Split-Heatmap
https://www.originlab.com/doc/Origin-Help/Contour-Profile
https://www.originlab.com/doc/Origin-Help/Image-Profile
https://www.originlab.com/doc/Origin-Help/XYZ-Polar-Contour
https://www.originlab.com/doc/Origin-Help/XYZ-Polar-Contour
https://www.originlab.com/doc/Origin-Help/Matrix-Polar-Contour
https://www.originlab.com/doc/Origin-Help/Matrix-Polar-Contour
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Ternary Contour  

Start with a Worksheet. 

Columns should be designated as XYZZ. 

For specific data requirements, follow the link in the 
Graph Types column. 

2D Kernel Density 

Start with a Worksheet. 

Select at least one Y column or a range from at least one 
Y column. 

For specific data requirements, follow the link in the 
Graph Types column. 

Image Plot  

Start with a Matrix. 

Z values are from an imported raster image. 

10.5.1.6 Specialized 

  

Graph Types  Notes  

Vector XYAM 

Vector XYXY 

Start with a Worksheet. 

For XYAM Vector, select three Y columns (or a range of 
the three Y columns). 

For XYXY Vector, select two X columns and 2 Y columns 
(or a range of two X and two Y columns). 

For specific data requirements, follow links in the Graph 
Types column. 

Streamline Vector Plot  

Start with a Matrixsheet with two matrix objects.  

The two matrix objects are the derivatives of the plotted 
curve in the (x,y) directions, respectively. 

Ternary  

Ternary, Line+Symbol  

Ternary, Line  

Right-Triangle Ternary 

Ternary Vector 

Start with a Worksheet. 

For specific data requirements, follow links in the Graph 
Types column. 

https://www.originlab.com/doc/Origin-Help/Ternary-Contour
https://www.originlab.com/doc/Origin-Help/2D-Kernel-Density
https://www.originlab.com/doc/Origin-Help/Image-Plot
https://www.originlab.com/doc/Origin-Help/XYAM-Graph
https://www.originlab.com/doc/Origin-Help/XYXY-Graph
https://www.originlab.com/doc/Origin-Help/Streamline-Vector-Plot
https://www.originlab.com/doc/Origin-Help/Ternary-Graph
https://www.originlab.com/doc/Origin-Help/Ternary-Graph
https://www.originlab.com/doc/Origin-Help/Ternary-Graph
https://www.originlab.com/doc/Origin-Help/Right-Triangle-Ternary
https://www.originlab.com/doc/Origin-Help/Ternary-Vector
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Piper  

Stiff  

Stiff Map  

Durov  

Radar  

Line Fill 

Line  

Symbol  

Start with a Worksheet. 

Select at least one Y column (or a range from at least 
one Y column). The X column displays as the title of the 
radial axis around the chart. If there is an associated X 
column, X column supplies X values; otherwise, Y 
sampling interval or row number is used. 

Radar Charts are also known as "Spider Plots". 

For more information, see Radar Chart (Spider Plot). 

Polar theta(X) r(Y) 

Polar r(X) theta(Y) 

Bar theta, r 

Bar r, theta 

Line + Symbol theta, r 

Line + Symbol r, theta 

Symbol theta, r 

Symbol r, theta 

Wind Rose - Binned Data 

Wind Rose - Raw Data 

Start with a Worksheet. 

Select one or more Y columns or a range from one or 
more Y columns. If there is an associated X column, X 
column supplies X values; otherwise, Y sampling interval 
or row number is used. 

For data requirements and other information on polar 
graphs, see Polar Graph. 

Stacked Radial 

Start with a Worksheet. 

Select at least one Y column of values (or a range from at 
least one column). If there is an associated X column, X 

https://www.originlab.com/doc/Origin-Help/Piper-Diagram
https://www.originlab.com/doc/Origin-Help/Stiff-Diagram
https://www.originlab.com/doc/Origin-Help/StiffMap-Diagram
https://www.originlab.com/doc/Origin-Help/Durov-Diagram
https://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
https://www.originlab.com/doc/Origin-Help/RadarChart-Graph
https://www.originlab.com/doc/Origin-Help/WindRose-Binned-Graph
https://www.originlab.com/doc/Origin-Help/WindRose-Raw-Graph
https://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
https://www.originlab.com/doc/Origin-Help/Polar-Graph
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Radial Bar Plot  

Radial Stacked Bar  

column supplies X values; otherwise, Y sampling interval 
or row number is used. 

For more information, see Radial Bar and Radial 
Stacked Bar Plot 

Polar Vector θr θr] 

Compass Plot 

Start with a Worksheet. 

For Compass, Select at least one Y column of values (or 
a range from at least one column). If there is an 
associated X column, X column supplies X values; 
otherwise, Y sampling interval or row number is used. 

For Polar Vector θr θr, select two pairs of XY columns 
in the order θr θr. 

Smith Chart 

Start with a Worksheet. 

Select at least one Y column of values (or a range from at 
least one column). If there is an associated X column, X 
column supplies X values; otherwise, Y sampling interval 
or row number is used. 

For more information, follow the link in the Graph Types 
column. 

High-Low-Close 

Japanese Candlestick 

OHLC Bar Chart 

OHLC-Volume 

Line 

Start with a Worksheet. 

For specific data requirements, follow links in the Graph 
Types column. 

Bullet Chart 

Vertical Bullet Chart 

Normalized Bullet Chart 

Start with a Worksheet. 

Select one X column and at least two Y columns. 

For more information, see Bullet Chart.  

10.5.1.7 Categorical 

  

https://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
https://www.originlab.com/doc/Origin-Help/Radial-Bar-Plot
https://www.originlab.com/doc/Origin-Help/Radial-Bar-Plot
https://www.originlab.com/doc/Origin-Help/Polar-Vector-theta-r
https://www.originlab.com/doc/Origin-Help/Compass-Plot
https://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
https://www.originlab.com/doc/Origin-Help/SmithChart-Graph
https://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
https://www.originlab.com/doc/Origin-Help/High-Low-Close-Graph
https://www.originlab.com/doc/Origin-Help/Japanese-Candlestick
https://www.originlab.com/doc/Origin-Help/OHLC-Bar-Chart
https://www.originlab.com/doc/Origin-Help/OHLC-Volume
https://www.originlab.com/doc/Origin-Help/Stock_Line
https://www.originlab.com/doc/Origin-Help/Bullet-Chart
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Graph Types  Notes  

Grouped Scatter - Indexed 
Data 

Start with a Worksheet. 

Select at least one Y column as input data.  

One or more column(s) of categorical data provide 
grouping information. 

For more information, see the link in the Graph Types 
column. 

Color Mapped 

Bubble + Color Mapped 

Start with a Worksheet. 

If there is an associated X column, X column supplies X 
values; otherwise, Y sampling interval or row number is 
used. 

For specific data requirements, follow links in the Graph 
Types column. 

Grouped Columns - 
Indexed Data 

Grouped Floating Bar 

Start with a Worksheet. 

Select at least one Y column (Grouped Columns) or two Y 
columns (Grouped Floating Bar). 

If there is an associated X column, X column supplies X 
values; otherwise, Y sampling interval or row number is 
used. 

For Grouped Columns - Indexed Data, an additional 
column supplies the Group information. 

For Grouped Floating Bar Graphs, subgroup by size 
(i.e. number of columns) or by column label. 

Grouped Box Charts - 
Indexed Data 

Grouped Box Charts - Raw 
Data 

Grouped Column Scatter - 
Indexed Data 

Grouped Interval Plot - 
Indexed Data 

Grouped Mean Bar - 
Indexed Data 

Grouped Violin - Indexed 
Data 

Start with a Worksheet. 

Select at least one Y column (or a range from at least 
one Y column), plus a second column with grouping 
information. If there is an associated X column, X column 
supplies X values; otherwise, Y sampling interval or row 

number is used. 

Plots of Indexed Data are all style variations of the 
Grouped Box. 

For more information, follow the links in the Graph 
Types column. 

https://www.originlab.com/doc/Origin-Help/GroupedScatter-IndexedData
https://www.originlab.com/doc/Origin-Help/GroupedScatter-IndexedData
https://www.originlab.com/doc/Origin-Help/Color-Mapped-Graph
https://www.originlab.com/doc/Origin-Help/Bubble-Color-Map-Graph
https://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
https://www.originlab.com/doc/Origin-Help/grouped-column-index-data
https://www.originlab.com/doc/Origin-Help/grouped-column-index-data
https://www.originlab.com/doc/Origin-Help/Grouped-Floating-Bar
https://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
https://www.originlab.com/doc/Origin-Help/GroupedBoxCharts-IndexedData
https://www.originlab.com/doc/Origin-Help/GroupedBoxCharts-IndexedData
https://www.originlab.com/doc/Origin-Help/GroupedBoxCharts-RawData
https://www.originlab.com/doc/Origin-Help/GroupedBoxCharts-RawData
https://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
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Grouped Half Violin - 
Indexed Data 

Grouped Half Box - Indexed 
Data 

Trellis Plot 

Start with a Worksheet. 

Select at least one Y column as input data. Optionally, 
you can have an additional associated Y error column for 
each Y column. Other column(s) generally contain 
grouping information. 

For more information, see the link in the Graph Types 
column. 

Double Y Trellis Plot 

Start with a Worksheet. 

Select two Y columns as input data. Optionally, you can 
have an additional associated Y error column for each Y 
column. Other column(s) generally contain grouping 
information. 

For more information, see the link in the Graph Types 
column. 

Cluster Plot 

Start with a Worksheet. 

You need at least two Y columns, one of which should 
contain grouping information.  

Grouping columns can be used to create separate panels 
in the horizontal and/or vertical directions and/or to 
modify plotted points (color, scatter point size, scatter 
point shape, etc.). 

Parallel Plot 

Parallel Sets 

Parallel Index 

Start with a Worksheet. 

Select at least one (ideally, two or more) column(s) or a 
range from one or more columns. Column designation 
does not matter. Each column will be treated as data on 
a single variable.  

Variables may be numeric (Parallel Plot or Parallel Index) 
or they may be categorical (Parallel Sets). 

Parallel Sets plots have a "curvature" option that is 
sometimes seen in plots termed "Alluvial Diagrams" (see 
next). 

For more information, follow links in the Graph Types 
column. 

Sankey Diagrams 

Start with a Worksheet. 

For Sankey Diagrams, select exactly two columns of 
categorical data + 1 column of numeric data. Column 

https://www.originlab.com/doc/Origin-Help/trellis
https://www.originlab.com/doc/Origin-Help/Trellis-Double-Y
https://www.originlab.com/doc/Origin-Help/cluster-plot
https://www.originlab.com/doc/Origin-Help/Parallel-Plot
https://www.originlab.com/doc/Origin-Help/Parallel-Sets
https://www.originlab.com/doc/Origin-Help/Parallel-Index
https://www.originlab.com/doc/Origin-Help/Sankey-Diagram
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Alluvial Diagrams 

designation is ignored  

For Alluvial Diagrams, select two or more columns of 
categorical data. Column designation is ignored. 

For more information, follow links in the Graph Types 
column. 

Chord Diagram 

Chord Diagram with Ratio 
Layout  

Start with a Worksheet or Virtual Matrix. 

Select at least three columns of values (worksheet) or a 
block of values (virtual matrix) from at least three 
columns. 

The first column will be treated as X and should be 
monotonic. 

For more information, see Chord Diagram and Chord 
Diagram with Ratio Layout. 

Ribbon 

100% Ribbon  

Start with a Worksheet. 

Select at least two Y columns of values (or a range from 
at least two columns).  

If there is an associated X column, X column supplies X 
values; otherwise, sampling interval of the Y column or 
row number is used. 

Network  

Start with a Worksheet. 

The plot requires one of three data arrangements: 
Adjacency matrix, Incidence Matrix or Edge List. 

A dialog box is used to specify input and analysis 

parameters. 

Regardless of data arrangement, an intermediary 
worksheet will be created to tabulate node and link 
information. 

Sunburst Plot 

Circular Packing Graph  

Start with a Worksheet. 

Select multiple categorical X columns and one Y column. 

10.5.1.8 3D 

  

Graph Types  Notes  

https://www.originlab.com/doc/Origin-Help/Alluvial-Diagram
https://www.originlab.com/doc/Origin-Help/Chord-Diagram
https://www.originlab.com/doc/Origin-Help/Chord-Diagram
https://www.originlab.com/doc/Origin-Help/Ribbon-Chart
https://www.originlab.com/doc/Origin-Help/100percent-Ribbon
https://www.originlab.com/doc/Origin-Help/Network-Plot
https://www.originlab.com/doc/Origin-Help/Sunburst-Plot
https://www.originlab.com/doc/Origin-Help/Circular-Packing
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3D Scatter 

3D Scatter + Z Error Bar 

3D Line 

3D Trajectory 

Data requirements vary by plot type. See links in the 
Graph Types column. 

3D Vector XYZ XYZ 

3D Vector XYZ dXdYdZ 

Start with a Worksheet. 

Select 6 worksheet columns, designated as XYZ XYZ. 

For more information, see links in the Graph Types 
column. 

3D Ribbons 

Start with a Worksheet. 

Select at least one Y column (or a range from at least 
one Y column). Ideally, select at least two Y columns (or 
a range of at least two Y columns). If there is an 
associated X column, X column supplies X values; 
otherwise, Y sampling interval or row number is used. 

For more information, see the link in the Graph Types 
column. 

3D Walls 

3D Stacked Walls 

3D 100% Stacked Walls 

Start with a Worksheet. 

Select at least one Y column (or a range from at least 
one Y column). Ideally, select at least two Y columns (or 
a range of at least two Y columns). If there is an 
associated X column, X column supplies X values; 
otherwise, Y sampling interval or row number is used. 

For more information, see the link in the Graph Types 
column. 

Waterfall 

Y Color Mapped Waterfall 

Z Color Mapped Waterfall 

3D Waterfall 

Y Color Mapped 3D 
Waterfall 

Start with a Worksheet. 

Select at least one Y column (or a range from at least 
one Y column). Ideally, select at least two Y columns (or 
a range of at least two Y columns). If there is an 
associated X column, X column supplies X values; 
otherwise, Y sampling interval or row number is used. 

For more information, see the links in the Graph Types 
column. 

 

Waterfall, Y Color Mapped 
Waterfall and Z Color 
Mapped Waterfall, are only 
available from the 2D Graphs 

https://www.originlab.com/doc/Origin-Help/Mat-3DScatter
https://www.originlab.com/doc/Origin-Help/3D-ErrBars
https://www.originlab.com/doc/Origin-Help/3DLine
https://www.originlab.com/doc/Origin-Help/Trajectory-Graph
https://www.originlab.com/doc/Origin-Help/3DVector-XYZ-XYZ
https://www.originlab.com/doc/Origin-Help/3DVector-XYZ-dXdYdZ
https://www.originlab.com/doc/Origin-Help/Ribbon-Graph
https://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
https://www.originlab.com/doc/Origin-Help/Wall-Graph
https://www.originlab.com/doc/Origin-Help/Stacked-Wall-Graph
https://www.originlab.com/doc/Origin-Help/100-Stacked-Wall-Graph
https://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
https://www.originlab.com/doc/Origin-Help/2DWaterfall-Graph
https://www.originlab.com/doc/Origin-Help/2DWaterfall-Y-ColMap
https://www.originlab.com/doc/Origin-Help/2DWaterfall-Z-ColMap
https://www.originlab.com/doc/Origin-Help/3D-Waterfall-Graph
https://www.originlab.com/doc/Origin-Help/3D-Waterfall-YColor-Mapping
https://www.originlab.com/doc/Origin-Help/3D-Waterfall-YColor-Mapping
https://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
https://www.originlab.com/doc/Origin-Help/2D-Graph-Toolbar
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Z Color Mapped 3D 
Waterfall 

toolbar.  

 

3D Color Fill Surface 

3D X Constant with Base 
Surface 

3D Y Constant with Base 
Surface 

3D Color Map Surface 

3D Color Map Surface with 
Projection 

3D Wire Frame 

3D Wire Surface 

Start with a Worksheet or Matrix. 

For specific data requirements, follow links in the Graph 
Types column. 

3D Color Fill Surface with 
Error Bar 

3D Color Map Surface with 
Error Bar 

Multiple Color Fill Surfaces  

Multiple Color Map Surfaces 

Start with a Matrix. 

For specific data requirements, follow links in the Graph 
Types column. 

3D Stacked Surfaces 

3D Stacked Heatmaps 

Start with a Worksheet or Matrix. 

For specific data requirements, follow links in the Graph 
Types column. 

3D Bars 

3D Stacked Bars 

Start with a Worksheet (XYZ) or a Virtual Matrix or 
Matrix of Z values. 

For specific data requirements, follow links in the Graph 

Types column. 

https://www.originlab.com/doc/Origin-Help/3D-Waterfall-ZColor-Mapping
https://www.originlab.com/doc/Origin-Help/3D-Waterfall-ZColor-Mapping
https://www.originlab.com/doc/Origin-Help/2D-Graph-Toolbar
https://www.originlab.com/doc/Origin-Help/Color-Fill-Surface
https://www.originlab.com/doc/Origin-Help/X-Const-Base-Surface
https://www.originlab.com/doc/Origin-Help/X-Const-Base-Surface
https://www.originlab.com/doc/Origin-Help/Y-Const-Base-Surface
https://www.originlab.com/doc/Origin-Help/Y-Const-Base-Surface
https://www.originlab.com/doc/Origin-Help/Color-Map-Surface
https://www.originlab.com/doc/Origin-Help/Color-Map-Surface-Projection
https://www.originlab.com/doc/Origin-Help/Color-Map-Surface-Projection
https://www.originlab.com/doc/Origin-Help/Wire-Frame
https://www.originlab.com/doc/Origin-Help/Wire-Surface
https://www.originlab.com/doc/Origin-Help/Color-Fill-Surface-ErrBar
https://www.originlab.com/doc/Origin-Help/Color-Fill-Surface-ErrBar
https://www.originlab.com/doc/Origin-Help/Color-Map-Surface-ErrBar
https://www.originlab.com/doc/Origin-Help/Color-Map-Surface-ErrBar
https://www.originlab.com/doc/Origin-Help/Multi-Color-Fill-Surface
https://www.originlab.com/doc/Origin-Help/Multi-Color-Map-Surface
https://www.originlab.com/doc/Origin-Help/3D-Stacked-Surfaces
https://www.originlab.com/doc/Origin-Help/3D-Stacked-Heatmaps
https://www.originlab.com/doc/Origin-Help/3D-Bars
https://www.originlab.com/doc/Origin-Help/3D-Stacked-Bars
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3D 100% Stacked Bars 

XYY 3D Bars 

XYY 3D Side by Side Bars 

XYY 3D Stacked Bars 

XYY 3D 100% Stacked Bars 

Start with a Worksheet. 

Select at least one Y column (or a range from at least 
one Y column). Ideally, select at least two Y columns (or 
a range of at least two Y columns). If there is an 
associated X column, X column supplies X values; 
otherwise, Y sampling interval or row number is used. 

For more information, see the links in the Graph Types 
column. 

3D Ternary Colormap 
Surface 

3D Ternary Symbol 

Start with a Worksheet. 

Select two Z columns (XYZZ) or a range of data from two 
Z columns (Z columns may be multiples of 2). 

For more information, follow links in the Graph Types 
column. 

3D Tetrahedral 

Start with a Worksheet. 

Select two Z columns (XYZZ) or a range of data from two 
Z columns (Z columns may be multiples of 2). 

For more information, follow links in the Graph Types 
column. 

Parametric Surface  

Start with a Matrix. 

The matrix should have, at minimum, 3 objects in the 
same matrixsheet. 

For more information, follow links in the Graph Types 
column. 

 
For an overview of Origin's 3D graph types and their source data requirements, see these topics:  

Creating 3D Graphs 

3D and Contour Graphing 

Creating Contour Graphs 

Creating 3D and Contour Graphs from Virtual Matrix 

10.5.1.9 Browser Graph 

   

https://www.originlab.com/doc/Origin-Help/3D-100PC-Stacked-Bars
https://www.originlab.com/doc/Origin-Help/3DBar-Graph
https://www.originlab.com/doc/Origin-Help/3DBars-Side-by-Side
https://www.originlab.com/doc/Origin-Help/3DStackBar-Graph
https://www.originlab.com/doc/Origin-Help/3D100PC_StackBar-Graph
https://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
https://www.originlab.com/doc/Origin-Help/3d-ternary-colormap
https://www.originlab.com/doc/Origin-Help/3d-ternary-colormap
https://www.originlab.com/doc/Origin-Help/3d-ternary-symbol
https://www.originlab.com/doc/Origin-Help/3d-Tetrahedral
https://www.originlab.com/doc/Origin-Help/Parametric-Surface
https://www.originlab.com/doc/Origin-Help/Create-3D-Graph
https://www.originlab.com/doc/Origin-Help/3D-Contour-Graphing
https://www.originlab.com/doc/Origin-Help/Create-Contour-Graph
https://www.originlab.com/doc/Origin-Help/Plot-3D-Contour-VirtMat
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Browser graphs are useful for selectively plotting data from worksheets containing many columns (and 
rows), into a single graph layer:  

Select a single plot or every Nth column for plotting.  

Easily change column selection. 

Stretch the window in either dimension to obtain the best view. 

Specify automatic rescale and/or common display range for all plots. 

Works with other Origin tools including Gadgets. 

Plots can be further customized via Plot Details dialog box. 

You can export a Browser Graph as a video (GIF, TIFF, AVI): 

Click the menu button and choose Flip Through. 

Click the Export button and set File Type = GIF, TIFF or AVI. 

Modify other settings as needed and click OK. Unless it has been turned off, export will dump a clickable link 
to the Messages Log. 

 

The page-level Mini Toolbar includes an Add Browser button so that you can add a 
Browser panel to a regular 2D line plot.  

 

 

Graph Types  Notes  

Black Lines 

Color Lines 

Histogram 

Starts with a Worksheet. 

Plot selected Y columns, plot every nth column or plot all 
columns. 

For more information on use and configuration of 
Browser Graphs, see Graph with Browser Panel 

https://www.originlab.com/doc/Origin-Help/Graph-Browser
https://www.originlab.com/doc/User-Guide/Gadgets
https://www.originlab.com/doc/Origin-Help/Graph-Browser


Graphing 

195 

Stack  

10.5.1.10 Function Plot 

  

Graph Types  Notes  

New 2D Plot 

New 2D Parametric Plot 

Function plots are not created from physical data. 

Once a function plot is created, you can obtain the 
derived dataset. 

For more information on function plots, follow links in the 
Graph Types column. 

New 3D Plot 

New 3D Parametric Plot 

Function plots are not created from physical data. 

When a 3D Function is plotted, a matrix of Z values is 
simultaneously generated. 

For more information on function plots, follow links in the 
Graph Types column. 

10.5.1.11 My Templates 

  

Dialog Box  Notes  

My Templates  

This Category lists and gives direct access to the custom 
templates in your User Files Folder. 

10.5.1.12 Other Graphing Tools 

  

App  Notes  

Graph Maker App  

The Graph Maker app is pre-installed in your Origin 
software. 

Launch the App from the Plot menu or from the Graph 
Maker app icon in the Apps Gallery to the right side of 
your Origin workspace. 

Use the Graph Maker app with Preview pane, to 

https://www.originlab.com/doc/Origin-Help/PD-Dialog-2DFunc-Tab
https://www.originlab.com/doc/Origin-Help/PD-Dialog-2DParaFunc-Tab
https://www.originlab.com/doc/Origin-Help/PD-Dialog-3DFunc-Tab
https://www.originlab.com/doc/Origin-Help/PD-Dialog-3DParaFunc-Tab
https://www.originlab.com/doc/Origin-Help/Graph-Template-Gallery
https://www.originlab.com/doc/Origin-Help/UserFilesFolder
https://www.originlab.com/FileExchange/Details.aspx?fid=445
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interactively plot grouped data. 

Choose from line, scatter, line+symbol, column, box and 
histogram chart types. 

Supports fitting for scatter plots. 

Drag-and-drop worksheet columns to set up the graph. 

Graph settings are saved and can be re-loaded. 

Template Library  

Use this dialog to organize your custom graphing 
templates. 

Template Center  

Use this dialog to search and download the online graph 
templates 

10.6 Topics for Further Reading 

The Page-Layer-Plot Hierarchy 

Page Viewing Modes 

Graph Template Basics 

Creating Graphs from Graph Templates 

The Graph Template Library 

Graph Axes 

Zooming In or Out on the Graph Page 

Creating Multi Layered Graphs 

Adding Data Plots to the Graph Layer 

The Layer Contents Dialog Box 

The Object Manager 

Graph Layers 

Linking Layers 

3D and Contour Graphing 

Graph with Data Slicer 

Plotting Mathematical Functions 

Batch Plotting 

Appendix 2 - Complete Listing of Origin Graph Types 

https://www.originlab.com/doc/Origin-Help/Graph-Template-Gallery
https://www.originlab.com/doc/Origin-Help/Template-Center
https://www.originlab.com/doc/Origin-Help/Page-Layer-Plot-Hierarchy
https://www.originlab.com/doc/Origin-Help/Compare-PageView-Modes
https://www.originlab.com/doc/Origin-Help/Graph-Template-Basics
https://www.originlab.com/doc/Origin-Help/Plot-Graph-Template
https://www.originlab.com/doc/Origin-Help/Graph-Template-Gallery
https://www.originlab.com/doc/Origin-Help/GraphAxes
https://www.originlab.com/doc/Origin-Help/Zoom-GraphPage
https://www.originlab.com/doc/Origin-Help/MultiLayer-Graph
https://www.originlab.com/doc/Origin-Help/DataPlot-Manage
https://www.originlab.com/doc/Origin-Help/LayerN-Dialog
https://www.originlab.com/doc/Origin-Help/Object-Manager
https://www.originlab.com/doc/Origin-Help/MultiLayer-Graph
https://www.originlab.com/doc/Origin-Help/Link-Layers
https://www.originlab.com/doc/Origin-Help/3D-Contour-Graphing
https://www.originlab.com/doc/Origin-Help/Graph-Data-Slicer
https://www.originlab.com/doc/Origin-Help/FuncPlot
https://www.originlab.com/doc/Origin-Help/Graphing-Batch-Plotting
https://www.originlab.com/doc/Origin-Help/GraphTypes
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11 Customizing Graphs 

Customizing-Graphs 

 

 

11.1 Introduction 

This chapter introduces you to various aspects of graph customization. All Origin graphs start from a graph 
template. If the graph you are making is fairly standard for its type, the options that were stored in the graph 
template may be entirely adequate to produce a polished-looking graph. The business of basic graph creation 
was covered in the last chapter, Graphing.  

Sooner or later, however, you are going to want to add annotations, modify axis scales, or change plot colors. 
Hence, the purpose of this chapter is to introduce you to some key Origin graph customization tools and 
techniques, as well as to point you toward resources that will help you manage more complex graph 
customization tasks.  

We begin with a discussion of the graph customization-related toolbars, as these toolbars have tools that are 
commonly used for quick modifications of graph elements.  

https://www.originlab.com/doc/User-Guide/Graphing
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11.2 Dockable Toolbars 

Toolbar buttons useful for graph customization tasks, include the following:  

Description  
Toolbar  
(default configuration)  

Format toolbar 
buttons:  

 

Creating and 

customizing text 
objects. 

 

Style toolbar buttons:  

 

Editing colors, line 
thickness, fill patterns.  

Tools toolbar buttons:  

 

Add text objects, lines, 
curves, arrows, 
rectangles/circles/poly
gons.  

Graph toolbar buttons:  

 

Add graph layers incl. 
inset graphs, merging 
or extracting graphs; 
exchanging axes; anti-
aliasing and Speed 
Mode. 

 

Add Object to Graph 
toolbar buttons:  

 

Add legends/color 
scales/bubble scales; 
date & time and 

project path stamps; 
XY scale; table 
objects. 

 

Object Edit toolbar 
buttons: 

 

Arranging and aligning 
objects and layers on 

 

https://www.originlab.com/doc/User-Guide/Toolbars
https://www.originlab.com/doc/User-Guide/Toolbars
https://www.originlab.com/doc/User-Guide/Toolbars
https://www.originlab.com/doc/User-Guide/Toolbars
https://www.originlab.com/doc/User-Guide/Toolbars
https://www.originlab.com/doc/User-Guide/Toolbars
https://www.originlab.com/doc/User-Guide/Toolbars
https://www.originlab.com/doc/User-Guide/Toolbars
https://www.originlab.com/doc/User-Guide/Toolbars
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the page. 

11.3 Menus, Dialogs and Buttons Used in Graph Customization 

Many quick graph customizations can be done using Origin's graphing Mini Toolbars. More complex 
customization options can be accessed from commands on the Format or Graph menus. The following table 
lists key menu commands and dialog boxes plus a few toolbar buttons, used in customizing graphs.  

Task  Dialog Name  Method  

Customize the graph 
Page, Layer, or Data 
Plot  

Plot Details dialog  

Double-click on Page, Layer or Data Plot 

Format: Page... menu 

Format: Layer... menu 

Format: Plot... menu 

See, Customizing Page, Layer and Data 
Plots  

Customize Axes  Axis Dialog   

Double-click on axes or tick labels 

Format: Axes... menu 

Format: Axis Tick Labels... menu 

Format: Axis Titles... menu 

See, Customizing Graph Axes  

Add a Default Legend  
(most 2D graphs)  

N/A  

Click the Reconstruct Legend 

(CTRL+L)  button on the Add Object 
to Graph toolbar 

Right-click on the legend object and 
choose Legend: Reconstruct Legend 

Choose Graph: Legend: Reconstruct 
Legend from the main menu 

See, Graph Legends  

Customize the Legend   

(Text Object -) Legend 
dialog  

Ctrl + double-click on the legend object 
text 

See, The (Text Object Properties) Text 
tab  

Update Legend dialog  

Right-click legend and choose Legend: 
Update Legend or choose Graph: 
Legend: Update Legend... 

See, The legendupdate Dialog Box  

https://www.originlab.com/doc/User-Guide/Customizing-Graphs
https://www.originlab.com/doc/User-Guide/Customizing-Graphs
https://www.originlab.com/doc/User-Guide/Customizing-Graphs
https://www.originlab.com/doc/User-Guide/Customizing-Graphs
https://www.originlab.com/doc/Origin-Help/TextOb-Prop-Text-tab
https://www.originlab.com/doc/Origin-Help/TextOb-Prop-Text-tab
https://www.originlab.com/doc/Origin-Help/legendupdate-dlg
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Legends/Titles tab at 
Page level of Plot 

Details dialog  

Double-click in the white area just inside 
graph window frame (but outside of the 
data plot), then click on the 
Legends/Titles tab 

Choose Format: Page and click on the 
Legends/Titles tab 

See, The (Plot Details) Legends/Titles 
tab  

Add a Color Scale 
(color-mapped plots)  

N/A  
Click the Add Color Scale  button on 
the Add Object to Graph toolbar  

See, Color Scales  

Add a Bubble Scale 
(symbol-size mapped 
plots)  

N/A  
Click the Add Bubble Scale  button 
on the Add Object to Graph toolbar  

See Bubble Scale  

Merge multiple graph 
windows into one graph 
window  

Merge Graphs dialog  

Graph: Merge Graph Windows... menu 

See, Merge and Arrange Graphs 
(tutorial) and The Merge Graph Dialog 
Box.  

Adjust multi-layer 
graphs: 
resize, move, swap, 
align, or add layers  

Layer Management 
dialog  

Graph: Layer Management... menu 

Right-click on the layer icon. 

See, Layer Management-Quick Start  

Simple adjustment of 
multi-layer graphs: 
arrange and/or resize 
layers  

Arrange Layers dialog  
Graph: Arrange Layers... menu 

Right-click on the layer icon. 

Save settings as graph 

template  
Save Template As dialog  

File: Save Template As... menu 

Right-click graph window title and 

choose Save Template As... 

See, Graph Template Basics  

Manage graph 

templates, 
plot to a template  

Template Library   

Plot > Template Library menu 
(worksheet or matrixsheet is active) 

See, The Graph Template Library  

Save settings as graph 
Theme  

Save Format as 
Theme dialog  

Right-click and choose Save Format as 
Theme... context menu (graph is 

https://www.originlab.com/doc/Origin-Help/PD-Dialog-LegendTitles-Tab
https://www.originlab.com/doc/Origin-Help/PD-Dialog-LegendTitles-Tab
https://www.originlab.com/doc/Origin-Help/ColorScale
https://www.originlab.com/doc/Origin-Help/BubbleScale
https://www.originlab.com/doc/Tutorials/GSB-Merge-Arrange-graphs
https://www.originlab.com/doc/Origin-Help/GraphRef-MergeGraph
https://www.originlab.com/doc/Origin-Help/GraphRef-MergeGraph
https://www.originlab.com/doc/Origin-Help/Layer-Management-Quick-Start
https://www.originlab.com/doc/Origin-Help/Graph-Template-Basics
https://www.originlab.com/doc/Origin-Help/Graph-Template-Gallery
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active) 

See, Saving Formats to a Theme  

Manage Graph Themes: 
edit, combine, apply 
Theme, set as System 
Theme  

Theme Organizer 
dialog  

Preferences: Theme Organizer.. > 
Graph tab. 

F7 hotkey. 

See, Theme Organizer  

11.4 Quick Editing: Mini Toolbars and Object Manager 

While the dialog boxes listed in the previous section will provide full access to plot properties, settings are 
sometimes buried and hard to find. Often, the most convenient way to carry out common graph editing tasks 
is to use Mini Toolbar buttons or Object Manager short-cut menu commands -- or a combination of the two.  

11.4.1 Mini Toolbars for Graph Editing 

Most Origin graphs support a set of "quick editing" tools for interactively modifying common graph object 
properties. Tools are context-sensitive so that -- (1) depending on where you click inside the graph window, 
(2) what the selected object is and (3) whether you have selected an individual plot or a plot group -- you will 
have a different set of tools available to edit your selection.  

 

Workspace display of Mini Toolbars is controlled via View: Mini Toolbars. 

There are five levels -- i.e. five groupings of graph properties -- that can be edited with Mini Toolbars: page, 
layer, plot, text or drawn objects and graph axes.  

When editing grouped plots, a single click will select a single plot. The Mini Toolbar displays two tabs -- one for 
the customizing the group, the other for customizing the single plot.  

https://www.originlab.com/doc/Origin-Help/ThemeRef-SaveFormat
https://www.originlab.com/doc/Origin-Help/ThemeRef-ThemeOrganizer
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Most Mini Toolbars have a "properties" button that opens a related Origin dialog box where you will find 
the full range of available controls. 

 

Unless you have changed your selection, you can do a one-time restore of a Mini 
Toolbar after it has faded by pressing the SHIFT key.  

 

 

If you disable selection of individual graph layers, plots and graphic objects with the 

Selectable Mini Toolbar button, these elements remain selectable in the Object Manager 
(OM).  

To restore graph window selectability,  

Highlight the element in OM, and click the Mini Toolbar Selectable button again (Hint: If 
OM doesn't list plots in the active graph window, right-click on OM and Show Plots. 
Likewise, if OM only shows plots, right-click on OM and Show Graph Objects). 

 

11.4.1.1 Controlling Buttons that Increment 

Some Mini Toolbar buttons will increase or decrease some property by some increment, each time you click 
the button (e.g. font size, rotation angle, layer grid spacing). In such cases, you can modify that increment by 
manipulating the value of a LabTalk system variable.  

 

 

For information on these LabTalk system variables, see this Appendix in Origin Help.  

https://www.originlab.com/doc/Origin-Help/Mini-Toolbar
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11.4.2 Manipulating Graphs with the Object Manager 

The Object Manager is general tool for managing Origin windows but it is especially useful for manipulating 
graph windows. When a graph window is active, the Object Manager offers alternate views -- toggled by right-
clicking in an empty portion of the Object Manager and choosing Show Plots or Show Graph 
Objects(Ctrl+Shift+S):  

Show Plots: a collapsible, hierarchical list of plots by layer, plot group, etc. 

Show Graph Objects: a collapsible, hierarchical list of window objects (legends, text objects, images, etc.) 
by layer. 

 

Object Manager Tips:  

Whether in Show Plots or Show Graph Objects view, right-clicking on an element will open a shortcut menu 
of relevant actions (ungrouping a set of plots or designating a plot as the first plot in a plot group, for 
instance).  

Common to both views is a check box beside each element; when checked, the element displays in the graph 
window, when cleared, the element is hidden. 

Besides openning Plot Details to rename the layer, you can right-click on the layer icon (e.g. Layer1) in 
Object Manager and choose Rename. 
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Additional shortcuts give quick access to source data, to Plot Details, allow you to rearrange plot or object 
order and to other relevant tasks such as opening an inserted image in an Image window for further editing. 

11.4.3 Editing Graphs Using Object Manager and Mini Toolbars 

When a graph is active and you select graph elements in the Object Manager, a Mini Toolbar will show (make 
sure the Mini Toolbars option is checked in the Show Plots/Show Graph Objects shortcut menu as shown 
in the image above).  

With the available buttons, you can make quick customizations to common plot properties such as line color, 
line thickness, display of labels, etc.  

 

 

In Object Manager Show Graph Objects view, there is a Select All with Same 
Name shortcut menu entry. Use in combination with Mini Toolbar buttons (e.g. Font 
Size) to make quick graph changes.  

11.4.3.1 Example: 1 Layer, 2 Y Axes 

There is now general support for "Double-Y" graphs in a single layer. Previously, two independent Y axes 
meant "two layers." Beginning with Origin 2023 the user can create Double-Y graph in single layer using only 
the basic plot type templates using new GUI controls,.  

In the following simple example, the user has plotted four Y datasets against a single X dataset. Because 
values in two of the Y datasets are of an order of magnitude larger than values in the other two, two plots 
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appear "flat" and seem to show little variation with changes in X. However, using a combination of Object 
Manager and Mini Toolbars, we can select the "flat" plots and Plot on Right Y. With a more appropriate 
scale, the plots no longer appear flat.  

 

 

In addition to the above simple example, you can find an example of a single-layer 
Double-Y Violin Plot in your Learning Center samples by pressing F11 and searching 
on "2023". Also, Origin includes some templates for simple cases, see Multi-
Panel/Axis section for more information.  

11.5 Customizing Page, Layer and Data Plots 

 A graph window is a collection of objects, organized in a hierarchical structure. As we shall see, there are 
editable properties at the Page, Layer, Data Plot and Data Point levels.  

Quick formatting of many plot properties can be done using Mini Toolbar or dockable toolbar buttons, as 
mentioned above. However, more comprehensive access to plot properties is available from each graph's Plot 
Details dialog box.  

 
To open Plot Details:  

Double-click on your plot. 

Click the Format menu, then choose Page..., Layer... or Plot..., to open Plot Details at the corresponding 
level. 

The figure below shows an example of the Plot Details dialog box:  

The left panel depicts the Page > Layer > Plot hierarchy as an expandable/collapsible tree. 

The right panel contains controls, organized by tabs, that pertain to the object that is currently selected in the 
left panel.  

To customize an object, select it in left panel and modify the corresponding properties that appear on the 
various tabs in the right panel.  

https://www.originlab.com/doc/User-Guide/Graphing
https://www.originlab.com/doc/User-Guide/Graphing
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Selected Left 
Panel Object  

Right Panel, Controls for...  

Page  
Settings that pertain to the whole page -- Print/Dimensions, layer drawing 
orders, page display color, legends/titles, etc.  

Layer  

Settings that are specific to the graph layer -- Layer background colors, layer 
size and speed mode settings, layer display settings, stack settings for applicable 
plot types. Some plot types will include extra tabs/controls specific to the plot 

type.  

Plot  

Plot-specific properties. The tabs and controls vary by plot type (e.g. Scatter 
plots have a Symbol tab with controls pertaining to scatter symbols, Line plots a 
Line tab with controls pertaining to line plots). Anything to do with a particular 

data plot -- color, fill patterns, colormapping, labeling -- will be found at this 
level in Plot Details.  

Data Point  Properties that apply to user-specified "special points". Available for any plot for 
which plots discrete points (scatter, line + symbol, column/bar, etc.). The tabs 

https://www.originlab.com/doc/Origin-Help/Customize-Plot-Element
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and controls are generally similar to those available at the Plot level but any 
property that you set at the level of a special point, will apply only to that point.  

 
:

  

 

Prevent text and label objects from scaling when resizing layer, by going to the Size 
tab of Plot Details (Layer level) and setting Fixed Factor to 1.  

11.5.1 Customizing Grouped Plots 

  

 

Beginning with Origin 2020, there was a change in selection behavior that affects 
grouped plots. Now, a single-click on a plot selects the plot. A second click (or 

CTRL+click) selects a single point. SHIFT+click selects the entire group. Note that when 
using the new mini toolbars, a single click on a plot group displays tools for editing the 
plot group or the single, selected plot. To revert to the old plot selection behavior, set 
@GSM=0.  

https://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
https://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
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When you select and plot multiple data ranges to a single graph layer, the plots are grouped in the layer. 
Generally speaking, plots within a group are automatically differentiated by assigning styles built from one or 
more customizable "increment lists", one for each plot property (symbol shape, symbol color, line style, etc.).  

By default, some properties are configured to increment "by one" (e.g. line color is assigned according to the 
"Candy" color list and each successive plot is assigned the next color in the list) and some will be configured 
not to increment (e.g. line style is solid for every plot), though this is ultimately controlled by the user. In any 
case, the increment lists for each property are saved with the graph template (.oggu) or Theme file (.oth) so 
that you can easily use them later to create graphs with the same look.  

 

 

 

The above image shows the Plot Details Group tab settings for a line + symbol plot in the upper-left. On this 
Group tab, the first column lists Line Color, Symbol Type, Line Style Symbol Edge Color and Symbol 
Interior. Properties of Line Color, Symbol Type and Symbol Edge Color are set to increment By One and 
Between Subgroups (subgrouping occurs using the column Comments), while Line Style and Symbol 
Interior are set to increment by None (they do not vary).  

As previously mentioned, this arrangement is completely customizable and you can save customizations with 
the graph template:  

To find out more about customizing of grouped and subgrouped plots, see The Plot Details Group Tab Controls. 

To find out more about saving graphs as templates, see Graph Template Basics. 

11.5.1.1 Using Object Manager with Grouped Plots 

To highlight a single plot and dim others (grouped or ungrouped) in the layer, click once on the plot in Object 
Manager. Conversely, clicking once on a plot in the Object Manager, highlights the plot in the graph window, 
while dimming others. 

https://www.originlab.com/doc/Origin-Help/PD-Dialog-ColorList-Tab
https://www.originlab.com/doc/Origin-Help/PD-Dialog-Group-Tab
https://www.originlab.com/doc/Origin-Help/Graph-Template-Basics


Customizing Graphs 

209 

 

To reorder plots in the layer, drag a plot icon within the group; or right-click on the plot (in Object Manager) 
and choose Move Up or Move Down. 

 

To group or ungroup data plots in the layer, right-click on the group icon ("gN") and choose Ungroup. To 
group plots in the layer, right-click on a plot and choose Set as Group Begin. 

 

To move a plot from one group to another, drag the plot to the other group. 

To move a series of plots out of the group, right-click the last plot that you want to keep in the group and 
choose Set as Group End. 

To remove a plot from the layer (and the graph), right-click on the plot and choose Remove. 

To move a plot to a second Y axis, or move the plot to another layer, right-click on the plot in Object Manager 
and choose Move Plot to Second Y Axis or Move Plot(s) to Other Layer .... 

11.5.2 Customizing Multi-layer Graphs 

The graph layer is a fundamental concept in Origin and it is a primary building-block of most complex Origin 
graphs (e.g. a graph with both left and right Y axes may be constructed by overlaying one layer on another, 
and sharing a common X axis between the two layers). While the graph layer is, fundamentally, a self-
contained unit it is, at times, desirable to create dependencies between layers:  

https://www.originlab.com/doc/User-Guide/Graphing
https://www.originlab.com/doc/Quick-Help/Graph-Layer-Defination
https://www.originlab.com/doc/Quick-Help/Graph-Layer-Defination
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One type of dependency is what we call "linking" of layers, which involves establishing spatial relationships or 
relationships between axis scale values. You can read more about linking graph layers, below. 

Another type of dependency is based on what we call "common display" and this is most useful in a situation 
where we have multiple similar panels in a graph and we want to do something like change the background 
color of each graph, or perhaps the change plot colors used in each layer. 

At the graph page level in Plot Details, you will find a Layers tab that has controls that affect all layers within 
a given graph page. The Common Display controls can be used to enable simultaneous editing of layer, plot 
and axis properties of multi-layer graphs. For instance, in the following example, we have a two-layer trellis 

plot -- the two layers being necessitated by there being a left-Y axis and a right-Y axis with two completely 
different scales -- and as a simple illustration, we have used the Common Display controls to simultaneously 
add a background color to both layers. We could have accomplished the same thing without using the Common 
Display controls but this would have required twice the work -- set the background color of layer 1, then set 
the background color of layer 2.  

 

This was a simple illustration but we can use the Common Display controls for application of more complex mix 
of layer, plot and axis properties. Some of Origin's built-in multi-layer graph templates have Common Display 
elements turned on by default. When working with multi-panel graphs, you may want to choose Format: 
Page, click the Layers tab in Plot Details, and check the Common Display settings. See Common Display 
for more information.  

 

The Common Display Apply to control supports including or excluding certain layers 
from common display customizations. For instance, you might have a 4 panel graph, 
each with an inset layer and using this control, you could apply a common background 
color to the inset layers without applying the same background color to the 4 primary 
layers (panels). See Common Display for more information.  

11.5.3 Special Points: Customizing a Single Data Point 

https://www.originlab.com/doc/User-Guide/Customizing-Graphs
https://www.originlab.com/doc/Origin-Help/PD-Dialog-Layers-Tab
https://www.originlab.com/doc/User-Guide/Graphing
https://www.originlab.com/doc/Origin-Help/PD-Dialog-Layers-Tab
https://www.originlab.com/doc/Origin-Help/PD-Dialog-Layers-Tab
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 For some plot types such as scatter, column or pie, you can modify the display properties of a single data 
point.  

To edit a single point:  

Click twice (slowly) or press CTRL + click on a data point to select it. Use the Mini Toolbars to edit properties of 
the data point; or click available buttons on the Style or Format toolbars. 

For access to a wider range of customization options, (a) double-click on the selected point or (b) CTRL + 
double-click on an unselected data point. This opens the Plot Details dialog box with the focus set to edit the 
data point (identified in the left-panel of Plot Details by its row index number). Then use controls on the tabs 
in the right panel to modify the appearance of the data point, add drop lines, data label, etc. Changes you 
make to the special point will not affect the appearance of other points in the same plot. 

 

 

 

Note:: When the Custom Construction box is checked, you can use these controls to customize the 
plot symbol of the selected point. Custom Construction can be applied to any plot symbol -- not simply 
those that are designated as special points.  

 

 

https://www.originlab.com/doc/Origin-Help/PD-Dialog-Sym-Tab
https://www.originlab.com/doc/Origin-Help/PD-Dialog-Sym-Tab
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Origin supports adding your own plot symbols. For more information, see User 
Defined Symbols Grid.  

 
To remove customizations made to a single data point:  

Right-click the single point in the left panel of the Plot Details dialog and choose Delete. 

In the graph window, click on the single point to select it, then press DELETE on the keyboard.  

The point itself is not deleted; only the custom style is removed, with the point reverting to the style of the 
containing data plot.  

 

Adding a special point at the beginning or end of a plot is not always easy, but there is a 
simple, foolproof technique:  

Select a special point anywhere on the plot, then double-click on the point to open Plot 
Details. 

In the left-hand panel of Plot Details, click once on on the point index number and wait 
until the index number becomes editable.  

 

To add the special point to the first point in the plot, type Begin; to add to the last point 
type End. If you know the index number of the first or last point, you can type that 
instead. 

Click outside the edit box. Make other special point customizations as needed, the click 
Apply or click OK to close Plot Details. The special point will be added to the beginning or 
end of your plot. 

11.6 Customizing Graph Axes 

  Many common edits to axis properties can be done quickly from Mini Toolbar buttons. Click on an element 
to edit.  

https://www.originlab.com/doc/Origin-Help/Options-Dialog-Graph-Tab
https://www.originlab.com/doc/Origin-Help/Options-Dialog-Graph-Tab
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For more complex edits of axis properties, open the Axis Dialog:  

from the Axis Mini Toolbar > Open Properties Dialog.  

from the Origin menu > Format: Axes. 

11.6.1 Customizing Axes with Mini Toolbars 

For quick adjustments to axis properties, you can use Origin's axis Mini Toolbars. As with all Mini Toolbars, 
available tools will vary by plot type and selected object. For instance, note that clicking on a graph axis line 
brings up a different set of buttons than clicking on the axis tick labels.  

 

Note that clicking the "gear" button on the axis line Mini Toolbar produces a popup menu with simplified "Mini 
Dialogs" for axis line elements. For access to all axis settings, click Axes Dialog on either toolbar.  

11.6.2 Customizing Axes with the Axes Dialog Box 

All graph axis customizations can be made in the Axes Dialog box. Click on the Mini Toolbar "gear" button 
and choose Axes Dialog; or double-click on the graph axis or tick labels. This will open the Axis Dialog - 
Layer N dialog box.  

 

This image shows the tab-based axis dialog used by most 2D and 3D graphs.  



UserGuide 2026 

214 

 

In the left panel, you can select one or more icons (hold the CTRL key to select multiple icons) to specify the 
axis or axes to be customized, then select the desired tab and choose your options. 

Click the Apply To... button to apply the axis format settings of the currently selected axis to another axis. 

 

Tab  Controls for  

Scale  
Scale range of values, scale type, rescale mode and margin, reverse scale, major and minor 
ticks.  

Tick 
Labels  

Display and Format options for major and minor tick labels, including custom labeling using 
LabTalk substitution or mathematical expression. For information on custom formatting of 
numeric data including display of percentages, fractions, pi, and geographic (Lat/Lon) formats, 
see Origin Custom Formats.  

 

Font size of major and minor tick labels can be scaled separately 
(Axis Dialog > Tick Labels > Minor Tick Labels > Font 
Scaler(%)).  

https://www.originlab.com/doc/LabTalk/ref/Origin-Formats
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Title  
Axis title (often set using variable notation) and font options. Note that you can directly edit 
by double-clicking the text object in the graph.  

Grids  Control display and properties of grid lines at major and minor ticks.  

Line 
and 
Ticks  

Global axis line and tick display options for all axes.  

Specia
l Ticks  

Placement of special tick labels.  

Refere
nce 
Lines  

Reference lines are optional lines that you add to your graph, either for emphasis or to mark 
some key statistic. Additionally, they can be paired to add fill color to some portion of your 
graph (e.g. "recession bars" in plots of financial data).  

 

You can use named ranges to place Reference Lines on a graph. 

You can set a default line style for Reference Lines -- either in the 
Reference Lines dialog or in a customized graph -- by right-clicking 
on the Reference Line and choosing Set as Default Line Style. 

 

 

Breaks  Enable line breaks and configure each break.  

https://www.originlab.com/doc/Origin-Help/AxesRef-RefLines
https://www.originlab.com/doc/User-Guide/Worksheets-Columns
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Note: For more information on axis customization and for axis controls for specialized graph types (e.g. 
polar, ternary, radar chart.etc), refer to:  

Help: Origin: Origin Help > Graphing > Graph Axes  

11.7 Customizing Data Plot Colors 

Origin ships with a number of installed color lists or palettes. If you prefer to create your own color lists or you 

have a standard set of palettes and want to port them over to Origin, there are a number of tools available in 
the software for doing that. See the next section, Color Manager, for more information.  

11.7.1 Color Manager 

Use the Color Manager for importing, creating and organizing the color lists and palettes that you use in 
Origin:  

 
To open the Color Manager:  

Choose Preference: Color Manager. 

 

The following list numbers correspond to controls shown in the image above:  

Click these radio buttons to display installed Color Lists or Palettes. 

Click Import from Web to open a dialog where you can specify a URL to install palettes. Support for Scribus 
(.xml), Office Color Table (.soc), Adobe Color (.aco), Adobe Color Table (.act), Adobe Swatch Exchange (.ase) 
and JASC PaintShopPro (.pal). 

Click to install locally-stored palettes. Support for Scribus (.xml), Office Color Table (.soc), Adobe Color (.aco), 
Adobe Color Table (.act), Adobe Swatch Exchange (.ase) and JASC PaintShopPro (.pal). 

Click to open the Build Colors dialog where you can build a color using a number of tools: using standard 
color controls, direct entry of HTML codes or use an eye-dropper tool to pick onscreen colors. You can read 
more about the Build Colors dialog in the Origin Help file. 

Right-click on the Available list(s) to:  

Delete or Rename lists (you can also rename by clicking directly on the name). Lists that are dimmed have 
already been Selected for GUI. Those that are Selected for GUI appear from drop-down lists throughout 

https://www.originlab.com/doc/Origin-Help/GraphAxes
https://www.originlab.com/doc/Origin-Help/Color-Manager
https://www.originlab.com/doc/Origin-Help/Color-Manager
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the user-interface -- in Plot Details, from the Fill Color button on the Style toolbar and from the Mini 

Toolbar Fill Color button when a plot or special point is selected. 

Merge Color two or more Color Lists/Palettes selected in the Color Manager. Note that the total number of 
colors in selected lists/palettes cannot exceed 256 (i.e. Merge Color will not be available).  

Use the list control to set Category = Undefined, Sequential, Diverging or Qualitative. 

Use these controls to add or remove color lists and palettes from the user-interface (GUI). 

Use these controls to move a selected list or palette up or down in the various GUI color lists. 

Click Set Default Plot Colors to open the Theme Organizer's System Increment Lists tab, where you can 
set default colors for use in your plots. 

Drag list-number icons to rearrange GUI color list order. 

11.7.2 Applying Color to Your Graphs 

There are many options for applying color to your graphs. We will try and cover the basics here, pointing you 
to other resources for more in-depth discussion.  

 
List of key topics on the subject of plot color:  

The Color Manager 

Customizing Data Plot Colors 

Using a Dataset to Control Plot Color 

The Plot Details Color Map/Contours Tab Controls for 3D and Contour Plots 

11.7.2.1 Applying Colors Singly 

 

 

Picking and applying a single custom color has been made easier with the addition of 
the "eyedropper" tool to the Single tab of the Color Chooser. Previously, the 
eyedropper tool was buried in the Build Colors dialog.  

Applying colors singly simply means applying a single color to a plot as opposed to applying color from a color 
list to a series of plots. It is the most basic way to apply color to a single plot or special point. Simply select a 
color well from anywhere on the Single tab -- from the LabTalk colors at the top, from a selected color list, or 
from a custom or recently used color.  

https://www.originlab.com/doc/Origin-Help/ThemeRef-ThemeOrganizer
https://www.originlab.com/doc/Origin-Help/Color-Manager
https://www.originlab.com/doc/Origin-Help/Customize-PlotColor
https://www.originlab.com/doc/Origin-Help/PlotColor-DatasetControl
https://www.originlab.com/doc/Origin-Help/PD-Dialog-ColorMapContour-Tab
https://www.originlab.com/doc/Origin-Help/Color-Manager
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Select a plot (e.g. scatter plot) and click the Fill Color button on the Mini Toolbar that appears. 

Select a plot and click the Fill Color button on the Style toolbar. 

Double-click on a plot to open the Plot Details dialog box where you can click on a tab to the right side (e.g. 
Symbol tab for a scatter plot) and set color for the element. 

To create a special point -- i.e. to assign special characteristics to one data point in your plot -- press 
Ctrl+click to select the point, then use the Mini Toolbar, Style toolbar or Plot Details controls to customize 
color for that point.  

 

11.7.2.2 Applying Colors By Points 

Applying colors By Points generally means applying a color to each point in a plot by one of several schemes. 
The simplest involves picking an Increment From color from a predefined color list and assigning colors, in 
sequence, to each point in the plot.  
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As in the case of applying a single color, you can apply these settings using controls in Plot Details; or by 
selecting the plot and using the Fill Color buttons on the floating Mini Toolbar or Style toolbar docked to the 
top of your workspace.  

Other schemes typically make use of a column of values to assign color to points:  

Indexing assigns point color by associating an integer or text string (categorical value) to different colors in a 

list. 

Direct RGB assigns color using a value derived from columns of RGB values. 

Color Mapping -- used for 2D, Contour and 3D plots -- assigns colors in a list or palette, to values across the 
range of the plot's Y or Z values. 

There are several other schemes which are specific to a certain plot type (or family of plots), but the list above 
covers most of what you will use. For more information see Using a Dataset to Control Plot Color.  

11.7.2.3 Applying Colors By Plots 

You apply color By Plots when you want to assign differentiating colors to a series of plots. Typically, this 
series of plots comprises a "plot group." In a plot group, plot attributes including color, are assigned to each 
plot by incrementing through a style list -- color, line-style, symbol shape, etc.  

 

https://www.originlab.com/doc/Origin-Help/PlotColor-DatasetControl
https://www.originlab.com/doc/Origin-Help/PlotColor-DatasetControl
https://www.originlab.com/doc/Origin-Help/PlotColor-DatasetControl
https://www.originlab.com/doc/Origin-Help/PlotColor-DatasetControl
https://www.originlab.com/doc/User-Guide/Graphing
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From Origin 2023, a new way to apply a color palette to 3D bar charts is available. The 
method works best for 3D bars as it allows you to apply a color palette by Z value (this is 
neither "apply colors by plots" in the above sample graph, nor "applying a colormap" as 
described below, but something unique to 3D column/bar plots).  

 

To find out more about this graph customization, press F11 and on the Learning Center 
Graph Samples tab, set the drop-down list to 3D Bar Charts and search on "gradient."  

11.7.2.4 Applying Colormaps to 2D, 3D and Contour Plots 

While you can use a color list with a contour or 3D plot, it is probably more common that you will use a color 
palette. This allows a wider range of color variation and can add realism to 3D surfaces and 3D function plots.  
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You can add new color palettes to Origin by drag-and-drop. Support for Scribus (.xml), 
Office Color Table (.soc), Adobe Color (.aco), Adobe Color Table (.act), Adobe Swatch 
Exchange (.ase) and JASC PaintShopPro (.pal).  

Colormapping can also be applied to 2D plots. This allows you apply a greater range of color variation to data 
points than would be possible with incrementing or indexing. A good example of applying a color map to a 
scatter plot would be Origin's Density Dots plot in which, typically, thousands of scatter points are plotted 
and an algorithm is used to calculate point density and assign color to ranges of point densities.  

 

Applying a colormap to a 3D or contour plot is much the same as applying color singly, by points or by plots. 
You select a plot -- then using the Palette button on the floating Mini Toolbar or the Style toolbar. You pick 
a palette.  

 

You can also use the controls on the Colormap/Contours tab of Plot Details. This tab gives many more 
options beyond simply picking and applying a colormap.  
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For more information on applying color to colormapped plots, including contour and 3D surfaces, see these 
topics:  

The Plot Details Colormap/Contours Tab 

Tutorial: Contour Plots and Color Mapping 

Colormap Surface Graph 

Symbol Plot with Size and Colormap from Other Columns 

Parametric Surface with Colormap from Data 

11.8 Graph Legends 

11.8.1 How the Default Legend is Created 

   A graph legend is automatically created when you plot data. For most 2D and some 3D graph templates, the 
default legend combines (A) plot style information stored with the graph template, with (B) dataset 
information stored in the worksheet column label rows, and places the resulting legend object on the 
graph page.  

https://www.originlab.com/doc/Origin-Help/PD-Dialog-ColorMapContour-Tab
https://www.originlab.com/doc/Tutorials/Contour-Color-Map
https://www.originlab.com/doc/Tutorials/3D-Colormap-Surface
https://www.originlab.com/doc/Tutorials/Symbol-Plot-with-Size-and-Colormap-from-Other-Columns
https://www.originlab.com/doc/Tutorials/3D-ParaSurf-DataColormap
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Note that the default legend object is not created with literal text and plot symbols but instead is created from 
LabTalk script.  

This allows the legend object to be dynamically linked to plotted data and worksheet metadata, so that the 
legend can be updated when data or plot metadata change.  

Because construction of the legend object relies on scripting rather than literal information, you can save 
customizations to a graph template and recreate the graph with its accompanying legend object using new 
data, as often as is needed. 

 
The legend script relies on "substitution notation" to convert variable values to readable symbols and text. You 
can see this notation when you double-click inside of the legend object (as if to edit it).  

 

You control which dataset metadata are used in constructing the default legend text by setting the the 
Translation mode of %(1), %(2) list in the Legends/Titles tab of the Plot Details dialog box (Format: 
Page...). 

Custom strings can be constructed using LabTalk substitution. Customizations can be saved to the graph 

template for repeat use. 

 

Origin has a Fit Layers to Page tool that is useful for arranging a graph and a large, 
text-wrapped legend on the page.  

11.8.2 Adding and Updating the Default Legend 

The table below lists tasks associated with adding or updating the graph legend, and where to find editing 
controls for each legend type. Before proceeding, we should point out that there are two legend refresh 
modes:  

Updating a legend will preserve any customizations that you might have made to the existing legend, 
including size and position adjustments and legend symbol and text customizations.  

Reconstructing a legend will overwrite any customizations. When you add or reconstruct the legend, you are 
creating a copy of the legend that is stored in the graph template.  

https://www.originlab.com/doc/Origin-Help/PD-Dialog-LegendTitles-Tab
https://www.originlab.com/doc/Origin-Help/PD-Dialog-LegendTitles-Tab
https://www.originlab.com/doc/LabTalk/ref/Legend-Substitution-Notation
https://www.originlab.com/doc/Origin-Help/Fit-Page-Layer
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The legend object occasionally goes missing. If you cannot add or reconstruct your 
legend, there is a good chance it already exists but is outside of the page and can't be 
seen. Try clicking Graph: Legend: Reset Legend Position which should restore the 
legend to its default location.  

 
In addition, the graph template stores a Legend Update Mode setting that determines how the legend is 
refreshed when adding or removing data plots from the graph. See Controlling Legend Update, below.  

 

Task  Method (graph is active)  

Add or 
reconstruct 
legend  

Graph: Legend: Reconstruct Legend menu. 

Reconstruct Legend button  (Add Object to Graph toolbar). 

CTRL+L. 

 

Legend customizations not saved with the template, 
will be lost when you reconstruct.  

 

Update legend  

Open the legendupdate dialog box:  

Graph: Legend: Update Legend menu. 

Right-click on legend and select Legend: Update Legend. 

 
Note: "Updating" a legend does not overwrite legend customizations.  

Customizing 
special legends  

Right-clicking on these special legends opens a dialog box with customization 
options specific to each legend type:  

Categorical legends. 

Box chart legends. 

Point-by-point legends. 

Add color scale   

Only available for color-mapped plots (e.g Contour Plots).  

Click the Add Color Scale button  (Add Object to Graph toolbar). 

Right-click in the layer and select New Color Scale. 

Insert: Color Scale menu. 

When you have multiple color-mapped plots in a single graph window, you can 
click on each plot to select it, then add a corresponding color scale. 

Control color Available when a color scale object has been added to a graph. To open the 

https://www.originlab.com/doc/Quick-Help/zoom-all-show-graph-contents
https://www.originlab.com/doc/Quick-Help/zoom-all-show-graph-contents
https://www.originlab.com/doc/Origin-Help/PD-Dialog-LegendTitles-Tab
https://www.originlab.com/doc/User-Guide/Customizing-Graphs
https://www.originlab.com/doc/Origin-Help/Legend-CateData
https://www.originlab.com/doc/Origin-Help/pts-pts-legend
https://www.originlab.com/doc/Origin-Help/box-legend
https://www.originlab.com/doc/Origin-Help/PlotColor-DatasetControl
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scale  Color Scale Control dialog:  

Double-click on the color scale object. 

Right-click on the color scale object and choose Properties. 

Add bubble 
scale  

Available for bubble plot, or when symbol size is controlled by a dataset.  

Select Insert: Bubble Scale. 

Right-click in the layer and select New Bubble Scale.  

Click the Add Bubble Scale button in the Add Object to Graph toolbar. 

Right-click the legend to select Add Bubble Scale from the context menu. 

Control bubble 
scale  

Available when bubble scale object has been added to a graph. To open the 
Bubble Scale Control dialog:  

Double click on the bubble scale object. 

Right-click on the bubble scale object and choose Properties. 

 

 

The legendupdate dialog box and the Legend/Titles tab at page level of Plot 
Details both have an Auto Legend Translation Mode drop-down that determines 
which worksheet metadata (e.g. column Long Name, Comments, etc.) is used to 
generate the legend text. For a list of Custom options, see Legend Substitution 
Notation.  

 

Note: For more information on creating and customizing graph legends, see:  

Help: Origin: Origin Help > Graphing > Graph Legends and Color Scales  

11.8.3 Controlling Legend Update 

When a data plot is added or removed from a graph layer, the default behavior is to update the legend. The 
Legend/Titles tab at the graph page level in the Plot Details provides a Legend Update Mode drop-down 
to control this behavior.  

The default setting Update when Adding only affects the legend display of data plots that are added or 
removed. Previous legend customizations to existing plots, such as literal text entered manually, will be 
maintained.  

 

Tutorial: Customize legend and add data plots  

Start with a new project in Origin. 

Open Windows Explorer and navigate to the subfolder <Origin EXE 
folder>\Samples\Import and Export\ 

Shift-select the files S15-125-03.dat, S21-235-07.dat, S32-014-04.dat and then 
drag-and-drop the files onto an empty Origin workbook. The three files will be imported 
into three separate workbooks. 

https://www.originlab.com/doc/Origin-Help/PlotAttribute-DatasetControl
https://www.originlab.com/doc/LabTalk/ref/Legend-Substitution-Notation
https://www.originlab.com/doc/LabTalk/ref/Legend-Substitution-Notation
https://www.originlab.com/doc/Origin-Help/Legend-ColorScale
https://www.originlab.com/doc/Origin-Help/PD-Dialog-LegendTitles-Tab
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Click on one of the workbooks, select the column B, and create a line plot. 

Right-click on the legend and select Legend: Update Legend... to open the 
legendupdate dialog. 

Change the Auto Legend Translation Mode drop-down to Custom, and in the edit 
box that appears below, enter the string: 
@WS, @LD3 
and then press OK to close the dialog box. The legend updates, displaying the sheet 
name and the third user parameter. 

Click on the second workbook, select column B, move the mouse over the right-edge of 

the column until it changes to , and then drag-and-drop this data onto the graph 
to create a 2nd data plot.  

Repeat the procedure with column B from the third workbook. The graph will now 

display three data plots, and the legend will automatically update to display the 
identifier for all three plots.  

Click on each individual curve and use the Style toolbar to set a different line color for 
each. The legend will automatically update and display the new line color. 

 

11.8.4 Special Legend Types 

As mentioned, Origin supports these specialized legends for use with specific graph types. These legends can 
be customized and updated similarly to the Data Plot legend used by most 2D graph types.  

Legend Type  Menu to Create  Used in situations where ...  

Legend for Graph:Legend:Categorical At least one plot attribute (e.g. color, 
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Categorical Values  Values  symbol shape.etc) is controlled by data 
indexing.  
 
See the Legend for Categorical Values 
help page.  

Point by Point 
Legend  

Graph:Legend:Point by Point  

The plot symbol style is controlled by 
data indexing, an increment list, or 
color mapping.  
 
See the Point by Point Legend help 
page.  

Legend for Box 
Chart Components  

Graph:Legend:Box Chart 
Components  

The graph is a box chart, or a grouped 
box chart.  
 
See the Legend for Box Chart 
Components help page.  

11.8.5 Tips for Quick Legend Edits 

Many edits to the graph legend can be made from the legend's Mini Toolbars. The default legend for 2D graphs 
has two Mini Toolbars:  

The Legend toolbar -- available when you select the legend object -- has general controls for font, legend 
reconstruction, reversing order, etc. Click on the legend object to produce the blue selection handles. 

 

You also gain quick access to more complex controls such as Data Plot Legend Translation Mode -- 
identifying the column label row metadata that you wish to use to create your graph legend. 

 

The Legend Symbol toolbar becomes available when you click on a legend symbol. Use it to change symbol 
or pattern block height and width, line thickness, etc. 

https://www.originlab.com/doc/Origin-Help/Legend-CateData
https://www.originlab.com/doc/Origin-Help/pts-pts-legend
https://www.originlab.com/doc/Origin-Help/box-legend
https://www.originlab.com/doc/Origin-Help/box-legend
https://www.originlab.com/doc/Origin-Help/Mini-Toolbar
https://www.originlab.com/doc/Origin-Help/PD-Dialog-LegendTitles-Tab
https://www.originlab.com/doc/Origin-Help/Mini-Toolbar
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In addition to the Mini Toolbar for the default legend, there are toolbars specifically for Color Scales and 
Bubble Scales.  

 
To format your legend or scale using a Mini Toolbar:  

 

Select a legend or legend component (e.g. legend symbol). A Mini Toolbar with context-specific buttons will 
show.  

If the toolbar fades too quickly, restore it by pressing the Shift key. 

 

To format multiple legend objects on a page using a Mini Toolbar, press Ctrl and select 
the objects. Release Ctrl to display a Mini Toolbar for editing. Alternately, when the 
graph window is active, go to Object Manager and right-click on a legend object and 
choose Select All with Same Name and use the Mini Toolbar that appears in the 
Object Manager space  

.  

11.8.5.1 Other Legend Editing Tips 

Apart from the Mini Toolbar buttons, you can also right-click on the legend object, choose Legend and open a 
shortcut menu with some useful commands such as Text Color Follows Plot, Reverse Order, and Show 
Legend for Visible Plots Only. The same menu commands are available from Graph: Legend.  

Both the Mini Toolbar and the shortcut menu have an Arrange in Vertical/Horizontal button/command for 
changing the legend aspect; or you can modify it interactively by selecting the legend object, then pressing 
CTRL while dragging a selection handle (e.g. drag horizontally to create a legend that is all on one line).  

 

You can modify the white space around legend entries in the default 2D legend, by clicking precisely on the 
legend frame and dragging the selection handles.  

https://www.originlab.com/doc/Origin-Help/Mini-Toolbar
https://www.originlab.com/doc/Origin-Help/Mini-Toolbar
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While plot metadata stored in column label rows is an ideal source for legend text, you can simply overwrite 
the existing legend text with literal text. Either double-click on the legend text to enter in-place edit mode or if 
that proves to cumbersome, right-click on the legend and choose Properties (taking care not to overwrite the 
"\l( )" notation that creates the plot symbol). CTRL + double-clicking on the legend will also open the this 

dialog.  

As discussed above, the default legend is automatically-generated by combining worksheet metadata with 
customizable plot styles. However, there are times when your auto-generated legend needs some "tweaking":  

 

One common legend customization is to manually add legend symbols and text that are independent of any 
data plot (you can read about that here). Besides frequently used symbol, you can also add an independent 
Color Block (1):  

Right-click on the legend object and choose Properties to open the Text Object - Legend dialog. 

https://www.originlab.com/doc/Quick-Help/Customize-AxisTitle
https://www.originlab.com/doc/Origin-Help/Legend-ColorScale
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Click the Add Legend Symbol button . 

Enable Color Block, customize the block and click Add.  

Manually add text at the end of the string that is used to generate the block before closing Properties. 

Another desirable adjustment is to add some white space between legend entries. This is done using the 

Separator button on the Text Object - Legend toolbar (2).  

In the upper panel of the Text Object - Legend dialog, place the cursor at the end of the line preceding where 

you want to place the separator, then click the Separator button  (hint: separator thickness can be 
controlled by editing the numeric portion of the inserted syntax \sep:50). 

If you are adding special characters to the legend manually, there is a simplified Symbol Map dialog for doing 
that. Most-used symbols are arranged on tabs for easy access. To access the full Symbol Map dialog, click the 
Advanced button. 

 

Double-click a legend symbol to open the Plot Details dialog box.  

Any changes that you make to the legend can be saved with the graph template (File: Save Template As) If 
you do not want a legend object added to your graph each time you create the graph, delete the legend object 
and re-save the graph template.  

11.9 Annotating Your Graph 

 When we speak of "annotating" a graph, we are talking about adding text or drawing objects to the graph. 
Generally, these "annotations" help to enhance the graph in some way -- add a page title, add an arrow to 
draw attention to some graph feature, label data points, add a date-time stamp to note the time of graph 
creation, etc.  

Annotating a graph can be as simple as adding a static text object and formatting it with Mini Toolbar 
buttons. Or you might add a more complex object that is dynamically linked to a variable value or to some 
LabTalk script that is executed whenever some user-specified event occurs.  

The following table lists some common graph annotation tasks and available tools for accomplishing those 
tasks:  

Task  Method  

https://www.originlab.com/doc/Origin-Help/OFileType-Template
https://www.originlab.com/doc/Origin-Help/LinkVar-TextLabel
https://www.originlab.com/doc/Origin-Help/LinkVar-TextLabel
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Label Data 
Points and 
Plots  

Choose Format: Plot ..., then click the Label tab and select Enable (not available for 
all plot types). 

Select a plot and use the Mini Toolbar Show Data Labels button to turn on 
labels. Some label buttons may support formatting options for the data labels (hint will 
be a downward pointing arrow as on the button shown here). 

To label a single data point, click twice on the point (hint: not a double-click but a 
click, pause, click). When the single-point is selected, click the Show Data Labels 
button on the Mini Toolbar. 

For format options not supported by Mini Toolbars, you will generally use controls on 
the Label tab of Plot Details. Note that labeling options will depend on the plot type. 

Add Text 
Objects  

Click the Text Tool button, then click on the graph to place the object. 

Right-click on the graph and choose Add Text from the shortcut menu. 

Double-click on text to do rich text editing; or click on the object and use the text 
object Mini Toolbar to change font color, bold, align, wrap text, etc. 

Add Page Title  

To add a page title to the graph window, hover near the top of the page (just below 

the title bar) and click the Add Page Title Mini Toolbar button.  

 

Add Layer 
Title  

To add/modify layer title in the active layer, click on the graph layer, then click the 
Add Layer Title Mini Toolbar button; or right-click on the graph and choose 
Add/Modify Layer Title from the shortcut menu. 

 

This is a new type of text object which is (a) center-aligned horizontally on the layer 
and in which (b) wrap-text is enabled. Once a title is added, it can be toggled ON/OFF 
with the Mini Toolbar button.  

Add 
Vertical/Horiz
ontal Line  

With a 2D graph active, use the Insert: Straight Line... menu item. Note that this 
tool allows use of a simple LabTalk expression in the At Value field (e.g. 
"mean(plotdata(1,Y))" which translates to "mean of 1st plot's Y dataset") for 
positioning the line object. For information, see At Axis Value. 

Annotate a 
Data Point  

This is another another option for labeling individual data points. Click the Annotation 

tool on the Tools toolbar. See The Annotation Tool. 

https://www.originlab.com/doc/Origin-Help/AxesRef-RefLines
https://www.originlab.com/doc/User-Guide/Graphical-Exploration-of-Data
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Add Drawing 
Objects  

Use the corresponding toolbar buttons on Tools toolbar. Origin supports:  

Arrow, Curved Arrow. 

Line, Polyline, Curve, Freehand Draw. 

Rectangle, Circle, Polygon, Region. 

Insert 
Equation, 
Word Object, 
Excel Object, 
Other OLE 
Object   

Insert Equation button group on the Tools toolbar. For equations, note that you can 
download a free App from the OriginLab File Exchange, for adding LaTeX objects to 
worksheets and graphs.  

Insert 
Worksheet, 
Insert Graph  

Click the Insert Worksheet or Insert Graph buttons on the Tools toolbar 

(the two share a split button). This opens a browser dialog from which you can choose 
a worksheet or graph. Both insert an image object (name = WBook or GPage) into the 
graph. 

To style inserted tables(worksheets), including coloring alternating rows and a new 

Mini Toolbar for modifying the appearance of grids, frames, cell colors, fonts, etc. For 
more information, see Inserting Worksheets in Graphs (and Layouts). 

Insert Image  

Right-click on the graph and choose Insert Images From Files. You will be asked 
whether you want to insert your image as a background for the active graph layer. 

Answering yes will cause the image to be imported and placed behind plots, graph 
legends, text objects, etc. 

Add Table  

Click the New Link Table button on the Add Object to Graph toolbar and then 

click on the graph. 

From the main menu, choose Insert: Table. 

To edit table content, double-click the table object.  

To format the table, select it and use the available Mini Toolbar. 

https://www.originlab.com/fileExchange/details.aspx?fid=221
https://www.originlab.com/doc/Origin-Help/Graph-InsertWks
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Insert Date & 
Time Stamp  Date & Time button on the Add Object to Graph toolbar. 

Insert Project 
Path  Project Path button on the Add Object to Graph toolbar. 

Add Bracket 
with Asterisk  

To indicate statistical groupings, click the Add Asterisk Bracket button on the 
Add Object to Graph toolbar.  

To change bracket shapes, click on the barcket and select from drop-down list of 
Bracket Type Mini Toolbar button. 

 

Manually adjust the size and placement of brackets by dragging handles on the object. 

To format the bracket, click the bracket and use the Mini Toolbar buttons. 

Add XY Scale  

This is useful when using a nonlinear xy scale.  

New XY Scale button and click on a graph layer. 
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Select Insert: XY Scaler. 

11.9.1 Tips for Editing Your Graph Annotations 

 

Beginning with Origin 2021, use Alt+Enter when creating multi-line text objects. To 
revert to using Ctrl+Enter to insert a line break, set @FCA=1.  

Pressing CTRL when drawing with the Rectangle or Circle tools, will draw a square or circle (as 

opposed to a rectangle or ellipse). 

Use Mini Toolbar buttons for quick edits to selected objects. For more complex edits, right-click an object and 
choose Properties to edit object properties and set defaults. 

For text objects, including the axis titles and graph legends, you can edit text objects directly in "In-place Edit" 
mode. Double-click on a text object to edit. Use the Format toolbar buttons to add superscript, subscript, and 
Greek characters. 

You can enable text wrapping for text objects, including legend objects. Open the object's Properties dialog, 
click the Frame tab and enable Wrap Text, Adjust Height; or select the object and click the Wrap Text Mini 
Toolbar button.  

NEW: By default, there is an 80 character limit (with spaces) to in-place editing of wrapped text. Below this 
threshold, double-clicking on the object will put you into in-place edit mode; above the threshold, double-
clicking will open the Properties dialog. You can adjust this threshold using system variable @TLIP. 

NEW: When long text objects are not wrapped, you can use system variable @TLIPN (default = 60) to 
determine the character threshold for entering in-place edit mode or to open the Properties dialog, upon 
double-clicking. 

Note that while manual editing of axis titles and legends may be the best "quick solution", in most cases, you 
are better off using worksheet column metadata to automatically create axis title and legend text.  

Do NOT set font size while in "In-place Edit Mode" unless you need to mix font sizes within a single text object. 
The correct way to change font size is to click the text object once so that the green selection handles appear, 
then select font size from the Format toolbar. If you set while in In-place Edit mode, Origin will not indicate 
the proper font size when you hover on the text object. 

When you are in In-place Edit mode, you can right-click and choose Symbol Map to insert special characters 
into your text object. 

You can insert data from of a worksheet cell into a text object by copying and pasting the cell contents. While 
in In-place Edit mode in the text object, right-click and choose Paste or Paste Link. Data added by Paste is 
static; Paste Link is dynamic and thus, the text object will update if the data in the linked cell changes. 

Also, when in In-place Edit mode, you can right-click and choose Insert Info. Variable... to insert project 
variables into the text object. Since the pasted information is linked to a LabTalk variable value, the inserted 
data updates if the variable value changes. 

You can insert variable values into a text object using the LabTalk %, and $ substitution notation by setting 
the Link to (%,$), Substitution Level to 1 in the text object's Properties dialog box, Programming tab. 
Right-click on the text object and choose Properties from the shortcut menu. Alternately, you can use the 
Link to Substitution Mini Toolbar button, saving you from having to open the Properties dialog. 

 

https://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
https://www.originlab.com/doc/LabTalk/ref/sys-var-list
https://www.originlab.com/doc/LabTalk/ref/sys-var-list
https://www.originlab.com/doc/Quick-Help/Customize-AxisTitle
https://www.originlab.com/doc/Origin-Help/LinkVar-TextLabel
https://www.originlab.com/doc/Origin-Help/InsVar-Metadata-TextLabel
https://www.originlab.com/doc/Origin-Help/LinkVar-TextLabel
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You can use controls on the Programming tab of Properties to associate your LabTalk script with a text or 
drawing object (for instance, see Linking Text Labels to Data and Variables). Enter your script in the text box 
and specify a Script, Run After condition for running the script. Use the Apply to drop-down to set the scope 
for the script. 

You can copy a range (of cells) from a workbook and paste it into a graph as a table object. Table content is 
(a) edited by double-clicking on the object and (b) can be formatted using Mini Toolbar buttons. 

 

 

You can add text formatting (e.g. super-/subscripting) to non-consecutive characters 
via the text object's Properties dialog:  

Right-click on the text object and choose Properties. 

On the Text tab, press CTRL and in the text box, highlight multiple characters by 
dragging with your mouse. 

Click the desired text formatting button above the text box and click OK to close. 

11.9.1.1 Simple Symbol Map 

The Simple Symbol Map is a "settings" menu to assist in managing symbols.  

To insert a symbol, highlight the symbol and click Insert. 

For help with Advanced or other dialog settings, see the Origin Help file. 

 

 
From the "gear" icon...  

Add: Enter space-separated Unicode 4-character sequence. Symbols will be appended to the current tab. 

Delete: Enter space-separated Unicode 4-character sequence. Symbols will be removed from the current tab; 
or click Select to pick symbols to remove. 

Reorder: Drag to reorder, click Done to apply changes. 

https://www.originlab.com/doc/Origin-Help/LinkVar-TextLabel
https://www.originlab.com/doc/Origin-Help/Graph-InsertTable
https://www.originlab.com/doc/Origin-Help/Symbol-Character-Map
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Reset to Factory Default: Resets to default symbol set for current tab. 

Append from Factory Default: Restores previously-deleted default symbols to current tab (does not affect 
user symbols). 

For more information, see the Origin Help file page Adding Unicode and ANSI Characters in Text Labels.  

11.9.2 Grouping, Aligning and Arranging with the Object Edit Toolbar 

 

 
You can group text labels and drawn objects so that they move or resize as a unit:  

To select objects, press SHIFT + click; or drag out a box around objects using the Pointer tool. 

To group the selected objects, click the Group button on the Object Edit toolbar. 

To ungroup objects, click the Ungroup button on the Object Edit toolbar. 

 
You can align multiple text labels and/or drawn objects with one another using the tools on the same Object 
Edit toolbar:  

Select objects to be aligned by holding the SHIFT key while selecting (or drag out a selection box using the 

Pointer tool), then click one of the align objects buttons on the toolbar. Note that objects will be aligned 
with respect to the first-selected object. 

 
You can bring overlapping objects to the front or send them to the back:  

Select the objects that you want to move to the front or the back. 

Click the Front button or the Back button on the Object Edit toolbar. 

Note: For more information on graph annotations, see your Origin User Guide:  

Help: Origin: Origin Help > Graphing > Adding Text and Drawing Objects  

 

 

You can also use the Object Edit Toolbar to manipulate graph layers. Use buttons to 
align and set a uniform size for multiple graph layers or to swap layer order.  

11.9.3 Using Page or Layer Grids to Place Objects 

For manually placing objects -- graph layers, text objects, legends, etc. -- you can turn on a non-printing, non-
exporting page or layer grid:  

With the graph active, choose View: Show: Page Grid/Layer Grid (displays only one at a time). 

Alternately, you can turn on grids by clicking near the page margin and clicking the Mini Toolbar Show Grids 
button. In addition, you'll find buttons for increasing or decreasing grid size by increments. 

https://www.originlab.com/doc/Origin-Help/Access-ExtCharSet
https://www.originlab.com/doc/Origin-Help/AddText-DrawObject
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11.9.3.1 Control of the Grid 

Grid display and related grid settings are found by clicking on the Show Grids button.  

Click Show Grids, then click Page Grid Settings. 

 

11.9.4 Object Attachment and Scaling in Graphs 

  

There are two settings that you should know something about, particularly if you subsequently modify axis 
scales or resize the graph layer after adding annotations: One is the object's Attach to method, the other is 
the layer's Scale Elements behavior.  

11.9.4.1 Object Attachment 

When you add a text or drawing object to an Origin graph window, the object becomes part of the active graph 
layer. Thus, if you resize or delete that graph layer, you will resize or delete the added object.  
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In addition to being part of the graph layer that was active at the time of object creation, note also that 
objects are attached to the graph in one of three ways, depending upon the type of object and where it is 
created on the page.  

 
To view the "Attach to" setting for any object:  

Right-click on a text or drawing object and choose Properties....  

Click on the Programming tab and note the object's Attach to setting.  

 

Though objects remain a part of the layer that was active at the time of their creation, you can manage some 

object behaviors by changing the object attachment method. An object is attached in one of three ways:  

Page. When attached to the page, objects are not affected by moving or resizing the graph layer, nor are they 
affected by a change in axis scales. These objects are still associated with a particular graph layer and they will 
be hidden or deleted if the layer is hidden or deleted. 

Layer Frame. Objects that are attached to the layer frame, are resized and moved with respect to the layer 
frame. However, they are not tied to axis scales and are not affected by changes in the layer's axis scale 
values. Objects are hidden or deleted if the associated layer is hidden or deleted. 

Layer and Scales. Objects are linked to a particular range of axis scale values. If you resize the layer, the 
object is resized accordingly. If you rescale the axes, the object moves in relation to the visible scale and will 
disappear from view if the linked axis scale range is not displayed. These objects are hidden or deleted if the 
associated layer is hidden or deleted. 

To briefly illustrate why object attachment is important, let's look at the following graph. After the graph was 
created, arrows and text objects that point to their respective data plots, were added to the graph. Both 
arrows and text objects are attached to the graph Layer Frame.  

https://www.originlab.com/doc/Origin-Help/Attachment-Scaling-Object
https://www.originlab.com/doc/Origin-Help/Attachment-Scaling-Object
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Now, consider what happens to these objects when we modify the graph's X axis scale (recall that objects 

attached to the Layer Frame "are unaffected by changes in the layer's axis scale values"). Note that by 
changing the axis scale display range, we have shifted the data plots but the text objects and arrows did not 
move with them.  

 

The remedy for this is to change the text and drawing objects' Attach to method to be Layer and Scales 
because "if you rescale the axes, the object moves in relation to the visible scale." Sometimes we may want an 
object to move with scale changes; at other times we may not. You can force either behavior if you keep in 
mind the Attach to setting.  

11.9.4.2 Object Scaling 

Object scaling often comes up when manually resizing the graph layer or when merging separate graphs into a 
single multi-panel graph (Graph: Merge Graph Windows). By default, added objects are set to Scale with 
Layer Frame -- that is, when the graph layer is resized, associated objects such as text objects, axis lines and 
ticks, and axis titles -- will be scaled proportionally. In the case where you merge four single layer graphs into 
a single, four layer multi-panel graph, these objects will be scaled down with the reduction in size of the layer 
frame.  
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However, this is another default behavior that you may want to change (e.g. you have set your font size to 10 
pt. and you want to preserve that size), and you can do this using the Scale Elements control on the Size tab 
(Layer level) of Plot Details. If our goal is to keep objects at their current size when merging graphs, for 
instance, we can open the Plot Details dialog box and at the layer level (Format: Layer...), click on the Size 
tab, choose the Fixed Factor radio button and set the scaling factor to 1.  

 

If you have resized the graph layer, either by merging multiple graphs into a single 
graph or by manually resizing the layer, you will find that the font sizes do not display 
at their "correct" size (i.e. if you select a text object, the Font Size list on the Format 
toolbar shows the original font size). Further, if select a text object, the Status bar will 
report two font size numbers -- "size" and "actual". You can reset font size so that they 
are shown as actual size, not scaled size, by choosing Graph: Fix Scale Factors. For 
more information, see FAQ-441 How do I export graphs with exact size and resolution 
as specified by publishers?  

11.10 Inserting Images to Graphs 

There are two general approaches to adding images to graph windows:  

Insert the images as floating or background images. 

Insert images within a text object. 

11.10.1 Floating or Background Images 

Images can be inserted to graphs from file or from Image Windows. 

Images can be inserted as floating images or as a layer background. 

Double-click on a graph image to open the image in an Image Window. 

Once opened in the Image Window, define a region-of-interest (ROI) and Clip the image (graph image clipped 
to ROI) or Crop the image (image is cropped in Image Window and graph). 

Use the Image Window to Set (image) Scale or Set (image) Coordinates of the inserted image. 

Images may be saved with the project or linked to an external file (Link File) to control project size. 

https://www.originlab.com/doc/Quick-Help/Set-ExpGraph-Size-Resolution
https://www.originlab.com/doc/Quick-Help/Set-ExpGraph-Size-Resolution
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Prior to Origin 2022b, images linked to an external file had to be manually reimported 
on project open. Now, linked images are automatically reimported, including modified 
source images. Disable or modify auto import with system variables @LFAU and @LFC.  

11.10.1.1 Inserting Image from File 

You can insert an insert an image into graph page, with the option of inserting it as a background image that is 
linked to layer and scales.  

With the graph layer active, choose Insert: Image from File. The image is inserted as a floating image. 

To convert the image to a background image, double-click to open it in an Image Window. 

Right-click on the Image Window image and choose Set as Layer Background. 

Click the Close button on the Image Window. 

11.10.1.2 Inserting Image from Image Window 

You can also insert images to graphs from an Image Window:  

 

With the graph window active, choose Insert: Image from Image Window. The Insert from Image 
Window dialog opens.  

Set the Image Window drop-down to the desired image. 

Optionally, choose to insert the image as Layer Background and to Rescale Layer using Image Coordinates 
(Layer Background only). 

 

11.10.1.3 Manipulating Images with the Image Window 

https://www.originlab.com/doc/LabTalk/ref/sys-var-list
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11.10.1.3.1 Mini Toolbar 

Clicking on an Image Window image produces a Mini Toolbar with buttons for simple image manipulations 

(flip, rotate, convert to gray scale, etc.).  

 

11.10.1.3.2 Region-of-Interest (ROI) 

Placing an ROI object on the Image Window image allows you to perform certain image editing operations.  

 
Add an ROI to the image by one of the following:  

Click the Add ROI button on the Mini Toolbar. 

Right-click on the image and choose Add ROI. 

Click the Rectangle Tool on the Tools toolbar. 
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Once added, the ROI can be resized (by dragging handles) or moved. Additionally, various operations can be 
performed on the ROI, including:  

Clip graph image to ROI, Crop image to ROI or Copy ROI as image to graph. 

Copy Positions/Paste Positions for copying ROI dimensions to a second ROI on another Image Window. 

Export ROI or Import ROI to save or apply previously-saved ROI dimensions. 

 
For more information on the Image Window, see the Origin Help File.  

11.10.2 Inserting Images into a Text Object 

Images can also be inserted as part (or the entirety) of a text object. Source images can be from:  

Local image file or Web image URL 

Worksheet cell 

https://www.originlab.com/doc/Origin-Help/Intro-Image-Processing
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11.10.2.1 Local Image or Web URL 

When you insert an Image from File or Image from Web using the following methods, the image is linked 
and not stored in the Origin project file. This helps control project file size.  

On the Tools toolbar, click the Text tool and click once on the graph to enter "in-place" edit mode. 

Enter text if needed and when ready to insert image, right-click and choose Insert: Image from File or 
Image from Web:  

When inserting an image from file, browse to your local image file and click Open. 

When inserting an image from Web, you'll need a URL (hint: locate your Web image, then right-click and copy 
the address (Copy Image Address, Copy Image Link, etc, depending upon browser). 

To examine (or modify) the syntax used for inserting an image, you can select the inserted object and choose 
Properties. In the Text Object dialog, you should see something like these examples:  

Examples:  

\img(file://"C:/Program Files/OriginLab/Origin2023/Samples/Image Processing and 

Analysis/white camellia.jpg",w=200)  

\img(https://www.originlab.com/images/header_logo.png, w=200) 

... where option "w=" is the default width in pixels, of the inserted image. Width is user-modifiable by editing 
the "w=" value in Properties or -- if no width is specified -- by simply dragging the object's selection handles.  

11.10.2.2 Worksheet Cell 

You can also insert an image from a worksheet cell into a text object, but you'll need to make use of a special 
syntax. The syntax is not complicated and combines a \cell( ) escape sequence with a cell reference -- 

either a range reference (e.g. [Book1]Sheet1!col(C)[1] ) or a named range reference.  

https://www.originlab.com/doc/Origin-Help/InsObject-to-WksCell
https://www.originlab.com/doc/User-Guide/Worksheets-Columns
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On the Tools toolbar, click the Text tool and click once on the graph to enter "in-place" edit mode; or 
right-click and choose Add Text from the shortcut menu. 

Enter your string into the text object using the examples below as a guide:  

If you are copying and pasting a string (e.g. \cell([Book1]Sheet1!B[1])), click outside the text object to 

leave edit mode. Your cell image should display in the text object. 

If you are typing directly into the text object in "in-place" mode, enter your syntax (e.g. 
\cell([Book1]Sheet1!B[1])) and when finished, right-click on the object, choose Properties and on the 

Text tab, remove one of the leading "\" characters from your cell reference (Origin automatically "protects" "\" 
characters entered into text objects which is why you'll need to remove one "\". See Escape Sequences). 

If you are typing directly into the Text Object (Properties) dialog, enter your syntax (e.g. 
\cell([Book1]Sheet1!B[1])) directly to display the cell image. 

Examples:  

\cell([Book1]1!col(C)[2]) // Book1, Sheet1, col C, row2, size = current font height 

\cell(alpha,200) // named range "alpha", width=200 logical pixels 

\cell(alpha,h=300) // named range "alpha", height=300 logical pixels 

11.11 Working with Map Data 

 

You can overlay geopolitical boundaries on graphs or Image Plots of NetCDF data from the Insert menu.  

Insert: World Map will apply boundaries within the graphs current Lat and Lon ranges. 

Depending upon the graph's Lat and Lon ranges, other options may be available (e.g. Continental USA Map, 
Map of China, etc.). 

11.11.1 Importing Shapefiles 

You can also import locally-stored shapefiles using Origin's Shapefile Connector:  

https://www.originlab.com/doc/Origin-Help/insert-image-file-web
https://www.originlab.com/doc/User-Guide/Import-Data
https://www.originlab.com/doc/User-Guide/Import-Data
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With a workbook active, choose Data: Connect to File: Shapefile. 

11.11.2 Map-related Apps 

There are at least two add-on Apps for inserting geographic data:  

OriginLab's free Google Map Import App lets you place a Google Map as background on the graph page using 
specified coordinates. 

Maps Online is another free OriginLab App that lets you connect to one of several map databases. 

 
You can find and install these Apps by pressing F10 and searching on maps. For information on App 
installation, see Where Do I Find Apps?  

11.12 Arranging Graphs and Layers 

   

Task  Method  

Merge 
multiple 
graph 
windows 
into a 
single 
graph 
window.  

Graph: Merge Graph Windows... menu command 

or  

Merge Graph Windows button on the Graph toolbar. 

 

Origin has two dialog boxes -- Fitting Layers to Page and Fit 
Page to Layers -- that are useful for arranging multiple graph 
panels on the page and for adjusting graph margins.  

 

Extract 
data plots 
in one 
layer to 
multiple 
layers.  

Extract to Layers button on the Graph toolbar.  

 

Hint: to preserve your original graph, click the Duplicate button before extracting to 

layers.  

Extract 
multiple 
layers in a 
single 
graph to 
multiple 

graph 
windows  

Graph: Extract to Graphs  

or  

Click the Extract to Graphs button on the Graph toolbar.  

All layers are extracted to individual graph windows, even if a layer is linked to another 
layer. 

By default, the layextract dialog box has Extracted Layers set to 1:0, which specifies 
that all layers be extracted. To extract only certain layers, clear Auto and use the 
layextract X-Function's comma/colon notation to control which layers are extracted. The 
notation 1:0 means starting with layer 1, extract all layers to graphs (0 denotes all). 
Specifying 1,3:4, for example, tells Origin to extract only the first, third and the fourth 
layer. Note that you can enable Keep Source Graph to preserve the original graph. 

https://www.originlab.com/fileExchange/details.aspx?fid=344
https://www.originlab.com/fileExchange/details.aspx?fid=240
https://www.originlab.com/doc/User-Guide/Apps
https://www.originlab.com/doc/Origin-Help/Fit-Page-Layer
https://www.originlab.com/doc/Origin-Help/Fit-Page-Layer
https://www.originlab.com/doc/X-Function/ref/layextract
https://www.originlab.com/doc/X-Function/ref/layextract
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Add, 
arrange, 
resize, 
position, 

swap, 
align, or 
link layers  

Graph: Layer Management... menu.  

Position selected layers using Object Edit toolbar buttons. Hold SHIFT + click to select 
multiple layers and Align Left, Right, Top, Bottom, etc. 

 

You can use the Layer Management tool's Swap control 
(Graph: Layer Management,Size/Position tab) to physically 
swap layer positions without reassigning layer numbers. Before 
doing so, set each linked layer's Units to % of Page 
(Size/Speed tab of Plot Details).  

 

Simple 
arrangeme
nt of 
layers  

Graph: Arrange Layers... menu. 

Row by column layer arrangement with control of page size and spacing between layers. 

Link graph 
layers   

Linked Axes Scales tab, layer level of Plot Details dialog box.  

Link tab of the Layer Management dialog box. 

When linking layers, the child layer must have a higher layer number than the parent 
layer.  

Linked layers can be moved and resized together. 

You can link layers' axis scale values to be Straight (1:1) or you can specify a Custom 
mathematical relationship. 

For Column/Bar/Box chart, each set of linked layers can share the Spacing tab Gap 
Between Bars (%) setting of the Link to layer (requires that page-level Layers tab 
Column/Bar/Box Gap Across Layers be enabled).  

 

Reorder 
layers   

There are several ways to reorder graph layers (reassign Layer number for each Layer). 
Learn more about reassigning layer numbers in the mini tutorial below this table.  

Method 1: Open the Layer Management dialog and click the row header (shown in 
image below) and drag it up or down to change the Layer order. 

https://www.originlab.com/doc/Origin-Help/PD-Dialog-Size-Tab
https://www.originlab.com/doc/Origin-Help/PD-Dialog-LinkAxesScale-Tab
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For more information, see the Layer Management tool.  

Method 2: Enter the following LabTalk script in the Command Window 
(Window:Command Window), then press Enter to execute. 

page.reorder(n,m)  

The command changes the nth Layer to the mth Layer.  

Method 3: Use the Front and Back buttons on the Object Edit toolbar (these buttons 

work on the active layer as indicated by the graph layer icon ). Alternately, right-
click on the graph layer icon and change layer order using shortcut menu commands (e.g. 
Bring to Front). 

 

When two layers are linked by a common X axis (e.g. Double-Y 
graph), you can swap layer drawing order by right-clicking on 
the "front" layer in Object Manager and choosing Push to 
Back. This will not break layer linking.  

 
Note: Reordering layers may break layer linking relationships.  

 

A Note on Inset Graphs: In certain situations (see Tutorial, 
below), the order in which the layers are drawn on the screen 
becomes an issue. In this image, we have added an inset graph 
using the Add Inset Graph with Data button (Graph toolbar). 
The problem is that the data plot of the parent layer (red 
symbols) shows through the inset layer (small, black symbols). 
To fix this, we do two things:  

Set the inset layer background Color = White -- by default, it is 
None (Format: Layer, then Background tab). 

Set the layer Drawing order to Draw layer by layer (Format: 
Page then Layers tab). 

https://www.originlab.com/doc/Origin-Help/GraphRef-LayerManage
https://www.originlab.com/doc/Origin-Help/Object-Manager
https://www.originlab.com/doc/Origin-Help/PD-Dialog-LinkAxesScale-Tab
https://www.originlab.com/doc/Origin-Help/PD-Dialog-Background-Tab
https://www.originlab.com/doc/Origin-Help/PD-Dialog-Layers-Tab
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By default, an inset layer is added "on top of" the parent layer 
but if needed, you can click on the inset layer to select it, right-
click and choose Bring to Front.  

 

Exchange 
X-Y Axes  

Graph: Exchange X-Y Axes menu command 

Exchange Axes button on the Graph toolbar. 

Move a 
plot(s) to 
another 
layer  

Method 1: Open Plot Setup dialog(by selecting Graph:Plot Setup), expand the bottom 
panel, select a plot and drag it from a layer to another layer. 

Method 2: Run laymplot -d; (e.g. open the Script Window, type the command and 

press <Enter>) to open the Move Plot dialog to specify plot(s) to move and a target 
layer. 

Method 3: Copy (CTRL+C or Copy Range context menu) a plot and pasting (CTRL+V 
or Paste context menu), between different layers or different graphs.  
Note: the pasted plot won't be associated with the source data of the copied plot, but 
exists as a loose dataset. 

 

 

In a multi-layer graph, layer order determines drawing order. The 1st layer is plotted 
and then 2nd layer is plotted on top of it, and so on. The layer with higher number is 
drawn on top of the layer with lower number. This is important when plots in one layer 
overlay plots in another layer. When necessary, you can change layer order to change 
plot drawing order.  

This mini tutorial shows you how layer reassignment works. Use the preview window to 
see how layer number reassignment affects your graph.  

Click Help: Origin Central or press F11. 

Click on the Graph Sample tab, set the Samples in drop-down list to Area Plots and 
double-click on this graph:  
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Activate the graph Area Plot With Horizontal Color Gradient, then click the Extract 

to Layers button on the Graph toolbar. Set both number of rows and columns to 

1, click OK, then, click OK again for the page spacing. The green layer is on the top of 
the yellow layer in the figure. The purpose of this last step was simply to create a two 
layer graph in which the data in one layer partially hides the data in the other layer. 
What we will do now is to reorder the layers and set the yellow layer on the top, giving 
you a better view of the two plots.  

 

Choose Graph: Layer Management... menu, then drag the row header "1" of the 
Layer1 in the Layer Selection downward under the Layer2 (indicated by a blue line), 
and click OK. 

You can see the yellow layer is on the top now.  
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Alternate Method: You can use the Front or Back toolbar buttons (located in 
the Object Edit toolbar, or at the top of Layer Selection box in the Layer 
Management dialog) to bring a layer forward or push it backwards. As happens when 
you rearrange layer order with the Layer Management dialog, this method swaps 
layer numbers.  

 

 

You can easily add an inset layer with data by clicking the Add Inset Graph With 

Data button on the Graph toolbar or Insert: New Layer(Axes): Inset With 

Data (Linked Dimension) .  

 

 

You can copy a layer from one graph window to another graph window. Click to select 
the layer first (a frame shows around the layer). Then press Ctrl+C or right-click and 
choose Copy. Click on the target graph window, then right-click to Paste.  

 

Note: For more information on merging graphs, see your Origin User Guide:  

Help: Origin: Tutorials > Graphing > Layers > Merging and Arranging Graph Layers  

Help: Origin : Origin Help > Graphing > Reference > The Merge Graph Dialog Box  

https://www.originlab.com/doc/Tutorials/Customize-Merge-Arrange-Graph
https://www.originlab.com/doc/Origin-Help/GraphRef-MergeGraph
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11.13 Templates and Themes 

Origin's flexible Page > Layer > Plot hierarchy, plus an extensive list of editable object properties makes it 
easy to customize and save your graph settings for repeat use. You can preserve your custom settings in a 
couple of ways -- either with templates or with Themes. These concepts are introduced below.  

Note: For detailed information please refer to Origin Help file, see:  

Help: Origin: Origin Help > Graphing > Creating Graphs from Graph Templates  

Help: Origin: Origin Help > Customizing Your Graph > Graph Formats and Themes  

11.13.1 Templates 

 A new Origin installation lists close to 240 plot types, each one backed by an Origin graph template file (*.otp 

or *.otpu). For most users, a Plot menu graph is the starting point for customizing and saving your own 
custom graph templates. The basic process goes like this:  

Plot your worksheet or matrixsheet data using the Plot menu (or equivalent graphing toolbar button). 

Customize the graph's default settings. 

Save the graph as a graph template file (*otp or *.otpu) by choosing File: Save Template As and filling in 
the requisite information. By default, custom templates are saved to your User Files Folder (hint: easily find 
this folder by clicking Help: Open Folder: User Files Folder). 

 
A few things to note:  

The Plot menu is the definitive list of built-in plot types. At one time, a graphing toolbar button was created 
for each new plot type but in recent versions, few toolbar buttons have been added as toolbar space has 
become limited. 

In a fresh Origin installation, each one of Origin's 240 built-in graph types uses a specific "system" template 
when creating a particular graph type. When you click on a Plot menu graph or graphing toolbar button (e.g. 

Area ), one of these system templates is used to plot the selected data. 

System templates are installed to the Origin Program Folder. They are completely customizable but as the 
Program folder is write-protected, you cannot overwrite the original system template file (see next).  

Instead, when you customize and save a system template, it is saved by default to your User Files Folder 
(UFF). If you save the customized template to the same system template name, the customized template 
replaces the system template as the template associated with the Plot menu command or corresponding 
toolbar button used to create that plot type. Additionally, the customized template is added to the user's 
Template Library. 

To view your custom graph templates, click Plot (workbook or matrix should be active) and click Category = 
MyTemplates.  

You can save a graph template anywhere (and with any name) that you like -- it does not need to be saved to 
your UFF. However, by saving customized templates to your UFF, they will be collected in one, easily-
remembered place and they will be readily available when you upgrade your Origin software (since Origin 
2018, all Origin versions have shared a common User Files Folder). 

For an overview of graph templates, see Graph Template Basics. 

For information on the Template Library, see The Graph Template Library. 

For information on "cloneable" templates, see Cloneable Templates. 

11.13.1.1 The Template Library 

https://www.originlab.com/doc/Origin-Help/Plot-Graph-Template
https://www.originlab.com/doc/Origin-Help/Graph-Format-Theme
https://www.originlab.com/doc/Origin-Help/OFileType-Template
https://www.originlab.com/doc/Origin-Help/UserFilesFolder
https://www.originlab.com/doc/User-Guide/Installation-Startup
https://www.originlab.com/doc/User-Guide/Installation-Startup
https://www.originlab.com/doc/Origin-Help/Graph-Template-Basics
https://www.originlab.com/doc/Origin-Help/Graph-Template-Gallery
https://www.originlab.com/doc/Origin-Help/Graph-Template-Basics
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Summary of Features:  

Toggle between list and thumbnail view modes. Thumbnails images are automatically generated when you 
save a template. 

In either mode, you can hover on the template to preview, read template location, comments, etc. 

In list mode you can sort; or opt to list a User or Extended template under Plot: My Templates. 

Templates are listed as System, Extended or User. System templates are Origin's default templates for 
creating Plot menu graphs. They can be plotted to and customized but cannot be overwritten. Extended 
templates are add-on templates that are installed with Origin. User templates are those that you specifically 
customize then save using File: Save Template As; or which you add using the Library's Add or Scan 
functions. Note that User templates can include customized System templates that you have saved to \User 
Files. 

To scan your User Files folder (UFF) for custom templates, click the Scan User Template icon. To browse and 
add a template file to the Library, click the Add Template icon. 

Click the List Cloneable Templates icon to show only cloneable templates.  

Click the Manage Mode icon to delete, show or hide a given template. Hiding a template removes it from My 
Templates but does not remove it from the Template Library (note that you can also remove a template from 
My Templates simply by clearing Show in Menu). Deleting a template removes it from the Library and moves 
the template to User Files\DeletedTemplates. 

Click the Template Center icon to open a dialog and search the OriginLab site for additional graph templates. 

https://www.originlab.com/doc/Origin-Help/OFileType-Template
https://www.originlab.com/doc/Origin-Help/OFileType-Template
https://www.originlab.com/doc/Origin-Help/OFileType-Template
https://www.originlab.com/doc/Origin-Help/UserFilesFolder
https://www.originlab.com/doc/Origin-Help/Graph-Template-Basics
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You can search for Template Center templates and install them directly from the 
Start menu.  

 

11.13.2 Themes and Copy/Paste Format 

  An Origin Theme is a file containing a set of object properties. There are four kinds of Theme files in Origin: 
graph Themes, worksheet Themes, dialog Themes and function plot Themes.  

Graph Themes are a collection of properties of different elements in a graph window. A graph Theme can be 
very simple (e.g. graph axis major and minor tick direction settings) or it could be something more complex 
(e.g. a combination of page dimensions, layer background, axis scales, and color palettes). Whether simple or 
complex, the purpose of graph Themes is to allow you to quickly change one or more object properties in an 
existing graph, or to apply a consistent set of properties to a selection of graph windows, without having to 
recreate a suite of settings, or to apply those settings one-by-one to individual graph windows.  

All graph objects have a customizable set of properties that are specific to the object type. Therefore, it follows 
that the properties that can be saved as a Theme differ depending upon the selected object. You can (1) copy 
a Theme from one object and "paste" it to another object of the same type or (2) you can save a Theme from 
one object as a named Theme and apply that named Theme to other like objects at a later time.  

Right-click on an object in a graph window (e.g. a plot) and choose Copy Format. Depending on what you 
click on, there may be sub-menu items under the Copy Format shortcut menu, which give you the option as 
to what exact format to copy.  

To apply the copied formats to a single object, right-click on your target graph and choose Paste Format To. 
Again, this shortcut menu might has some sub-items that limit what to paste. In this way, the formatting 
option(s) from your source object should be applied to your target object. 

To apply the copied formats to multiple windows in the project, keep the source graph window active and 
select Edit:Paste Format(Advanced)... from the Origin menu. This opens the Apply Formats dialog box. 
Here you have the option of editing or selectively applying formats to one or more graph windows in the Origin 
Project. 

If you would prefer to save formats to a named Theme file that you can re-apply at a later time, choose the 
Save Format As a Theme... shortcut menu item, then use Preferences: Theme Organizer to apply the 
Theme when needed. 

11.13.2.1 Theme Organizer 

  Use the Theme Organizer (Preferences: Theme Organizer) to organize and apply Themes to graphs. 
With this dialog box you can apply a graph Theme simultaneously to multiple graphs in the Origin project file. 

To combine multiple Themes in the Theme Organizer dialog box:  
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Press the CTRL key while selecting multiple Themes, then right-click and choose Combine from the shortcut 
menu. The shortcut menu in the tool provides an option for editing a Theme, allowing the user to add/delete 
properties from an existing Theme. 

 

 

 

The Theme Organizer has separate tabs for managing graph, increment list, worksheet, dialog boxes and 
plotted mathematical function Themes. 

If you right-click on a graph Theme and save it as your System Theme, then each time you plot a new graph, 
this System Theme will be applied regardless of the settings that were saved with the graph template†. 

Use the System Increment Lists tab to manage increment lists and selectively apply them to project graphs. 

You can load a graph Theme in the Export Graph dialog and the Theme will be applied to the exported image 
file. 

 

† If you don't want a System Theme to be applied automatically to the graph, save the 
graph as a template (File: Save Template As) and clear the Apply System Theme 
to Override check box.  

11.14 Topics for Further Reading 

Plot Details: Customizing Graph Page Elements 

Plot Details: Customizing Graph Layer Elements 

Plot Details: Customizing Plot Elements 

https://www.originlab.com/doc/Origin-Help/ThemeRef-System
https://www.originlab.com/doc/Origin-Help/ThemeRef-ThemeOrganizer
https://www.originlab.com/doc/Origin-Help/Customize-Page-Element
https://www.originlab.com/doc/Origin-Help/Customize-Layer-Element
https://www.originlab.com/doc/Origin-Help/Customize-Plot-Element
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The Preferences: Options: Axis tab Settings 

The Preferences: Options: Graph tab Settings 

Graph Axes 

Controlling the Graph Axis Display Range 

Graph Legends 

Color Scales 

Customizing Data Plot Colors 

Using a Dataset to Control Plot Color 

Using a Dataset to Control Plot Attributes 

Labeling Data Points 

Adding Text and Drawing Objects 

Adding Unicode and ANSI Characters in Text Labels 

Linking Text Labels to Data and Variables 

Associating Script with an Object 

Hiding Labels, Data and Layers 

Working with Maps 

Graph Template Basics 

Graph Template Library 

System Templates 

System Themes 

https://www.originlab.com/doc/Origin-Help/Options-Dialog-Axis-Tab
https://www.originlab.com/doc/Origin-Help/Options-Dialog-Graph-Tab
https://www.originlab.com/doc/Origin-Help/GraphAxes
https://www.originlab.com/doc/Origin-Help/Axis-DisplayRange-Control
https://www.originlab.com/doc/Origin-Help/Legend-ColorScale
https://www.originlab.com/doc/Origin-Help/ColorScale
https://www.originlab.com/doc/Origin-Help/Customize-PlotColor
https://www.originlab.com/doc/Origin-Help/PlotColor-DatasetControl
https://www.originlab.com/doc/Origin-Help/PlotAttribute-DatasetControl
https://www.originlab.com/doc/Origin-Help/Labelling-DataPoint
https://www.originlab.com/doc/Origin-Help/AddText-DrawObject
https://www.originlab.com/doc/Origin-Help/Access-ExtCharSet
https://www.originlab.com/doc/Origin-Help/LinkVar-TextLabel
https://www.originlab.com/doc/Origin-Help/Associate-script-object
https://www.originlab.com/doc/Origin-Help/Labels-Data-Layer-Hide
https://www.originlab.com/doc/Origin-Help/working-with-maps
https://www.originlab.com/doc/Origin-Help/Graph-Template-Basics
https://www.originlab.com/doc/Origin-Help/Graph-Template-Gallery
https://www.originlab.com/doc/Origin-Help/System-Templates
https://www.originlab.com/doc/Origin-Help/ThemeRef-System
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12 Graphical Exploration of Data 

 

 

Origin includes a number of tools for graphically exploring your data including those for zooming and panning 
data plots, reading XY coordinate values and other data point metadata, or highlighting or masking selected 
data points.  

 

With Origin 2016, OriginLab began releasing add-on tools called Apps. Many 
exploratory and analysis-related tools have been added to OriginLab's File Exchange 
since that time. If you find you need some exploratory or analysis tool that is not a 
standard part of Origin, you might check to see if the tool exists as an App. If it does 

http://www.originlab.com/fileexchange/index.aspx
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not, request it!.  

12.1 Plot Highlighting 

While plot highlighting can be used to select a subset of data for more in-depth analysis, at a basic level it is 
useful for quick visual comparisons.  

 

 
To engage plot highlighting:  

Click on one plot in the graph layer. Other plots in the layer and in linked layers sharing the same X axis, will 
be dimmed.  

Click on the plot in the Object Manager. 

To highlight/dim plots on hover (without clicking), click the Highlight Plot when Mouse Over Mini Toolbar 
button (page-level). 

 

 
Other Origin features useful for quick visual inspection of data plots:  

If you have many columns of Y data, plotting a Browser Graph, or adding a Browser panel to an existing 2D 
line plot, can be useful for quick visual inspection. Clicking the menu on the Browser panel, you can plot every 
Nth column or Flip Through plots using a specified Move By factor. 

For scatter data, use the customizable Data Point Tooltip to read coordinate values and column metadata on 
mouseover. 

You can also use Tools toolbar buttons to zoom or pan your graph, as you will see in the next section. 

Origin has various other tools available for visually inspecting and recording information on your data plots and 
those are covered in the remaining subsections of this chapter. 

12.2 Data Slicer 

If you are plotting worksheet data where a data filter has been applied, you can enable a Data Slicer panel, 
make quick changes to filter conditions and see the effect on your plot. The tool is intended for plotting and 
comparing single categories.  

https://www.originlab.com/www/company/qform.aspx?s=1&sbj=applications@
https://www.originlab.com/doc/User-Guide/Graphing
https://www.originlab.com/doc/Origin-Help/Wks-DataFilter
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Apply one or more filters to your worksheet data and create your plot. 

Hover just inside the graph window but outside the layer and when you see the Mini Toolbar cursor, click and 
look for the Data Slicer button. 

Once the Data Slicer panel is enabled, you will want to right-click on the title bar of both the worksheet and 
the graph and Duplicate the two windows. Duplicating the two will allow you to make side-by-side 
comparisons. 

In the left panel of the duplicated graph, click on the listed filter(s) and choose another category from the 
drop-down list. 

12.3 Zooming, Panning and Rescaling 

     

This section discusses the use of toolbar tools, and keyboard and menu commands that change the view of 
your 2D graph. We have split these tools and commands into two groups:  

Page-level zoom and pan operations that do not change axis scales. 

Axis rescale operations which zoom and pan the graph by changing axis From and To values. 

 

Page level zoom and pan do not alter the graph; they only determine which portion of 
the graph page is visible within the graph window. You can read the current zoom level 
in the Zoom dropdown list of the Standard toolbar. Page-level zoom and pan will not 
affect the printout or export of the graph. On the other hand, axis rescaling tools (e.g. 

and ) do alter the graph and, thus, will affect the printout and export of the 

graph.  

https://www.originlab.com/doc/Origin-Help/AxesRef-Scale
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12.3.1 Page-level Zoom and Pan 

Action  Button  
Shortcut 
Key  

Menu  Notes  

Zoom-Panning: 
Zoom and pan the 
graph page.  

 

A +  
+/- keys 
(zoom) 
or 
arrow 

keys 
(pan)  

 

Click the toolbar button; or 
with the Pointer tool 

active, place the 
cursor on the graph page 

and press "A", then ...  

Use +/- keys or mouse 
wheel to zoom in or out.  

Use the arrow keys to pan 
horizontally or vertically.  

Stepped Zoom-
Pan†: Zoom graph 
in or out, by 
increment.  

 

 

CTRL + I 
CTRL + 
M  

View:Zoom 
In and 
View:Zoom 
Out  

Stepped zoom. 

CTRL+I activates zoom in; 
click on the graph to 
establish the focal point.  

CTRL+M zooms out; 
clicking on graph not 
needed. 

Whole Page: Show 
the whole graph 
page.  

 

CTRL + 
W 

View: 
Whole 
Page  

Reset the view of the page 
after using the Zoom-
Panning tools, above. 

Zoom All: All 
objects in the 
window are shown.  

--  --  
View: 
Zoom All  

Can be used to locate 
"lost" objects lying outside 
the graph page. 

†Notes:These are older tools and methods that have been deprecated. Toolbar buttons are not shown by 
default. To add them to the workspace, use the Customize Toolbars dialog box (View: Toolbars > Graph 
button group).  

12.3.2 Axis Rescaling 

Action  Button  Shortcut Key  Menu  Notes  
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Rescale: 
Rescale and 
pan the graph 
in both X and Y 
dimensions.  

 

Z + right mouse 
button and drag 
vertically(scale in 
Y)/horizontally(scale 
in X)  

--  

Scroll mouse wheel to 
rescale X.  

SHIFT + scroll to 
rescale Y. 

Drag with the left 
mouse button to pan 
(will rescale both X and 
Y).  

Select the Pointer tool 
to exit Rescale mode. 

Rescale the 
graph in the X 
dimension.  

--  

Z + scroll wheel 

or 
Z + +/- keys  

--  
Rescale the graph in 
the X dimension 
without limits.  

Pan the graph 
in the X 
dimension.  

--  

X + scroll wheel 

or 
X + +/- keys  

--  
Rescales X.  

Does not rescale Y. 

Rescale X: 
Rescale the 
graph in the X 
dimension.  

 

--  --  
Rescales (Resets) X to 
full X range + some 
padding factor. 

Rescale the 
graph in the Y 
dimension.  

--  

SHIFT + Z + scroll 
wheel 

or 
SHIFT + Z + +/- 
keys  

--  
Rescale the graph in 
the Y dimension 
without limits. 

Pan the graph 
in the Y 
dimension.  

--  

SHIFT + X + scroll 
wheel 

or 
SHIFT + X + +/- 
keys  

--  
Rescales Y.  

Does not rescale X. 

Rescale Y: 
Rescale the 
graph in the Y 
dimension.  

 

--  --  
Rescales (Resets) Y to 
full Y range + some 
padding factor. 

Rescale XY: 
Rescale the 
graph in both X 
and Y 
dimensions.  

 

-- --  
Rescales (Resets) X and 
Y to full range + some 
padding factor. 
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Rescale Z: 
Rescale the 
graph in the Z 
dimension.  

 

-- --  
Rescales (Resets) Z to 
full range + some 
padding factor. 

Scale 
In/Scale Out: 
Rescale the 
graph in X and 
Y dimensions.  

and 

 

--  --  

Select Scale In button, 
then drag out 
rectangle(s) to define 
axis scale range 
desired.  

Reset by clicking on the 
Scale Out button (no 
need to drag) several 
times.  

Rescales both X and Y. 

Press ESC (or select 
another tool) to quit 

magnifying mode.  

With a graph active, 
press Ctrl then click the 
Scale In button 

and drag out a 
rectangle on a 2D 
graph to copy an 
enlarged portion to a 
new window. Note that 
this Enlarged graph is 
dynamic. Move or 
resize the rectangle on 
the original graph and 
the Enlarged graph is 
updated. This will also 
work on any graph that 
has multiple linked 
layers as long as the 
layers are overlapped 
and share a common 
axis (% of Linked 
Layer has Left/Top 
set to 0 and 
Width/Height set to 
100, plus Straight (1 
to 1) linking to the 
parent layer).  

Rescale: 
Rescale the 
graph in the all 
dimensions.  

 

CTRL + R  

Graph: 
Rescale 
to 
Show 
All  

Rescales (Resets) all 
axes to display all data 
in the layer (+ some 
padding factor). 

3D Graphs  

Rescale in the 
--  Z + scroll wheel  --  

If the plot extends 

https://www.originlab.com/doc/Origin-Help/Link-Layers
https://www.originlab.com/doc/Origin-Help/Link-Layers
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X dimension.  beyond the 3D frame, 
go to Plot Details > 
Miscellaneous tab 
(layer level) and set 
controls under 
Clipping.  

Rescale in the 
Y dimension.  

--  
SHIFT + Z + scroll 
wheel  

--  

Rescale in the 
Z dimension.  

--  D + scroll wheel  --  

 

 

If you do not see a toolbar button, it may be turned off. To add or remove buttons from 
a toolbar, see The Customize Toolbar Dialog Box. 

To prevent an axis from rescaling when using one of the axis rescaling tools, set 
Rescale = Fixed. If both X and Y axes are set to Fixed and you pick one of these axis 
rescaling tools, you are reminded that X and Y axes are in "Manual Rescale mode" and 
are prompted to proceed. Answering Yes will allow you to override and manually 
rescale in one or both dimensions. If you need to block such manual overrides of Fixed 
axis scales, set @nrm = 1. 

12.4 Rotation of 3D openGL Graphs 

 

This openGL toolbar that previously displayed when a 3D layer was selected, has been 
replaced by layer-level Mini Toolbar buttons.  

 

When you click inside the layer of a 3D graph, the layer is selected and a Mini Toolbar appears. Click the 
Rotate Mode button to enter rotation mode; then use one of the hotkey/mouse combinations listed below; or 
drag the radial rotation handles in the graph with your mouse.  

Hot Key  Menu/Action  Context  

Rotate 3D graphs with the 3D floating buttons  

X + Arrow key  
Rotate the 3D graph around 
the X axis.  

With graph layer active and with 
Rotate Mode button selected in the 
3D floating button group. 

 

Y + Arrow key  
Rotate the 3D graph around 
the Y axis.  

Z + Arrow key  
Rotate the 3D graph around 
the Z axis.  

Q + Arrow key  Rotate the 3D graph in screen.  

https://www.originlab.com/doc/Origin-Help/CustomToolbar-Dialog
https://www.originlab.com/doc/Origin-Help/Axis-DisplayRange-Control
https://www.originlab.com/doc/LabTalk/ref/sys-var-list
https://www.originlab.com/doc/Quick-Help/OpenGL-3D-Requirements
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W + Arrow key  
Rotate the 3D graph around 
any axes.  

Rotate 3D graphs using R key  

R + Mouse  
Drag to rotate the 3D graph in 
an arbitrary direction.  

Press "R" before pressing other keys. 
 
Hovering on a 3D graph while pressing 

"R" changes the Pointer tool to a 

. Press Ctrl and/or Shift as 
needed, and rotate by (a) dragging 
with your mouse or (b) pressing the 
arrow keys on your keyboard.  

R + Ctrl + 
Mouse/Arrow key  

Rotate the 3D graph around 
the X axis.  

R + Shift + 
Mouse/Arrow key  

Rotate the 3D graph around 
the Y axis.  

R + Ctrl + Shift + 
Mouse/Arrow key  

Rotate the 3D graph around 
the Z axis.  

12.5 Reading Coordinate Values and Distances 

 Origin provides several tools to aid in labeling and graphical exploration of your data plots. Most of these tools 
are available from the Tools toolbar (View: Toolbars). There is a related tool -- Vertical Cursor -- available 
from the Gadgets menu.  

12.5.1 Data Point Tooltip 

Most 2D plot types, 3D Scatter, XYY Bar and XYZ Bar plots support a floating, customizable tooltip that reads 
data point values when you hover on a data point.  

 

 
Tooltip Shortcut Menu  
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For tooltip customization and other options, right-click directly on the data point tooltip.  

 

Go to Sheet pops up the worksheet with source data highlighted. 

Show Data Plot Tooltip toggles display of a non-customizable data plot tooltip in place of the customizable 
data point tooltip (see, below). 

Pick Data Points puts the cursor into data reading mode and opens a Pick Points dialog. Double-click on 
points in the graph and when finished, click Done. This generates summary data (source, X-Y coordinates, 
etc.) for your picked points. 

Copy copies data point tooltip information, including labels, to the Clipboard. 

Copy Coordinates copies only coordinate values. Right-click on a cell and Paste each value to a separate cell 
within the row; or Paste (keep spaces) to paste values to the selected cell as a space-separated string. 

Preferences opens the Data Point Tooltip dialog allowing you to customize tooltip content and formatting. 
Use documentation of the Data Info window, below, as a guide to configuring your tooltips. 

 
The Data Point Tooltip dialog is a slightly simpler version of the Data Info window's preferences dialog (Data 
Info Report Settings). See The Data Info Window for help with customizing your Data Point Tooltip.  

 

By default, the Data Point Tooltip displays with a moderate degree of transparency. You 
can affect tooltip transparency by changing the value of LabTalk System Variable 
@TDT. For information on changing the value of a LabTalk System Variable, see this 
FAQ.  

12.5.2 Data Plot Tooltip 

There is a second tooltip that can be displayed in place of the Data Point Tooltip and this we refer to as the 
Data Plot Tootip. This non-customizable tooltip displays the source book, worksheet and coordinate datasets, 
on hover.  

https://www.originlab.com/doc/Origin-Help/Picking-Points
https://www.originlab.com/doc/Origin-Help/Data-Info-Tool
https://www.originlab.com/doc/LabTalk/ref/sys-var-list
https://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
https://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
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The Data Point Tooltip displays by default. If you prefer to use the Data Plot Tooltip, right-click on the Data 
Point Tooltip and choose to Show Data Plot Tooltip. Conversely, right-click on the Data Plot Tooltip and 
choose Show Data Point Tooltip.  

12.5.3 Managing Tooltip Display 

You can turn off display of data tooltips by activating the graph window, clicking on the View menu and 
clearing the check mark beside Data Tooltips.  

There is a second way to control tooltip display that is more complicated but allows a greater degree of 
control. This entails changing the value of LabTalk system variables @PT and @PTI.  

@PT=0; //Disable both data plot and data point tooltips 

@PT=1; //Enable data plot tooltips for 2D graph  

@PT=2; //Enable data plot tooltips for 3D OpenGL graph (default) 

@PT=3; //Enable data plot tooltips for both 2D graph and 3D OpenGL graph  

@PTI=0; //Disable only data point tooltips 

@PTI=1; //Enable data point tooltips (default) 

12.5.4 The Annotation Tool 

 The Annotation tool shares a "split-button" with the Distance Annotation and Angle Annotation tools.  

 

https://www.originlab.com/doc/Origin-Help/Customization-with-SysVar
https://www.originlab.com/doc/LabTalk/ref/sys-var-list
https://www.originlab.com/doc/LabTalk/ref/sys-var-list


Graphical Exploration of Data 

267 

Use the Annotation tool to label a data point. The tool works with Symbol/Line+Symbol and Column/Bar 
plots. Choose from several standard data point labels or create your own custom label using LabTalk script.  

To annotate a data point:  

Click the Annotation button on the Tools toolbar and move the cursor to the desired data point. The 

cursor and the Status Bar will display the current label form. 

 

Use the TAB to toggle between the following standard annotation forms: (X coordinate value, Y coordinate 
value); (X coordinate value, Y coordinate value)[index number]; X coordinate value; Y coordinate value; index 
number (row number); or Custom (see Tutorial, next). 

When you've selected your label form, double-click to add a label to the data point; or single-click on the point 
and press Enter. 

 

Tutorial: Customizing the Annotation String  

The annotation string can be customized by combining literal characters with the X and 
Y coordinate values:  

Start with a graph of your data  

Open the Script Window (Window:Script Window) and type the following 
command, then press Enter:  

system.annotation.customlabel$="X value: $(x,.2), Y 

value: $(y,*5) 

Click the Annotation button , hover on your graph, then press the Tab key several 

times to cycle through the annotation choices until the custom string format specified 
above is displayed in the Status Bar. The cursor will display the word "Custom". 

Start double-clicking on data points (or single-click and press Enter) to add the custom 
annotation string. The X values will be displayed with two decimal places and the Y 
values will be displayed with 5 significant digits, as specified by your script.  

 
Adjustments using the Pointer Tool:  

To move a label to another data point, click the Pointer tool , press the ALT key and drag the label. 

To re-position overlapping labels, drag the label. A leader line is automatically added. 

To copy a label to another data point, press CTRL + SHIFT and drag the label to a new data point. 

 

Note: Please view more information on string formatting in the Programming help file:  

Help: Programming: LabTalk > Language Reference > Object Reference > Alphabetical Listing of Objects 
> String  

https://www.originlab.com/doc/LabTalk/ref/String-obj
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12.5.5 The Screen Reader Tool 

The Screen Reader uses the Data Display window to report the XY(Z) coordinates of the cursor on the 

graph page. Note that the Screen Reader is not reading data point coordinates; rather it is reading page 
coordinates relative to the graph axes.  

The Data Display window opens automatically when you select the Screen Reader tool from the Tools toolbar 
(by default, the Data Display window is docked at the bottom of your Origin workspace).  

 

 
You can alter basic properties of the Data Display window by right-clicking on the window title bar or by right-
clicking inside the window.  

To use the Screen Reader:  

Click the Screen Reader button on the Tools toolbar. This opens the Data Display tool.  

Click on a location in the graph page to read its X,Y, and Z coordinates (ternary and contour only). Coordinate 
values show in the Data Display window.  

To increase cross-hair size, press the space bar.  

Click the Pointer button on the Tools toolbar to exit screen reading mode. 

12.5.6 The Data Reader Tool 

The Data Reader is used to read information associated with a data point in your plot. This could be 
coordinate values or it could be more complex information including metadata or even images that relate to 
the data point. The Data Reader works in concert with the customizable Data Info window.  

The Data Reader tool is grouped with two related tools -- the Data Cursor and the Data Highlighter 

. Only one of these toolbar buttons will show at any given time. To select a hidden tool, click on the small 
arrow to the right of the button and select a tool from the pop-up menu.  

 

https://www.originlab.com/doc/Origin-Help/Data-Info-Tool


Graphical Exploration of Data 

269 

 

You can zoom into the graph while using the Data Reader. While the tool is active, 
press CTRL and use your mouse wheel to zoom in or out on the page.  

To use the Data Reader tool:  

Click the Data Reader button on the Tools toolbar. This opens the Data Info window.  

Click on a data point to read its X,Y (and Z, if they exist) coordinates. Coordinate values display in the Data 
Info window (and Data Display window).  

To move the cross-hair to the next data point along the data plot, use the LEFT and RIGHT arrow keys or click 
on the data point using your mouse. If you have multiple plots in a layer, use the UP and DOWN arrow keys to 
move to a data point on another plot or use your mouse to click on the point.  

To change the vertical and horizontal cross-hair size, click on a point and press the spacebar. 

Click the Pointer button on the Tools toolbar or Esc key to exit the Data Reader tool. 

 

There are a number of system variables that control Arrow key acceleration and data-
increment for the Data Reader. For more information, see the summary table in 
Reading Coordinate Values in the Graph.  

12.5.7 The Data Cursor Tool 

  The Data Cursor tool -- grouped on the Tools toolbar with the Data Reader tool -- allows you to place one 
or more cursors on a data plot and (using the Data Info window) read the cursor coordinates or measure the 
X and Y distance between two cursors, or the distance between a cursor and a point selected with the Data 
Reader.  

 

Tutorial: Using the Cursor Tool to Measure Relative Distance  

Import the file Samples\Spectroscopy\Sample Pulses.dat and create a line plot. 

Click and select the Data Cursor button from the Tools toolbar.  

 

Double-click on one of the peaks or click once on a data point and press ENTER, to add 
a cursor object.  

https://www.originlab.com/doc/Origin-Help/Read-Coordinate-in-Graph
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Repeat to place a second cursor object on another peak. 

Double click in the Data Info. window to open the Data Info. Report Settings dialog. 
If this window is not visible, select the View: Show Data Info menu item to open the 
Data Info. window. 

Switch to the Columns tab and then right-click in the gray area to the right of the 
columns and choose Add Column. 

In the new column that is added, click on the source row of new column, and select 
Relative (Cursor2 - Cursor1) from the drop-down, and then press OK to close the 
dialog. 

Now you can drag and move the cursor objects and the third column in the Data Info 
window will display the X and Y distances between the two cursors. 
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12.5.8 Distance Annotation Tool 

The Distance Annotation tool shares a Tools toolbar "split-button" with the Annotation and Angle 
Annotation tools.  

 

 
Use the Distance Annotation tool for drawing a scale-labeled, double-headed arrow between two points on a 
2D graph.  

 

Click the Distance Annotation button on the Tools toolbars. 

On a graph, place the crosshair on the starting point and drag with your mouse. Press Shift to force the 
double-headed arrow to the horizontal or vertical 
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To fine-tune arrow placement, right-click on the drawn arrow and choose Properties. Use Dimensions tab 
settings to control exact placement of object. 

12.5.9 Angle Annotation Tool 

The Angle Annotation tool shares a Tools toolbar "split-button" with the Annotation and Distance 
Annotation tools.  

 

Use the Angle Annotation tool to draw and label an interior angle of < 180°.  

 

12.5.10 The Data Highlighter Tool 

The Data Highlighter is grouped on the Tools toolbar with the Data Reader and Data Cursor tools. Use the 
Data Highlighter to pick one or more points in the your graph and simultaneously highlight the corresponding 
data row in the worksheet. Unselected points are dimmed in the graph and the worksheet. 

 

 
While in Data Highlighter mode ...  

CTRL+click to select multiple points in the graph. 

Drag out a rectangle/freehand object on the graph to select multiple points. 

Use SPACE to toggle between rectangle and freehand selection modes. 
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Use left/right arrow keys to highlight individual points in sequence by row index. 

In the worksheet (still in Highlight mode), CTRL+click multiple rows or SHIFT+select blocks of rows, and 
highlight corresponding points in the graph. 

Press ESC to exit Highlight mode in the graph while keeping highlighted rows selected in the worksheet. 

 

Some users did not know about ESC'ing (Highlight mode) in the graph window and 
found that when trying to plot selected data in the worksheet, the Plot Setup dialog 
opened. In this case, you can skip pressing the ESC key by setting system variable 
@QDHT=1. This will allow you to go directly to the worksheet and directly plot the 
highlighted data.  

Another option, is to use the graph window's Create Subset Sheet Mini Toolbar button 
to output selected points to a new worksheet.  

 

12.5.10.1 Collect Data from Multiple Sheets 

When the Data Highlighter is active, a Mini Toolbar displays at the upper-right corner of the graph or 
worksheet window. The toolbar has buttons to Create Subset Sheet, Delete Points, Mask/Unmask 
Highlighted Points or Dimmed Points; plus a Highlighter Properties for configuring how to pick and 
collate data from multiple worksheets.  

 

 
How to Pick Points Plotted from Multiple Sheets  

Use this method for picking a subset of points from a graph window containing plots from multiple worksheets, 
and adding them to a single sheet:  

Pick the Data Highlighter tool , then CTRL+click to select multiple points from a SINGLE plot; or drag 
out a rectangle/freehand object on the graph to select multiple points (hint: press spacebar for ROI shape). 

When finished, click the Create Subset Sheet button on the Highlighter Mini Toolbar. 
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Click the Open Properties Dialog button on the Mini Toolbar and set Add Data Mode = Append or Append 
with Gap. 

Continue to pick points from other plots (worksheets) as in step 1, clicking the Create Subset Sheet button 
each time you finish picking points from one of the plots. 

When you have finished, pick the Pointer tool . 

12.5.11 The Data Info Window 

     The Data Info window opens when you choose either the Data Reader , the Annotation or the 

Data Cursor tools . When you click on a plotted data point with one of these tools, the Data Info window 

displays information about this particular data point.  

 

In its default configuration, the Data Info window reports only a column short name, plot designation (e.g. 
"X") and the XY coordinate values of a data point. However, the window is capable of displaying any of the 
worksheet-contained information that is associated with a data point including metadata and images.  

 

To customize the Data Info window:  

Double-click on the Data Info window; or right-click and choose Preferences....  

Use the controls in the Data Info Report Settings dialog box to customize the display of the Data Info 
window: 
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The Data Info window can report any information in the source data worksheet. You are not limited to 
displaying plotted data. 

The window can display anything that can be inserted into the worksheet cell, including inserted graphs and 
images. 

The window can be customized with a Window Title and Report Title. 

Window configurations can be saved as Themes, including Save to <Graph>, Save to <Layer> and Save to 
<DataPlot>. This allows, for instance, all graph windows in your project or all graph layers in your multi-
panel graph to have a unique Data Info window. Saved Themes can loaded and applied to the current Data 
Info window.  

 

 

If you save your Data Info Theme settings in the graph, then save the graph window 
as a standalone graph window file (OGG, OGGU), know that the OGG/OGGU file travels 
only with the data that are plotted in the graph. Therefore, if your Data Info Theme 
uses data in other columns in your worksheet, the Data Info display will be incomplete 
if, for instance, you reopen the window file in a new project.  

 

 
For more information on customizing the Data Info window, see:  

The Data Info Window. 

Tutorial: The Data Reader Tool (discussion on customizing the Data Info window). 

12.5.12 Gadgets 

    Origin provides several Gadgets for data exploration and analysis. These gadgets are accessible from the 
Gadgets menu when a graph window is active. Three gadgets in particular are suitable for data exploration:  

Vertical Cursor 

https://www.originlab.com/doc/Origin-Help/Data-Info-Tool
https://www.originlab.com/doc/Tutorials/DataReader
https://www.originlab.com/doc/Origin-Help/Gadget-VerticalCursor
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Statistics 

Cluster (OriginPro) 

The Vertical Cursor gadget is especially useful for reading XY coordinate values for data points in stacked 
panel plots or multi-plot graphs, where plots share a common X scale.  

To open the Vertical Cursor:  

With a graph window active, choose Gadgets: Vertical Cursor... from the main menu. This opens the 
Vertical Cursor dialog box. 

Using the controls in this Gadget's dialog box, you can add data labels to the graph, increase or decrease label 

font size, hide labels, etc.  

 

 

When labeling plots with the Vertical Cursor, you can opt to combine separate data 
labels into a single label by clicking the gadget's Show All Info in One Label button.  

 

The Statistics gadget returns basic statistics on data points falling inside a rectangular region-of-interest 
(ROI) on the graph.   

https://www.originlab.com/doc/Origin-Help/Gadget-Statistics
https://www.originlab.com/doc/Origin-Help/Gadget-Cluster
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Display basic statistics for data inside the ROI. 

Display mean and nth Standard Deviation lines inside the ROI. 

Update results dynamically as ROI is moved or resized. 

 

 

 
The Cluster gadget (available in OriginPro) provides the following features:  

Display basic statistics for data inside a region of interest (ROI). 

Switch between rectangular or elliptical ROI. 

View statistics for points inside and outside of the ROI. 

Edit, copy, mask, delete or group data points. 

Update results dynamically as ROI is moved/re-sized. 

Output results to a worksheet. 

 

When you use the Cluster gadget to define a category (points within a ROI on a plot), 
you can apply a differentiating color to points within the ROI.  

https://www.originlab.com/doc/User-Guide/OriginPro
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Note: To learn more about these gadgets, see:  

Help: Origin: Origin Help > Gadgets  

12.6 Drawing Data Points on the Graph 

https://www.originlab.com/doc/Origin-Help/Gadgets
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This section discusses methods of graphically creating and modifying data plots.  

This collection of tools and menu-driven operations is helpful in exploring certain "what if" scenarios, or to 
quickly generate some data for purposes such as testing a fitting function. These procedures work only with 2D 
scatter plots.  

12.6.1 Drawing a Data Point 

Activate the graph window. 

Click on the Draw Data Tool . 

A small dialog opens and displays the graph window short name. Click the Settings button to expand the 
options as below:  

 

Set Add Data Mode to Append With Gap. Click the Start button, then hover on the graph and double-click 
to set a data point. Continue clicking to set as many data points as you need.  

Points drawn on a new graph window will be added to a new sheet in the GAData book. Click the Worksheet 
button to pop-up this new Workbook.  

 

Click Finish to end the point series.  

Each time you click Finish, a "--" separator is added to the worksheet columns to delineate a group of XY 
coordinates (drawn points). 

Points drawn on a new graph window will be added to a new sheet in the GAData book. Each graph window will 
have its own sheet in the workbook. 
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To label data points, go to the new Worksheet and enter label information in the Label column. Note that 
Label column info can also be used to create plot groups by opening Plot Details and editing controls on the 
Symbol tab (e.g. Symbol Color is indexed, by points, using the Label column data). 

 

 

12.6.2 Moving or Deleting Data Points in the Graph 

   

12.6.2.1 Moving a Data Point 

Move data point in graph will change the underlying data in worksheet. For data imported with data connector, 
by default it's locked with the external data and therefore unmovable. You would need to click the data 
connector icon and unlock imported data, disconnect sheet, or fully remove data connector before moving data 
points in graph. Then do the following :  

Select Data: Move Data Points (you'll be warned that you are about to change your data). There are hints 
on status bar about how to move. 

Crosshair will be put to a point in graph. Use arrow keys to navigate to or directly click on point you want to 

move.  

Drag the point to new location or use Ctrl + arrow keys.  

Click the Pointer button on the Tools toolbar or press ESC to exit the Move Data Points mode. 

The data point is moved in the plot and the X and Y coordinates are changed in the worksheet cell.  

 

By default, Move Data Points function caused scatter points to revert to the 
template's default style. You can press the TAB key to toggle between default symbol 
and customized symbol.  
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12.6.2.2 Deleting a Data Point 

You can delete individual data points from your graph:  

Select Data: Remove Bad Data Points.  

Double-click on the data point, or click to select the data point and press ENTER key.  

Click Arrow button on Tools toolbar or press ESC key to exit the Remove Bad Data Points mode. 

The data point is deleted from both the data plot and the worksheet cell. In the worksheet, only the data cell 
for the Y value will be cleared and shown as missing value.  

12.7 Topics for Further Reading 

Gadgets 

The Data Analysis chapter of this User Guide 

The Cluster Gadget (OriginPro) 

The Vertical Cursor Gadget 

The Digitizer 

The Statistics Gadget 

Masking Data 

Data Filtering 

Drawing or Deleting Data Points in the Graph 

List of Origin Built-in Toolbars and Buttons 

https://www.originlab.com/doc/Origin-Help/Gadgets
https://www.originlab.com/doc/User-Guide/Data-Analysis
https://www.originlab.com/doc/Origin-Help/Gadget-Cluster
https://www.originlab.com/doc/Origin-Help/Gadget-VerticalCursor
https://www.originlab.com/doc/Origin-Help/Tool-Digitizer
https://www.originlab.com/doc/Origin-Help/Gadget-Statistics
https://www.originlab.com/doc/User-Guide/Data-Analysis
https://www.originlab.com/doc/Origin-Help/Wks-DataFilter
https://www.originlab.com/doc/User-Guide/Data-Analysis
https://www.originlab.com/doc/User-Guide/Toolbars
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13 Gadgets 

Gadgets 

Gadgets provide a quick and easy way to perform exploratory analysis on plotted data. The concept is simple: 
While each Gadget has a specific purpose, each is built around applying a set of customizable analysis 
operations to a range of plotted data defined by a movable, resizable, region-of-interest (ROI) object.  

You can drag to modify the ROI at any time, then change your analysis options and recalculate results by 
clicking the arrow button in the upper-right corner of the ROI and choosing one of the menu options. For 
general access to Gadget formatting and analysis options, choose Preferences at the bottom of the context 
menu. Use the Preferences Dialog Theme box to save a group of Gadget settings to a Theme file.  

Multiple Gadgets are supported on a graph. You can distinguish ROIs by giving each a different color. Click on 
an ROI object to bring it forward. When an ROI is selected, you can use the TAB key to switch the ROI.  

                 

 

 

Origin 2016 introduced add-on tools called Apps. Since being introduced, many new 

exploratory and analysis-related tools have been added to OriginLab's File Exchange 
and more tools are being released all the time. Please visit the File Exchange to review 
available tools.  

13.1 Origin Gadgets 

The Gadgets main menu is available when a graph window is active. There are 14 gadgets available in Origin.  

http://www.originlab.com/fileexchange/index.aspx
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Cluster Gadget  
View statistics on points inside or outside of a graphically-defined region-of-

interest (rectangular, circular/elliptical or arbitrarily-shaped).  

Differentiate Gadget  Calculate and plot the nth-order derivative of selected data.  

FFT Gadget  View FFT spectrum of selected data.  

Integration Gadget  Calculate the area under a curve, or between two curves.  

2D Integration 
Gadget  

Calculate the 2D integration for a contour or image graph created from 

matrix or XYZ worksheet data.  

Interpolate Gadget  
Perform linear, spline, b-spline or Akima spline interpolation of selected 
data.  

Intersect Gadget  Calculate the intersection points of two or more data plots.  

Quick Fit Gadget  Perform linear, polynomial, or nonlinear fitting of selected data.  

Quick Peaks Gadget  Locate peaks, and compute area and other peak properties.  

Quick Sigmoidal Fit 
Gadget  

Perform Sigmoidal fit of selected data.  

Rise Time Gadget  Analyzes rise/fall time for the step-like signal.  

Statistics Gadget  
Compute and display simple descriptive statistics of selected data on the 

graph.  

Vertical Cursor 
Gadget  

Read coordinate values and label data plots across multiple graph layers that 
share the same X axis.  

Image/Contour 
Profile  

Analyze the image or contour from matrix data and generate profiles.  

Curve Translate 
Gadget  

Drag a curve in the vertical or horizontal direction, adjusting source data in 
the process.  

 

Note:To learn more about these gadgets, see:  
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Help: Origin: Origin Help > Gadgets  

Help: Origin: Origin Help >Matrixbooks Matrixsheets and Matrix Objects > Viewing and Profiling 
Matrix Data  

 

 

Tutorial: Using the Integrate Gadget to Output Results to a Worksheet  

With a new workbook active, import the file Peaks on Exponential Baseline.dat located 
in the Samples\Spectroscopy subfolder under the Origin installation folder. 

Create a line plot of the data in column B. 

With the graph active, go to the main menu and click Gadgets: Integrate.... 

In the dialog box that opens, click the Baseline tab and select Straight Line from the 
Mode drop-down list. 

Click the Output tab, and under the Output Quantities to node, select Append to 
Worksheet and clear the other check boxes. 

Expand the Quantities node, select None from the Dataset Identifier drop-down list 
and enable Beginning X and Ending X. 

Press OK to close the dialog box. The Region-of-Interest (ROI) rectangle object is added to 
the graph. 

Resize and move the ROI object to cover just the first peak in the data plot, then press the 

arrow button located at the top-right of the ROI and select New Output; or press "O" 
on your keyboard. This will write the parameters for the first peak to a worksheet. 

Drag and move the ROI to cover the second peak, and repeat the steps above to generate 
output for the second peak. 

Press the arrow button again and this time select Go to Report Worksheet. A 
worksheet with the integration results will open. 

https://www.originlab.com/doc/Origin-Help/Gadgets
https://www.originlab.com/doc/Origin-Help/View-Profile-MatData
https://www.originlab.com/doc/Origin-Help/View-Profile-MatData
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13.1.1 Custom Label for ROI Box 

Origin supports custom labeling of the ROI Box for the Quick Fit and Statistics gadgets. Custom labels are 
preserved and updated when you select new output. Further, they can be saved as part of a Dialog Theme.  

https://www.originlab.com/doc/Origin-Help/Dialog-Theme
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13.1.2 Custom Label and Button Size 

13.1.2.1 General Change Label Font Size and Button Size of Any Gadget 

To customize the label font size and button size (both the close button and the menu flyout button):  

Open \User Files\Origin.ini and search for the [Font] section. 

Add two lines to this section as shown in the image below, then save the file with your additions.  

Any new Gadgets added to the window should use the new font and button size. Adjust as needed. 

 

13.1.2.2 Quick Fit Gadget 

Choose a gadget from the Gadgets: Quick Fit menu. 

Open the gadget dialog (hint: if the ROI is already added, click the menu button and choose 
Preferences). 



UserGuide 2026 

288 

Click the ROI Box tab and enable Custom Label.  

Build your custom label using a mix of (a) literal text (b) escape sequences (e.g. Greek symbols or 
superscripts) and (c) custom variables. Specify decimal places, etc. using Origin custom formats. 

Dialog Label  Custom Variable  Example  

Reduced Chi-Sqr  chisqr  Chi-Square \g(c)\+(2) = $(chisqr, .2)  

R-Square  cod  R-Squared r\+(2) = $(cod, .2)  

Pearson's r  r  r = $(r, .2)  

Y Intercept  intercept  Y Intercept = $(intercept, .2)  

Slope  slope  Slope = $(slope, .2)  

X Intercept  xintercept  X Intercept = $(xintercept, .2)  

13.1.2.3 Statistics Gadget 

Choose Gadgets: Statistics: Open Dialog (hint: if the ROI is already added, click the menu button and 
choose Preferences). 

Click the Show on Center-Top of ROI Box tab and enable Custom Label.  

Build your custom label using a mix of (a) literal text (b) escape sequences (e.g. Greek symbols or 
superscripts) and (c) custom variables. Specify decimal places, etc. using Origin custom formats. 

Dialog Label  Custom Variable  Example  

N  n  Count = $(n)  

Mean  mean  \g(m) = $(mean, *4)  

SD  sd  \g(s) = $(sd, .2)  

Minimum  min  Min = $(min, .2)  

X at Minimum  xminy  X Min = $(xminy, .2)  

Maximum  max  Max = $(max, .2)  

https://www.originlab.com/doc/Origin-Help/Escape-Sequences
https://www.originlab.com/doc/LabTalk/guide/numeric-string-conversion
https://www.originlab.com/doc/Origin-Help/Escape-Sequences
https://www.originlab.com/doc/LabTalk/guide/numeric-string-conversion
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X at Maximum  xmaxy  X max = $(xmaxy), .2)  

Sum  sum  Sum = $(sum, .2)  

13.2 Topics for Further Reading 

Gadgets 

The Image/Contour Profile tool 

Tutorial: Using Multiple Gadgets 

Tutorials for Individual Gadgets 

Peak Analyzer 

Digitizer 

https://www.originlab.com/doc/Origin-Help/Gadgets
https://www.originlab.com/doc/Origin-Help/View-Profile-MatData
https://www.originlab.com/doc/Tutorials/Using-Multiple-Gadgets
https://www.originlab.com/doc/Tutorials/Gadgets
https://www.originlab.com/doc/Origin-Help/PeakAnalyzer
https://www.originlab.com/doc/Origin-Help/Tool-Digitizer




 

291 

14 Data Analysis 

Data-Analysis 

14.1 Introduction 

Origin contains powerful tools for all of your data analysis needs, including curve fitting, statistics, peak 
analysis and signal processing. Most of Origin's analysis tools can make use of a stored collection of settings -- 
something known as a Dialog Theme -- that makes repeat analyses a snap. Furthermore, the output from 
one operation can become the input for another operation, thus allowing you to set up a chain of operations, 
with results that update whenever there are changes to source data, as would happen when importing a series 
of data files.  

The following sections cover (1) selecting the data that you wish to analyze and (2) the Origin and OriginPro 
tools available for analyzing that data. Please refer to the How to Handle Repetitive Tasks chapter of this User 
Guide for more information on Analysis Templates, Dialog Themes and other time-saving features.  

 

Apps are add-on tools that extend Origin's graphing and analysis capabilities. Many 
analysis-related tools are available free-of-charge from OriginLab's File Exchange. To 
find out more about Apps in Origin, see the Apps for Origin chapter of this User Guide.  

14.2 Data Input 

Origin's analysis tools will work with workbook, matrix and/or graph data, depending upon the tool. By default, 
analyses will be on done on selected data (note that in the case of matrix data, "selected data" will the the 
matrix sheet or matrix object, depending on the analysis). When working with worksheet or graph data, you 
may want to restrict your analysis to a subset of the data -- say, a certain range of rows or columns in a 
worksheet or a certain X range in a graph.  

Data selections can be made before or after opening an analysis dialog. Most of Origin's X-Function based 

analysis tools have a Input branch with a range selection control that you can use to interactively select your 
data (as explained below).  

14.2.1 Selecting Data in the Worksheet 

 When you highlight a range of worksheet data, then open one of X-Function based dialog boxes -- that would 
include nearly all of those that open from the Analysis or Statistics menus -- you will see your range 
selection already entered into the dialog box Input branch. Most will find that selecting worksheet data prior 
to opening an Analysis or Statistics dialog box, is the easiest way to specify which data you wish to analyze. 

https://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
https://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
http://www.originlab.com/fileexchange/index.aspx
https://www.originlab.com/doc/User-Guide/Apps
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If you open one of the X-Function dialog boxes without pre-selecting your data, the first thing you should do 
upon opening the dialog is to select data in Input branch: 

 

Click the range selection control next to Input (or Input Data). The dialog box will roll up. 

Go to worksheet and highlight your worksheet data, then click the button at the right end of the rolled up 

dialog box. The Input branch will now show the selected range. 

Note that you do not have to select entire datasets (columns). You can select a portion of your worksheet data 
and analyses will be confined to that selected subset of your data. Also if the analysis supports multiple 
datasets, you could support multiple ranges such as multiple Y columns or Y ranges. If the analysis only 
supports one dataset, you may be able to select multiple ranges in the worksheet, but only the 1st range will 
be picked in the analysis.  
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Notes  

The Input Data branch has a hierarchical structure. If the analysis supports multiple datasets, you can add 
multiple ranges under Input Data and they will show as Range 1, Range 2, etc., each with its corresponding 
X, Y, Error and Row controls.  

Mousing over each level will show a tooltip indicating where the data on that level is from (i.e. book, sheet and 
column). 

A Rows control under each range node lets you set range by row index or X value. If you want to apply the 
same row range to all ranges under Input Data, click the arrow button to the right of the range node and 
choose Apply Row Range to All. 

Depending on where you are in the Input Data hierarchy, the range selection button may have some 
limitations ( e.g. if you click range selection control next to Y, though you could select multiple columns in a 
worksheet, only the 1st column is accepted).  

Clicking the arrow button to the right of the range selection control will show more selection options, including 
individual worksheet columns that can be quickly added to your data selection.  

Depending on which level you are in, the selection options when clicking the arrow button may vary. For 

instance, clicking the "arrow" button next to Input Data and clicking the Select Columns... menu item, will 
open the Column Browser allowing you to select multiple columns from different worksheets.  
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Use the List Datasets drop-down list to filter which sheets you want to pick from. The top panel list can be 
sorted by clicking any of the column headings, making it easy to select, for example, all columns that share 
the same LName or Comments.  

Then click the Add button to add the column to your selection list in bottom panel.  

To modify the data input range of any dataset, click the range button to the right of any dataset added to the 
bottom panel and edit the From and To values. 

 

14.2.2 Selecting Data in the Graph 

  When a graph window is active and you select one of the Analysis menu tools, the default behavior is for the 
analysis dialog box to open showing the selected range of the active dataset as your Input Data (note that 
analysis dialogs include an Input Data node that allows adjustments -- adding more datasets with the 
interactive range selector button, changing a data range, etc.).  

14.2.2.1 The Data List and the Active Data Plot 

The active data plot is the one that shows in the data list (bottom of the Data menu) with a check mark next 
to it. If the active graph layer contains a plot group, the default behavior is to make the first plot in the group 
the active data plot (note the "g1" beside each range in the following image, indicating that all are members of 
plot group 1). You can activate a different plot by clicking on another of the data plots listed at the bottom of 
the Data menu. Subsequently, when you open an analysis dialog box, this newly-selected plot will be listed as 
your input data.  

https://www.originlab.com/doc/User-Guide/Graphing
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However, for most purposes, you can ignore the data list and select your plot data directly in the graph 

window or using the Object Manager:  

If your data plots are part of a plot group, select the entire group by pressing SHIFT + clicking on a plot. 
Alternately, click on the group icon in the Object Manager. Either will set Input Range to all plots in the 
group.  

To select just a single plot -- whether it be an independent plot or part of a group -- click once on the plot. 
Alternately, click on the plot icon in the Object Manager. Either will set Input Range to only the selected plot. 

 

 

 

You can also indicate the active dataset by placing a red box around the plot's legend 
entry. In the case of grouped plots, the red box shows on the first plot in the group. 

To turn this feature on or off:  

Click on your graph window, select Format: Page..., click on the Legends/Titles tab 
and enable or clear the Indicate Active Dataset box.  

Select the graph legend, then right-click on it and choose Legend, then select/deselect 
the Indicate Active Dataset menu entry. 

Select the graph legend, then right-click on it and choose Legend: Update Legend 

https://www.originlab.com/doc/User-Guide/Origin-Interface
https://www.originlab.com/doc/User-Guide/Graphing
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and enable or clear the Indicate Active Dataset box. 

14.2.2.2 Customizing X scale range using Analysis Dialog "Rows" controls 

You can adjust data range using the Rows controls under the Input Data branch of most analysis dialogs. If 
you have an analysis dialog box open:  

Click on Input Data branch to expand. 

Change the Rows drop-down list to By Row or By X and enter your From and To values. Note that each 
Range N will have its own Rows controls. 

 

14.2.2.3 Customizing X scale range using Axis Scale Mini Dialog 

Before opening an analysis dialog...  

Click on an axis then click the Mini Toolbar Axis Scale button to open the Axis Scale dialog box. 

 

Adjust the X axis scale to your desired range. 

Now open your analysis dialog (e.g. Linear Fit) and click the arrow button beside the Input Data box and 
select Use X Scale Range from the context menu: 
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As you can see, the customized scale range of X axis on the graph has been used to specify the input data 
range for your analysis (Rows = By X).  

14.2.2.4 Selecting data graphically using The Regional Data Selector 

You can graphically select a range of data using the Regional Data Selector tool:   

With a graph window active, click and hold on the Regional Data Selector button on the Tools toolbar, 
and then choose either the Selection on Active Plot or Selection on All Plots button. 

Drag out a rectangle or freehand object to select an area of the plot(s). Note that you can press Space to 

toggle between rectangle and freehand modes . 

 

When you make your selection, Data Markers are placed on the graph to mark the selected range(s). You can 
now use Origin's analysis tools (e.g., Linear Fit) to perform an analysis on the selection, but note that some 
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analysis dialog boxes do not work on multiple data ranges. The smoothing dialog box, for example, (Analysis: 
Signal Processing: Smooth...) will only smooth data in the active dataset or a single, selected plot.  

 

There is a new Mini Toolbar for controlling X scale range when using Data Markers. 
Click on a Data Marker and use the buttons to Set Display Range or Reset to Full 
Range.  

 

 

 

Tutorial: Linear Regression on Partial X Range  

Import the file \Samples\Curve Fitting\Exponential Decay.dat into a new workbook. 

Select all Y columns and create a line plot. 

Click and hold the Regional Data Selector button on the Tools toolbar, and then 

choose the Selection on All Plots button . 

Drag out a rectangle to select the tail-end of the three curves between values of 
approximately 0.6 and 1.0 along the X axis. 

Use the Analysis:Fitting:Linear Fit menu to open the Linear Fit dialog.  

Input Data branch is filled with three ranges. Mouse over Input Data branch will show 
tooltip which shows 1X,1Y, ...3X and 3Y.  

If you want to change the data selection, click the arrow button in Input Data and 
choose Reselect All Data from Graph. The dialog will roll up. Drag out a rectangle in 

graph again to make your selection and then click the button at the right end of 
the rolled up dialog box. The new data selection will show in Input Data branch. 

Accept default Linear Fit settings and press OK to close the dialog. Linear fitting will be 
performed on all three curves over the selected range. 
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In addition to the data selection and data masking methods discussed in this 
section, Origin offers data filtering and data reduction tools. Please visit the linked 
pages for details.  

14.2.2.5 Editing a Data Marker 

To edit a Data Marker:   

To modify a data range, right-click a data marker and choose Edit; or double-click on the data marker. The 
red marker changes to a dark color with arrows on both ends and the cursor changes into a cross-hair. Drag 
the beginning or ending marker to a new position or use one of the keyboard shortcuts listed below and modify 
the data range. To escape edit mode, double-click on the marker or press the Enter key.  

There are other options when right-clicking the data marker such as Delete Marker, Delete Data, etc.. 

 

Note: If you have used the Regional Data Selector tool to place markers on multiple plots (Selection 
on All Plots), be aware that moving markers will affect the data range of the active plot only; the 

https://www.originlab.com/doc/Origin-Help/Wks-DataFilter
https://www.originlab.com/doc/Origin-Help/Wks-DataReduction
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ranges of other selected plots will not follow that of the active plot. This is a limitation of the Regional 
Data Selector.  

 
Alternately, you can use these keyboard shortcuts to select and edit data markers:  

Select data markers using these keys ...  

Hot Key  Action  

s  
Select the first pair of data markers on the graph (those marked with 
"1").  

Tab  
Select the next pair of data markers (not in edit mode) or the other 
data marker of the pair (in marker edit mode).  

Home  Return to the first data marker.  

End  Go to the last data marker.  

... then activate and edit the data marker using these key combinations:  

Hot Key  Action  

Enter  
Activate the selected data marker for editing. (Press Enter again to 
exit data selection mode.)  

Arrow  Move the active data marker exactly one data point.  

Ctrl/Shift + 
Arrow  

Move the active data marker multiple data points.  

Delete  Delete the the active data marker.  

14.2.2.6 Difference between Data Markers and Analysis Markers 

   

Data Markers define a sub-range that you select using the Data Selector tool.  

If you want to remove the data markers from a graph, you can select Data: Clear Data Markers from the 

main menu, or click the Clear Data Markers button on the Markers and Locks toolbar. 
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When the analysis routine is completed, Data Markers are replaced with Analysis Markers. By default, 
Analysis Markers will not show if the analysis is done on the entire dataset. If performed on a subrange, 
Analysis Markers will show at the beginning and end of that subrange. To modify the data range and rerun 
your analysis, you must right-click an analysis marker and choose Change Parameters.... Change the Input 
Data range and rerun the analysis. 

 

Note:  

If you set Recalculate to None in the analysis dialog box, then no analysis markers are generated. 

Data markers and analysis markers are not exported when you choose File: Export Graphs. 

To select the exact same range again for another analysis, click the green lock and choose Plot Input 
Data with Data Markers to create a new graph and do analysis on it. 

https://www.originlab.com/doc/Origin-Help/AnalyDialog-Recalculate
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There is a Markers and Locks toolbar to control analysis markers and locks, such as Marker Hide 

Show to toggle analysis markers on or off, etc. There is also an Analysis Markers submenu, 
available from the Data menu; or when you right-click on an analysis marker or green lock and choose 
Analysis Markers. 

14.2.2.7 The Pick Points Tool 

You can also pick the data points in the graph using the Pick Data Points tool. This works best for scatter or 
line + symbol plots of smaller datasets.  

Select Data: Pick Data Points. The Pick Points dialog will pop up. 

With the square cross-hair, you can read the coordinate of current data points in the Pick Points dialog (also 
the Data Source). Double-click on the point you want to pick until the cross-hair cursor became round, the 
actual X&Y values will be recorded and the total number of picked points will be counted up.  

 

Once you finished the picking, click the Done button to output the results to a new workbook. 

14.2.2.8 The Data Highlighter 

In some cases, the Data Highlighter on the Tools toolbar, can be useful for selecting some portion of your 
data for further analysis. For instance, you have a 2D scatter plot and you are interested in data points in a 
particular region of the graph.  

Click the the Data Highlighter button on the Tools toolbar. 

Highlight the desired group of data points. Note that you can toggle between rectangular and freehand 
selection modes by pressing the spacebar while the Highlighter is active. Selection points in the graph 
simultaneously highlights selected rows in the source worksheet. 

Go the source worksheet, right-click on it and choose Create Subset Sheet. 

You now have a secondary worksheet named as wcopyN, that contains only the data points that you selected 
in the graph.  

For more information, see The Data Highlighter Tool.  

14.3 Data Output 

Origin's analysis tools typically have an Output branch (the exact name varies by tool), in which you can 
specify the output that you wish to generate and where you would like that output to go. This happens to be 
the output branch of the Integration tool.  

https://www.originlab.com/doc/Origin-Help/Picking-Points
https://www.originlab.com/doc/User-Guide/Graphical-Exploration-of-Data
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Output can be directed to various places -- a range of worksheet cells or columns, or possibly to a worksheet, 
a workbook, a matrixsheet, or a graph layer. Output options depend upon the target object as well as the type 
of window that was active when the tool was opened. You can determine your output target by:  

Typing directly in the associated text box, using a standard range notation 

Selecting data with the interactive range control. 

Type or select your target using a set of predefined range strings. 

 
This being an introductory manual, we will stick with the simplest to use -- using predefined range strings. 
For information on other options, follow the links above.  

14.3.1 Specifying Output Using Range Strings 

Referring to the image above, note that range strings are enclosed by < > characters. Valid strings will differ 
from dialog to dialog (e.g. <source> is available from the Book list under the Output Fitted Values To 
branch of the Fit Linear dialog, but it is not used to specify Output in the Smooth dialog).  

The most common strings:  

<none>: Generate no output. 

<new>: Create a new Origin object -- a column, a worksheet, a graph, etc. 

<input>: Use the input object for output. 

You can type these strings directly into the edit box but the easiest thing to do is to just select them from the 
flyout menu (options will vary by tool). Alternately, you can click the Custom button and open the Range 
String Builder. Despite the intimidating name, it is just a way to step through the process of specifying your 
output target. For more information on range strings and Range String Builder, see Output Results in the 
Origin Help file.  

14.4 Data Masking 

   Masking is another technique that you can use when you want to analyze only a subset of your data, or 
when you have spurious data points that you do not want included in your analysis. Masking or unmasking 
data will trigger recalculation of linked operations.  

You can mask data points in both worksheets and graphs.  

When data exist in both the worksheet and the graph, masking data in one will mask (and mark) the 
corresponding data in the other. 

Mask toolbar buttons work on both graphs and worksheets.  

Tools toolbar buttons work on graphs. 

https://www.originlab.com/doc/LabTalk/guide/Range-Notation
https://www.originlab.com/doc/Origin-Help/AnalyDialog-SpecifyInput
https://www.originlab.com/doc/Origin-Help/AnalyDialog-OutputResult
https://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
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When data are selected in the worksheet, a Mini Toolbar Mask Data button becomes available.  

Additionally, you can mask worksheet data by mathematical condition. 

 

The active worksheet's Masked and/or Unmasked Data Count can be reported to the 
Status Bar.  

14.4.1 Masking with the Mask Toolbar (worksheet, graph) 

These toolbar buttons are used to mask and manipulate masking of selected data. Note that this includes 
graphs, once data have been selected (see the next section on Tools toolbar buttons for graph selection).  

Action  
Toolbar 
Button  

Shortcut Command  Notes  

Mask data  
 

Mask: Range  
Mask the selected data range. 
Masked data will display in the 
mask color.  

Unmask data  
 

Mask: Clear Range  

Unmask the selected data range. 
Unmasked points are included in 
analysis operations and plot 
"normally".  

Swap mask  
 

Mask: Swap  
Swap masked and unmasked 
points in the active dataset.  

Change mask 
color  

 

Mask: Change Color  
Change the mask color of the 
masked data range.  

Hide/Show 
masked points  

 

Mask: Hide  
Toggle display of masked points 
ON and OFF on-screen, and in 
printed and exported graphs.  

Disable masking  
 

Mask: Disable 
Masking  

Toggle the mask ON or OFF for all 
masked data in the worksheet. 
When toggled OFF, all data points 
are analyzed and included in 
printed and exported graphs.  

14.4.2 Masking with the Tools Toolbar (graph) 

 

There was a change made to the default masking mode, starting with Origin 2021:  

Default is changed from mask by row index number to mask by rectangular region. 

Otherwise, behavior remains as before: toggle between masking modes (see next) by 

https://www.originlab.com/doc/User-Guide/Origin-Interface
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pressing Spacebar. 

Use system variable @MTI=1 (persistent) to revert to mask by row index as default. 

To mask points, click on the graph window to activate it:  

Choose Data: Mask Data Points from the main menu or click the Mask Points on Active Plot button or 
Mask Points on All Plots button on the Tools toolbar, then hover on the graph.  

To mask a single point, double click on the point. To mask a region of points, press the Space bar to toggle 
among masking by row index number, by rectangular region or by freehand region (differences explained 
below), then drag out a region. 

Once data are masked in the graph, you can use the Mask toolbar buttons, described above. 

Mask Points 
on Active 
Plot  

Mask Points on 
All Plots of 
Active Layer  

Purpose  

 

 

Mask data points by rectangular region. Only the data points 
inside the rectangle that you drag out, will be masked.  

 

 

Mask data points by freehand region. Only the data points 
inside the region that you drag out, will be masked.  

 
 

Mask data points by row index number. All data points 
between the lowest and highest selected index numbers are 
masked regardless of whether they lie inside your rectangle.  

 
To remove the mask from data points in the graph window:  

Choose either the Unmask Points on the Active Plot tool or the Unmask Points on All Plots of Active Layer 

tool on the Tools toolbar.  

Use the space bar, as needed, to choose points by index, rectangular region or by freehand region, then drag 

to unmask your data points. The tool will be active until press ESC or click the Pointer tool. 

14.4.3 Mask Mini Toolbar Button (worksheet) 

When worksheet data are selected -- cells or entire columns -- A Mini Toolbar Mask Data button becomes 
available. The button works as a toggle to mask or unmask data within the selection.  

14.4.4 Mask Cells by Condition (worksheet) 

There is a tool for masking worksheet data values by condition (e.g. <= 0).  

With the data selected (cells or one or more columns), choose Column: Mask Cells by Condition. This opens 
the colmask dialog. 

Choose your Condition and Value, plus other options as needed and click OK. 

https://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
https://www.originlab.com/doc/X-Function/ref/colmask
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14.4.5 Copy Mask Status 

Two ways to copy mask status (the masked cells location) to other columns or worksheet.  

menu Edit: Copy: Copy Mask Status. 

menu Worksheet: Copy Columns to, or right click on columns and select from context menu Copy Columns 
to. This will open the colcopy X-Function. Uncheck Copy Data and check Copy Mask. 

14.5 Mathematics 

Origin provides a number of mathematics tools to perform basic calculations, interpolation, and area or volume 
calculations.  

14.5.1 Basic Math 

  

Tool Name  Description  Menu Entry  

Simple Column 
Math/Simple Curve Math 

Normalize Columns/Curves 

Average Multiple Curves 

Differentiate 

Perform basic calculations on 
worksheet columns or XY data 
plots 

Analysis:Mathematics 
(workbook, graph)  

Simple Math 
Perform element-wise arithmetic 
on two matrices. 

Analysis:Mathematics 
(matrix)  

Subtract Reference Data 
Subtract one dataset from 
another 

Analysis:Data Manipulation 
(workbook, graph)  

Subtract Straight Line 
Subtract a straight line defined 
graphically by clicking in the 
graph. 

Analysis:Data Manipulation 
(graph)  

Subtract 
Subtract matrices in sheet by 
another matrix. 

Analysis:Mathematics 
(matrix)  

Vertical Translate 

Horizontal Translate 

Use a Gadget to graphically 
translate curve(s) in vertical or 
horizontal. 

Analysis:Data Manipulation 
(graph)  

Differentiate Gadget 
Perform differentiation over a 
region of interest in a graph  

Gadgets:Differentiate... 
(graph)  

Intersect Gadget 
Calculate the intersection points Gadgets:Intersect... 

https://www.originlab.com/doc/X-Function/ref/colcopy


Data Analysis 

307 

of two or more data plots.  (graph)  

Vertical Cursor 

Read and tag X, Y coordinate 
values for data plots across 
multiple graphs that share the 
same X axis.  

Gadgets:Vertical Cursor... 
(graph)  

Set Column Values 
Use formulae to set/transform 
worksheet column values 

Analysis:Mathematics 
(workbook)  

Inverse 
Generate pseudo inverse of a 
matrix 

Analysis:Mathematics 
(matrix)  

Median Filter 

Special Filter 

Custom Filter 

Apply median/special/custom 
filter to a matrix 

Analysis:Mathematics 
(matrix)  

14.5.2 Interpolation 

  

Tool Name  Description  Menu Entry  

Interpolate Gadget 
Perform interpolation over a 
region of interest 

Gadgets:Interpolate... 
(graph)  

Interpolate/Extrapolate 

XYZ Trace Interpolation(3D 
Graph)  

Trace Interpolation(2D 
Graph) 

Perform 
interpolation/extrapolation on a 
group of XY data. 

Perform periodic interpolation on 
XYZ worksheet data 

Perform interpolation on cycle or 
periodic curves 

Analysis:Mathematics 
(workbook, graph)  

Interpolate/Extrapolate Y 
from X 

3D Interpolation  

Perform 
interpolation/extrapolation on a 
group of XY data to find Y at 
given X values. 

Perform 2D interpolation on a 
group of XYZ data to find Z at 
given XY values w/ choice of 8 
methods. 

Perform interpolation with a 3D 
function on XYZ dataset.  

Analysis:Mathematics 
(workbook)  
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2D Interpolate/Extrapolate 
Perform 2D 
interpolation/extrapolation for a 
matrix 

Analysis:Mathematics 
(matrix, graph from matrix)  

14.5.3 Area/Volume Calculation 

  

Tool Name  Description  Menu Entry  

Integrate Gadget 
Perform integration over a region 
of interest in a 2D Graph 

Gadgets:Integrate... 
(graph)  

2D Integrate Gadget  

Calculate max height, volume, 
FWHM (X,Y) for a contour or 
image graph created from matrix 
or XYZ worksheet data (OriginPro 
Only).  

Gadgets:2D Integrate... 
(graph)  

Integrate(2D Graph) 

Polygon Area(2D Graph) 

XYZ Surface Area (3D 

Graph)  

Perform integration on input data 

Calculate the area of enclosed 
plot regions 

Calculate the area of the XYZ 
surface  

Analysis:Mathematics 
(workbook, graph)  

2D Volume Integrate  

Matrix Surface Area  

Calculate the volume beneath the 
matrix surface from zero plane 

Calculate the area of the matrix 
surface 

Analysis:Mathematics: 2D 
Volume Integrate (matrix, 
3D graph from matrix) 
or 
Analysis:Mathematics: 
Matrix Surface Area 
(matrix, 3D graph from 
matrix)  

14.6 Curve Fitting 

In addition to Origin's built-in curve-fitting tools, there are a number of add-on Apps designed for various 
curve-fitting operations that are available for free from the OriginLab File Exchange. To find and install these 
Apps click Analysis: Fitting: Find Apps. The App Center will open, displaying only fitting-related Apps. 

Browse available Apps and click the Download and Install button to install an App.  

 

You can use named range values as X "From" and "To" values, initial parameter values, 
lower and upper bounds and fixed parameter values, in the linear fit, nonlinear fit 
(NLFit), polynomial fit and multiple linear regression dialog boxes.  

https://www.originlab.com/doc/User-Guide/Worksheets-Columns
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14.6.1 Linear and Polynomial Fit 

  

 

Most curve fitting and peak finding analyses add an optional Result Table with equation, 
weighting, slope, intercept, etc., to the active graph. There is a Mini Toolbar button for 
adjusting displayed digits in the Result Table.  

 

Linear and polynomial fitting can be performed on worksheet data or data plots in a graph. Linear Fit of 
Matrix Stack is performed on a series of matrix objects.  

Tool Name  Menu Entry  

Linear Fit 
Analysis:Fitting:Linear Fit 
or 
Gadgets:Quick Fit (graph)  

Fit Linear with X Error  Analysis:Fitting:Fit Linear with X Error  

Multiple Linear Regression Analysis:Fitting:Multiple Linear Regression  

Polynomial Regression 
Analysis:Fitting:Polynomial Fit 
or 
Gadgets:Quick Fit (graph)  

Perform a linear fit on a series of matrix 
objects for each pair of XY coordinates. 

Analysis: Linear Fit of Matrix Stack (matrix)  

14.6.2 Nonlinear Curve Fit 

  You can perform nonlinear curve fitting using one of many built-in fitting functions, or you can create a user-
defined fitting function. OriginPro supports implicit function fitting, surface fitting, and fit comparison. Some 
tools are available only in OriginPro.  

The table below summarizes available nonlinear curve fitting tools:  

Tool Name  Features  Menu Entry  

https://www.originlab.com/doc/User-Guide/Matrix-Book-Matrix-Sheet-Matrix-Objects
https://www.originlab.com/doc/X-Function/ref/mstacklr
https://www.originlab.com/doc/X-Function/ref/mstacklr
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Quick Fit Gadget 

Fit a region of interest in a graph 
interactively 

Fit with built-in or user-defined 
fitting functions 

Fit one or multiple datasets 

Choose from a number of pre-
defined analyses (incl. Linear, 
Cubic, Peak and Sigmoidal). 

Gadgets:Quick Fit (graph) 
or 
Gadgets:Quick Sigmoidal 
Fit (graph)  

Nonlinear Curve Fitting 

Fit with built-in or user-defined 
fitting functions 

Fit one or multiple datasets 

Compare fit, multiple parameter 
sets 

Global fit with parameter sharing 

Global fit, parameter sharing with 

multiple functions  

Fit with replicas 

Advanced options including 
bounds, constraints, fit control 

Analysis:Fitting:Nonlinear 
Curve Fit (workbook, 
graph)  

Implicit Curve Fitting  

Fit with implicit functions 

Orthogonal Distance Regression 
(ODR) algorithm 

Analysis:Fitting:Nonlinear 
Implicit Curve Fit 
(workbook, graph)  

Surface Fit  
Fit data from a matrix or 
worksheet XYZ columns 

Analysis:Fitting:Nonlinear 
Surface Fit (workbook, 
graph) 
or 

Analysis:Nonlinear Matrix 
Fit (matrix)  

Fitting Function Builder 
Create or edit user-defined fitting 

functions 

Tools:Fitting Function 

Builder  

Fitting Function Organizer 

Manage fitting functions by 
categories 

Move or share functions between 
categories 

Tools:Fitting Function 
Organizer  

Fitting Function Library App 

Download fitting functions from 
originlab.com 

Request or Share a Function with 
OriginLab 

Click the Fitting Function 
Library icon in the Apps 
Gallery  
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Simulate 

Simulate a curve from a given 
function 

Simulate a surface from a given 

function  

Analysis:Fitting:Simulate 
Curve 
or 
Analysis:Fitting:Simulate 
Surface  

Fit Comparison  

Compare fit results from two 
datasets using one function 
function 

Compare fitting results for one 
dataset using two fitting functions 

Analysis:Fitting:Compare 
Datasets 
or 
Analysis:Fitting:Compare 
Models (workbook, graph)  

Fit and Rank Functions 

 

Compare fit results of two or 
more functions for a single 
dataset 

Analysis:Fitting:Rank 
Models (workbook, graph)  

 

 

User Defined fitting functions support an EMF or SVG image of the Formula (Equation) to 
display in lower panel of Nonlinear Curve Fitter (NLFit) or Fitting Function Organizer.  

 

To add an EMF or SVG image to your user-defined function:  

Create the EMF/SVG using an equation editor (hint: Origin's LaTeX App can convert a user-
defined fitting function into a LaTeX equation object). 

Name the EMG/SVG image just as you named the user-defined fitting function (e.g. 
MyFunction.SVG), making sure to add the correct file type, and place the image in \User 
Files\fitfunc. 

14.7 Peak Analysis 

http://www.originlab.com/fileExchange/details.aspx?fid=221
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Origin provides several tools for peak analysis. With these tools, you can define and subtract baselines, find 
peaks, integrate peaks, and fit peaks. Some tools are available only in OriginPro.  

Note that a number of free Apps designed for peak analysis are available from the OriginLab File Exchange. To 
find and install these Apps click Analysis: Peaks and Baseline: Find Apps. The App Center will open, 
displaying only peak-fitting related Apps. Browse available Apps and click the Download and Install button 

to install an App.  

The table below summarizes various built-in tools available for peak analysis:  

Tool Name  Features  Menu Entry  

Quick Peaks Gadget 

Perform peak analysis over a 
region of interest  

Create baseline 

Subtract baseline 

Find peaks 

Integrate peaks 

Fit peaks 

Gadget:Quick Peaks 
(graph)  

Multiple Peak Fit 
Pick multiple peaks 

Fit peaks 

Analysis:Peaks and 
Baseline:Multiple Peak Fit 
(graph, workbook)  

Peak Analyzer  

Create baseline 

Subtract baseline 

Find peaks 

Integrate peaks 

Fit multi-peak datasets  

Fit baseline  

Find hidden peaks  

Compute many peak 

characteristics  

Analysis:Peaks and 
Baseline:Peak Analyzer  
(graph, workbook)  

Batch Peak Analysis 

Use a theme file created using 
Peak Analyzer tool 

Perform batch peak analysis on 
multiple datasets 

Analysis:Peaks and 
Baseline:Batch Peak 
Analysis Using Theme 
(graph, workbook)  

14.8 Signal Processing 
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Origin provides signal processing tools for many tasks, including producing signal transforms, 
smoothing/filtering, and correlation on 1D and 2D signals. Advanced tools are available in OriginPro.  

You may refer to the tables below for the signal processing tools and their menu entry.  

14.8.1 Signal Transforms 

  

Tools  Menu Entry  

FFT Gadget Gadgets:FFT... (graph)  

Fast Fourier Transform (FFT) 

Inverse Fast Fourier Transform (IFFT) 

Analysis:Signal Processing:FFT 
(workbook, graph)  

2D FFT  

2D IFFT  

Analysis:Signal Processing:FFT (matrix)  

Short-time Fourier Transform (STFT) 

 

Analysis:Signal Processing:STFT 
(workbook)  

Hilbert Transform  
Analysis:Signal Processing:Hilbert 
Transform (workbook, graph)  

Image Profiling 
Plot>2D:Profile:Image Profile 
(matrix, worksheet, XYZ data)  

14.8.2 Filtering 

    

Tools  Menu Entry  

FFT Filter 
Analysis:Signal Processing:FFT Filters 
(workbook, graph)  

2D FFT Filter  
Analysis:Signal Processing:2D FFT 
Filters (matrix)  

IIR Filter Design  
Analysis:Signal Processing:IIR Filter 
(workbook, graph)  
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14.8.3 Smoothing 

   

Tools  Menu Entry  

Smooth 
Analysis:Signal Processing:Smooth 
(workbook, graph, matrix)  

14.8.4 Correlation 

  

Tools  Menu Entry  

Correlation 
Analysis:Signal Processing:Correlation 
(workbook, graph)  

2D Correlation  
Analysis:Signal Processing:2D 
Correlation (matrix)  

14.8.5 Convolution 

  

Tools  Menu Entry  

Convolution 
Analysis:Signal Processing:Convolution 
(workbook, graph)  

14.8.6 Wavelet Analysis (Pro Only) 

  

Tools  Menu Entry  

Continuous Wavelet Transform 

Discrete Wavelet Transform 
(Decomposition) 

Inverse Discrete Wavelet Transform 
(Reconstruction) 

Multi-Scale Wavelet Decomposition 

Analysis:Signal Processing:Wavelet 
Analysis (workbook, graph)  
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Smoothing 

Noise Removal 

2D Wavelet Decomposition 

2D Wavelet Reconstruction 

Analysis:Signal Processing:Wavelet 
Analysis (matrix)  

14.8.7 Other Advanced Tools (Pro Only) 

     

Tools  Menu Entry  

Rise Time Gadget Gadget:Rise Time (graph)  

Decimation 
Analysis:Signal Processing:Decimation 
(workbook, graph)  

Coherence 
Analysis:Signal Processing:Coherence 
(workbook, graph)  

Envelope Curves 
Analysis:Signal Processing:Envelope 
(workbook, graph)  

14.9 Image Processing 

 Origin provides a collection of tools for basic image processing. These tools are accessible from the Image 

menu when a matrixbook is active. Some tools are only.  

The tools are organized in the following sub-menus:  

Image:Adjustments 

Image:Arithmetic Transforms 

Image:Conversion 

Image:Geometric Transforms 

Image:Spatial Filters 

14.10 Topics for Further Reading 

Analysis Dialog Boxes: Specifying Your Input Data 

Outputting Analysis Results 

Recalculation of Analysis Results 

Generating Analysis Report Sheets 

https://www.originlab.com/doc/Origin-Help/AnalyDialog-SpecifyInput
https://www.originlab.com/doc/Origin-Help/AnalyDialog-OutputResult
https://www.originlab.com/doc/Origin-Help/AnalyDialog-Recalculate
https://www.originlab.com/doc/Origin-Help/Analysis-Rep-Wks-Cols
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Performing Math Operations on Datasets 

Linear/Polynomial Regression 

Nonlinear Curve Fitting 

Peak Analysis using Origin 

Signal Processing 

Image Processing and Analysis 

https://www.originlab.com/doc/Origin-Help/Mathematics
https://www.originlab.com/doc/Origin-Help/Linear-Polynomial-Regression
https://www.originlab.com/doc/Origin-Help/Nonlinear-Curve-Fit
https://www.originlab.com/doc/Origin-Help/PeakAnalysis
https://www.originlab.com/doc/Origin-Help/Signal-Processing
https://www.originlab.com/doc/Origin-Help/Image-Processing-Analysis
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15 Statistics 

Statistics 

15.1.1 Apps for Statistics 

Origin 2016 introduced add-on tools called Apps. Since being introduced, a number of statistics-related 
graphing and analysis Apps have been added to OriginLab's File Exchange and more tools are being released 
all the time.  

A few Apps are installed with your Origin software. Note that as of the fall of 2019, all Apps are available at no 
extra cost and they are easily added to Origin. Click Statistics: Find Apps. This opens the App Center to 

show only statistics-related Apps. Browse available Apps and click the Download and Install button to 
install an App.  

Origin includes a pre-installed App called Stats Advisor. This App uses an interactive "wizard" interface to 
help you choose appropriate statistical tests and to tell you where to find them in your Origin software, or -- if 
the test is available from another add-on App -- where to find it on the OriginLab File Exchange.  

 

15.2 Basic Statistics 

   

 

Many of Origin's advanced statistical tests are available only in OriginPro. Users of 
standard Origin will see these Pro-only tests marked as (Pro) in the main menu. If you 
own the standard version of Origin but find that you need features of OriginPro, you 
can upgrade by contacting your Origin representative.  

If you wish to continue using standard Origin without seeing (Pro) menu commands, 
click Preferences: System Variables and enter the following in the Set System 
Variables dialog box and click OK (Comment is optional):  

https://www.originlab.com/Fileexchange/index.aspx?t=App&v2=NULL&o=UpdateOnDESC&s=statistics
https://www.originlab.com/Fileexchange/index.aspx?t=App&v2=NULL&o=UpdateOnDESC&s=statistics
https://www.originlab.com/fileexchange/index.aspx
https://www.originlab.com/doc/User-Guide/OriginPro
https://www.originlab.com/index.aspx?go=Company/Distributors
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15.2.1 Basic Statistics on Worksheet 

Descriptive Statistics  Menu entry with worksheet active  

Statistics on Columns 

Statistics on Rows 
Statistics:Descriptive Statistics  

Statistics on Y by X Bin 

No menu access. To open the dialog box:  

Click Window: Script Window. 

At the cursor, type statsxy -d and press Enter. 

Cross Tabulation and Chi-

Square  
Statistics:Descriptive Statistics  

Frequencies/Counts   

Discrete Frequency 

Frequency Counts 

2D Frequency 
Counts/Binning 

Statistics:Descriptive Statistics  

Distribution   

Distribution Fit  Statistics:Descriptive Statistics  
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Normality Test 

Relationship   

Correlation Coefficient 

 

Partial Correlation 

Coefficient  

Statistics:Descriptive Statistics  

Detecting Outliers   

Grubbs Test 

Dixon's Q-test 
Statistics:Descriptive Statistics  

 

 

You can apply Conditional Formatting to a worksheet by applying mathematical 
expressions or statistics to cell values. For more information, see Conditional Formatting.  

 

15.2.2 Descriptive Statistics on Graph 

Origin provides a couple of gadgets to explore and summarize data plotted in graphs.  

Descriptive Statistics  Menu entry with graph active  

Cluster Gadget  Gadgets:Cluster...  

https://www.originlab.com/doc/Origin-Help/conditional-format
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Statistics Gadget Gadgets:Statistics...  

15.2.3 Descriptive Statistics on Matrix 

Descriptive Statistics  Menu entry with matrix active  

Output descriptive statistics (mean, sd, min, 
max, etc.) on the matrix stack (series of 
matrix objects), for each pair of XY 
coordinates. 

Analysis: Descriptive Statistics  

15.2.4 Statistics on Selected Range 

Origin provides some quick ways to obtain basic statistics on a selected range of worksheet cells, or data 
plot(s) in a graph.  

15.2.4.1 Status Bar 

 Select a range of cells in a worksheet. Note that the selection can include cells from one or more columns, and 
you can use the CTRL key to select non-contiguous groups of cells.   

Basic statistics (average, sum, count, min, max) for your selected data will be displayed in the status bar. 
Right click on the status bar to customize what quantities to display.  

 

15.2.4.2 Command or Script Window 

https://www.originlab.com/doc/X-Function/ref/mstackstats
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Statistics, Report to Script/Command Window  

Select a range of cells in a worksheet, or click and select a group of data plots or an individual data plot in a 
graph.  

Open the Command Window or the Script Window from the Windows menu, and type one of these 
commands, then press ENTER: 

stats 

moments 

quantiles 

With the Command Window, the results are typed out below the command line. With the Script Window, you 
will need to issue an additional command to return your results: 

stats; 

stats.=; 

 

Note: For more information, please refer to the:  

Help: X-Function > X-Function Reference > Statistics  

 

15.3 Statistical Graphs 

  

Origin provides numerous statistical graph types. All graphs can be easily customized and saved as a template 
for repeat use. View the Graphing and Customizing Graphs chapters of this guide for more information.  

 

Graph Type  
Plot Menu 
Category  

Box Charts: Box, Interval Plot, Bar Charts, Box Overlap, Box Normal, Half Box, 
Bar Overlap, Bar Normal, Scatter Interval, Double-Y Box, Marginal Box Charts. 

 

Box Scale is available for box charts, diagramming 
key user-selected box statistics.  

 

Statistical  

Box Charts, Violin Plots, etc., Grouped: Grouped Scatter - Indexed Data, 
Grouped Box Charts - Indexed Data, Grouped Box Charts - Raw Data, Grouped 
Column Scatter - Indexed Data, Grouped Interval Plot - Indexed Data, Grouped 
Mean Bar - Indexed Data, Grouped Violin - Indexed Data, Grouped Half Violin - 

Categorical  

https://www.originlab.com/doc/X-Function/ref/Statistics
https://www.originlab.com/doc/User-Guide/Graphing
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Indexed Data, Grouped Half Box - Indexed Data.  

Violin Plots: Violin Plot, Violin with Box, Violin with Point, Violin with Quartile, 
Violin with Stick, Split Violin, Half Violin.  

Statistical  

Histograms: Histogram, Histogram + Rug, Histogram + Probabilities, Multi-
Panel Histogram, Distribution, Distribution + Rug, Histogram with Labels, 
Stacked Histograms, Marginal Histograms.  

Statistical  

Population Pyramid  Statistical  

2D Kernel Density  Contour  

Heatmap: Heatmap, Heatmap with Labels, Split Heatmap  Contour  

Contour - Categorical Z  Contour  

Cluster Plots  Categorical  

Probability: Probability Plot, Q-Q Plot.  Statistical  

Pareto and QC Chart: Pareto Chart - Binned Data, Pareto Chart - Raw Data, QC 
(X-bar R) Chart.  

Statistical  

Bland-Altman Plot (Tukey mean-difference)  Statistical  

Scatter Matrix  Statistical  

Trellis Plot: Trellis Plot, Double-Y Trellis Plot, Double-Y Trellis Plot  Categorical  

Parallel Plot: Parallel Plot, Parallel Sets, Parallel Index.  Categorical  

 

The following statistical graphs are only available within the Plots branch of the statistical analysis dialogs.  

Graph Type  Menu Entry  

Means Plot 

Means Comparison 
Plot 

Statistics: ANOVA: One-Way ANOVA, Two-Way ANOVA 
 

Statistics: ANOVA: One-Way Repeated Measure ANOVA  
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Survival Curve  

One Minus Survival 
Curve 

Hazard Curve 

Log Survival Curve 

Statistics: Survival Analysis: Kaplan-Meier Estimator  

Scree Plot 

Component Plot 
Statistics: Multivariate Analysis: Principal Component Analysis  

Dendrogram  Statistics: Multivariate Analysis: Hierarchical Cluster Analysis  

Classification 
Summary Plot  

Classification Fit Plot  

Canonical Score Plot 

Statistics: Multivariate Analysis: Discriminant Analysis  

ROC Curve Statistics: ROC Curve  

15.4 Comparing One, Two or More Groups 

Origin provides parametric and non-parametric tests to compare one, two, three or more groups.  

15.4.1 Parametric Hypothesis Tests 

  

Feature  Menu Entry  

One-Sample t-Test 

Two-Sample t-Test 

Pair-Sample t-Test 

One-Sample Test for Variance 

 

Two-Sample Test for Variance 

 

Statistics: Hypothesis Testing  

One-Sample Proportion Test 

 

Two-Sample Proportion Test 

Statistics: Hypothesis Testing  
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Two-Sample t-Test on Rows 

 

Pair-Sample t-Test on Rows  

Statistics: Hypothesis Testing  

15.4.2 ANOVA 

  

Feature  Menu Entry  

One-Way ANOVA 

Two-Way ANOVA 

Three-Way ANOVA 

One-Way Repeated-Measures ANOVA  

Two-Way Repeated-Measures ANOVA  

(Supports both Balanced and Unbalanced data) 

Statistics: ANOVA  

15.4.3 Non-parametric Tests  

  

Feature  Menu Entry  

One-Sample Wilcoxon Signed Rank Test 

Paired-Sample Wilcoxon Signed Rank Test 

Paired-Sample Sign Test 

Mann-Whitney Test 

Two-Sample Kolmogorov-Smirnov Test 

Kruskal-Wallis ANOVA 

Moods Median Test 

Friedman ANOVA 

Statistics:Nonparametric Tests  

 

Notes:  

Multiple nonparametric tests can be run simultaneously. (Accessible from the Statistics:Nonparametric 



Statistics 

325 

Tests menu ) Available options are:  

(NPH) K Independent Samples: Kruskal-Wallis ANOVA and Mood's Median Test 

(NPH) Paired Samples: Paired-Sample Wilcoxon Signed Rank Test and Paired-Sample Sign Test 

(NPH) Two Independent Samples: Mann-Whitney Test and Two-Sample Kolmogorov-Smirnov Test 

15.5 Advanced Statistics 

Several additional tools are available in OriginPro.  

15.5.1 Multivariate Analysis  

 Origin offers several multivariate analysis methods to help you simplify, classify, or make predictions from 
your data.  

Feature  Menu Entry  

Principal Component Analysis 

K-Means Cluster 

Hierarchical Cluster 

Discriminant Analysis 

Canonical Discriminant Analysis 

Partial Least Squares 

Statistics:Multivariate Analysis  

 

Notes: Canonical Discriminant Analysis is integrated with Discriminant Analysis. It is accessible from the 
Statistics:Multivariate Analysis:Discriminant Analysis: Canonical Discriminant 
Analysis(System) menu.  

15.5.2 Survival Analysis  

 OriginPro includes widely used survival tests to quantify survivorship in a population.  

Feature  Menu Entry  

Kaplan-Meier Product-limit Estimator 

Comparing Survival Curves 

Cox Proportional Hazards Model 

Weibull Fit Model 

Statistics:Survival Analysis  

 

Notes: Comparing Survival Curves is accessible in the Kaplan-Meier Product-limit Estimator feature.  
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15.5.3 Power and Sample Size  

Statistics, Power and Sample Size Origin provides eight types of power and sample size analysis, useful in 
designing experiments. Origin can compute the power of the experiment for a given sample size and can also 
compute the required sample size for given power values.  

Feature  Menu Entry  

One-Proportion Test 

Two-Proportion Test 

One-Sample t-Test 

Two-Sample t-Test 

Paired-Sample t-Test 

One-Variance Test 

Two-Variance Test 

One-Way ANOVA 

Statistics: Power and Sample Size  

15.5.4 ROC Curve  

  

ROC Curve analysis is useful in determining if an incident has occurred, or in comparing the accuracy of two 
methods that are used to discriminate between diseased and healthy cases.  

Feature  Menu Entry  

ROC Curve Statistics: ROC Curve  

15.6 Topics for Further Reading 

Statistics on Worksheet Columns 

Statistics on Worksheet Rows 

Descriptive Statistics 

Statistics Charts, General 

Appendix 2 - Origin Graph Types 

Appendix: Statistical Graph Types by Template 

Normality Testing 

Distribution Fit  

Parametric Hypothesis Testing 

ANOVA 

Nonparametric Tests 

https://www.originlab.com/doc/Origin-Help/Statistics-on-Columns
https://www.originlab.com/doc/Origin-Help/Statistics-on-Rows
https://www.originlab.com/doc/Origin-Help/Descriptive-Statistics
https://www.originlab.com/doc/Origin-Help/Statistics-Chart
https://www.originlab.com/doc/Origin-Help/GraphTypes
https://www.originlab.com/doc/Origin-Help/Statistical-Graph
https://www.originlab.com/doc/Origin-Help/Normality-Test
https://www.originlab.com/doc/Origin-Help/Distribution-Fit
https://www.originlab.com/doc/Origin-Help/Hypothesis-Testing
https://www.originlab.com/doc/Origin-Help/ANOVA
https://www.originlab.com/doc/Origin-Help/NonPara-Test


Statistics 

327 

Multivariate Analysis 

Survival Analysis 

ROC Curves 

Power and Sample Size Tests 

LabTalk Supported X-Functions: Statistics 

https://www.originlab.com/doc/Origin-Help/Multivariate-Analysis
https://www.originlab.com/doc/Origin-Help/Survival-Analysis
https://www.originlab.com/doc/Origin-Help/ROC-Curve
https://www.originlab.com/doc/Origin-Help/Power-Sample-Size
https://www.originlab.com/doc/LabTalk/guide/LT-Supported-XFs
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16 How to Handle Repetitive Tasks 

Handling-Repetitive-Tasks 

   

 

16.1 Analysis Report Sheets 

 

Analysis operations, such as those performed with the tools listed in the Analysis chapter or in the Statistics 
chapter, create detailed Analysis Report Sheets.  

Analysis Report Sheets contain tables that are organized in a tree structure.  

Expand or collapse each branch to show or hide table contents.  

Tables are not static reports. They are constructed using placeholders linked to particular analysis results and 
thus, results can be recalculated with changes to input or analysis parameters. 

You can add comments to the sheet or copy tables and paste or paste-link them to other windows in your 
project. 

Analysis Report Sheets often contain embedded graphs such as fit curves or residual plots. To customize these 
plots, double-click on them. This opens the embedded graph in a separate window where -- as with any Origin 
graph -- you can customize it using Mini Toolbar buttons or Plot Details controls. When you are done 

customizing, click the Close button and re-insert the customized graph back into the report sheet. 

For more information on Analysis Report Sheets, see the Origin Help File.  

16.2 Recalculation 

https://www.originlab.com/doc/User-Guide/Data-Analysis
https://www.originlab.com/doc/User-Guide/Statistics
https://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
https://www.originlab.com/doc/Origin-Help/Analysis-Rep-Wks-Cols
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 All Analysis and most data processing dialog boxes in Origin include a Recalculate  control. This control 
allows you to tie output operations to the source data. When Recalculate is set to Auto or Manual, changes to 
the source data will trigger an update of the output (pending, in the case of Manual). This allows you to 
analyze multiple datasets by, for instance, serial import of a new data file to replace existing data. This feature 
is also the basis for creating Analysis Templates. The Analysis Template concept is explained below.     

 

 
The Recalculate control has three modes:  

None  
No lock is displayed in the output.  

Changes to the input data will not result in an update of the output. 

Auto  

An auto green lock displays on the output columns and graphs of the output data. The 

main operation lock displays on the left-most column as , while any related operations 

columns to right of the main operation display the "+" icon . 

The output will be automatically updated when input data is changed. 

You can also click on a lock icon and open the dialog to make changes to the analysis 
settings, including changing the Recalculate mode. 

Manual  

A manual green lock is displayed in up-to-date output columns, and graphs that 
contain plots of the output data. Any related operations columns to right of the main 

operation display the "+" icon . 

A yellow lock indicates that input data have changed and recalculation operations are 
pending. You can trigger updates individually by clicking on a yellow lock and selecting 
Recalculate from the shortcut menu; or you can update all pending operations by clicking 

the yellow Recalculate button on the Standard toolbar. 

You can also click on a lock icon and open the dialog to make changes to the analysis 

https://www.originlab.com/doc/Origin-Help/AnalyDialog-Recalculate
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settings, including changing the Recalculate mode. 

 
Tips for Managing Recalculation Operations  

A left-click on the lock displays a menu that provides multiple options including changing analysis parameters, 
opening source data sheet, switching to result sheets, and controlling the status of the operation such as 
switching from manual update to auto update. 

The Standard toolbar displays a Recalculate button that shows green when all project operations are up-

to-date and yellow when there are recalculation operations pending. If you have opened a project and you 
see that the Recalculate button is yellow, understand that calculations are pending and that the data and 
data plots you see in the project may not be up-to-date. 

If a lock icon appears dark gray in color , this indicates that the associated operation was performed in 
OriginPro and the window or project has been opened in standard Origin. The operation is not supported by 

standard Origin and to modify or re-run the analysis, you will need to locate a computer with an OriginPro 
license. 

If a lock icon appears red something has occurred which makes recalculation operations impossible. Such 

conditions are rare but would occur if, for instance, you passed a project file that included a user-defined curve 
fitting operation to a colleague but failed to pass along your user-defined fitting function. 

Having many recalculation operations in your project file can slow down your work. You can block recalculation 
-- both Manual and Auto recalculation -- by clicking on a lock icon and choosing Block Recalculation from 

the popup menu. Placing a block on pending recalculations places a yellow "block" icon on each associated 

operation in the chain. Placing a block on up-to-date calculations places a green "block" icon on each 
operation in the chain. To remove the block, click on the "block" icon and clear the check mark (Note that 

clicking the yellow Recalculate button on the Standard toolbar does not update blocked operations). 

To suspend all recalculation, press Ctrl+0, choose Analysis: Pause Auto Recalculate (worksheet only) or 

click the Pause Auto Recalculate button on the Standard toolbar. 

You can hide the lock icons on your graph window by clicking on the graph and, from the main menu, choosing 
View: Show and clearing the check mark beside Lock Icons. This does not remove associated operations 
from the graph window. To re-display the icons, repeat the procedure. 

16.3 Dialog Themes 

  Settings in analysis dialogs and most other data processing dialogs can be saved as a Dialog Theme file. 
Once saved, these Theme files containing your custom settings can be recalled as needed. Multiple theme files 
can be saved from a dialog, allowing for easy repeat analysis of datasets that may each require different 
settings.  

Last used dialog box settings are automatically saved as a <last used> Theme. Origin also allows you to save 
your custom settings as the <default> Theme. The default Theme, last used Theme, and any named Theme 
that you have saved, can all be accessed from the Dialog Theme fly-out menu that opens from the dialog box. 
The same Themes are also available from the main menu item associated with the analysis dialog box. 

https://www.originlab.com/index.aspx?go=Products/Origin


UserGuide 2026 

332 

 

Dialog Themes are managed with the Theme Organizer tool, available from the Tools menu.  

 

Tutorial: Saving and Re-using a Dialog Theme  

Import the file Linear Fit.dat from the Samples\Curve Fitting\ subfolder. 

Highlight column B and select Analysis: Fitting: Linear Fit... 

In the Linear Fit dialog that opens, check the Fix Intercept checkbox (under Fit 
Options) and set the Fix Intercept at edit box to 0. 

Click the button next to the Dialog Theme control and select Save as .... In the 
Theme Name box, enter Zero Intercept and press OK. Press OK again to close the 
Linear Fit dialog box and perform the analysis. FitLinear1 and FitLinearCurve1 result 
sheets are added to the workbook.  

Return to the source data and highlight column C. Select Analysis: Fitting: Linear Fit 
from the menu. You will see a fly-out menu with multiple Theme options including the 
Zero Intercept Theme you saved in the previous step. 

Select your saved Theme. The analysis is automatically performed on Column C using 
the settings saved in the Theme. Note that the dialog box does not open.  

 

 

Tips for Working with Themes:  

Hold the SHIFT key while clicking on your Theme in the main menu and the associated 
dialog box will open with settings from the selected Theme loaded into the dialog box. 

The default Theme Origin shipped for an analysis is called System Default. Click the 
fly-out menu in the analysis dialog and choose System Default to load it.  

Click the fly-out menu in the analysis dialog and choose Delete to delete Themes you 
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have created, including any customized <default> Theme.  

The customized <default> Themes for all analysis dialogs are saved in Defaults.xml in 
the User Files Folder. Deleting this file restores system default settings of all analysis 
dialogs.  

16.4 Workbook and Project Templates 

  There are a number of reasons for saving a single workbook or an entire project, as a "template" file. Here 
are a few typical scenarios.  

You might import data files that always have a fixed number of columns with a repeating pattern of column 
designations (e.g. XYyError, XYyError, etc.) so you create a custom workbook just for importing these files 
(File: Save Template As). 

You regularly import data files of similar structure and you perform some routine graphing and analysis 
operations on the data, then generate a report using a worksheet or a workbook embedded Notes window. 
This would be a typical example of an Analysis Template (File: Save Workbook As Analysis Template). 

You perform some operations similar to those described in the previous example but you can't save your 
workbook as an Analysis Template because all data are cleared from the workbook on saving and that would 
destroy a sheet of reference values that you rely on for your analysis. Instead, you could opt to clear only the 
imported data and save your workbook as a window file (File: Save Window As). This preserves the sheet of 
reference data and like the Analysis Template, saves analysis and graphing operations with the workbook. 

You routinely import data, do some analysis and generate a report and would like to make use of the Analysis 
Template concept (as in the second bullet point), but you have multiple windows in your project, including 
Layout windows that cannot be embedded in the workbook. So, a single workbook Analysis Template won't do 
the job. In this case, you could save the project without data by "cloning" it (File: Clone current Project). 

16.4.1 The Workbook as Template 

The workbook can contain worksheets with data, metadata, floating or embedded graphs, embedded matrices 
and notes, plus scripts, variables and other supporting data.   

You can save a workbook as a template for repetitive graphing and/or analysis tasks. Depending on your 
needs, there are three options for saving your workbooks -- as a workbook (OGWU), as a template (OTWU) 
or as an Analysis Template (OGWU):  

Workbook (OGWU): Choosing File: Save Window As saves all workbook content. 

Analysis Template (OGWU): Choosing File: Save Workbook as Analysis Template clears all data 
columns that are used in analysis operations in the workbook before saving. Operations are preserved as are 
data that are not associated with analysis operations.  

Template (OTWU): Choosing File: Save Template As saves the structure of the workbook, plus any 
analysis operations that exist in the workbook, but all data including data that are not associated with these 
analysis operations, are cleared. 

 

The New Book dialog is a template library for managing workbook, matrixbook and 
Analysis Templates. See Workbooks for an overview of dialog box features.  

 

https://www.originlab.com/doc/Origin-Help/UserFilesFolder
https://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
https://www.originlab.com/doc/User-Guide/Worksheets-Columns


UserGuide 2026 

334 

 

Tutorial: Creating an Analysis Template  

Start with a new workbook and import the file Samples\Curve 
Fitting\Sensor01.dat. 

Select column B and use the Analysis: Fitting: Linear Fit and open the Linear Fit 
dialog. 

Change the Recalculate drop-down to Auto. 

Click the Fit Control tab, check the Fix Intercept check box and enter 0 in the Fix 
Intercept at edit box.  

Click OK to close the dialog and perform the linear regression. 

Answer "Yes" to the prompt and switch to the FitLinear1 report sheet to view results 
including plots of the best-fit line and residuals. 

Now switch back to the original data sheet and import the file Samples\Curve 
Fitting\Sensor02.dat. The analysis results will be automatically updated with this 
new data. Note that you could continue to use this workbook for importing other data; 
or you could right-click the workbook window title and choose Duplicate without 
Data to create a new workbook with the linear fitting operation saved into it. This 
allows you to import new data into the new workbook and thus save a project with 
multiple such workbooks, if desired. 

With the workbook active, select the menu File: Save Workbook as Analysis 
Template..., and in the dialog that opens, give a name such as Linear Fit of Sensor 
Data and click Save. 

Choose File: Recent Books and select the template that was saved in the previous 
step. The workbook will open and the data sheet will be empty. 

Import the file Samples\Curve Fitting\Sensor3.dat into the empty data sheet (1st 
sheet). The analysis results will be automatically generated upon data import. 

Analysis Templates can include summary sheets and custom report sheets (worksheet-based or HTML), 
making them an ideal medium for importing, analyzing, plotting and reporting the results of your routine 
analyses. When used in combination with the the Batch Processing tool, you can repeat a set of analyses 
and graphing operations for any number of data files and create a PDF summary report for each one, as it is 
processed. View the Batch Plotting and Batch Analysis sections of this chapter for examples of using the 
workbook as a template for handling repetitive tasks.  

 

Notes windows now support HTML. Notes windows can be added to the workbook 
(right-click on sheet tab and Add Notes as Sheet) making it easy to incorporate HTML 
reports into your Analysis Templates. For more information, see HTML Reports 
From Notes Windows.  

16.4.2 The Project as Template 

The Origin project file can also be used as a "template" for carrying out repetitive graphing and analysis tasks 
-- particularly when your analyses and graphing tasks can't be resolved within a single workbook.  

The basis steps of creating a "project template" are as follows:  

Create the desired graphs and/or analysis results from data in your workbook(s) and save the project.  

After saving the project, choose File: Clone current Project. A small dialog opens for configuring your cloned 
project:  

https://www.originlab.com/doc/Tutorials/Create-Custom-Report
https://www.originlab.com/doc/User-Guide/Publishing-and-Export
https://www.originlab.com/doc/Origin-Help/Batch-Processing
https://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
https://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
https://www.originlab.com/doc/User-Guide/Publishing-and-Export
https://www.originlab.com/doc/User-Guide/Publishing-and-Export
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Add Data Connectors: Check this box to add Data Connectors from the cloned project to your saved 
project. Each cloned worksheet will have a connection to the original worksheet in the saved project. If you 
plan to import data from other similar files in your cloned project, you should CLEAR this box. 

Clear All: Clear imported data only. Analysis operations are preserved in the cloned project.  

Clear Imported Data and Delete Calculations: Clears imported data and analysis operations. 

Click OK to create your cloned project. Selected data are cleared and the cloned project named UNTITLED is 
added to the workspace. 

Name and save the cloned project and when you are ready to process more data files, you can open it and 
import new data: 

If your analysis and graphing operations are linked to a particular set of data files that are periodically 
updated, you don't necessarily need to use Connectors. You can simply re-import the files (Data: Re-
import... or Re-import Directly). 

If your operations are linked using Data Connectors, click the Connector icon and from the popup menu 
choose Import (this Connector only) or Import All (all Connectors in the book). 

One possible scenario is that you store all of your data in a single Origin project file. If you have added Data 
Connectors from your cloned project, to your original project then you can selectively import just the data that 
you need to perform your graphing and analysis operations. When you have finished, you can save the file to a 
new name, preserving your cloned project for re-use. 

16.5 Batch Plotting 

 Origin provides several methods for batch plotting of graphs from multiple datasets or files. The following two 
sections outline how to create multiple graphs from (1) data that is already in worksheets, or (2) multiple data 

files. In addition to these two procedures, batch plotting can also be performed programmatically using 
LabTalk script or Origin C.  

16.5.1 Duplicating Graphs with Data from Other Books/Sheets/Columns 

If you have several workbooks, worksheets or columns with similar data structure as you the data used to plot 
the graph, you can have Origin clone that graph via Window: Duplicate (Batch Plotting) menu with new 
data. There are two cases:  

If you have plotted a graph with a single dataset and customized it, and want to clone the graph with other 
data in the same worksheet: Choose Window: Duplicate (Batch Plotting): Duplicate with New Columns. 
Pick other data (columns) that you want to plot. Each column will be plotted as a new graph.  

If you have plotted a graph with data in one worksheet or workbook and customized the graph, and you want 
to clone the graph with other worksheets or workbooks with a similar data structure: Choose Window: 
Duplicate (Batch Plotting): Duplicate with New Sheets/Duplicate with New Books. Origin will list all 
worksheets or workbooks with a similar data structure. Pick the worksheet or workbook you want to plot from. 
Each worksheet or workbook will be plotted as a new graph. 

https://www.originlab.com/doc/User-Guide/Import-Data
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Tutorial: Duplicating a graph with data from other books/sheets  

Press the New Project button on the Standard toolbar. 

Press the Import Wizard button on the same toolbar. This opens the Import 
Wizard dialog box. 

Click the browse button to the right of the File box. Browse to the Import and 

Export folder and select the files S15-125-03.dat, S21-235-07.dat, and S32-014-
04.dat. Click Add File(s), then press OK. In the Import Wizard dialog box, press 
Finish. The files are imported into three separate workbooks. 

Drag and select all three Y columns in one of the workbooks, then select the menu item 
Plot>2D: Multi-Y: 3Ys Y-YY to create a graph with multiple Y axes and one shared X 
axis. Make any desired customizations to the graph. 

Right-click on the title bar of the graph window then select Duplicate (Batch 
Plotting) shortcut menu.  

In the dialog box that opens, press Ctrl and select the other two workbooks/worksheets 
then press OK. Two more graphs are created with data from the other two 
workbooks/worksheets.  

16.5.2 The Workbook as a Template for Processing Multiple Files 

If you want to plot graphs from many data files but don't want to import all files to workbooks before plotting, 
you can import one file, create the desired graph(s) based on that data, then add the graph(s) to your 
workbook and save the workbook as a template. Using this template you can process multiple files, creating a 
workbook for each file and its corresponding graph.  

 

Tutorial: Creating graphs from multiple data files  

With a new workbook active, choose Data: Import From File: Single ASCII and 
import the file Sensor01.dat from the Samples\Curve Fitting subfolder of the Origin 
installation folder. 

Highlight column B and create a line+symbol graph of the data. 

Double click on the X axis to open the Axis dialog. Make sure Scale tab is active. Select 
both Horizontal and Vertical on the left panel and set Rescale to be Auto and click 
OK. This will ensure that the graph scale will update automatically on data change. 

In the workbook, right-click on the worksheet tab and select Add Graph as Sheet, 
then select the graph created above and click Done. This will add a new workbook 
sheet containing an embedded graph. 

Switch to the data sheet, double-click on the tab rename the sheet as Data. 

Select the Worksheet: Clear Worksheet menu item to clear the data in this sheet. 
Note that this step is optional. Clearing the data will reduce the size of the template 
saved in the next step.  

Select the File: Save Window As... menu item, assign a name such as Sensor Data 
and Graph and press Save. 

Now we can use this template to process multiple files. Select the File: Batch 
Processing... menu item. 

In the dialog box that opens set the Batch Processing Mode to Load Analysis 
Template, then set the Analysis Template control to point to your saved template. 
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Set Data Source to Import from Files and select the three files Sensor01.dat, 
Sensor02.dat, and Sensor03.dat from the Samples\Curve Fitting subfolder. 

Set the Data Sheet(s) to Data and set Result Sheet to <none>.  

Press OK to close the dialog box. You should get three workbooks with the data 
imported into the first sheet and the graphs updated in the 2nd sheet. To further edit 
any of the graphs, double-click on the graph to pop up an editable page. 

 

 

If processing of your data requires some custom import settings, those settings will be 
saved to the data sheet by default. Settings thus saved to the sheet will be used for 
import when batch processing of multiple files using the workbook as a template.  

16.6 Batch Analysis 

Origin provides several ways to perform batch analysis of multiple files, data columns, or data plots.  

16.6.1 Analyzing Multiple Datasets in Dialogs 

Some analysis dialog boxes, for instance Linear Fit and Nonlinear Fit, support analysis of multiple datasets. 
Report sheets created by these dialog boxes include a summary table listing the parameter values for each 
dataset and other pertinent results such as goodness-of-fit indicators. The summary table can be copied to an 
external sheet for further processing.  

 

Tutorial: Fitting Multiple Datasets  

Open a new workbook and import the file Samples\Curve Fitting\Multiple 
Gaussians.dat from the Origin installation folder. 

Set the Long Names of the four Y columns as Peak 1, Peak 2, Peak 3 and Peak 4. 

Select all four Y columns, and use the Analysis: Fitting: Nonlinear Curve Fit... menu 
item to open the NLFit dialog box. 

Select Gauss from the Function drop-down list, then press the Fit button to perform fitting 
and close the dialog box. 

Switch to the FitNL1 report sheet. You will see a table named Summary which lists the fit 
parameters and fit statistics for each dataset. 

 

 

 

In the NLFit report sheet, click on the downward-pointing arrow button next to the 

table named Summary and select Create Copy as New Sheet. This will create a copy 
of the table in which all cells are linked to the report. Any updates/changes to the fit 
will automatically update the values in this copied sheet. This sheet can then be used to 
plot or to perform secondary analysis on the fit parameters.  
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When enumerating something like a column Long Name, as you did in step 2 above, 
enter the string in the first cell (e.g. "Peak 1"), select the cell and hover over the lower-
right corner. When the cursor becomes a "+", drag across the other cells and the 
contents of the first cell will be extended to those cells.  

 

16.6.2 Using Gadgets for Analyzing Multiple Curves 

 Origin includes several gadgets for performing interactive analysis on plotted data. Gadgets allow selecting a 
data range of interest, switching from one dataset to another, and setting various preferences specific to the 
analysis being carried out.  

Most gadgets offer an option to perform the analysis on all data plots in the current layer, or all data plots in 
the graph page. This allows for performing repetitive analysis on multiple datasets using the same settings, 
and generating a table of results across all datasets.  

 

  

Tutorial: Using the Integrate Gadget to Integrate Multiple Curves  

Open the project "Samples\Spectroscopy\Absorbance Spectra.opj". 

With the graph window active, choose Gadgets: Integrate from the main menu.  

In the dialog that opens, click the Baseline tab and set the Mode drop-down to Straight 
Line. 

Click the Output tab, expand the Output Quantities to node, and check Append to 
Worksheet. Press OK to close the dialog box. 

A region of interest (ROI) object is placed on the graph. If necessary, click on the ROI and 
resize this object to cover the entire data range plotted in the graph. The integrated area will 
be displayed as a shaded region. 

Click the arrow button at the top right of the ROI object, then choose Change Data from 
the context menu and switch to another plot in the layer. Check that the current baseline 
setting works for other curves in the layer. 

Click the arrow button , select New Output for All Curves (N) or simply press the "N" 
key. Integration is performed on all curves.  

Click the arrow button again and select Go to Report Worksheet. Expand the report 

worksheet to view the integration results from all curves. 
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16.6.3 Batch Analysis Using an Analysis Template 

    The Batch Processing tool allows you to process multiple files or datasets using an Analysis Template. 
Simply perform the analysis on one of the files, include all desired results and report sheets in one workbook, 
and save that workbook as an Analysis Template. The Batch Processing tool then uses the Analysis Template 
to process multiple files/datasets. You have the option to retain one workbook for each file/dataset, and 
additionally, to create a summary table with select analysis parameters and other metadata that you have pre-
configured in your analysis template.  

 

Tutorial: Batch Analysis of Multiple Files using an Analysis Template  

From the main menu, choose File: Batch Processing.... This opens the Batch Processing 
dialog box. 

Set Batch Processing Mode to Load Analysis Template. 

Press the browse button to the right of the Analysis Template box and browse to and 
select the file <Origin Program Folder>\Samples\Batch Processing\Sensor 
Analysis.OGW. This Analysis Template contains multiple sheets set up for linear regression 
analysis, reporting, and summary tables. 

Set Data Source = Import From Files, then click the browse button to the right of 
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the File List and from the Samples\Curve Fitting folder, select files Sensor01.dat, 
Sensor02.dat and Sensor03.dat . 

Set Dataset Identifier to File Name, Data Sheet(s) to Data, and Result Sheet to 
Result. Note that these are the names of existing sheets in the Analysis Template. 

Uncheck Delete Intermediate Workbook. 

Click OK to close the dialog box and process the three files (you can answer "No" to the 
prompt). You will obtain three books with the data, analysis results, and report for each file, 
and a fourth book containing the summary table of analysis results from all files. 

 

 

 

Saving the initial workbook as an Analysis Template is optional. You can simply save 
the Origin project (.opj) and next time replace the data in your workbook to update all 
results and graphs. The Batch Processing tool also has an option to repeatedly import 
files into the active window, allowing you to simply re-use an existing book within a 
project (which contains all desired analysis and graphs) as an on-the-fly template for 
the batch analysis.  
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You can batch generate analysis reports using a custom MS Word template, with the 
option of outputting a PDF and/or an MS Word file for each report. Additionally, you 
can opt to combine reports into a single file. For information on Batch Processing 
with a Word Template for Reporting, see this tutorial.  

16.7 Repeating Analysis on Other Datasets or Data Plots 

For some analysis operations, you can perform the analysis on one dataset or data plot and then repeat the 
analysis for all other data. This feature is available via a special shortcut menu entry, when you click on the 
lock associated with the operation.  

In worksheet columns or reports, clicking the lock will show the menu command Repeat this for All Y 
columns. Selecting this will repeat the analysis on all other Y columns in the source data sheet.  

In a graph, clicking the lock will show the menu command Repeat this for All Plots. Selecting this will repeat 
the analysis for all other data plots in the graph page, even if the plots are in different layers. 

This is particularly useful for such analysis dialog boxes as smoothing or interpolation that support input of 
only one dataset. As long as the data are contained in one worksheet or plotted in one graph, the analysis can 
be repeated on all other datasets.  

 

Users should note a change for Origin 2022b: In earlier versions, if the original 
analysis output created a new sheet or book, Repeat this for All would create a new 
sheet or book for the remaining Y columns or plots. Users expressed a desire to send 
all output to a single sheet regardless of the original output specification. If input 
columns share a common X dataset, the X dataset will be written to the output sheet 
only once. To roll back to the previous behavior, set @RAO = 0 (default is 1).  

 

 

Tutorial: Smoothing Multiple Columns in a Worksheet  

Import the file Samples\Curve Fitting\Multiple Gaussians.dat into an empty workbook. 

Select column B and click Analysis: Signal Processing: Smooth to open the smooth 
dialog box. 

Accept the defaults and press OK to perform smoothing. A new column will be added 
with the smoothed data. 

Click on the lock in the output column and select Repeat this for All Y columns. 
Three more columns of smoothed data with same settings will be generated from the 
data in columns C thru E. 

16.8 Duplicate this Operation 

Output produced by the Origin's analysis operations is linked to its source data by a particular analysis and a 
particular set of analysis parameters. This linkage is signified by the placement of an "operations lock" on 
analysis output and -- unless the user turns off recalculation for a particular operation -- such results are 
generally "locked" to editing. You can find out more by reading about Analysis Report Sheets and 

Recalculation, in the introductory sections of this chapter.  

The lock icon placed on analysis output can be clicked on to open a menu, giving you post-analysis access to 
operation parameters and other information. This includes the dialog box and parameter-set used to produce 
the analysis output, opened by clicking Change Parameters.  

Towards the bottom of this menu, you will see a Duplicate this Operation entry.  

https://www.originlab.com/doc/Tutorials/BatchProcess-WordTemplate
https://www.originlab.com/doc/LabTalk/ref/sys-var-list
https://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
https://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
https://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
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One possible use of the feature goes like this:  

The user performs an analysis operation on a data plot, say, a fitting operation using the nonlinear curve fitter 
(NLFit). 

The user is not sure which fitting function best models her data so she tries a fit using one potential function. 

The user clicks the resulting operations lock and chooses Duplicate this Operation. 

A duplicate analysis is run and a second operations lock is added to the graph window. 

The user clicks the second operations lock, chooses Change Parameters and when the NLFit dialog opens, 
chooses her alternate fitting function and performs a new fit operation. The new fit operation results in new 
output which can now be compared to the output generated by a fit of the first fitting function. 
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16.9 Repeating Analysis Using Data Filters 

  

Large multi-column datasets can be quickly reduced by applying filter conditions to one or more columns. This 
Data Filter feature can also be used in conjunction with the colcopy (column copy) X-Function to produce 
multiple graphs from the same source data using different filtering conditions. The filtered data can also be 
analyzed, allowing you to compare graphs and analysis results across multiple filter conditions.  

Selected columns from the source data sheet can be copied to create child sheets where the filter condition 
stays synchronized with the parent sheet, or is locked to the child sheet. When the source data sheet is 
updated, all child sheets, associated graphs and analysis results will automatically update using their 
respective filter conditions. Additionally, the filter condition of a particular child sheet can be pushed back to 
the parent sheet at any time.  

The image below displays the source workbook with data for several makes of automobiles. Two books were 
created with a subset of columns and a data filter to restrict the data to a particular make of automobile. 
Linear regression analysis of the filtered data was performed, allowing comparison of the results across the 
two filters.  

https://www.originlab.com/doc/Origin-Help/Wks-DataFilter
https://www.originlab.com/doc/Origin-Help/copy-columns
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Tutorial: Locking a Filter Condition on Copied Columns  

Import the file Samples\Statistics\Automobile.dat 

Click on the Make column, then click the Add/Remove Data Filter button on the 

Worksheet Data toolbar. 

Click on the filter icon that was added to the column, and uncheck all makes but 
Honda (Hint: Clear the check mark beside Select All, then check Honda and click OK). 

Hold down the CTRL key and click and select the Make, Power and Engine 
Displacement columns. Next, right-click and select Copy Columns to... from the 
shortcut menu. 

In the dialog that opens, expand Copy Labels and place a check mark beside Long 
Name and Units, then click OK. A new worksheet will be added to the workbook and it 

will contain only the Honda data, for Power and Engine Displacement. 

Click and hold the tab of the new worksheet and drag it to an empty spot in the Origin 
workspace to create a separate workbook. 

Click on any of the locks in the columns of this copied sheet, and select Worksheet 
Filters: Lock. The filter conditions will be locked to this sheet. If you change the filter 
condition in the original data sheet, this copied sheet will not be affected.  

You can now return to the original automobile book, click the filter icon and change 
the filter condition to Toyota, then use Copy Columns to to create another worksheet. 

Highlight column B in your Honda workbook,then right-click and choose Set As: X. Do 
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the same for the Toyota book.  

Highlight column C in your Honda workbook and click the Scatter button on the 
2D Graphs toolbar. Do the same for the Toyota book. This gives you two plots of Power 
vs Engine Displacement, one for Honda, one for Toyota. 

Click on the Honda graph and choose Analysis: Fitting: Linear Fit. Accept the dialog 
defaults and click OK. Do the same for the Toyota graph. A linear fit is performed for 
both datasets and an Analysis Report Sheet is generated for each. 

Compare the fitting results for the two automobile makes. 

 

 

By default, when there is a data filter on a column that is input for an analysis 
operation, filtered data (hidden rows) are ignored in the analysis. To include hidden 
rows, click on an analysis lock icon and set Ignore Hidden Rows = No.  

 

16.10 Automating Tasks Using Programming 

  

In addition to the above mentioned methods for automating tasks  using the interface, graphing and analysis 
features can also be accessed programmatically from the LabTalk scripting language, from Origin C or from 
Python (internal or external). Access to Graph Themes and templates, and Analysis Templates can be 
programmed. You can set up some of the procedures manually by first creating templates (graph templates, 
Analysis Templates™, etc.) using the graphical user interface, and then write your code to call the templates 
as needed.  

You can get a broad look at what programming options are available in Origin by browsing the Programming 
Chapter of this User Guide. More in-depth programming-related information is linked to from that chapter.  

https://www.originlab.com/doc/User-Guide/Programming-in-Origin
https://www.originlab.com/doc/User-Guide/Programming-in-Origin
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16.11 Topics for Further Reading 

Recalculation of Analysis Results on Data or Parameter Change 

Saving Analysis Dialog Settings as a Theme 

The Theme Organizer, Dialog Themes 

Analysis Templates 

Batch Processing and Analysis Templates 

Copy and Paste Operations 

Using Data Filters to Obtain Different Views of Your Data 

Analysis Report Sheets and Columns 

Tutorials: Batch Processing 

Video: Batch Processing 

Tutorial: Combine Quick Peaks Gadget with Peak Analyzer 

https://www.originlab.com/doc/Origin-Help/AnalyDialog-Recalculate
https://www.originlab.com/doc/Origin-Help/Dialog-Theme
https://www.originlab.com/doc/Origin-Help/ThemeRef-ThemeOrganizer
https://www.originlab.com/doc/Origin-Help/Analysis-Templates
https://www.originlab.com/doc/Origin-Help/Batch-Processing
https://www.originlab.com/doc/Origin-Help/Copy-Paste-Oper
https://www.originlab.com/doc/Origin-Help/Wks-DataFilter
https://www.originlab.com/doc/Origin-Help/Analysis-Rep-Wks-Cols
http://www.originlab.com/doc/Tutorials/Batch-Processing
http://originlab.com/index.aspx?go=Support/VideoTutorials&ss=chm&pid=1559
http://www.originlab.com/doc/Tutorials/Combine-QuickPeakGadget-PA
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17 Publishing and Export 

Publishing-and-Export 
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17.1 The Master Page 
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The Master Page feature is used to add one or more common objects to exported or printed graphs. Use 
the master page to add a set of properties and objects -- a custom background, a company logo, text labels, 
images, etc. -- to selected graph windows in your project.  

 

To make use of this feature, you must first create your Master Page. The Master Page should contain only the 
properties and objects that you want to display on your selected graph windows:  

From the menu, choose File: New: Master Page. If you are not in the project root folder when selecting this 
menu item, you will be asked to switch to the project root folder.  

Customize the Master Template. Note that the comments that show beneath the Save Master Template 
button are "hidden" and will not be applied to your graph windows.  

Click the Save Master Template button. When you save, the Master Template will be saved to the User 
Files Folder as "name of active window".otpu (e.g. "C:\Users\YourName\Documents\OriginLab\User 
Files\Master.otpu"). 

 
Things to know about the Master Page:  

Master items will only show in graphs pages of the same dimensions as the template. Apply Dimension to 
All Graphs applies Master Template page dimensions to all graphs of the same aspect ratio. 

If you create a graph and modify page size, then choose File: New: Master Page and load a Master Template 
into the workspace, the Master Template will be loaded with the page dimensions of your modified graph page. 

The Rotate button swaps the Master Template page dimensions (toggles orientation between landscape and 
portrait). 

When you click Apply Dimension to All Graphs you are prompted to apply dimensions only to graphs of the 
same aspect ratio, or to all graphs of the same orientation (portrait or landscape). 

Master Page items on a graph with portrait orientation will not show on a graph with landscape orientation and 
vice versa. 

When NOT using Master Items, Edit: Copy Page (CTRL + J) will place an OLE-editable Origin graph object on 
the Clipboard. When using Master Items, Edit: Copy Page will place an image on the Clipboard; the Copy 
Graph as Image dialog will open asking you to accept or adjust image settings before clicking Copy. 

If a graph uses Master Items, Send Graphs to PowerPoint does not support Insert Graphs as Embedded 
Object. Instead, use Insert Graphs as Picture which does support Master Items.  

https://www.originlab.com/doc/Origin-Help/UserFilesFolder
https://www.originlab.com/doc/Origin-Help/UserFilesFolder
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There is a mechanism for selectively excluding Master Items in your exported or printed page. Any object that 
you do not want to appear in the exported or printed page should begin with "NoExport" (e.g. open an arrow 
object's Properties dialog and on the Programming tab, rename "Arrow" to "NoExport_Arrow"). 

When you customize and save your Master Page to the User Files Folder, the next time you choose File: New: 
Master Page, you load your customized template. 

If you don't want to show Master Items in the workspace, click View: Show: Master Items and remove the 
check mark. The exported graph will still contain the Master Items (they just won't show in the workspace). 

If you want to remove Master Items from a graph in both the workspace and exported images, click Format: 
Page..., Display tab and clear the Use Master Items check box. 

 

You could use the Text tool to add project and system information to your Master 
Template as static text objects, but since the idea is to build a template for re-use, 
consider "soft-coding" information in your text labels. To learn more, see these topics:  

Substituting Variable Values in Text Labels] 

LabTalk String Registers 

17.2 The Export Margin Offsets Dialog Box 

By default, the margins of your copied or exported graph are determined by the Margin Control in Copy 
Page Settings group of Preferences: Options (Copy actions) or the Export Settings branch of Export 
Graphs (Export actions). You can interactively modify the default margins using the Export Margin Offsets 
Dialog Box.  

 

Click on the graph window (to activate) and choose Edit: Set Export Margins. This opens the Export Margin 
Offsets dialog. 

Drag the blue selection handles that appear at the page margins; or enter values into the dialog edit boxes 
and click Apply. 

17.3 Fit Page to Layer and Layer to Page 

There are two small dialog boxes that are also helpful for removing white space or placing a margin around 
your graph before exporting:  

https://www.originlab.com/doc/Origin-Help/UserFilesFolder
https://www.originlab.com/doc/Origin-Help/LinkVar-TextLabel
https://www.originlab.com/doc/LabTalk/guide/String-registers
https://www.originlab.com/doc/Origin-Help/Options-Dialog-Page-Tab
https://www.originlab.com/doc/Origin-Help/Options-Dialog-Page-Tab
https://www.originlab.com/doc/Origin-Help/Export-Margin_Offsets
https://www.originlab.com/doc/Origin-Help/Export-Margin_Offsets
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Fit Page to Layers: Choose Graph: Fit Page to Layers to open the pfit2l dialog box. 

Fit Layers to Page: Choose Graph: Fit Layers to Page to open the gfitp dialog box. 

 

Both dialogs can be used to remove white space. Both can perform resizing, with or without changing graph 
aspect ratio. You can view the documentation for both to decide which might work best for you but basically it 
boils down to whether you need to keep a particular page size. If so, you'll likely want Fit Layers to Page; if 
not, either one may work for you.  

17.4 Copying and Pasting Graphs to Other Applications 

   There are two ways you can include Origin graphs in another application's files (e.g. Microsoft Word .docx 
files):  

As an image 

As an editable OLE graph object 

 
When you paste as an image, you are pasting a static object. In MS Word, for instance, you may be able to 
modify the image using Word's picture-editing tools, but you cannot make edits to the graph in Origin and 
have it update the graph in Word (short of deleting the existing image and replacing it with a new one).  

By contrast, when you paste an editable OLE graph object you can later double-click on the object in the host 
application to launch a new instance of Origin. The graph and any associated data sheets will be available for 
editing. After editing, use Origin's File: Exit and Return to... menu item to update the embedded object, 
close Origin and return to the host application.  

17.4.1 Copy Graph as Image 

Click on your Origin graph to activate it, then ... 

Choose Edit: Copy Graph as Image (CTRL+ALT+J). Alternately, click on the graph window near the page 
margin and click the Copy Graph as Image button on the Mini Toolbar.  

https://www.originlab.com/doc/Origin-Help/Fit-Page-Layer
https://www.originlab.com/doc/User-Guide/Origin-Interface


UserGuide 2026 

352 

 

In your host application choose Paste or press CTRL+V. 

When copying the graph as an image (CTRL+ALT+J), you have a choice of image formats (PNG, EMF, DIB, 
HTML, JPG). Additionally, you can make quick size adjustments and specify background transparency (PNG). 
The Copy Graph as Image (copyimg) dialog includes a Dialog Theme control which allows repeating <Last 
used> settings, saving current settings as default Save as <default> or saving settings to a named Theme 

(Save As...).  

 

 

There is a Copy control on the Preferences: Options: Page tab that lets you assign 
the CTRL+C hotkey combination to either Copy Graph as Image <last used> or 
Copy Page (CTRL+J) (i.e. "editable OLE graph object"). This allows you to bypass the 
Copy Graph as Image dialog and speed up placing a standardized image on the 
Clipboard using CTRL+C.  

17.4.2 Copy Graph as Editable OLE Graph Object 

Choose Edit: Copy Page (CTRL+J). 

In your host application choose Paste or press CTRL+V. 

 

Note: For more information, please refer to the:  
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Help: Origin: Origin Help > Exporting and Publishing Graphs > Pasting or Embedding Graphs in 
Other Applications  

17.5 Organizing Your Graphs for Presentation or Export 

If your Origin project file contains a large number of graphs that you plan to export or use in an Origin slide 
show, you can make things easier by adding shortcuts to your graphs to a Project Explorer Favorites folder 
and arranging them there:  

Right-click on a window and choose Add Shortcuts to Favorites. This will add a shortcut to each graph 
window, to a new Favorites subfolder (visible in Project Explorer). 

When sending graphs to PowerPoint or creating an Origin slideshow, you can (1) set slide order in the 
corresponding dialog box or (2) set slide order following this procedure. 

 

If you are preparing a manuscript for publication, you may want to see FAQ-441 How 
do I export graphs with exact size and resolution as specified by publishers?  

17.6 The Layout Page 

A layout page, as the name implies, is a window useful for laying out different elements for publication or 

export. Use it to assemble graphs, result tables, text objects, etc. onto a single panel.  

 

Typically, you start by creating a blank panel:  

https://www.originlab.com/doc/Origin-Help/Paste-Embed-OLE
https://www.originlab.com/doc/Origin-Help/Paste-Embed-OLE
https://www.originlab.com/doc/Origin-Help/Project-Explorer
https://www.originlab.com/doc/Origin-Help/Project-Explorer
https://www.originlab.com/doc/Quick-Help/Set-ExpGraph-Size-Resolution
https://www.originlab.com/doc/Quick-Help/Set-ExpGraph-Size-Resolution
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Click the New Layout button on the Standard toolbar. 

Right-click on the blank layout to paste Clipboard content, add text, insert images from files, add graphs, 
tables, etc. 

When inserting an image from file, right-click in the area where you want to insert. When adding graphs or 
worksheets, pick a window in the Browser and drag out an area on the layout with your mouse. Note that 
added objects can be moved or resized by dragging with your mouse.  

You can make edits to inserted images, by double-clicking on the image. This opens the image in the Image 
Window.  

You can make edits to the graph by double-clicking on the inserted graph object. This opens the source graph 
for editing. Edits to the source graph will update the graph on the layout page. 

Inserted tables can be edited by double-clicking on the table object. Style adjustments can be made by 
selecting a table object and using available Mini Toolbar buttons. 

Note that selected elements on the layout page can be aligned using Object Edit toolbar buttons. 

 

 

Exporting of layout pages to .SVG files is supported. When adding graphs to the layout, 
choose Add Graph from the layout shortcut menu and elements of your SVG file (e.g. 
text) will be editable in applications such as Inkscape or Adobe Illustrator.  

 
For more on the layout page, see Using the Layout Page Window in the Origin Help file.  

17.6.1 Merge Graphs to Layout 

As an alternative to manually creating layouts, Origin offers a tool that will merge select graphs into a single 
layout page of equal spacing. In this case, merged graphs are images and, therefore, not editable using the 
procedure described in step #3 of the previous section. However, if further graph edits are not needed, you 
can use this method to quickly produce a nice-looking layout.  

 

https://www.originlab.com/doc/User-Guide/Matrix-Book-Matrix-Sheet-Matrix-Objects
https://www.originlab.com/doc/User-Guide/Matrix-Book-Matrix-Sheet-Matrix-Objects
https://www.originlab.com/doc/Origin-Help/ExpGraph-Layout-Window
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In addition to Merge Graphs to Layout, Origin includes "merge graphs" utilities in 
several other dialogs: Merge Graph Windows, Arrange Layers and Layer 
Management.  

 
To merge graph images into a single layout:  

With a graph window active, click Graph: Merge Graph to Layout: Open Dialog. 

Use the Selection drop-down to specify how to select graphs. To choose individual graphs, choose Specified 
and use the browse button beside Graphs to open the Graph Browser and pick graphs. 

 

Use the Fit Page to Objects menu command (Format: Fit Page to Objects) to apply 
a uniform margin to the active Layout page. This works the same as the 

aforementioned Fit Page to Layers does for graph windows.  

17.7 Exporting Graphs and Layout Pages to an Image File 

   

Origin 2021b added a simplified graph export routine to complement the existing graph export routine:  

File: Export Graph: If you simply want to export one or two graphs to one of several common image format 
(PNG, BMP, JPEG, TIFF, EMF) and need only minimal control of image size, this routine is quick and easy. 

File: Export Graphs (Advanced): If you want to batch export graphs (e.g. All in Active Folder, All in Project, 
etc.), or export to vector types such as PDF or EPS, use this routine. The dialog supports outputting to a 
specified path, auto naming, application of Speed Mode settings to exported graphs, plus margin control, 
image size and other filetype-specific settings. 

 

Beginning with Origin 2023, the following export dialogs will add a date-time stamped 
clickable link to the Messages Log. Click the link to open the file using an internal Origin 
viewer (see below):  

https://www.originlab.com/doc/User-Guide/Customizing-Graphs
https://www.originlab.com/doc/User-Guide/Customizing-Graphs
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In addition, two system variables are added to manage Messages Log output for images:  

@VID is added to select image viewer (raster, EMF): 1 = use Origin viewer (default); 0 = 
use system default application. 

@MSG is added to control what is output to the Messages Log: 0 = output both file and and 
link (default); 1 = output link only; -1 = disable message output. 

 
To open file location in Windows Explorer (without opening the file):  

Right-click on a link and choose Open File Location; or press Ctrl while clicking on the link. 

17.7.1 File: Export Graph 

File: Export Graph (X-Function = expG2img) is a simplified routine for exporting the active graph page to 
one of the following formats: PNG, BMP, JPEG, TIFF, or EMF. It does not offer the level of control or flexibility 
as File: Export Graphs (Advanced) (next section) but it works well for simple export of individual graph 
pages.  

 
To export a graph or layout page to raster image using the simplified expG2img dialog:  

When a graph window is active, choose File: Export Graph. 

For EMF images, set a size factor relative to the Image Size reported at the bottom of the dialog. For raster 
formats, choose an output DPI setting. Alternately, clear the Auto check box and specify a Width in Pixels. 
Clicking Preview opens the graph-to-export in an internal viewer. 

https://www.originlab.com/doc/LabTalk/ref/sys-var-list
https://www.originlab.com/doc/LabTalk/ref/sys-var-list
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17.7.2 File: Export Graphs (Advanced) 

File: Export Graphs (Advanced) (X-Function = expGraph) is Origin's primary tool for exporting graphs and 
layout pages. It supports raster or vector output, flexible multi-page export (e.g. All in Active Folder), DPI 
and Speed Mode control and more.  

 
To export a graph or a layout page as an image file:  

Select the menu File:Export Graphs (Advanced).  

 

 

The expGraph routine exports graphs to one of 15 file formats:  

Raster 
Formats  

BMP, GIF, JPG, PCX, PNG, TGA, PSD, TIF;  

 

When you select Image Type = TIF/TIFF, and select 
multiple graphs for export (e.g. All in Active Folder), an 
Export as multi-frame TIF check box is added to the 
dialog. Check the box to export selected graph windows to a 
single TIF image (TIF stack).  

 

https://www.originlab.com/doc/User-Guide/Graphing
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Vector 
Formats  

CGM, DXF, EPS, EMF, PDF, SVG, WMF  

17.7.2.1 Saving Export Settings to a Theme 

As is the case with many other Origin dialog boxes, you can save your graph export settings as a Dialog 
Theme for repeat use.  

 

Once you have determined your export settings:  

Click the flyout button to the right of Dialog Theme and choose one of the Theme save options. 

Using any group of custom settings creates a temporary default Theme called <Last used>. This Theme then 
becomes available for loading your last used settings and you can access it from the expG2img or ''expGraph 
dialog boxes or from the File: Recent Exports menu. 

 

 
Since Origin 2021, expGraph dialog box settings are saved to the graph automatically on export.  

To save current settings withtout exporting, choose Save to <Graph>.  

To restore saved settings after you've modified them in the export dialog, choose <Graph> 

https://www.originlab.com/doc/Origin-Help/Dialog-Theme
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Note: For more information, please refer to the:  

Help: Origin: Origin Help > Exporting and Publishing Graphs > Exporting Your Graph or Layout Page 
to an Image File  

 

 

You can export multiple graphs, such as all graphs in a folder or all graphs in a project 
file, to a single, multi-page PDF file. Choose File: Export Graphs and open the Export 
Graphs dialog box. Set Image Type to Portable Document Format (*.pdf) and 
Select Graph(s) to one of the following options and you will see a checkbox for 
Export as multi-page PDF file.  

 

17.8 Exporting Browser Graphs to Video 

To export a Browser Graph as a video (GIF, TIFF, AVI):  

Activate the Browser Graph. Before going further, confirm that the graph is in Page View (click just below the 
window title bar and when the Mini Toolbar appears, verify that there is NOT a red check mark beside the 
Window View button. If there is, clear it).  

https://www.originlab.com/doc/Origin-Help/ExpGraph-to-Image
https://www.originlab.com/doc/Origin-Help/ExpGraph-to-Image
https://www.originlab.com/doc/User-Guide/Graphing
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In the panel to the left, click the menu button and choose Flip Through. 

Click the Export button and set File Type = GIF, TIFF or AVI. 

Modify other settings as needed and click OK. Unless it has been turned off, export will dump a clickable link 
to the Messages Log. Click the link to run the video in the supporting application. 

 

17.9 Exporting Images to a Raster or Video File 

Using File: Export Image (X-Function = cvExport) Image window you can export images to one of several 
raster formats: BMP, GIF, JPG, PNG, TIF.  

 
To export an (image window) image using cvExport:  

With the image window active, choose File: Export Image. 

Choose from the list of raster images; or save as a video file (*.avi). 

https://www.originlab.com/doc/User-Guide/Matrix-Book-Matrix-Sheet-Matrix-Objects
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After exporting, a clickable link will be generated in the Messages Log.  

17.10 Exporting Matrices 

17.10.1 Export Matrix as ASCII 

This will create an ASCII file of the data contained in the active matrix object.  

With the matrix active, choose File: Export: ASCII. 

17.10.2 Export Matrix as NetCDF 

This will export all objects in the active matrix to a .nc file:  

With the matrix active, choose File: Export: NetCDF. 

For Base year for sampling across years, note that when the matrix data are averaged across years, the 
time variable is not exported with the NetCDF file. Use this to specify how to indicate time: 

https://www.originlab.com/doc/User-Guide/Origin-Interface


UserGuide 2026 

362 

 

None  Do not specify a time variable  

Use Starting 
Year  

Use starting year as time variable  

Use Ending Year  Use ending year as time variable  

For more information on Exporting NetCDF data, see the Origin Help file.  

17.10.3 Export Matrix as Image 

Matrix images can be exported using File: Export: Image (X-Function = expImage).  

 
To export a matrix image to raster file including as Grayscale GeoTIFF:  

With the matrix active, choose File: Export: Image. 

Verify that the File Type is correct. For GeoTIFF data, the TIF/TIFF format should be pre-selected but to 
export as grayscale GeoTIFF, check the Export as Grayscale GeoTIFF box. 

https://www.originlab.com/doc/Origin-Help/Exporting-NetCDF
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After exporting, a clickable link of exported file path will be generated in the Messages Log.  

17.10.4 Export Matrix as Video 

Matrices containing multiple matrix objects can be exported to GIF, TIF and AVI (X-Function = expm2video).  

 

 
To export a series of matrix objects as a video file:  

With the matrix active, choose File: Export: Video. 

https://www.originlab.com/doc/User-Guide/Origin-Interface
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17.11 Exporting Worksheets 

   

 

After exporting worksheet data to ASCII or Excel, a clickable link of exported file path 
will be generated in the Messages Log.  

 
With a worksheet active, the File: Export menu item provides the following options:  

17.11.1 As ASCII, NI TDM (TDM, TDMS), and Sound (WAV) 

These apply only to sheets containing data columns, and are not available for analysis report sheets (see other 
options, below). The exported file will contain only data from the worksheet columns. Floating or embedded 
graphs placed in the worksheet will be ignored.  

17.11.2 As Excel 

Export books of worksheet columns with text and numeric data to an MS Excel file (XLS, XSLX, XSLM). Note 
that analysis report sheets with their hierarchical tables, and things such as embedded graphs and images, are 
not exported to the Excel file. Analysis results that are output to regular Origin worksheets are exported.  

With the worksheet active, choose File: Export: Excel. 

In the dialog that opens, set Export Sheets to Whole Book or Active Sheet Only. 

Optionally, check the Export Cell Formats box to export numeric and style formats (decimal digits, font, 
background color, etc.). 

https://www.originlab.com/doc/User-Guide/Origin-Interface
https://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
https://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks


Publishing and Export 

365 

 

 

For information on copying analysis report sheets and pasting to MS Office applications, 
see FAQ-815 How do I copy report sheet tables and paste them into Word, Excel or 

PowerPoint?  

17.11.3 As SQLite 

This option exports the active worksheet(s) as an SQLite file. Specify a file extension of .sqlite, .sqlite3 or .db 
(note that file structure is identical). Options to skip hidden columns or rows. Limited to export of data in 
worksheet columns.  

17.11.4 As Multipage PDF File 

This option is available only on sheets with data columns, and not for analysis report sheets. Use the View: 
Page Break Preview Lines menu item to view the vertical and horizontal page break lines that determine 
which columns and rows will be included in each page of the export. Floating or embedded graphs placed in 
the worksheet will be included in the exported image.  

17.11.5 As Image File 

This option is available on both data and analysis report sheets:  

With the worksheet active, choose File: Export: As Image File. 

In the dialog that opens,  

Image file formats including PDF and SVG are supported.  

Floating or embedded graphs placed in the worksheet will be included in the exported image. 

Set Export Area to Visible, Whole or Selection. Note that empty rows no longer exported when Export 
Area = Whole. 

Border is added to exported worksheet by default. Change border width or remove border, set the Frame 
Thickness drop-down. 

https://www.originlab.com/doc/Quick-Help/Copy-table
https://www.originlab.com/doc/Quick-Help/Copy-table
https://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
https://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
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17.11.6 As PDF File 

This option is available for both data and analysis report sheets. In the dialog that opens, you can opt for 
exporting the entire sheet, the visible area, or a selection. Floating or embedded graphs are included in the 
exported PDF.  

 

When creating a custom report from a worksheet that combines data, numeric results 
and graphs, the best option is to export the entire sheet as a PDF file, or export the 
sheet as a multi-page PDF file.  

17.12 Send Graphs to PowerPoint 

  You can send a group of Origin graphs to MS PowerPoint as pictures or as embedded objects (see limitations 
of embedded objects and Master Items, explained above). Graphs inserted as embedded objects can be 
further edited in your Origin software. Double-click on the graph in PowerPoint to open the graph in an OLE 
instance of Origin.  

 
To Send Graphs to PowerPoint:  

Click the Send Graphs to PowerPoint button on the Standard toolbar. 

or...  

Click the Send Graphs to PowerPoint icon in the Apps Gallery, docked to the right-side or your Origin 
workspace (if you do not see the Apps Gallery, click View: Apps or press ALT + 9). 

or...  

Right-click in the lower-pane of Project Explorer and choose Send Graphs to PowerPoint.  

 

https://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
https://www.originlab.com/doc/User-Guide/Origin-Interface
https://www.originlab.com/doc/User-Guide/Origin-Interface
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Tutorial: Send Graphs to PowerPoint  

Run Origin and open the sample file <Origin EXE Folder>\Samples\Graphing\Column 
and Bar.opju. 

Click the Send Graphs to PowerPoint button on the Standard toolbar. 

Click the Select Graphs button and choose Specified. 

Select all except Graph5B in the left panel and move them to the right panel by clicking 

the in the middle of the dialog box. Click OK. A scrollable list of graphs is added 
to the left panel in the App. 

Set Insert Graph as = Picture. 

Set the Slide Margin top dimension as 8% and leave the others as 0. 

Set Title Line = Top of Slide, and Title = Window Long Name. 

Set Starting Slide Index = 3 and Slide Mode = Start New. 

Use the browse button beside Load File/Template (optional) to load the file <Origin 
EXE Folder>\Samples\Import and Export\Column_Plots_in_Sample_OPJ.pptx. 

Specify a Save File as (optional) output path for the resulting PPTX file. 

 

 

There is also a Send Graphs to Word App that is pre-installed with your Origin 
software. This App is particularly useful for batch export of graphs to a book-marked 
MS Word document.  

17.13 Slide Show of Graphs 

  Origin has a built-in slideshow utility for viewing or presenting your graphs while running Origin. The slide 
show can be started in two ways:  

Right-click on any folder in Project Explorer and select Slide Show of Graphs...  

or  

Click the Slide Show of Graphs button on the Standard toolbar.  

A dialog box opens offering options to set slide order, slide cycle time, whether to include graphs in sub 
folders, etc. The dialog also lists shortcut keys for use during the slide show (e.g. G = go to the actual graph 
window of the currently displayed slide).  

 

Tutorial: Slide Show of Graphs  

Use the File: Open Sample Projects: 2D and Contour Graphs menu to open the sample 
project. 

Click on the Slide Show of Graphs button in the Standard Toolbar. 

Accept default settings in the dialog that opens, and press OK to start the slide show. 

You can use the up/down arrow keys or the mouse wheel to flip thru the slides.  

https://www.originlab.com/fileExchange/details.aspx?fid=238
https://www.originlab.com/doc/Tutorials/BatchProcess-WordTemplate
https://www.originlab.com/doc/Tutorials/BatchProcess-WordTemplate
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17.14 Creating Movies 

    Origin provides a Video Builder tool, accessible from the Open Video Builder button on the 

Standard Toolbar. This tool can be used to manually capture a series of graph windows, and write one frame 
at a time to a video (.AVI) file.  

Videos can be created using LabTalk script or Origin C code, by programmatically computing or updating data 
and then writing out the graph as a frame in the video, at each step during the computation.  

Note: For more information, please refer to the:  

Help: Origin: Origin Help > Exporting and Publishing Graphs > Creating Graph Animation  

 

 

For specific examples of programmatically created movies, including Origin Projects and 
code, please visit www.originlab.com/animation.  

17.15 Notes Windows for Reporting 

Over time, Origin's Notes window has morphed from a plain-text window for jotting down your research notes, 
into a flexible medium for collating a variety of research-related materials.  

Because the Notes window can contain linked objects -- graphs, images, worksheet cell values, etc. -- it can 
be useful to add a Notes window to an Analysis Template™ for purposes of summarizing analysis results. 
Alternately, you can save your Notes window as a PDF by clicking File: Print and choosing a PDF driver.  

17.15.1 Notes Window Syntax 

Origin's Notes window supports four syntaxes: Text, Origin Rich Text (default), HTML, and Markdown.  

To switch syntaxes, choose Notes: Syntax: Text. 

Once you have selected Text, you can freely choose other syntaxes from the Notes menu. 

17.15.2 Rich Text 

With Rich Text, the Notes window has two modes -- raw text mode and Render mode. Toggle between these 
modes using Notes: Render Mode or shortcut key combination CTRL + M.  

To add text to the Notes window, you need to be in raw text mode. To style added text, use the Format 
toolbar and/or apply pre-defined paragraph styles.  

https://www.originlab.com/doc/Origin-Help/Graph-Animation
http://www.originlab.com/animation
https://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
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17.15.2.1 Adding Content to Your Notes 

You can insert these objects to the Notes window by by right-clicking in the Notes window and choosing from 
the shortcut menu:  

 

Object  Comments  

Graph/Image  

Opens the Graph/Image Browser where you can pick project graphs and 

images. Note that you can Show Embedded Graph (see the first row of this 
table for a definition of "embedded graph") and Project Explorer "Favorites" 

folder shortcuts (Include Shortcut Page).  

Worksheet Opens the interactive range selector. Use this to pick a cell value in a worksheet 

https://www.originlab.com/doc/Origin-Help/Project-Explorer
https://www.originlab.com/doc/Origin-Help/AnalyDialog-SpecifyInput
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Cell...  or report sheet. Click Done to insert a linked cell value.  

Info Variable...  
Opens the Insert Variables dialog for inserting project variables stored on data 

import.  

New Table  

Opens the New Table dialog for configuring a basic table. Clicking OK closes the 

dialog and opens a basic workbook containing a single worksheet. Customize the 
worksheet, add data, etc., then use Notes window Render Mode to view the 
resulting table.  

Symbol Map  
Opens a simplified Symbol Map with characters sorted by tab. Click Advanced 

to go to the full Symbol Map.  

LaTeX Equation  

Opens the LaTeX Equation Editor App (if you've not already installed this free 

App, you are prompted to do so). You can click the Equation button to 

open a list of Origin's fitting functions (incl. your user-defined functions). Pick a 
function (or enter a function into the top box) and click Preview to see your 
equation rendered.  

Link  

Opens a dialog box for entering Text to display and a Link. The link can be a 

URL or it can be a link to such things as a worksheet data range (e.g. 

range://[book1]sheet1!col(1)[100]). Additionally, you can run simple LabTalk 
commands using a "labtalk://" tag (e.g. labtalk://newsheet).  

Image from File  
Opens a dialog to browse for image files. Note that the inserted image is linked 
to an external file and is not saved with the project.  

Image form 
Web  

Opens a dialog to specify a Image Link for a web image (hint: In your browser, 
right-click on an image and Copy Image Address, Copy Image Link, etc).  

 

Add your content using raw text mode.  

When you are ready to view your content, turn on (place a check mark beside) Notes: Render Mode or press 

CTRL + M. Note that you can use the Zoom combo box on the Standard toolbar to zoom in or out 
on the page (CTRL + mouse wheel also works). 

https://www.originlab.com/doc/Origin-Help/InsVariable-Dialog
https://www.originlab.com/doc/Origin-Help/Origin-Rich-Text
https://www.originlab.com/doc/User-Guide/Customizing-Graphs
https://www.originlab.com/doc/Origin-Help/Access-ExtCharSet
https://www.originlab.com/fileExchange/details.aspx?fid=221
https://www.originlab.com/doc/Origin-Help/Hyperlink-TextLabel
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17.15.2.2 Text Styles Manager 

In addition to styling text with the Format toolbar, you can apply a simple set of paragraph styles on a line-
by-line basis. Manage styles with the Text Styles Manager dialog box.  

With a worksheet active, choose Tools: Text Styles Manager. 

Select a Style to Modify and Apply or Close.  
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Note that you can add styles by selecting <new> from the Styles to Modify drop-down list; or select a style 
and Delete.  

To apply a paragraph style to Notes window text:  

Open the cell note in a Notes window. 

With Render Mode off (CTRL + M, to toggle), click on a line of text then right-click, choose Paragraph 
Styles and choose a style from the popup menu. 

To check results, press CTRL + M (Render Mode). 

 

To see a list of built-in paragraph styles, open a fresh Notes window, then from the 
menu choose Notes: Load Samples: Built-in Styles.txt.  

17.15.2.3 Adding Rich Text Content to Layout or Graph 

You can insert Rich Text content from a Notes window to a text object on a Layout or graph page.  
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To add the content of an existing Note (Layout or Graph):  

Select the Text tool , then click on the Layout/Graph and enter "@@@NotesN" (i.e. the Notes window 
Short Name). 

Click off the text object to insert Notes content. 

 
To add content by creating a new Note (Layout only):  

Right-click on the Layout and choose Insert Notes Text. 

See Adding Content to Your Notes. 

17.15.2.4 Print or Export to PDF 

You can output Rich Text content to a physical printer; or print to PDF using a third-party driver such as 
Microsoft Print to PDF.  

To create nice-looking output, you'll need to pay attention to these settings:  

Paper Size: This is set in File: Page Setup or in the Advanced options for your printer driver. 

Margins: These are set in File: Page Setup. 

Notes Display Margin: By default, the Notes display margin = 5 (units = points). Thus, you will note that in 
Render Mode (CTRL + M), there is a slight margin to the left side of the Notes page. This display margin is 
controlled by setting system variable @NDM.  

Notes Window Page Width: Page width is controlled by the property note.width (units = in/cm, etc). 

Default = 0, which corresponds to an uncontrolled width.  

https://www.originlab.com/doc/LabTalk/ref/sys-var-list
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When width is uncontrolled (note.width = 0), Notes Window Page Width is approximately equal to 

Paper Size – Margins. This should produce a satisfactory printout to PDF or paper. 

If you do specify note.width, do not exceed Paper Size – Margins or your text may be cut off. 

17.15.3 HTML and Markdown 

You can also use Notes windows to create HTML or Markdown reports. Similar to Rich Text, you can build your 
HTML report using placeholders that link to report sheet elements such as metadata, statistical results or 
graphs. The resulting HTML report can be printed or exported; or it can be incorporated into your Analysis 
Template. If Markdown syntax is used, optional HTML syntax can be also included for advanced customization.  

To use this feature, the user should have some basic familiarity with HTML or Markdown, and as with most 
things, the more proficient the user is, the easier it will be to create professional-looking output. However, the 
skill needed to generate a basic report can be easily mastered. See this OriginLab blog post for guidance.  

 

17.15.3.1 Adding Content to Your HTML Report 

The basic steps of creating reports using an Origin Notes window, are as follows:  

Create your project to include graphing and analysis results. 

Click the New Notes button to add a Notes window. 

From the menu, choose Notes: Syntax, then choose HTML or Markdown (Hint: You can toggle between 
text/view and markup modes by pressing CTRL+M and you can choose the default syntax by setting LabTalk 
System Variable @NPS). 

You can write your code in the Notes window's markup mode or you can use a text editor such as Notepad++, 
then copy and paste it to your Notes window. If you have no experience with HTML or Markdown, you may 
want to load samples by activating your Notes window and clicking Notes: Load Samples (HTML = ".html", 
Markdown = ".md"). 

You will likely want to incorporate graphing and analysis results from the current project, into your report. The 
simplest way to do this is to insert "placeholders" for each Origin object that you intend to include in your 
report, into your code. These placeholders can be named using any string that makes sense to you and they 
should be enclosed in double-curly braces (e.g. {{MyR-SquareValue}}). 

Right-click on the Notes window title bar and choose Edit Placeholders. Placeholders that you have 
incorporated into your code will be picked up and added to a Placeholders worksheet in the workbook. The 
sheet will list, in column A, all of the placeholders found in your code. A second column -- Column B -- is blank 
and is reserved for adding the associated Origin objects (i.e. the variables, analysis and graphing results, etc.) 
that you want to include in your report. 

https://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
https://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
http://blog.originlab.com/publishing/creating-html-reports-and-documents-in-origin-2019b
https://www.originlab.com/doc/LabTalk/ref/sys-var-list
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For each placeholder in column A, find the associated Origin object and copy it to the Clipboard (e.g. if it is a 
numeric quantity in a sheet resulting from some statistical analysis, select the cell quantity, right-click and 
choose Copy, or press CTRL+C on your keyboard). 

Return to the Placeholders sheet, right-click in column B, beside the associated placeholder and choose 
Paste-Link. This associates your placeholder with the intended Origin object. 

If you intend to include your HTML report in an Analysis Template, you can right-click on a workbook tab in 
your Analysis Template and choose Add Notes as Sheet. This inserts your Notes window into workbook and 
you can now choose File: Save Workbook as Analysis Template. 

 

When a Notes window is active, you can click the Notes menu and load a sample HTML 
file into the Notes window.  

 

17.15.3.2 Using Your HTML Report 

As you fill in your Placeholders sheet, you should see your HTML report take shape in the Notes window. Once 
completed, you can do various things with your HTML report, including:  

Print to hard-copy or to PDF (File: Print). 

Export the window as a webpage (Notes: Export to Webpage). 

Click the embed button in the upper-right corner of the Notes window to embed the content into your 
workbook, then save the workbook as an Analysis Template (File: Save Workbook As Analysis Template). 

17.16 Topics for Further Reading 

The Preferences: Options Page Settings 

Pasting or Embedding Graphs in Other Applications 

Exporting Your Graph or Layout Page to an Image File 

Which Image Format Should I Choose? 

The Export Graph Dialog Box 

Send Graphs to PowerPoint 

Send Graphs to PowerPoint Dialog Box Settings 

View Graphs as a Slide Show 

https://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
https://www.originlab.com/doc/Origin-Help/Options-Dialog-Page-Tab
https://www.originlab.com/doc/Origin-Help/Paste-Embed-OLE
https://www.originlab.com/doc/Origin-Help/ExpGraph-to-Image
https://www.originlab.com/doc/Origin-Help/ExpGraph-Format-Comprison
https://www.originlab.com/doc/Origin-Help/ExpGraph-Dailog
https://www.originlab.com/doc/Origin-Help/Project-Explorer
https://www.originlab.com/doc/X-Function/ref/pef_pptslide
https://www.originlab.com/doc/Origin-Help/Project-Explorer
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The Slide Show of Graphs Dialog Box Settings 

Creating Graph Animations 

Printing Graphs, Layout Pages and Analytical Results 

The Print Dialog Box 

The Print Options Dialog Box 

Copying and Pasting Graphs inside Origin 

Inserting Graphs and Images into Worksheet Cells 

Tutorial: Creating a Custom Report Sheet 

Using the Layout Page Window 

Creating a Master Page Layout for Graphs 

https://www.originlab.com/doc/X-Function/ref/pef_slideshow
https://www.originlab.com/doc/Origin-Help/Graph-Animation
https://www.originlab.com/doc/Origin-Help/Print-Graph-Layout-AnalyResult
https://www.originlab.com/doc/Origin-Help/Print-Dialog
https://www.originlab.com/doc/Origin-Help/Print-Option-Dialog
https://www.originlab.com/doc/Origin-Help/CopyPaste-Graph
https://www.originlab.com/doc/Origin-Help/InsObject-to-WksCell
https://www.originlab.com/doc/Tutorials/Create-Custom-Report
https://www.originlab.com/doc/Origin-Help/ExpGraph-Layout-Window
https://www.originlab.com/doc/Origin-Help/Master-Page-Layout
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18 Apps for Origin 

Apps 

Origin 2016 introduced Origin Apps -- tools that you could easily add to your Origin installation by dropping 
them onto your Origin workspace. This ever-expanding collection of add-on tools is extending Origin's already-
powerful graphing and analysis capabilities.  

Because an App is a self-contained, easily-distributed tool aimed at solving a particular problem, it can be 
developed and deployed quickly, sidestepping the need to wait for a new Origin product release. In addition, 
an App can be developed by anyone with a basic knowledge of programming in Origin, making it attractive as 
a means to create and distribute tools for your company or user-community.  

At present, all Apps can be downloaded for free. Note that some Apps require OriginPro; these are denoted in 

the App description by the symbol.  

18.1 Where Do I Find Apps? 

Apps are listed on the OriginLab File Exchange. While you can download Apps from the File Exchange using 
your web browser, it easier to obtain and manage your Apps using the App Center.  

The App Center provides "one stop" App installation and maintenance: Browse and download new and 
popular Apps, search for Apps, update existing Apps, request an App or submit an App via the OriginLab 
website.  

To open the App Center, click the Add Apps button that appears on all tabs of the Apps Gallery.  

 

 
What to look for in the App Center:  

Installed Apps with an Up-to-date Version icon beside them are up-to-date. 

Apps with a clickable Download and Install icon beside them are not installed. Click this icon to install. 

Apps with an Update icon beside them have an available update that you can install. Click this icon to 
update. 

Click the New and Popular tab for a quick look at what's available. Download and update Apps. 

Click the Search tab to find Apps by Category and Minimum Version. Download and update Apps. 

The Updates tab will display a red circle icon when there is an update to one or more installed Apps. 
Improvements and bug fixes are listed for each. 

18.1.1 Finding Apps from Analysis and Statistics Menus 

You can find Apps for these specific applications by clicking Find Apps... from Origin's main menu:  

http://wikis/ocwiki/index.php?title=AppDev:Introduction
http://www.originlab.com/fileExchange/
https://www.originlab.com/doc/User-Guide/OriginPro
https://www.originlab.com/fileExchange/index.aspx
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Analysis: Fitting 

Analysis: Peaks and Baseline 

Statistics 

These menu commands open the App Center Search tab to show only relevant Apps that are currently 

available from OriginLab's File Exchange. Click the Download and Install button beside an App, to 
install the App.  

 

18.2 How Do I Install Apps? 

If you install your Apps using the Download and Install button in the App Center dialog, you don't 
need to do anything else. The App is automatically downloaded and installed. When App updates become 

available, you can use the Update button to update an installed App.  

If your workstation does not have internet access:  

If your workstation does not have internet access, you will need to find a computer that does (does not need 
to have Origin installed), download the App from the OriginLab File Exchange to a thumb-drive and bring it 
back to your workstation.  

On the internet-connected computer, open a browser window and browse to originlab.com/fileExchange. 

Browse the list of Apps, go to the App's description and download page, then click the Download File button 
and copy the file to your thumb-drive. 

Return to your Origin workstation, plug in your thumb-drive and run Origin. Open Windows Explorer, browse to 
your thumb-drive and once you locate the App (it will have a .opx file extension), drag the App file to an 
empty portion of the Origin workspace. Make sure you are not running Origin as administrator or drag-and-
drop operations will fail. The App will be installed and the App icon will appear in the Apps Gallery, docked to 
the right side of your Origin workspace.  

 
If you have questions, click the How to Install link below the Download File button on the File Exchange 
App description and download page.  

https://www.originlab.com/fileExchange/index.aspx
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18.2.1 Finding Apps from the Start Menu 

You can also search for and install Apps directly from the Start menu.  

 

18.3 How Do I Run an App? 

Upon installation, an App icon is placed in the Apps Gallery, docked to the right side of the Origin workspace.  

App operations may be window-specific. If the App is dimmed (grayed out), the active window cannot be 
operated on by the App. Check the required window type (hover on the dimmed App icon in the Apps Gallery). 

If the Origin window type (worksheet, graph, etc.) is matched to the App, you can launch the App by double-
clicking on it in the Apps Gallery. 

If you prefer to launch the App from a toolbar button, open the Customize (Toolbars) dialog box (View: 
Toolbars), click the Button Groups tab, locate the App's toolbar button and drag the button to the OriginLab 
workspace or to an existing toolbar. Close the dialog box. 

Specific usage information is available on the description and download page for each App. 

18.4 Managing Your Apps 

You can use the App Center in combination with the Apps Gallery, to manage your Apps:  

Use the App Center (discussed above) to add and update Apps, search for Apps, request an App or submit a 
review of an App. 

. To launch the App Center, click the Add Apps button in the Apps Gallery.  

https://www.originlab.com/doc/User-Guide/Origin-Interface
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Organize your Apps by adding tabs to the Gallery. Right-click in an empty portion of the Gallery and choose 
New Tab, then double-click on the default tab name and give the tab a meaningful name.  

 

Additional higher-level actions available from the shortcut menu: 

Apps Icon Spacing ... 

Uninstall All ... 

Refresh 

New Ttab 

Show Connector Apps 

Show Apps from Other Tabs 

Sort Apps (Alphabetically, Newest Install, Recently Used). 

A number of App-specific actions can be performed by right-clicking directly on the App icon in the Gallery and 
choosing from the shortcut menu. 
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Show in Folder: Opens the user's \AppData\Local\OriginLab\Apps\ folder to the App installation folder. 

Uninstall: Uninstalls the selected App. 

Open the File Exchange Page: Opens the App's description and download page on the OriginLab File 
Exchange. 

Send Feedback...: Opens a Rate App dialog box to provide feedback. 

Show All (user-added tabs only): Shows Apps from all Gallery tabs on the active tab. 

Refresh: Refreshes the tab view. 

Tab Views: Place or remove the check mark beside the App to determine on which Gallery tab(s) the App 
shows. 

18.4.1 Updating App Center 

New Apps and App updates are continually made available to Origin and OriginPro users. Be sure to open your 
App Center occasionally (press F10) and if it displays the red Download Now button, click to get the latest 
list of available Apps.  
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18.4.2 Docking the Gallery 

By default, the Gallery is docked to the right side of the workspace.  

 

If you prefer, you can dock the Gallery to the top of the workspace, just below the toolbars:  

Drag the title bar toward the top of the workspace. Guide it to and drop it on he workspace docking button 
that appears (shown outlined in magenta).  

Once docked, drag the bottom edge of the Gallery to adjust width, as needed. 

 

18.5 Will I be Notified When Updates are Available? 

Several things will indicate when an App update is available:  

A red dot appears in the upper-right corner of the Add Apps icon in your Apps Gallery (docked to the right 
side of your workspace). Additionally, the red dot shows on individual Apps when an update is available.  
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In the App Center, the App will appear with a clickable "update" icon beside it.  

 

The App Center Updates tab will show a red dot with a number indicating how many App updates are 
available. The tab will list updated Apps and allow you to apply updates for individual Apps or all Apps.  

 

 
To update an App:  

Click the Update icon that appears next to the App in the App Center. 

Right-click on the App in the Apps Gallery and choose Download and Install Update 

Click the Update All Compatible button that appears on the Updates tab in the App Center; or click the 
"update" icon beside each App. 

Right-click on the Add Apps icon in the Apps Gallery and choose Update All. 

 

 

You can verify the version of an installed App by hovering on the App in your Apps 
Gallery.  

18.6 How Do I Uninstall an App? 

Uninstalling an App is easy. Right-click on the App icon in the Apps Gallery and choose Uninstall from the 
shortcut menu.  



UserGuide 2026 

384 

 

18.7 How Do I Give Feedback on an App? 

OriginLab relies heavily on customer input to improve our software products. We encourage you to give 
feedback on Apps by right-clicking on the App icon in the Apps Gallery and choosing Send Feedback.... It 
takes just a few seconds!  

 

18.8 Can I Request an App? 

As previously mentioned, Apps can be developed by anyone with Origin programming knowledge. However, if 
you do not program but you find that you need some particular functionality that is not currently a part of the 
Origin product, you can request an App through the OriginLab website. OriginLab is continually building and 
posting new Apps to the File Exchange.  

To request an App, open the App Center and click the Request App button in the lower-left corner of the 

dialog box. This opens a web page on www.originlab.com. 

Verify that the Your Reason for Contacting Us drop down is set to Request an App. 

Fill out the remaining required fields and click the Submit Inquiry button at the bottom of the form. 
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19 Programming in Origin 

Programming-in-Origin 

 

 

As you gain experience with Origin, you may want to access Origin features programmatically, add your own 
custom routines and tools, or communicate with Origin from other applications. This chapter outlines basic 
programming options available in Origin. For more detailed information, see the following Origin programming-
related resources:  

Programming documentation including guides, language references, and examples are available from the Help 
menu in the product.  

Online programming documentation is available at www.originlab.com/doc.  

You can typically locate online programming pages by performing a web search from your browser using 
phrases such as: labtalk importing , originc interpolate, or labview origin send data. 

An Origin Programming Forum can be found at www.originlab.com/forum. 

Sample files for LabTalk, Python, COM Server and Client, etc. can be found in the \Samples folder of your 
Origin software. 

  

19.1 LabTalk 
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LabTalk is a scripting language that provides access to most of Origin's functionality. With LabTalk you can 
access and change properties of Origin objects such as worksheets, columns, graph layers, and data plots. 
LabTalk script can include calls to X-Functions to perform advanced data processing and analysis.  

There are many options for executing your LabTalk scripts. Multiple lines of script can be organized as sections 
in a file, and those individual sections can be executed from the user-interface at the command prompt in the 
Script Window or Command Window; from buttons added to worksheets and graphs; from included or 
custom-made toolbar buttons; or from custom menu commands.  

 

The following "mini-tutorial" will demonstrate adding a button object to a worksheet, 

associating a short LabTalk script with the button, then using the button to execute the 
script and perform a basic statistical calculation while writing the results to the 
worksheet.  

Run Origin and start a new project by clicking the New Project button on the 

Standard toolbar. 

Click Data: Import from File: Single ASCII and browse to the file 
\Samples\Graphing\Box Chart.dat. Select the file and click Open. The file is imported 
into the active worksheet window.  

With the worksheet window active, click Format: Worksheet. In the Worksheet 
Properties dialog, click the Size tab and set Gap from Top to 25, then click OK. A 
gap is added to worksheet window. 

Click the Text Tool on the Tools toolbar. Click inside the gap that you just added and 
type "Add Mean Label Row" into the text object. Click outside the text object to exit 
edit mode. 

Right-click on the text label and select Properties.... Choose Programming Control 
tab, set Script Run After to Button Up. Copy and paste the following script into the 
text box: 

wks.userParam1 = 1; 

wks.userParam1$ = "Mean"; 

for (int ii = 2; ii <= wks.ncols; ii++) 

{ 

 range rr = $(ii); 

 Col($(ii))[D1]$ = 

$(mean(rr),.2*); 

} 

Click OK to apply settings and close the Text Object dialog box. Note that your text 
object now looks like a button. 

Click the button. Note that a new header row labelled "Mean" is added to the worksheet 
and the mean value of each column of data is written to the Mean row cell above the 
corresponding column. 
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Note: For more information on LabTalk, Origin's built-in scripting language, please consult your product 
documentation at Help: Programming: LabTalk.  

Sample files can be found in the \Samples\LabTalk Script Examples folder of your Origin software.  

19.2 Python 

  

Origin provides an embedded Python environment so that you can run Python in Origin. Origin supports 

command line execution of Python code from the Python Console or Origin's Code Builder IDE. As of 
December 2022, the embedded Python version is version 3.11.  

Note: For more information on integrated usage of Origin and Python, see these topics in the Python 
documentation:  

Introduction to Python in Origin 

Embedded Python 

Sample Projects with attached Python Code. 

 

 

There is an API for calling Origin from Python. See note under Automation Server, 
below. 

To prevent package version conflicts, Origin now supports multiple PyPackage folders 
(set system variable @PYP). 

19.3 R 

 Origin supports running R commands in the Origin environment. You can issue R commands in the Script 
Window or from the built-in R Console, or you can run .R files. All releases of R are supported up through 
version 3.6.  

From Origin, you can connect with R in two ways:  

R. Installed on your local computer.  

Rserve. Installed on a remote PC. 

Note: For more information on integrating Origin and R, refer to the Origin Help file (R Console and 
Rserve Console) and the LabTalk Scripting Guide (Running R in Origin, R Objects, Rserve 
Objects).  

Sample files can be found in the \Samples\R folder of your Origin software.  

19.4 MATLAB 

The MATLAB Console allows Origin users to issue MATLAB commands from Origin, and to transfer data 
between the two applications either using a graphical interface or using a command line.  

The Console requires both Origin and MATLAB be installed on the same computer.  

Origin also supports importing MATLAB (MAT) files from disk. There are two import routines, the older Data: 
Import from File and the new Connector-based Data : Connect to File: MATLAB. Importing MAT files does 
not require that MATLAB be installed. 

https://www.originlab.com/doc/LabTalk/guide
https://www.python.org/downloads/
https://www.originlab.com/doc/python
https://www.originlab.com/doc/python/Run-Python-in-Origin
https://www.originlab.com/doc/python/Sample-Projects-with-attached-Python-Code
https://www.originlab.com/doc/Origin-Help/R-Console-dlg
https://www.originlab.com/doc/Origin-Help/R-Server-dlg
https://www.originlab.com/doc/Origin-Help/R-Console-dlg
https://www.originlab.com/doc/Origin-Help/R-Server-dlg
https://www.originlab.com/doc/LabTalk/guide/LT-Running-R
https://www.originlab.com/doc/LabTalk/ref/R-obj
https://www.originlab.com/doc/LabTalk/ref/Rserve-obj
https://www.originlab.com/doc/LabTalk/ref/Rserve-obj
https://www.originlab.com/doc/Origin-Help/Import-ThirdPartyFormats
https://www.originlab.com/doc/Origin-Help/Import-ThirdPartyFormats
https://www.originlab.com/doc/Origin-Help/Connect-to-File


UserGuide 2026 

388 

Note: For more information on the MATLAB Console, refer to the Origin Help file (MATLAB Console.  

The <Origin Program Folder>\Samples\COM Server and Client\MATLAB subfolder contains an example 
(CreatePlotInOrigin.m, CreatePlotInOrigin.OPJ) that illustrates how to connect to an Origin COM server 
from a MATLAB client (requires MATLAB).  

19.5 Origin C 

 Origin C is a full-featured high-level programming language based on the ANSI C programming language 
syntax. Origin C also supports a number of C++ features and a few C# features. Origin C provides access to 
all aspects of Origin including data import, data handling, graphing, analysis, and exporting. You can access 
Origin C functions from interface controls such as buttons, toolbars, and menu items, using LabTalk script.  

Origin C is organized as a set of functions with support for passing arguments. Origin C functions are compiled 
to object code and then loaded and executed inside of Origin. Origin C provides increased reliability and 
manageability for developing and debugging code of greater scope and complexity.  

Origin C also provides access to the NAG Numerical Library functions included in your Origin installation. 
NAG functions provide you with a large selection of algorithms for performing computations ranging from 
simple statistics and Fourier transforms to linear algebra and multivariate analysis. Origin currently supports 
NAG Library Version Mark 26.1.  

Note: For more information on Origin C, please refer to the Origin C documentation:  

Help: Programming: Origin C  

There you will find usage information, a language reference, developer notes, examples, etc.  

Sample files can be found in the \Samples\Origin C Examples folder of your Origin software.  

19.6 X-Function 

 An X-Function is a self-contained XML file that can be loaded in Origin as a special type of global function. 
Origin C is the language used to create X-Functions. X-Functions provide a way to expand the functionality of 
Origin by adding custom data processing features. Many of the built-in tools in Origin are based on X-
Functions. Once an X-Function has been created, it can be accessed from anywhere in the interface that allows 
for script execution, such as the script window, toolbar buttons, or custom menu items.  

Note: For more information on X-Functions, please refer to your product documentation that is installed 
with your software:  

Help: Programming: X-Functions  

There, you will find information on creating and using X-Functions, a language reference, and tutorials.  

19.7 Automation Server 

  Origin can be used as an Automation Server. Client applications such as National Instruments™ 
LabVIEW™, Microsoft Excel, Python, or custom VB/VC/C# applications can exchange data with Origin, and 
can also send commands to be executed within Origin.  

Note: For more information on Origin's Automation Server functionality, refer to the product 
documentation installed with your Origin software:  

Help: Programming: Automation Server.  

There you will find examples and language reference information. Sample files can be found in the 

https://www.originlab.com/doc/Origin-Help/MATLABConsole
https://www.originlab.com/doc/OriginC/guide
https://www.originlab.com/doc/X-Function/guide
https://www.originlab.com/doc/COM
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\Samples\COM Server and Client folder of your Origin software.  

19.8 LabVIEW 

National Instruments™ LabVIEW™ is widely used for data collection. For example, many instrument and 
sensor vendors provide LabVIEW drivers for acquiring data. Once the data is collected, the end user will need 
to graph and analyze the data, and create reports for presentation. Origin provides powerful data analysis and 
graphing tools, including the Analysis Template feature, which allows for repeat analysis on newly acquired 
data. The ability to communicate between LabVIEW and Origin can thus greatly improve the efficiency of post-
acquisition analysis and presentation.  

Origin ships with a collection of LabVIEW sub-VIs. LabVIEW users can simply incorporate these custom sub-VIs 
in their main LabVIEW application to communicate seamlessly with Origin.  

Note: For more information on Origin-LabVIEW connectivity, see the product documentation installed 
with your Origin software:  

Help: LabVIEW VI  

Examples and tutorials are provided.  

 

19.9 Orglab 

Orglab is a freely distributed component DLL for directly creating or reading Origin Project (.opj) and other 
Origin file types (.ogg, .ogw and .ogm). It is available as a free download. An Origin license is not required to 
use Orglab. Typical use of Orglab is for instrument manufacturers and other third-party vendors to allow their 
frontend software to output data as Origin files.  

The Orglab module is available for 64-bit systems. To find out more about Orglab and to download the 
Orglab module, go to the Products > Orglab page of www.originlab.com.  

 

https://www.originlab.com/doc/
http://originlab.com/index.aspx?go=Products/Orglab
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20 Customizing Origin 

Customizing-Origin 

 

20.1 Customizing Default Settings 

20.1.1 Setting Preferences with the Options Dialog Box 

   The multi-tabbed Options dialog box has controls for Origin global settings pertaining to numeric display, 
file and system paths, text fonts, Origin program opening and closing behaviors, etc.  

To open the Options dialog box:  

Choose Preferences: Options (any Origin window is active)  

If you opened an Excel file inside Origin, choose Window: Origin Options (Excel workbook is active) 

 Controls For  

Axis Tab  

Max number of ticks for numeric and date/time scales 

Distances from the tick labels to tick marks, axis titles 

Display of zeros and scientific notation in tick labels, units display in axis title 

 

Two zero control check boxes were added and turned 
on by default for Origin 2020b:  

Zero is '0' 

No Trailing Zero 

Beginning with Origin 2021, these options are turned 
OFF by default.  

 

Excel Tab  

Use of default plot assignments 

Scan datasets for legend text 

Prompt before opening Excel files by drag-and-drop or saving Excel workbooks 

File Locations 
Tab  

Set file paths to track last opened, last saved, last exported file 

Set default path and file extension for importing different file types 

Define applicable file types for ASCII import dialogs 

Graph Tab  

Dash lines definitions, line to symbol gap, user-defined symbols, etc. 

2D graph anti-aliasing 

Enable in-place editing of linked and embedded graphs in another application 

Speed mode reminder watermark 

https://www.originlab.com/doc/Origin-Help/Options-Dialog-Axis-Tab
https://www.originlab.com/doc/Origin-Help/Options-Dialog-Excel-Tab
https://www.originlab.com/doc/Origin-Help/Options-Dialog-FileLocation-Tab
https://www.originlab.com/doc/Origin-Help/Options-Dialog-FileLocation-Tab
https://www.originlab.com/doc/Origin-Help/Options-Dialog-Graph-Tab
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Origin 2022 improved support for user-defined 
symbols, removing some long-time restrictions and 
making it easier to apply custom symbols to your 
graph:  

 

Support for Clipboard, .bmp or .svg formats.  

Support B&W or color symbols. 

Add symbols via the Options dialog or via Plot Details 
Add from Clipboard button (Symbol tab > Custom 
Construction check box > User Defined Symbols 
radio button). 

 

Miscellaneous 
Tab  

Proxy server configuration 

Default templates for ASCII import 

Custom date/time formats 

Enable collapsible menus 

Use of dataset names in the Origin workspace 

 

Origin's Python Packages dialog for managing 
installation of Python packages used with Origin, 
supports package installation via proxy server. Open 
Preferences: Options, go to the Miscellaneous tab, 
choose Use HTTP Proxy Server and enter the proxy 
address.  

 

Numeric 
Format Tab  

Thresholds for displaying numbers in scientific notation 

Defaults for displayed digits in data and report sheets 

Radians, degrees or gradians 

Separators for decimal places 

Open/Close 
Tab  

Default window closing behaviors 

Project startup, backup and autosave options 

Options dialog save options 

https://www.originlab.com/doc/Origin-Help/Options-Dialog-Misc-Tab
https://www.originlab.com/doc/Origin-Help/Options-Dialog-Misc-Tab
https://www.originlab.com/doc/python/Python-Packages
https://www.originlab.com/doc/python/Python-Packages
https://www.originlab.com/doc/Origin-Help/Options-Dialog-NumFormat-Tab
https://www.originlab.com/doc/Origin-Help/Options-Dialog-NumFormat-Tab
https://www.originlab.com/doc/Origin-Help/Options-Dialog-OpenClose-Tab
https://www.originlab.com/doc/Origin-Help/Options-Dialog-OpenClose-Tab
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Page Tab  

Default percent of page size of OLE graphs copied to Clipboard, graph margin and 
CTRL+C hotkey controls. 

 

Until 2021b, the Size Factor (%) (formerly, Ratio) 
was set to 40. The default is now 100.  

 

Text Fonts 
Tab  

Default fonts for text objects 

WYSIWYG and in-place editing mode behaviors 

Size and positioning of superscripts/subscripts 

Footnote size, analysis report sheets 

 

For information on controlling fonts used in the Origin 
interface, see LabTalk's system.font(object).  

 

System Path 
Tab  

View/Change the location of the User Files, Autosave, Backup, Unsaved and 
Group folders 

View locations of system folders (Program, License and Application Data) 

20.1.2 System Variables Dialog 

 System variables are internal Origin settings that allow for the fine-tuning of a wide range of Origin behaviors. 
Origin's Set Systems Variables dialog box (Preferences: System Variables...) can be used to view and set 
system variable values. In the dialog, there is a link named System Variables List which opens a web page 
with a list of all system variables, the default value, and description.  

To customize a particular system variable:  

Type the system variable name in the first column of Set System Variables, without the @ symbol. For 
example, if you wanted to make a global change to the Recalculate mode of analysis dialog boxes, type: DAM 

Click on the 2nd column to view the current value, and type in a new value. For example, with DAM, to set 
Recalculate to Auto, type the value: 1. 

Add optional comments in the third column and click OK to close dialog. 

This modified value will be remembered and applied in every Origin session.  

You can quickly read or set the value of a writable system variable in the Script Window (Window: Script 
Window) by typing @systemVariable= as, for example ...  

@DAM= 

... then pressing ENTER. When setting the value of a system variable in this way, note that that typing in the 
Script Window sets the variable value for the current session only.  

20.1.3 3D OpenGL Settings Dialog 

https://www.originlab.com/doc/Origin-Help/Options-Dialog-Page-Tab
https://www.originlab.com/doc/Origin-Help/Options-Dialog-TextFont-Tab
https://www.originlab.com/doc/Origin-Help/Options-Dialog-TextFont-Tab
https://www.originlab.com/doc/LabTalk/ref/System-Font-obj
https://www.originlab.com/doc/Origin-Help/Options-Dialog-SysPath-Tab
https://www.originlab.com/doc/Origin-Help/Options-Dialog-SysPath-Tab
https://www.originlab.com/doc/LabTalk/ref/sys-var-list
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  Origin uses OpenGL (Open Graphics Library) for rendering of 3D graphs. OpenGL provides enhanced 
performance including fast drawing, fast rotation and zoom, transparency, and lighting support.  

For optimum performance, your card should support OpenGL version 3.0 or higher. To check your hardware's 
support for OpenGL, run Origin and choose Preferences: 3D Open GL Settings.... Look under OpenGL Info 
for information on graphics hardware and the supported version of OpenGL.  

If your graphics hardware is older, you may experience compatibility issues with things such as transparency 
settings and anti-aliasing. The controls under the Settings node in this dialog allow you do such things as 
disabling transparency. The dialog box also provides information on disabling OpenGL.  

For more information on OpenGL in Origin, see the links under "Topics for Further Reading" at the end of this 
chapter.  

20.2 Customizing Menus 

   

20.2.1 Collapsible Menus 

Like many software products, Origin uses an auto-expanding "collapsible" menu feature that shows only a 
partial list of menu commands when opening longer menus. If you want to show all commands upon opening, 
click Preferences: Options, click the Miscellaneous tab and clear the Enable Collapsible Menus check 
box.  

 

20.2.2 Custom Menu Organizer 

 If you have scripts that are frequently run, you can add them to the menu for quick access. With the Custom 
Menu Organizer you can...  

Create up to 3 main menus and corresponding sub-menus 

Assign LabTalk scripts and X-Functions to a menu item 

Restrict menu item access to specific window types 

Hide unused built-in menu items, streamlining your Origin workspace 

To open the Custom Menu Organizer, choose Preferences: Custom Menu Organizer... from the main menu. 

Then press F1 or click the button in the upper-right hand corner of the dialog box for instructions.  

Once you create and save a new menu configuration (.omc) file, you can then select that configuration from 
the Preferences: Menu fly-out menu. Multiple configuration files can be created, allowing you to easily switch 
from one configuration to another. A Default configuration is also available in the fly-out, to revert to default 
menu settings. Configuration files can be shared among colleagues so that you use a common set of menu 
commands.  

20.2.3 Displaying Bitmaps in Menus 

 You'll note that form some menu commands, a bitmap is displayed to the left of the menu entry. The bitmap 
indicates that there is an equivalent toolbar button.  

https://www.originlab.com/doc/Origin-Help/Create-Custom-Menus
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On some systems such as VirtualPC or Terminal Servers, such bitmaps may cause a long delay when opening 
menus. To turn off the display of menu command bitmaps:  

Select Preferences: Options to open the Options dialog box.  

Select the Miscellaneous tab, clear Display Bitmaps in Menus, and click OK. 

 

You can modify the size of the Plot menu icons using the LabTalk system variable 
@PPS. To find out how to change the value of a system variable, see Customizing 
Origin Using System Variables.  

20.3 Customizing Toolbars and Buttons 

In addition to the standard Windows OS toolbar customizations, Origin provides some clever and easy-to-use 
tools for creating, programming and distributing custom toolbar buttons. If you or your staff are performing 
complex but repetitive Origin routines, you'll want to explore creating and sharing custom toolbars.     

20.3.1 Displaying, Hiding or Moving Toolbar buttons 

Click the small down arrow at the end of any toolbar and select the Add or Remove Buttons context menu. 
Then select desired sub menu and check/uncheck to show/hide buttons. A Reset option is also available. 

Press ALT key and drag a button to any new toolbar location. 

Press ALT key and drag a button to blank Origin workspace to create a new toolbar. 

Press ALT key and drag a button to any window till X shows, then release to delete the toolbar. 

20.3.2 Customizing Toolbar Button Appearance 

Use controls on the Options tab (View:Toolbars) to:  

Show toolbar screen tips and shortcut keys on hover 

Increase toolbar and toolbar button size 

Toggle between "flat" or 3D toolbar buttons 

20.3.3 Displaying or Hiding a Toolbar 

Double click the left/top end of any docked toolbar to undock. Double-click on title of floating toolbar to dock. 

In floating mode, click X button to hide the toolbar. Drag it to any new location to reposition. Drag it to edge of 
the Origin workspace to dock.  

In docked mode, drag the left/top end of a toolbar to reposition. 

To show/hide multiple toolbars together, choose View: Toolbars... from the main menu. Use the check boxes 

on Toolbars tab to show/hide toolbars. Click the New button to add a new toolbar, then drag buttons from the 
Button Groups tab to add buttons on the new toolbar. 

Use the Reset, Reset All buttons to reset toolbars. 

20.3.4 Creating New Toolbars with New Bitmap Images 

 Origin supports creating new toolbar buttons with Labtalk script, both built-in or user-defined script to run 
when click it. Choose View: Toolbars... and create new button group on Button Group tab.  

Origin ships with three button groups starting with User Defined... with a bunch of bitmap images.  

https://www.originlab.com/doc/LabTalk/ref/sys-var-list
https://www.originlab.com/doc/Origin-Help/Customization-with-SysVar
https://www.originlab.com/doc/Origin-Help/Customization-with-SysVar
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Click any button and click Settings... button to link .ogs (Script) file section with the button. 

Drag the button to Origin workspace to create toolbar button.  

If you are feeling really creative, Origin allows you to define a new button group that uses your own 16 color, 
16 x 16 pixel bitmaps. 

Export the button group as an .OPX file and share it with others. The person who gets the OPX can drag and 
drop the OPX file onto Origin workspace to install the toolbar.  

Note: To learn more about creating and exporting user-defined toolbars, see:  

Help: Origin: Origin Help > Customization and Automation > Customizing Toolbars  

20.3.5 Add a Custom Button to the Window Title Bar 

 Origin supports adding a system button to the left of the minimize button on the window title bar. A custom 
LabTalk script can then be associated with this button.  

Note: Please view the -tbb option of the LabTalk Page command in the Programming help file:  

Help: Programming: LabTalk > Language Reference > Command Reference > Alphabetical Listing of 
Commands > Page  

20.4 Customizing the Status Bar 

Origin uses the Status bar at the bottom of the Origin workspace to report software hints, statistics and other 
useful information depending upon current action, selection, window, etc.  

Right-click on Status Bar to customize the display. 

Press ALT and drag items along the Status Bar to reorder. 

20.5 Customizing the Origin Workspace 

Origin also supports customizing dockable windows such as the Project Explorer, Quick Help and Messages 
Log windows.  

Right click on the window title bar to specify dock, hide, auto hide, and other settings. 

When auto-hide is unchecked, double click to float the window. 

Drag the window title to move or dock to a new location. 

Arrange dockable windows as multiple tabs along the edge of the workspace to save screen space. 

Choose View: Toolbars... from main menu. On the Toolbar tab:  

The Reinitialize button resets menu, toolbar and dockable windows to default settings.  

The Export button exports the current menu, toolbar and dockable window settings to an .OPX file. Drag and 
drop the OPX file onto another Origin installation to configure the workspace to match your customized 
settings. 

 

Occasionally, an Origin workspace component goes "missing" -- The Data Display 
window, one of the panels in Project Explorer, etc. When this happens, you can reset 
your workspace by choosing View: Toolbars: Reinitialize. The downside has been 
that this also resets workspace customizations and toolbar configurations. Beginning 
with Origin 2018, clicking the Reinitialize button produces an attention message 
asking if you want to restore the workspace settings from your previous version or use 
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the 2018 system defaults.  

20.6 Templates and Themes 

   

The hierarchy of Origin objects such as graph pages, combined with extensive object properties, lends itself to 
the creation of custom settings for repeat use. You can save your custom settings either as templates or 
themes, described briefly in the following sections.  

Note: For detailed information please refer to Origin Help file, see:  

Help: Origin: Origin Help > Origin Basics > Origin Template Files (OTW, OTP, OTM)  

20.6.1 Templates 

The Origin template concept applies to graphs, workbooks, matrixbooks, and Analysis Templates™. Templates 
allow you to choose a set of properties or operations and save those for repeat use.  

20.6.1.1 Template Center 

Both the New Book (File: New: Workbook/Matrix: Browse...) and Template Library (Plot: Template 

Library) dialogs include an Open Template Center button that opens a dialog for browsing and 
downloading additional templates.  

To open the Template Center directly, choose Tools: Template Center and set the Type drop-down to Graph 
or Book.  
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You can search for additional templates and install them directly from the Start menu.  

 

20.6.1.2 Workbook Templates and Analysis Templates 

You can save workbook or matrixbook settings, such as the number of columns and sheets, column plot 
designations, fonts, colors, display formats, custom header rows, scripts associated with the sheet, or 
dimension and coordinate settings, to OTWU (workbook template) or OTMU (matrix template) files.  

When the workbook or matrix window is active and you choose File: Save Template As, you save any 
window customizations, minus any data that might exist in the window at the time of saving, to a template 
file. The template file can then be used to create new windows, as needed, for storing and analyzing your data.  

You can use the New Book dialog box for managing your workbook, matrixbook and Analysis templates. The 
New Book dialog is re-designed for Origin 2021b and is covered in the Workbooks chapter of this User Guide.  

Use the same New Book dialog to manage your Analysis Templates™. An Analysis Template starts from a 
workbook but differs in that when you save it as an Analysis Template (File: Save Workbook as Analysis 
Template), it is saved with whatever analysis operations and dependent graphing operations, exist in the 
workbook at the time of saving. Analysis Templates are discussed briefly in the Batch Analysis section of 
How to Handle Repetitive Tasks chapter of this guide.  

For a more in-depth discussion of Analysis Templates, see these topics:  

Analysis Templates. 

Creating and Using Analysis Templates (tutorial). 

Batch Processing with Word Template for Reporting (tutorial). 

20.6.1.3 Graph Templates 

As mentioned in the Customizing Graphs chapter, Origin ships with about 240 built-in graph templates that are 
used to create Origin’s many science and engineering graph types. Using one of these as a starting point, you 
can create your own graph, adding more layers, setting scale or dimensional relationships between layers, 
modifying data plot properties, etc., and then save your customizations as a user-defined graph template 
(.OTP) file by clicking File: Save Template as.... See the "Templates and Themes" section of the Customizing 
Graphs chapter for a general discussion of graph templates.  

One important subset of graph templates are what are called “cloneable” templates. A cloneable template 
requires a very specific data arrangement in your worksheet or matrix; the idea being that if you have once 
created a complex arrangement between worksheet datasets, matrix objects, etc. and, for instance, layers or 

panels in your graph, then you shouldn't need to recreate this arrangement every time you want to recreate 
such a graph. Cloneable templates are identifiable in the Template Library by the presence of a “sheep” icon 
next to the template name or thumbnail image.  

https://www.originlab.com/doc/Origin-Help/Wkbk-Saved-with-Template
https://www.originlab.com/doc/Origin-Help/MatBk-Template-What-is-saved
https://www.originlab.com/doc/Origin-Help/New-workbook-dlg
https://www.originlab.com/doc/User-Guide/Worksheets-Columns
https://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
https://www.originlab.com/doc/Origin-Help/Analysis-Templates
https://www.originlab.com/doc/Tutorials/AnalysisTemplate-Create-Use
https://www.originlab.com/doc/Tutorials/BatchProcess-WordTemplate
https://www.originlab.com/doc/User-Guide/Customizing-Graphs
https://www.originlab.com/doc/User-Guide/Customizing-Graphs
https://www.originlab.com/doc/User-Guide/Customizing-Graphs
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For more information, see the section on cloneable templates in Graph Template Basics in your Origin Help 
file.  

20.6.2 Themes 

 An Origin Theme is a file containing a set of object properties or dialog settings. Thus for example, the 
customized settings of a graph window can be saved as a Theme, or the customized settings in an analysis 
dialog can be saved as a Theme. If you were to open the Theme Organizer (see below), you would see that 
there are tabs for Graph, Worksheet, Dialog, Function and System Increment Lists.  

Themes allow you to quickly apply a new set of properties to an object, such as a graph. For example, you 
might apply a black-and-white Theme to a color graph in order to prepare it for publication. Or you might take 
the object properties of one graph and apply them to all the other graphs in the same project.  

Right-click on plot, layer, object, etc. in graph -- or right click with nothing selected in graph -- and choose 
Copy Format context menu to copy format. Depending where you right click, the corresponding selection's 
format can be copied. Then right-click on corresponding selection or right click in target graph and click Paste 
Format to apply the copied settings to the target selection or graph. You can also choose Edit: Paste 
Format... to paste the Format to multiple target graphs.  

 
 

 

The Theme Organizer dialog box is opened from the Preferences menu. Use this dialog to organize your 
graph, worksheet, and dialog themes. 

https://www.originlab.com/doc/Origin-Help/Graph-Template-Basics
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With this dialog you can apply a graph theme to multiple graphs to have consistent look. To combine multiple 
graph themes in the Theme Organizer dialog, hold down Ctrl while selecting the Themes, and then right-click 
to access the Combine context menu. The context menu in the tool provides an option to edit a Theme, 
allowing the user to add/delete properties to an existing theme. Setting a Theme as a System Theme means 
that it will be applied to new graphs automatically, if the graph template allows a System Theme to override 
template settings (see the Allow System Theme & System Increment Lists to Override check box).  
 

 

The Theme concept extends to dialog box settings, as well. For instance, you can choose a particular suite of 
settings in the Linear Fit dialog box (Analysis:Fitting:Linear Fitting), and then save those settings to disk 
as a named Theme file. You can save multiple Theme files for a given dialog box and then load them into the 
dialog, as needed, using the dialog box's Dialog Theme drop-down list. Saving multiple Themes for a dialog 
box allows you to customize your analysis routines from different experiments, when each requires using a 
specific (and unique) group of settings.  

https://www.originlab.com/doc/Origin-Help/OFileType-Template
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Dialog themes are explained in more detail in the How to Handle Repetitive Tasks chapter of this guide.  

 

You can select Graph: Graph Styles... in the menu main or click Graph Styles button 

in Graph Page Mini Toolbar to open Theme Preview app for previewing and 
applying graph themes.  

20.7 Topics for Further Reading 

The 3D openGL Settings Dialog Box 

Creating Custom Menus 

The Custom Menu Organizer 

Analysis Themes 

How to Manage Multiple Menu Configuration (.OMC) Files 

Managing Collapsible Menus 

The User Files Folder 

 

https://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
https://www.originlab.com/fileExchange/details.aspx?fid=476
https://www.originlab.com/doc/Origin-Help/GraphRef-3DOpenGL-Dialog
https://www.originlab.com/doc/Origin-Help/Create-Custom-Menus
https://www.originlab.com/doc/Origin-Help/CustomMenuOrganizer-Dialog
https://www.originlab.com/doc/Tutorials/AnalysisThemes
https://www.originlab.com/doc/Origin-Help/Manage-Multi-OMCFile
https://www.originlab.com/doc/Quick-Help/collapsible-menu
https://www.originlab.com/doc/Origin-Help/UserFilesFolder
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21 Sharing Origin Files 

Sharing-Files 

 

You may want to customize some aspect of your Origin installation and then share your customizations with 
other Origin users. Custom settings can be saved in many file types including graph templates (.otpu) and 
themes (.oth), analysis templates (.ogwu or .opju), dialog themes, curve fitting functions, import wizard 
filters, LabTalk script files (.ogs), and X-Functions.  

21.1 Drag and Drop Sharing 

 A quick and easy way to share a file with another user is simply to send it as an email attachment. The 
recipient can then drag and drop the file into the Origin workspace.  

Drag-and-drop is supported for most Origin file types. Origin project (.opju) and graph template (.otpu) files 
automatically open when dropped into the workspace. Other files are copied to the appropriate subfolders in 
the User Files Folder (UFF). For example, when you drop a fitting function (.fdf) file into the workspace, a 
dialog opens asking how you want to categorize the new fitting function.  

 

You can use a small dialog to remove formulas and links from the current selection, the 
active sheet, the active book or the entire project. This converts formulas and links to 
raw numbers. Removing formulas and links can make it easier to share project data 
with colleagues without having to share such things as externally-linked (DDE) Excel 
files; or to significantly reduce project size before archiving data.  

21.2 Sharing Files with Multiple Machines for Single Users 

https://www.originlab.com/doc/User-Guide/Worksheets-Columns
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If you are a single user and have installed Origin on multiple machines, you can share your custom settings 
across multiple installations. Set up the User Files Folder (UFF) on a shared location, such as a network drive, 
or even a USB flash drive, and use the same UFF path with each installation.  

Note: For information on changing the UFF path, see:  

Help: Origin: Origin Help > Customization and Automation > Setting Your Preferences > The User Files 
Folder  

21.3 Sharing Files with Other Users in a Network 

 You can set up and use a group folder to share files among users. Multiple groups are allowed, and each 
group can have some power user(s) set as the group leader. The group leader can use the Group Folder 
Manager tool to publish custom files for sharing with other group members. When a group member launches 
Origin, the published files will be copied to their Origin automatically and made ready for use.  

 

Origin supports setting multiple group folders, making it possible to share different files 
between groups. A leader machine can set up multiple groups and publish different files 
to different groups. A member machine can belong to multiple groups and thus receive 
all files published by group leaders.  

 

Note: For information on group folders, see:  

Help: Origin: Origin Help > Sharing Your Origin Files with Others > Sharing Files with Multiple Clients > 

Setting a Group Folder Location  

21.4 Packaging Files 

 Origin provides a Package Manager tool for packing multiple files into a single Origin Package (.opx) file. 
This is a convenient way to distribute custom applications that may contain multiple Origin files, such as 
templates, X-Functions, and LabTalk script files. The Package Manager includes options for running LabTalk 
scripts before and after installation.  

To access the Package Manager, click Tools, and then click Package Manager...  

To install the contents of an .opx file, simply drag and drop into the Origin workspace.  

Note: For information on packaging files, see:  

Help: Origin: Origin Help > Sharing Your Origin Files with Others > Packaging Multiple Files as OPX  

21.5 The Origin Viewer 

The Origin Viewer is a freely distributed, standalone application that allows viewing and copying of 
information contained in Origin project files and window (graph, worksheet, matrix) files on computers that do 
not have Origin installed.  

The Origin Viewer is distributed as a single EXE file - no installation needed. 

Available as a 64-bit Windows application, or as a native Mac application (Not compatible with 11.0.1, Big 
Sur). 

Project Explorer-like folder view with graph previews on hover, icon or details views, X-large icon view option. 

Open a graph in a pop-up window for better viewing. 

https://www.originlab.com/doc/Origin-Help/UserFilesFolder
https://www.originlab.com/doc/Origin-Help/UserFilesFolder
https://www.originlab.com/doc/Origin-Help/FileShare-GroupFolder-Location
https://www.originlab.com/doc/Origin-Help/FileShare-Pack-OPX
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Supports viewing and rotating Origin's OpenGL 3D graphs. 

 

Origin 2018 introduced a new Unicode-compliant project file type (OPJU). Origin Viewer 
versions 9.6.5 or later allow anyone to save the Unicode-compliant OPJU project files 
to the pre-2018 OPJ format for sharing of projects with users of older versions of 
Origin.  

 
If you have Origin graphs or data that you wish to share with colleagues who are not currently using Origin, 
you might direct them to the Origin Viewer page (www.originlab.com/viewer) where they can find out more 
and download the free EXE.  

21.6 Topics for Further Reading 

The User Files Folder 

Attaching Files to the Origin Project 

Package Manager 

Setting Up a Group Folder 

Exporting Custom Button Groups 

Exporting Toolbar Settings 

Apps for Origin 

https://www.originlab.com/viewer/
https://www.originlab.com/doc/Origin-Help/UserFilesFolder
https://www.originlab.com/doc/Origin-Help/FileShare-Append-to-OPJ
https://www.originlab.com/doc/Origin-Help/FileShare-PackageManager
https://www.originlab.com/doc/Origin-Help/FileShare-GroupFolder-Location
https://www.originlab.com/doc/Origin-Help/Export-Button-Group
https://www.originlab.com/doc/Origin-Help/Export-Toolbar-Setting
https://www.originlab.com/doc/User-Guide/Apps
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22 Origin Toolbars 

Toolbars 

 
This is a list of Origin toolbars, and buttons by button group. Toolbars are shown in their default 
configurations. You will note that some buttons are missing from default toolbar configurations. This may be 
because a button has been deprecated, because it is duplicated on another toolbar, or simply because it is a 
lesser-used button.  

To add or remove buttons from a toolbar:  

Click View: Toolbars to open the Customize dialog box. 

Click on the Button Groups tab and drag desired buttons to a toolbar or to an empty portion of the 
workspace.  

To remove a button/toolbar, drag it from the toolbar back to the Buttons list or click the small "x" in the 
upper right-corner of the toolbar (removes entire toolbar from the workspace). 

Note also that some toolbar buttons have a small downward pointing arrow next to them. Clicking the tool 
displayed on these "split buttons" carries out the action associated with the displayed tool. Clicking the arrow 
beside it opens a menu, allowing you to pick another tool. A split button displays the tool that was last used.  

 
To hide/show all toolbars in the Origin interface：  

Click View: Hide Toolbars menu  
or  

Press the hotkey Ctrl+Alt+R 

 
Finally, toolbar buttons will be inaccessible (dimmed) if the object that they act on is not active. For instance, 
the 3D-Rotation Toolbar is only available when a 3D graph is active.  

 

In addition to these dockable toolbars, Origin has context-sensitive Mini Toolbars for 
variety of common editing tasks. These toolbars are discussed in The Origin Interface 
chapter of this Guide. For a complete list of those toolbars, see the Origin Help File.  

22.1 Standard 

 

Button  Description  Hotkey  Button  Description  Hotkey  

 

New Project   
 

New Folder   

 

New Workbook   
 

New Graph   

https://www.originlab.com/doc/User-Guide/Origin-Interface
https://www.originlab.com/doc/Origin-Help/Mini-Toolbar
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New Matrix   
 

New 2D 
(Function) Plot  

 

 

New 2D Parametric 
Plot  

 
 

New 3D 
(Function) Plot  

 

 

New 3D Parametric 
Plot  

 
 

New Layout   

 

New Notes   
 

Digitize Image   

 

New Image   
 

Open  
Ctrl + 

O  

 

Open From Cloud   
 

Save Project  
Ctrl + 
S  

 

Save Template   
 

Recalculate 
Auto/Up-to-
date vs 
Manual/Pending  

 

 

Pause Auto 
Update/Recalculation  

 
 

Zoom In and 
Out by 
Percentage  

 

 

Print  
Ctrl + 
P  

 

Slide Show of 
Graphs  

 

 

Send Graphs to 
PowerPoint  

 
 

Open Video 
Builder  

 

 

Refresh  F5  
 

Duplicate   

 

Custom Routine   
 

Project Explorer  Alt + 1  

 

Object Manager  Alt + 8  
 

Results Log  Alt + 2  

 

Command Window  Alt + 3  
 

Script Window  
Shift + 
Alt + 3  
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Code Builder  Alt + 4  
 

Add New 
Columns  

 

22.2 Folders and Windows 

Folders and Windows toolbar is added for working with Project Explorer folders and folder contents. It 
should be helpful when dealing with multiple project folders and when needing to compare windows in 
separate folders.  

When first running Origin, you may see this toolbar "floating" in the Origin workspace. You can drag it (by the 
title bar) to an empty portion of the toolbar spacer; or you can choose View: Toolbars and click the 
Reinitialize button to reset toolbars to the standard configuration.  

 

Button  Description  Hotkey  Button  Description  Hotkey  

 

Folder Backward   
 

Folder Forward   

 

Seesaw  
Ctrl + 
Alt + X  

 

Add Active 
Window Shortcut 
for Seesaw  

Ctrl + 
Shift + 
F7  

 

Add Shortcuts 
from Previous 
Folder  

 
 

Arrange Windows 
(Last Used)  

 

 

Pin Active 
Window  

    

22.3 Import 

 

Button  Description  Hotkey  Button  Description  Hotkey  

 

Import Wizard   
 

Import Single 
ASCII  

 

 

Import Multiple 
ASCII  

 
 

Import Excel   

https://www.originlab.com/doc/User-Guide/Origin-Interface
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Re-import no 
Dialog  

Ctrl + 
4  

 

Re-import with 
Dialog  

 

 

Clone Import   
 

Batch Processing   

 

Connect to Data 
from Web  

 
 

Connect Multiple 
Files  

 

 

Import All 
Connected Data  

    

22.4 Edit 

 

Button  Description  Hotkey  Button  Description  Hotkey  

 

Cut  Ctrl+X  
 

Copy  Ctrl+C  

 

Paste  Ctrl+V  
 

Undo  Ctrl+Z  

 

Redo  Ctrl+Y     

22.5 Graph 

 

Button  Description  Hotkey  Button  Description  Hotkey  

 

Enable/Disable 
Anti-Aliasing  

 
 

Rescale  Ctrl+R  

 

Rescale X   
 

Rescale Y   
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Rescale XY   
 

Rescale Z   

 

Exchange the X 
and Y axes  

 
 

Enable/Disable Speed 
Mode  

 

 

Extract to 
Layers  

 
 

Extract to Graphs   

 

Merge   
 

Duplicate with New 
Columns/Sheets/Books  

 

 

Add Bottom-X 
Left-Y Layer  

 
 

Add Top-X Layer   

 

Add Right-Y 
Layer  

 
 

Add Top-X Right-Y 
Layer  

 

 

Add Inset 
Graph  

 
 

Add Inset Graph With 
Data  

 

 

Zoom In   
 

Zoom Out   

 

Whole Page      

22.6 2D Graphs 

 

Note that only common plot types have a toolbar button. Complete access to Origin plot 
types is found on the Plot menu.  

 

Button  Description  Button  Description  

 

Line  
 

Horizontal Step  
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Vertical Step  
 

Spline Connected  

 

Scatter  
 

Grouped Scatter - Indexed Data  

 

Scatter Central  
 

Column Scatter  

 

Y Error  
 

X Y Error  

 

Vertical Drop Line  
 

Bubble  

 

Color Mapped  
 

Bubble + Color Mapped  

 

Line + Symbol  
 

Line Series  

 

2 Point Segment  
 

3 Point Segment  

 

Row-wise  
 

Column  

 

Column + Label  
 

Grouped Column-Indexed Data  

 

Bar  
 

Stacked Column  

 

Stacked Bar  
 

100% Stacked Column  

 

100% Stacked Bar  
 

Floating Column  

 

Floating Bar  
 

3D Color Pie Chart  

 

2D B&W Pie Chart  
 

Double Y Axis  
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3Ys Y-YY  
 

3Ys Y-Y-Y  

 

4Ys Y-YYY  
 

4Ys YY-YY  

 

Multiple Y Axes  
 

Stacked Lines By Y Offsets  

 

Colormapped Line Series  
 

Waterfall  

 

Y Color Mapped Waterfall  
 

Z Color Mapped Waterfall  

 

3D Waterfall  
 

Y Color Mapped 3D Waterfall  

 

Z Color Mapped 3D Waterfall  
 

Vertical 2 Panel  

 

Horizontal 2 Panel  
 

4 Panel  

 

9 Panel  
 

Stack  

 

Multiple Panels by Label  
 

Trellis Plot  

 

Cluster Plot  
 

Box Chart  

 

Violin with Box  
 

Grouped Box Charts-Indexed 
Data  

 

Grouped Box Charts-Raw 
Data  

 

Interval Plot  

 

Histogram  
 

Histogram + Probabilities  

 

Multi-Panel Histogram  
 

Marginal Histograms  
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Marginal Boxes  
 

Distribution + Rug  

 

2D Kernel Density  
 

QC(X-bar R) Chart  

 

Pareto Chart-Binned Data  
 

Pareto Chart-Raw Data  

 

Scatter Matrix  
 

Probability Plot  

 

Q-Q Plot  
 

Parallel Plot  

 

Area  
 

Stacked Area  

 

Fill Area  
 

Zoom  

 

Polar theta(X) r(Y)  
 

Polar r(X) theta(Y)  

 

Wind Rose-Binned Data  
 

Wind Rose-Raw Data  

 

Ternary  
 

Piper  

 

Smith Chart  
 

Radar  

 

Vector XYAM  
 

Vector XYXY  

 

High-Low-Close  
 

Japanese Candlestick  

 

OHLC Bar Chart  
 

OHLC-Volume  

 

Line (Stock)  
 

Bridge Chart  
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Template Library    

22.7 Add Object to Graph 

 

Button  Description  Hotkey  Button  Description  Hotkey  

 

Add Color Scale   
 

Add Bubble Scale   

 

Add Box Scale   
 

Reconstruct 
Legend  

Ctrl+L  

 

Add Asterisk 
Bracket  

 
 

Add Round 
Bracket  

 

 

Add Brace Bracket   
 

Add XY Scale   

 

Date & Time   
 

Project Path   

 

New Link Table      

22.8 3D and Contour Graph 

 

Button  Description  Button  Description  

 

3D Scatter Plot  
 

3D Trajectory  

 

3D Scatter + Error Bar  
 

3D Vector XYZ XYZ  
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3D Vector XYZ dXdYdZ  
 

3D Tetrahedral  

 

3D Bars  
 

3D Stacked Bars  

 

3D 100% Stacked Bars  
 

XYY 3D Bars  

 

XYY 3D Stacked Bars  
 

XYY 3D 100% Stacked Bars  

 

3D Ribbons  
 

3D Walls  

 

3D Waterfall  
 

Y Color Mapped 3D Waterfall  

 

Z Color Mapped 3D Waterfall  
 

3D Color Fill Surface  

 

Multiple Color Fill Surfaces  
 

3D X Constant with Base  

 

3D Y Constant with Base  
 

3D Colormap Surface  

 

Multiple Colormap Surfaces  
 

3D Color Fill Surface with Error 

Bar  

 

3D Colormap Surface with 
Error Bar  

 

3D Wire Frame  

 

3D Wire Surface  
 

3D Colormap Surface with 
Projection  

 

3D Ternary Colormap Surface  
 

Contour - Color fill  

 

Contour - B/W Lines + Labels  
 

Gray Scale Map  

 

Contour Profiles  
 

Polar Contour theta(X) r(Y)  
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Polar Contour r(X) theta(Y)  
 

Ternary Contour  

 

Image Plot  
 

Image Profiles  

 

Heatmap  
 

Heatmap with Labels  

22.9 3D Rotation 

 

Button  Description  Button  Description  

 

Rotate counterclockwise  
 

Rotate clockwise  

 

Tilt left  
 

Tilt right  

 

Tilt down  
 

Tilt up  

 

Increase perspective  
 

Decrease perspective  

 

Fit frame to layer  
 

Reset Rotation  

 

Reset  
 

Rotate on any direction  

 

Rotation Angle    

22.10 Worksheet Data 
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Button  Description  Hotkey  Button  Description  Hotkey  

 

Statistics on 
Column(s)  

 
 

Statistics on 
Row(s)  

 

 

Sort   
 

Set Column Values  Ctrl+Q  

 

Set All Column 
Values  

Ctrl+F5  
 

Row number   

 

Uniform random 
numbers  

 
 

Normal random 
numbers  

 

 

Add/Remove 
Data Filter  

 
 

Enable/Disable 
Data Filter  

 

 

Reapply Data 
Filter  

    

22.11 Column 

 

Button  Description  Button  Description  

 

Set as X  
 

Set as Y  

 

Set as Z  
 

Set as Y Error Bars  

 

Set as Labels  
 

Set as Disregard  

 

Set as Grouping  
 

Set as Subject  

 

Move to First  
 

Move Left  
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Move Right  
 

Move to Last  

 

Swap Columns  
 

Add Sparkline  

22.12 Layout 

This toolbars has been hidden in the workspace by default. To show it, select menu View: Toolbars.  

 

Button  Description  Button  Description  

 

Add Graph  
 

Add Worksheet  

22.13 Mask 

 

Button  Description  Button  Description  

 

Mask Range  
 

Unmask Range  

 

Change mask color  
 

Hide/Show masked points  

 

Swap mask  
 

Disable/Enable masking  

22.14 Tools 
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Button  Description  Hotkey  Button  Description  Hotkey  

 

Pointer   
 

Scale In   

 

Scale Out   
 

Screen Reader   

 

Data 
Highlighter  

 
 

Data Reader   

 

Data Cursor   
 

Data Selector   

 

Selection on 
Active Plot  

 
 

Selection on All 
Plots  

 

 

Mask Points on 
Active Plot  

 
 

Mask Points on 
All Plots  

 

 

Unmask Points 
on Active Plot  

 
 

Unmask Points 
on All Plots  

 

 

Draw Data   
 

Text Tool   

 

Annotation   
 

Distance 
Annotation  

 

 

Angle 
Annotation  

 
 

Arrow Tool   

 

Curved Arrow 
Tool  

 
 

Line Tool   

 

Polyline Tool   
 

Curve Tool   

 

Freehand Draw 
Tool  

 
 

Rectangle Tool   

 

Circle Tool   
 

Polygon Tool   
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Region Tool   
 

Zoom-Panning 
Tool  

Hold 
"A"  

 

Insert Equation   
 

Insert Word 
Object  

 

 

Insert Excel 
Object  

 
 

Insert Object   

 

Insert Graph   
 

Insert 
Worksheet  

 

 

Rescale Tool  
Hold "Z": 
Zoom; Hold 
"X": Pan  

 

Rotate Tool  
Hold 
"R"  

22.15 Object Edit 

 

Button  Description  Button  Description  

 

Left  
 

Right  

 

Top  
 

Bottom  

 

Vertical  
 

Horizontal  

 

Uniform Width  
 

Uniform Height  

 

Group  
 

Ungroup  

 

Distribute Selected 
Layers/Graphic Objects 
Evenly in Vertical Dimension  

 

Distribute Selected 
Layers/Graphic Objects 
Evenly in Horizontal Dimension  

 

Front  
 

Back  
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Forward  
 

Backward  

 

Front(data)  
 

Back(data)  

22.16 Arrow 

This toolbars has been hidden in the workspace by default. To show it, select menu View: Toolbars.  

 

Button  Description  Button  Description  

 

Horizontal Alignment  
 

Vertical Alignment  

 

Widen Head  
 

Narrow Head  

 

Lengthen Head  
 

Shorten Head  

22.17 Style 

 

Button  Description  Hotkey  Button  Description  Hotkey  

 

Fill Color   
 

Line/Border 
Color  

 

 

Lighting Control 
Dialog  

 
 

Palette   

 

Line/Border 
Style  

 
 

Line/Border 
Width  

 

 

Fill Pattern   
 

Fill Pattern 
Width  
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Pattern Color   
 

Clear Borders   

 

Left Border   
 

Top Border   

 

Right Border   
 

Bottom Border   

 

Frame Borders   
 

Inside 
Horizontal 
Borders  

 

 

Inside Vertical 
Borders  

 
 

Inside Horiz 
and Vert 
Borders  

 

 

All Horizontal 
Borders  

 
 

All Vertical 
Borders  

 

 

All Borders   
 

Merge cells  Ctrl+R  

22.18 Format 

 

Button  
Descripti
on  

Hotkey  Button  Description  Hotkey  

 

Font   
 

Font size   

 

Bold  Ctrl+"B"  
 

Italic  Ctrl+"I"  

 

Underlin
e  

Ctrl+"U"  
 

Superscript  Ctrl+"+"  

 

Subscrip
t  

Ctrl+"="  
 

SuperSubsc
ript  

Ctrl+"-"  
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Increase 
Font  

Ctrl+">"  

Ctrl+Shift
+"."  

 

Decrease 
Font  

Ctrl+"<"  

Ctrl+Shift
+","  

 

Greek  Ctrl+"G"  
 

Left   

 

Center 
Horizont
al  

 
 

Right   

 

Top   
 

Center 
Vertical  

 

 

Bottom   
 

Font Color   

22.19 Auto Update 

 

Button  Description  

 

Pause Auto Update/Recalculations  

22.20 Database Access 

 

Button  Description  Button  Description  

 

Open SQL Editor  
 

Open Query Builder  

 

Load ODQ File  
 

Preview Import  
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Import data  
 

Remove SQL  

22.21 Markers & Locks 

 

Button  Description  Hotkey  Button  Description  Hotkey  

 

Add Data 
Markers  

Ctrl+Alt+M  
 

Clear Data 
Markers  

Ctrl+Alt+N  

 

Marker Size   
 

Marker Hide 
Show  

 

 

Lock Positions      
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23 Index 

24 2 

2D Integration 311 

3 

32- and 64-bit 3 

3D Graphing, Hardware Compatibility 432 

3D Surface Fitting 14 

A 

AB? 72 

ABF 72 

Active Dataset 322 

Analysis Markers 329 

Analysis Reports 372 

Analysis Templates 131, 372 

Analysis Themes 437 

Animating Graphs 403 

Annotation Tool 293 

ANOVA 356 

Apps Gallery 35 

ASCII Data 70 

ASCII Data, Import to Graph 183 

Auto Recalculate 362 

Automating Origin 361, 379 

Axis Dialog Box 219, 234 

B 

B2D 72 

Batch Peak Analysis 342 

Batch Plotting 368 

Batch Processing 361 

BDF 72 

Binary 2D Array, Import 72 

BRUKER OPUS 72 

Buttons, Adding Programmable to Origin Windows
 434 

C 

CDF 72 

CGM 72 

Child Windows 39 

Clipboard Data, Importing 73 

Code Builder 48 

Column Label Rows, Worksheet 104 

Column Plot Designations 180 

Column Values, Setting 112 

Columns, Naming 84 

Command Window 44 

Concurrent Network 5 

Consulting 9 

Context Menu 50 

Convolution 345 

Coordinate Values, Reading/Annotating 311 

Coordinates, Reading/Labeling 303 

Copy/Paste Graphs 385 

CSV Files 63 

Curve Fit, Linear and Polynomial 338 

Curve Fit, Nonlinear 339 

Curve Fitting 311 

Custom Menu Organizer 432 

Customizing Menus 432 

Customizing Origin, Global Settings 429 

Customizing Toolbars and Buttons 433 

D 

DAT 72 

Data Cursor Tool 296 

Data Display 295 

Data Info Window 301 

Data Markers 327, 329 

Data Points, Deleting 308 

Data Points, Drawing 308 

Data Reader 295 

Data Reduction, Graphs 188 

Data Reduction, Worksheets 128 

Datasets, Creating 110 
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DCF 72 

Deactivate License 7 

Derivatives, Plot 311 

Descriptive Statistics 311 

Dialog Box Themes 364 

Differentiation 311 

Digitizing Scatter Plots 78 

Drag and Drop Plotting 181 

Drag-and-Drop Origin File Sharing 441 

Drag-and-Drop, Importing by 73–72 

DX 72 

DX1 72 

E 

EarthProbe 72 

EDF 72 

Embed Graphs, 3rd Party Applications 385 

Embed Graphs, Origin Templates 365 

EPA 72 

ETAS INCA 72 

Excel 40, 68, 256, 427, 429 

Exporting Graphs/Layout Pages 390 

Exporting Worksheets 399 

F 

Famos 72 

FFT 311, 344 

File Types, Origin 55 

Filtering, Signal Processing 344 

FLEXnet 5 

Full Menus 20 

Function Plots, 2D and 3D 172 

G 

Gadgets 15, 303, 311 

Graph Gallery 12 

Graph Layer 174 

Graph Layer Frame 174 

Graph Page 174 

Graph Types 191 

Graphical Exploration Tools, Annotation 301 

Graphical Exploration Tools, Data Cursor 301 

Graphical Exploration Tools, Data Info Window
 301 

Graphical Exploration Tools, Data Reader 301 

Graphing Matrix Data 171 

Graphing, Functions 172 

Graphs, Add Data by Insert Plot to Layer 181 

Graphs, Adding or Removing Plots 181 

Graphs, Adding Text & Drawing Objects 255–
54 

Graphs, Animating 403 

Graphs, Browser 213 

Graphs, Cloning with New Data 368 

Graphs, Copy/Paste Format 280, 437 

Graphs, Copy/Paste or Embedding 385 

Graphs, Creating 167 

Graphs, Customizing Axes 219, 234, 245 

Graphs, Customizing Data Points 232 

Graphs, Customizing Grouped Plots 229–28 

Graphs, Distance Between Two Points 296 

Graphs, Embed in Worksheets 131 

Graphs, Exporting 390 

Graphs, Extract to Graphs 271 

Graphs, Extract to Layers 271 

Graphs, Function 172 

Graphs, Insert Equation 256 

Graphs, Inset 277–75 

Graphs, Labeling a Data Point 256 

Graphs, Layer Contents Dialog Box 182 

Graphs, Layer Customizations 221 

Graphs, Legend Customization 220, 245 

Graphs, Linking Axis Scales 272 

Graphs, Listed by Type 192, 199, 202, 204, 
206, 210, 213, 214, 215 

Graphs, Magnifying 285 

Graphs, Merge 221 

Graphs, Panning 285 
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Graphs, Plot Details 219, 226 

Graphs, Reading Coordinate Values 291 

Graphs, Reorder Layers 273 

Graphs, Save Format as Theme 221, 222 

Graphs, Saving Custom Templates 221 

Graphs, Scaling Objects 262 

Graphs, Send to PowerPoint 401 

Graphs, Slide Show 402 

Graphs, Speed Mode 188 

Graphs, Template Library 221 

Graphs, Templates 278 

Graphs, Theme Organizer 281 

Graphs, Themes 280 

Group Folder Manager 442 

Grouping Plots 187 

H 

H5 72 

HDF5 72 

HE 72 

HEKA 72 

Help Files, Updating 9 

Hiding Worksheet Columns 127 

HPF 72 

HYP 72 

I 

IBW 72 

IgorPro 72 

Image Processing 16, 346 

Image Profile 311 

Image, Import 72 

Images, Matrix 137 

IMG 72 

Import Wizard 73 

Importing, Filter Files (OIF) 55 

imzML 72 

Inset Graph 277–75 

Installing Origin 3 

Integration 311 

Interpolation 311 

ISF 72 

J 

JCAMP 72 

JCAMP-DX 72 

JCM 72 

JDX 72 

JNB 72 

K 

KaleidaGraph 72 

L 

LabTalk 423 

LabVIEW™ 427 

Layer Contents Dialog Box 182, 187 

Layer Icon, Graph 175–74 

Layers, Graph 174 

Layout Pages, Exporting 390 

Legend, Box Charts 247 

Legend, Bubble Scales 248 

Legend, Color Scales 248 

Legend, Customizing 220, 245 

Legend, Update vs. Reconstruct 247 

License Management 3 

License, Dongle 5 

License, Maintenance 6 

License, Node-locked 5 

License, System Transfers 7 

Limitations, Matrix 135 

Limitations, Workbook 84 

Limitations, Workbooks 83 

Lock, Recalculate 362 

M 

Magnifying Graphs 285 

Manual Recalculate 362 

Masking Data, Graphs 332 

Masking Data, Remove or Disable Mask 332 
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Masking Data, Worksheets 332 

Mat 72 

Math Tools, Area/Volume 337 

Math Tools, Basic 335 

Math Tools, Interpolation 336 

MATLAB 72 

Matrix Objects 139 

Matrix Objects, Naming 135 

Matrix, Converting to Worksheet 160 

Matrix, Converting Worksheet Data 163 

Matrix, Data Mode vs. Image Mode 137 

Matrix, Manipulating Data 159 

Matrix, Profiling 156 

Matrix, Set Values 157 

Matrix, Virtual 164 

Matrixbooks, Naming 135 

Matrixsheets, Naming 135 

MDF 72 

Menus 20 

Menus, Customizing 432 

Menus, Organizer 21 

Messages Log 49 

Minitab 72 

Modifying Toolbars 433 

Movies, Animating Graphs 403 

MPJ 72 

MTW 72 

Multivariate Analysis 14 

Multivariate Statistics 358–57 

mzData 72 

mzML 72 

mzXML 72 

N 

NAG Numerical Library 426 

Naming Columns 84 

Naming Matrix Objects 135 

Naming Matrixbooks 135 

Naming Matrixsheets 135 

Naming Workbooks 84 

Naming Worksheets 84 

National Instruments 72 

National Instruments™ LabVIEW™ 427 

NC 72 

NetCDF 72 

Networks, Concurrent 5 

Networks, Installation 5, 442 

Networks, Multi-seat Node-locked 3 

NI DIAdem 72 

Non-parametric Statistics 357 

Numbers in Origin 51 

O 

Object Linking and Embedding (OLE) 385 

Object Manager 36, 176, 184 

OGM Files 55 

OGS Files 55 

OIF Files 55 

OpenGL 432, 443 

Orglab 427 

Origin C 426 

Origin C, IDE 48 

Origin Viewer 442 

Origin Workspace 19 

Origin, Display Language 7 

Origin, License Deactivation 7 

Origin, Licensing 3 

Origin, Registering 6 

Origin, Service Releases 6 

Origin, System Transfers 7 

Origin, Uninstalling 8 

Origin, Upgrading 3 

OriginPro, Features 13 

Orthogonal Regression 13 

P 

Packaging Origin Files 442 
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Page, Graph 174 

Panning Graphs 285 

parametric function plots 172 

Parametric Function Plots, 2D and 3D 172 

pClamp 72 

pCLAMP 72 

Peak Analysis 14, 311 

Pivot Tables 127 

Plot Designation 170–69 

Plot Details Dialog Box 176 

Plot Setup Dialog Box 176, 182, 188 

Plots, Exchanging 180 

Plotting Virtual Matrix Data 171 

Plotting Worksheet Data 170 

PowerPoint, Exporting to 401 

Preferences 

Options 429 

Princeton Instruments 72 

Prism 72 

Profiling Images 156 

Profiling Matrix Data 156 

Programming Origin 378, 423 

Programming Origin, LabTalk 423 

Programming Origin, R 425 

Programming Origin, X-Functions 426 

Project Explorer 27 

PXP 72 

Python 425 

PZFX 72 

Q 

QDA 72 

R 

R 425 

RAW 72 

REC 72 

Recalculate 362 

Recalculation of Results 362 

Region of Interest 137 

Region of Interest (ROI) 303, 304, 311, 336, 
337, 338, 340, 342, 371 

Regional Data Selector 325 

Re-Importing 80 

Repetitive Tasks, Filters for 376 

Reports, Analysis 372 

Rescaling Graphs 285 

Results Log 50 

Rise Time 311 

ROC Curve 359 

S 

Sample Projects 9 

SAS 72 

sas7bdat 72 

SAV 72 

Screen Reader 295 

Scripting 423 

Selecting Data, Graph 322 

Selecting Data, Worksheet 319 

Set Column Values, Worksheet 112 

Set Matrix Values 157 

Sharing Files with Multiple Users 442 

Sharing Origin Files 441, 442 

SIE 72 

SigmaPlot 72 

Sigmoidal Fit 311 

Signal Processing 15 

Signal Processing, Coherence 346 

Signal Processing, Correlation 345 

Signal Processing, Decimation 346 

Signal Processing, Envelope Curves 346 

Signal Processing, Filtering 344 

Signal Processing, Rise Time 346 

Signal Processing, Smoothing 344 

Signal Processing, Transforms 343 

Slide Show of Graphs 402 
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Smart Hints 47 

Smoothing 344 

Somat 72 

Sorting Worksheet Data 127 

Sparklines 107 

SPC 72 

SPE 72 

SPSS 72 

SQL Data 76 

Statistics 14, 303, 311 

Statistics, Basic 349 

Statistics, Charts 354 

Statistics, Data Selection 352 

Statistics, Descriptive 349 

Statistics, Multivariate 14 

Statistics, Report to Script/Command Window
 353 

Statistics, Report to Status Bar 352 

Status Bar 46 

Surface Fit 339 

Surface Fitting, 3D 14 

Survival Analysis 358 

System Transfer 7 

System Variables 431 

T 

Technical Support 9 

Tektronix 72 

Templates 435 

Templates, Analysis 131, 366, 372 

Templates, Project 365 

Templates, Workbook 365 

Theme Organizer 221, 281, 438 

Themes 435 

Themes, Dialog Box 364 

Thermo 72 

Toolbar Bitmaps, in Menus 433 

Toolbar Buttons, Custom 434 

Toolbars and Buttons, Customzing 433 

Toolbars, Customizing 21 

Training 9 

Transfer User Files 5 

t-Tests 356 

Tutorials, Help File 9 

Tutorials, Video 11 

U 

Update Legend 220 

Upgrading Origin 3 

User Files Folder (UFF) 5, 442 

User Files, Transferring 3 

User Forum 9 

V 

Video Builder 403 

Virtual Matrix 164 

Visual Basic/Visual C/C# 427 

W 

WAV 72 

Wavelet Analysis 345 

Windows, Dock/Float/Auto-Hide 50 

Workbook Organizer 108 

Workbooks, Naming 84 

Worksheet Column Label Rows 104 

Worksheet Column Properties 98 

Worksheet Plot Designations 174 

Worksheets, Converting from Matrix 160 

Worksheets, Converting to Matrix 163 

Worksheets, Exporting 399 

Worksheets, Naming 84 

Worksheets, Processing Data 127 

Worksheets, Set Column Values 112 

Worksheets, Sorting Data 127 

Worksheets, Transposing Data 127 

X 

X-Functions 426 

XML 72 
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Z Zooming Graphs 285 
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